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FlexNet Operations LLM 
Producer Portal User Guide 

FlexNet Operations LLM (License Lifecycle Management) is a software solution designed to manage and optimize 
the lifecycle of software licenses. It provides capabilities for software producers and high-tech manufacturers to 
effectively handle licensing, entitlement management, and software delivery.

FlexNet Operations LLM Producer Portal is the application used to manage members, products, and entitlements 
on the FlexNet Operations LLM service. FlexNet Operations LLM Producer Portal is a secure web based 
application that is accessible with any current generation web browser. 

Information about how to use the FlexNet Operations LLM Producer Portal is described in the sections listed in 
the following table.

Table 1-1 • FlexNet Operations LLM Producer Portal User Guide

Topic Content

Introduction to FlexNet 
Operations LLM Producer Portal

Introduction to the concepts in FlexNet Operations LLM and the Producer 
Portal. 

Accounts & Members Describes FlexNet Operations LLM Producer Portal internal users/accounts 
and how to manage user permissions.

Entitlements Provides an explanation of the processes necessary for managing software 
entitlements, and also includes the best practice for processing 
entitlement-related transactions.

Features Describes many of the features used in FlexNet Operations LLM.

Product Management Provides insights on product management support.

Transactions Explains how to view transactions, and in the case of failed transactions to 
edit and resubmit them.

FlexNet Publisher Licensing Describes FlexNet Publisher certificate style licensing in FlexNet 
Operations LLM.
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Product Support Resources
The following resources are available to assist you:

• Revenera Product Documentation

• Revenera Community

• Revenera Learning Center

• Revenera Support

Revenera Product Documentation
You can find documentation for all Revenera products on the Revenera Product Documentation site:

https://docs.revenera.com

Revenera Community
On the Revenera Community site, you can quickly find answers to your questions by searching content from other 
customers, product experts, and thought leaders. You can also post questions on discussion forums for experts 
to answer. For each of Revenera’s product solutions, you can access forums, blog posts, and knowledge base 
articles. 

https://community.revenera.com

FlexNet Embedded Licensing Describes FlexNet Embedded licensing in FlexNet Operations LLM.

Usage Search Describes how to use the Usage Search function to find the usage and drill 
down to various statistics and graphs

User Defined Fields (UDFs) Describes in the user-defined fields (UDFs) used in FlexNet Operations 
LLM.

FlexNet Operations LLM Support 
Process

Describes the FlexNet Operations LLM support process. 

Administer Explains how to perform administrative tasks.

Technical Reference Lists the state and province codes for the U.S. and Canada, as well as the 
Country Codes used in FlexNet Operations LLM.

FlexNet Operations LLM 
Web Services Implementation

Examples of FlexNet Operations LLM API commands.

Table 1-1 • FlexNet Operations LLM Producer Portal User Guide (cont.)

Topic Content

https://docs.revenera.com
https://docs.revenera.com
https://community.revenera.com
https://community.revenera.com
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Revenera Learning Center
The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the most out of your 
Revenera products. You can find a complete list of these training videos in the Learning Center.

https://learning.revenera.com

Revenera Support
For customers who have purchased a maintenance contract for their product(s), you can submit a support case 
or check the status of an existing case by first logging into the Revenera Community, clicking Support on the 
navigation menu to open the Support Hub page, and then clicking the Open New Case or Case Portal button.

Contact Us
Revenera is headquartered in Itasca, Illinois, and has offices worldwide. To contact us or to learn more about our 
products, visit our website at:

http://www.revenera.com

You can also follow us on social media:

• Facebook

• LinkedIn

• YouTube

• Instagram

https://learning.revenera.com
https://community.revenera.com/s/
https://www.facebook.com/flexera/
https://www.linkedin.com/company/revenera/
https://www.youtube.com/c/GetRevenera
https://www.instagram.com/weareflexera/
http://www.revenera.com
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Introduction to FlexNet 
Operations LLM Producer Portal

FlexNet Operations LLM Producer Portal is the application used to manage Members, Products, and Entitlements 
of FlexNet Operations LLM. FlexNet Operations LLM Producer Portal is a secure web based application that is 
accessible with any current generation web browser.

For the purpose of granting access to FlexNet Operations LLM Producer Portal, the functions are divided into 
three groups: 

• Account/Member/Entitlement

• Product Management

• Email Templates

These groupings generally correspond to the “order processing” and/or “customer support” role, the “product 
manager” role, and the “product marketing” role respectively at a software publisher. An individual user may 
have access to one or more of these role-based groupings. Other functionality, e.g., viewing transaction reports, 
is available to all FlexNet Operations LLM Producer Portal users.

Information about FlexNet Operations LLM Producer Portal is presented in the following sections:

• Overview of FlexNet Operations LLM Producer Portal

• Product Management

• Email

• Entitlements

Overview of FlexNet Operations LLM Producer 
Portal

This section explains how to access FlexNet Operations LLM Producer Portal, introduces you to the navigation, 
and explains how to access help resources and perform searches. 

• Access and Login
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• Navigation

• Help

• Searches

Access and Login
To access FlexNet Operations LLM Producer Portal, open a web browser and enter the below URL for the FlexNet 
Operations LLM Producer Portal you wish to access:

The following screen opens:

Figure 2-1: Login to FlexNet Operations LLM Producer Portal

Enter your Login ID and Password and click Login.

Note • If you forget your password or Login ID, click the Forgot your password? link. Simply provide your email 
address and this information will be emailed to you.

Table 2-1 • FlexNet Operations LLM Producer Portal URLs

Environment URL

User Acceptance Testing 
Environment

https://manageruat.flexnetoperations.com

Production Environment  https://manager.flexnetoperations.com

https://manageruat.flexnetoperations.com
https://manager.flexnetoperations.com
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Navigation
FlexNet Operations LLM Producer Portal is navigated via tabs and menus. Each tab represents a major area of 
functionality. Sub-menus within the tabs provide access to specific functions. 

Figure 2-2: FlexNet Operations LLM Producer Portal Navigation Bar

The major components of FlexNet Operations LLM Producer Portal (tabs) are: 

• Manage Accounts

• Entitle Customers

• Package Products

• Manage Hosts

• Track Usage

• Administer

Sub-menus also appear for the above mentioned tabs. For instance, the screen below shows sub-menu items for 
Manage Accounts tab.

Figure 2-3: Manage Accounts Sub-Menu Items

The top navigation bar also contains a Help icon to access product Documentation, and a Resources menu:
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Figure 2-4: Resources Menu

The Resources menu offers the following selections:

• A link to Switch Site (if you manage more than one FlexNet Operations LLM site).

• A link to FlexNet Operations LLM Reporter

Important • Access to Reporter is permission driven. For more information, see User Permissions and the 
FlexNet Operations Reporter User Guide. 

• The Latest News about FlexNet Operations LLM

• A link to view product Uptime on the Revenera Status page

• A link to the Documentation for FlexNet Operations LLM Producer Portal

• A link to Your Site

• A link to the Revenera Community

Help
For the online help, click on the Help icon in the navigation bar or select Documentation on the Resources menu.

You can also get Quick Help by mousing over field labels. Where available, a small popup window will display field 
usage, expected formats, and/or character limits.

For instance, while on the Add a Product page, mouse over the Product Name field. The underline indicates there 
is help available. Click on the Product Name label to view the details in the pop-up display. The following displays 
the quick help popup window for the Product Name field:

https://status.revenera.com/
https://docs.revenera.com/fno_CURRENT/reporter_llm/Default.htm
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Figure 2-5: Quick Help for the Product Name Field

Searches
Throughout FlexNet Operations LLM Producer Portal, you have multiple options to perform searches:

• Quick Search on Home Page

• Full Search

• Quick Search On Producer Portal Pages

Quick Search on Home Page
You can use the Quick Search area on the Home page to search for items on one of the listed tabs.
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Figure 2-6: Quick Search on Home Page

Full Search
You can perform a full search for accounts, members, entitlements, license tokens, catalog items, products, files, 
product lines, devices, license servers, served clients, device models, license hosts, emails, bounced emails, 
transactions, or batches by making a selection from the top navigation submenus. The submenu shows the 
search options on the Package Products menu. 

Figure 2-7: Full Search Options on Submenu

The following are the fields displayed when performing a full search for a product:
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Figure 2-8: Full Search for a Product

Quick Search On Producer Portal Pages
On many of the Producer Portal pages, you can use the Quick Search controls to perform a search.

Figure 2-9: Quick Search Controls on Producer Portal Page

After you select a property to search by, you can enter search criteria in the text box:
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Figure 2-10: Search Criteria in Quick Search Control

Product Management
This section explains the concepts behind managing products in FlexNet Operations LLM Producer Portal and 
how to set them up.

• Product Configuration Relationships

• Catalog Item Concepts

• Product Concepts

• File Concepts

• Examples of Product Hierarchy

• Setting Up Products

Product Configuration Relationships
You manage products at the following three different levels through FlexNet Operations LLM Producer Portal:

• Catalog Items (also known as part numbers or SKUs).

• Products (also called versions or releases).

• Files (the binary images that customers download).

From the FlexNet Operations LLM End User Portal, a user would click through the following levels to drill down to 
the next level.

Manufacturer* > Catalog Item Product Line* > Product Product Line* > Product > Files
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Note • The asterisk (*) symbol indicates that level ends if there is just one choice.

Catalog Item Concepts
Catalog Items (price list items) represent the things that your company sells. For example, this could be a product 
or a maintenance agreement. Catalog Items have attributes such as a unique identifier (ID), default duration, 
whether it includes updates (such as maintenance), and what product line it belongs to. 

When you Entitle your customers (or process orders) in FlexNet Operations LLM, you entitle them to Catalog 
Items. Catalog Items can contain one or more Products, and can be used to create a bundled “suite” of products 
delivered together.

You may also sell the same set of products or files under more than one part number.

Product Concepts
Products (product releases) represent the things that your company wants delivered. For example, this could be a 
specific version, release or service pack. Products have attributes such as a unique identifier (ID), version 
number, release dates, and what product line it belongs to.

The Product that you add through FlexNet Operations LLM Producer Portal is also a logical grouping of one or 
more downloadable Files, and can be associated with one or more Catalog Items.

More key elements of Products include:

• Effective and Expiration dates overlap with Entitlement date ranges to create a dynamic end user view,

• Export classification information, which is required to be able to export products outside the United States,

• Customizable download instructions for the set of files contained therein, and

• May contain a click-through or end user license agreement (EULA).

File Concepts
Files (images) are the actual software binary files that the end user downloads. For example, this could be a 
specific installation executable for a particular platform. Files have attributes such as a unique identifier (ID), a 
file description and file name.

Files which are part of the same release are grouped together into one or more Products which are in turn 
entitled through Catalog Items.

Files can also be readme files or product documentation such as an install guide or user’s manual.

Examples of Product Hierarchy
The following diagrams show sample product hierarchies:
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Figure 2-11: Product Hierarchies / Example 1

The following diagram is another example of product hierarchies.
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Figure 2-12: Product Hierarchies / Example 2

Setting Up Products
To set up products in FlexNet Operations LLM, you need to perform the following steps:

• Step 1: Plan

• Step 2: Create a Manufacturer

• Step 3: Create a Product Line 

• Step 4: Create an Agreement 

• Step 5: Add Catalog Items

• Step 6: Add Products

• Step 7: Associating Products to Catalog Items 

• Step 8: Add Files 

• Step 9: Associating Files to Products

Step 1: Plan
Perform the following planning steps:

• Begin your plan of action by gathering a list of files and determining how to group these files. These 
groupings become your Products. Sets of files grouped together by versions, platforms or languages are all 
good candidates.

• Gather a list of SKUs to entitle your customers to, and determine how the SKUs map to the products.

• Visualize the relationships (Excel or Visio are useful tools for visualization).
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Step 2: Create a Manufacturer
More than one Manufacturer of the software you distribute can be represented in our system. The ‘Manufacturer’ 
is an attribute of both Product and Catalog Items.

Task To create a Manufacturer:

1. On the Package Products menu, click Add Manufacturer. The Add Manufacturer page opens.

2. Enter the required data in the Manufacturer ID and Manufacturer Name fields, and then click Save.

Step 3: Create a Product Line
Product Lines are attributes of both Catalog Items and Products, and are used for navigational purposes both in 
the Producer Portal and on the End User Portal.
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Task To create a Product Line:

1. On the Package Products menu, click Add Product Line. The Add Product Line page opens.

2. Enter the required details in Product Line ID and Product Line Name fields (the other fields are optional) and 
then click Save.

Step 4: Create an Agreement
A click-through or End User License Agreement (EULA) commonly contains content supplied by your legal 
department. The end-user is prompted to ‘Agree’ to the terms before proceeding to the download page. The 
Agreement is an attribute of a Product.
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Task To create an Agreement:

1. On the Package Products menu, click Add Agreement. The Add Agreement page opens.

2. Enter the required data in the Agreement Name and Agreement Content fields. 

Tip • Click the Toggle Editor button under the Agreement Content field to access a formatting toolbar that 
you can use to format the text. The content supports HTML formatting, which is highly recommended. To 
enter content in HTML format, click the HTML button in the Editor toolbar to open the HTML Source Editor.

3. Click Save. 

Step 5: Add Catalog Items
Catalog Items need to exist before Entitlements (orders) can be processed and before Products can be 
associated to them.
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Task To add Catalog Items:

1. On the Package Products menu, click Add Catalog Item. The Add a Catalog Item page opens.

2. Enter the required data in the following fields (and leave remaining fields set to defaults):

• Catalog Item ID—The unique SKU or ID to which customers will be entitled.

• Catalog Item Name—The name of the item.

• Catalog Manufacturer—The Manufacturer of the item.

• Catalog Product Line—The Product Line that items appear in.

3. If there is a 1-1 relationship between Catalog Item and Product, then click Save & add product... to complete 
this transaction. The Product Details area of the Add Product page opens.
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Note • Alternately, you can also click Save & add another... or Save & associate product... or Save & configure 
FlexNet Licensing...

Step 6: Add Products
Products need to exist before they can be associated to Catalog Items as well as have Files associated to them.
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Task To add Products:

1. On the Package Products menu, click Add Product. The Add Product page opens.

2. Enter the required data in the following fields (leave remaining fields set to defaults):

• Product ID—Unique ID used to associate to Catalog Items and Files

• Product Name—Displayed to end users

• Version—The version of the Product

• Effective Date—Date when the Product becomes available on the site

• Expiration Date—Date when the Product moves to the archive tab, or is no longer accessible to 
Entitlement Lines with starting dates after this same date

• Product Manufacturer—The Manufacturer of the item

• Product Line—The Product Line in which the Product appears

• End User License Agreement—Optional click-through agreement
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• Download Instructions—Text or HTML displayed on the page above the list of files

• ECCN—Set to No Export unless you know the ECCN, ENC, and CCATS codes.

3. If there is a 1-1 relationship between Product and File, then click on the Save & add file... button to complete 
this transaction. The Add File page opens.

Note • Alternately, you can also click on the Save & add another....

Step 7: Associating Products to Catalog Items
If you need to manually associate Product to Catalog Items after they are created, you can do so by performing 
the following steps. 
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Task To associate Product to Catalog Items:

1. On the Package Products menu, click Search Catalog Items. The Search Catalog Items page opens.

2. Enter the required data in the Catalog Item Name or Catalog Item ID box and click on the Search button. A list 
of Catalog Items matching the search criteria are listed. 

3. Click on a System Catalog Item ID of the item you want to view. The View Catalog Item page for that item 
opens.
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4. Click on the Associate button and select Associate Products.

The Associate Products to Catalog Item page opens.
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5. There are following two ways to associate Products to Catalog Items:

• If you know the exact ID of the Product you want associated, then enter it here and click on the 
Associate products button.

• If you don’t know the exact ID of the Product you want associated, you can search for it on the lower half 
of the screen. Enter search criteria and click the Search button. A list of products matching the criteria is 
listed on the Associate Products to this Catalog Item page. 
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6. Once you have found the Products you wish to associate, click the check box next to the product name and 
then click the Associate products button below the listing. 

Step 8: Add Files
Files need to have a File ID placeholder in the database to attach the binary image to. Files also need to exist 
before you can associate them to Products.
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Task To add files:

1. On the Package Products menu, click Add File. The Add File page opens.

2. Enter the required data in the File Description field, which will be displayed to the end user next to a 
download button. The File ID field is optional to enter the data, but highly recommended for product 
management uses. The File Name field is optional at this stage – it will be populated when the actual image 
is loaded from your file system.

3. Click the Save & upload file ... button. The Upload File page opens.
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There are four methods for uploading files:

• HTTP Upload—File images residing at a location local to the end user’s machine can be uploaded via the 
browser. This is the simplest and most direct method to upload smaller sized files. Continue with Step 4. 
For more information, see HTTP Upload.

• FTP Upload—File images previously loaded to the Revenera FTP upload server can be uploaded. Skip to 
Step 5. For more information, see FTP Upload. 

• Remote FTP Server—File images located on a remote non-Revenera FTP Server can be uploaded. Skip to 
Step 6. For more information, see Remote FTP Server. 

• High Speed Upload—This is the optimized method to upload larger sized files. This method requires the 
installation of the high speed plug-in. Skip to Step 7. For more information, see High Speed Upload. 

4. To use the HTTP Upload option, perform the following steps:

a. Open the HTTP Upload tab. 

b. Click on the Browse… button and choose the file.

c. Click on the Upload button.

d. Wait for the file to upload.

5. To use the FTP Upload option, perform the following steps:

a. Open the FTP Upload tab. 
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b. Click the Browse button and select the file you want to upload. 

c. Enter the Expected MD5 CheckSum value. 

Note • The expected value of the MD5 CheckSum utility should be a 32 character hexadecimal value. 
When you enter a value in this field, the Upload File process will check that the file it received has the 
same CheckSum as the value you enter here. It enables additional quality control during the File Upload 
process.

d. Enter the Expected SHA2 CheckSum value (if applicable).

Note • The expected value of the SHA2 CheckSum utility should be a 64 character hexadecimal value. 
When you enter a value in this field, the Upload File process will check that the File it received has the 
same CheckSum as the value you enter here. It enables additional quality control during the File Upload 
process.

e. Click Upload File from Flexera Software FTP Server. 

6. To use the Remote FTP Server option, perform the following steps:

a. Open the Remote FTP Server tab. 

b. Enter the FTP Hostname of your FTP server.

c. Enter the FTP Username and FTP Password of your FTP server.

d. Enter the full path to the file in the Path and Filename field.

e. Enter the Expected MD5 CheckSum value. 

Note • The expected value of the MD5 CheckSum utility should be a 32 character hexadecimal value. 
When you enter a value in this field, the Upload File process will check that the File it received has the 
same CheckSum as the value you enter here. It enables additional quality control during the File Upload 
process.

f. Click Upload. 

7. To use the High Speed Upload option, perform the following steps:

a. When you open the High Speed Upload tab, you are prompted to install the plug-in by clicking Install 
add-on.
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b. Click Install add-on to install the plug-in. 

c. Next, click on the High-Speed Upload tab again. You are prompted to proceed with Step 2, Install 
Connect. 

d. Click Install Connect. A file is downloaded.

e. Install the downloaded file. The Activity - IBM Aspera Connect dialog box opens.

f. Return to the High Speed Upload tab:

g. Enter the Expected MD5 CheckSum. 

Note • The expected value of the MD5 CheckSum utility should be a 32 character hexadecimal value. 
When you enter a value in this field, the Upload File process will check that the File it received has the 
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same CheckSum as the value you enter here. It enables additional quality control during the File Upload 
process.

h. Initiate the High Speed Upload for your file by clicking on the Upload button and choosing the file.

i. You can monitor the file transfer status in the Activity - IBM Aspera Connect dialog box while you 
proceed to other functions using your browser.

Step 9: Associating Files to Products
If you need to manually associate Files to Products after they are created, you can do so by performing the 
following steps. Otherwise, if you followed the gray-box workflow button for a 1-to-1 mapping, this will be done 
automatically for you.

Task To associate Files to products:

1. On the Package Products menu, click Search Producs. The Search Products page opens.

2. Enter the required data in the  Product Name or Product ID field, and click on the Search button. A list of 
products is returned. 
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3. Click on the System Product ID of the product you want to associate files to. The View Product page opens.

4. Click on the Associate button and select Associate Files. 

The Associate Files to this Product page opens.
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5. There are the following ways to associate Files to Products:

• If you know the exact ID of the File you want associated, then enter it in the File IDs box and click 
Associate files.

• If you don’t know the exact ID of the File you want associated, you can search for it on the lower half of 
the Associate Files to this Product page. Enter search criteria and click the Search button. A list of files 
is returned. Once you have found the Files you wish to associate, click the check box next to the System 
File ID of the files you want to associate and then click the Associate files button below the listing.

Email
This section provides an overview of how email is used in FlexNet Operations LLM Producer Portal and how to edit 
email templates. 

• Email Overview
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• Editing Email Templates

• Localization of Email Templates

• Setting Up Variations of Email Templates

Email Overview
Email is sent to Members based on FlexNet Operations LLM events.

The following are the common events:

• New Member added (which sends the Welcome Email)

• New Entitlement created (which sends the Order Email)

• Software Update Available (which sends the Update Notification Email)

The FlexNet Operations LLM Producer Portal application allows you to change the templates that are used by the 
FlexNet Operations LLM application to send email to the end user, your customer. Email templates are listed on 
the Administer > List Email Templates page.

Figure 2-13: List Email Templates Page

FlexNet Operations LLM Producer Portal offers you flexibility in editing your Email Templates. You can create the 
new text in draft mode and then print it for approval. In the mean time, your template is saved in a Draft status. If 
you want to go back to a previous version, you can look in your archived versions and change it into the Live 
version again.
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Email Status Values
Email Templates can be in one of the following three statuses:

• Live—This template is used by the application to send out an email. There can only be one Live template at a 
time.

• Draft—This template is in progress. Changes have been made but it is not ready to be used as the live 
template yet. There can only be one Draft template at a time.

• Archived—These templates were once Live but have been replaced by newer versions. The system will 
archive your older versions of the template for you.

Send? Column
Whether or not the application will attempt to send the email is specified by the value in the Send? column:

• Yes—Send the email.

• No—Do not send the email.

Note • Email templates have to have a Status of Live and the Send? option set to Yes in order for emails to 
be sent.

Important • The UAT instance of FlexNet Operations Producer Portal does not send out any emails other than 
password finders, so emails will only be queued even if the email template has a Status of Live and the Send? 
option is set to Yes. 

You can change this value (provided you have the correct application permissions).

Task To edit the Send? option:

1. On the List Email Templates page, click on the Template ID of the email template you want to edit. The View 
Live/Draft Email Template page opens.

2. Click Edit > Edit Definition. The Edit Email Template Definition page for that email template opens.
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3. Set the Will Email Be Sent? field to either Yes or No.

4. Click Save template. 

Editing Email Templates
To edit an email template, perform the following steps. 

Task To edit an Email Template:

1. On the Administer menu, click List Email Templates. The List Email Templates page opens.

2. Choose the Email Template you wish to edit by clicking on the Email Template ID. The View Live Email 
Template page opens.

3. Click on the Edit button and select Edit Live Content or Edit Draft Content.
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The content of the email template is displayed:
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Note • Only the Live Template will be used to send emails to customers.

4. Edit the Template by inserting content into the available text boxes.

Note •  Emails can be created as text and HTML, and we recommend using both.

5. You can choose from the list of available merge tags in the Merge Tag List at the bottom of the page to draw 
in specific data at the time the email is actually generated. This list will vary depending on the Email 
Template and the type of data available to it.

6. When you have modified your Email Template, click the Preview & save button. The Edit Email Template 
Content - Preview page opens displaying a preview of the email template. 
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7. Click the Save button to save it as a Live Email Template, or click the Save draft button to save it in Draft 
mode. If you wish to continue editing the Email Template, click on the Back to edit button. 

Localization of Email Templates
You can localize email templates into multiple languages. However, this option needs to be enabled during 
implementation. 

Task To localize the content of an email template:

1. On the Administer menu, click List Email Templates. The List Email Templates page opens.

2. Choose the Email Template you wish to edit by clicking on the Email Template ID. The View Live/Draft Email 
Template page opens.

3. Click Edit > Edit Live/Draft Content. Next to each text field, a Show languages button is displayed.
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4. Click the Show languages button. Additional text fields for the specified languages are listed and the button 
is renamed to Hide languages.

5. Enter localized content in the language text fields and click Preview & save.

Note • For more information, see Localized Emails. 

Setting Up Variations of Email Templates
You can define multiple variations of each email template. If you define multiple variations, the users are given 
the option to select from available template alternatives when sending an email.
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Task To specify an email template variation:

1. Select Administer > Add Email Template. The Add Email Template Variation page opens.

2. From the Email Type list, select the type you want to create an alternate email template for. 

Note • This step assumes that a default version of that Email Type already exists. The first email template 
that is created for this Email Type was assigned the name DEFAULT in the Variation Name field. 

3. In the Variation Name field, enter a reference for an alternate email template. This value can be up to 25 
characters and is displayed to users who have the option to select from available template alternatives when 
sending an email.

4. Click Save template. This email template will now be listed on the List Email Templates page with a different 
Template ID than the default version of this Email Type template, and with the Variation Name that you 
entered listed in the Variation column. 

Entitlements
This section describes how entitlements are used in FlexNet Operations LLM Producer Portal and how to create 
customer entitlements. 
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• Overview of Entitlements

• Entitling Customers

Overview of Entitlements
An Entitlement in FlexNet Operations LLM is a representation of which software deliverables should be granted to 
which Account. The Entitlement includes the Catalog Item and the duration of time for which access to it should 
last. It can also be referred to as an order. The following represents the work flow pertaining to Entitlement in 
FlexNet Operations LLM: 

Figure 2-14: Entitlement Workflow in FlexNet Operations

Account Concepts
Accounts are customers who you sell to or are licensed to access the product. 

• Examples include companies, sites, departments or divisions.

• Accounts are entitled to software, and all Members associated with an account have the same access.

• An Account needs to have one or more Members associated with it. 

• At least one Member must exist in order for someone at the company to have access the site.
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Member Concepts
Members are end users. 

• A Member’s e-mail address is their username, and FlexNet Operations LLM generates a password. Username 
and password are sent via the Welcome Email. 

• Software access for a Member is controlled by which Account they are on. 

• The Member’s physical address is used for export compliance.

Entitlement Concepts
Frequently, Entitlements are order driven. Entitlements can also be thought of as a way of grouping Line Items. 

Entitlement header information shows up on the Order History page, and can be sent in an Order Notification 
email.

Line Item Concepts
Line Items specify the Catalog Item to grant an Account access to. 

• Line Items have Effective and Expiration dates and typically map to maintenance contracts.

• The end user view of specific Product versions is determined by how Line Item dates overlap with Product 
effective dates that are associated with the entitled Catalog Item.

Entitling Customers
This section describes the following scenarios for entitling customers:

• Creating and Entitling New Customers

• Entitling an Existing Customer Account

Creating and Entitling New Customers
To create and entitle new customers, perform the following steps. 



Chapter 2 Introduction to FlexNet Operations LLM Producer Portal
Entitlements

58  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Task To entitle a new customer:

1. On the Manage Accounts menu, click Add Account. The Add an Account page opens.

2. Enter the required details in the Account ID*, Account Name*, and Account Note box, 

Note • Consider the following while entering the required data: 

• Customer ID or other unique ID is entered in the Account ID field.

• Company name is entered in the Account Name field.

• Description is entered in the Account Note field, which is also optional.

3. Click Save & add members... The Add A Member page opens.
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4. Enter required details on the Add a Member page.

Consider the following while entering the details in the required fields on the Add a Member page:

•  Most fields are self explanatory; required fields are denoted with an asterisk (*) sign.

• Member ID is optional, but you can reuse the email address if you don’t have one and want to set it.

• Be sure to set the Member’s permissions. Account Administrators can add or remove Members from the 
Account on the FlexNet Operations LLM (download) site.

If there is a 1-1 relationship between Account and Member, then click Save & entitle account ... to complete 
the transaction. The Entitle Account page opens.
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5. On the Entitle Account page, you can start by choosing the members to receive the Order Notification email 
in the Send Entitlement Notification Email area. 

Note • This only controls Email notification, not Entitlements. All Members on an Account share the same 
Entitlements.
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6. Enter data into the Entitlement Details area. Fields are self explanatory and optional, but they can be used in 
the Order Notification email, as well as appear in the Order History section of the FlexNet Operations LLM End 
User Portal. 

7. If you know the exact Catalog Item ID that you want to entitle this customer to, enter it in the Catalog Item ID 
field in the Line Items area.

If you are unsure of the exact Catalog Item ID to use, you can search for it by typing in a partial Catalog Item 
ID (* is wildcard), and then click the Search icon. The Catalog Search dialog box opens.

8. Choose the appropriate Catalog Item from the dialog by clicking the Catalog Item ID. 

9. Enter the Effective Date and Expiration Date for access to this Line Item, or leave the default values. 

10. You can enter quantity (Qty) and extended price which are only used for display purposes in the Order 
History. FlexNet Operations LLM also supports the ability to store and display License Codes. Contact your 
Project or Account Manager for more information.

11. If desired, you can click Add more line items to add additional line items to this Entitlement.

12. Click Entitle account at the bottom of the screen.

Entitling an Existing Customer Account
To entitle an existing customer account, perform the following steps. 
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Task To entitle existing Accounts:

1. On the Entitle Customers menu, click Entitle Account. The Find the Account to Entitle page opens.

2. Enter search parameters and click Search. The Select an Account to Entitle page opens.

3. Click on an Account Name to choose that account. The Entitle Account page opens.
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4. On the Entitle Account page, you can start by choosing the members to receive the Order Notification email 
in the Send Entitlement Notification Email area. :

Note • This only controls Email notification, not Entitlements. All Members on an Account share the same 
Entitlements.
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5. Enter data into the Entitlement Details area. Fields are self explanatory and optional, but they can be used in 
the Order Notification email, as well as appear in the Order History section of the FlexNet Operations LLM End 
User Portal. 

6. If you know the exact Catalog Item ID that you want to entitle this customer to, enter it in the Catalog Item ID 
field in the Line Items area.

If you are unsure of the exact Catalog Item ID to use, you can search for it by typing in a partial Catalog Item 
ID (* is wildcard), and then click the Search icon. The Catalog Search dialog box opens.

7. Choose the appropriate Catalog Item from the dialog by clicking the Catalog Item ID. 

8. Enter the Effective Date and Expiration Date for access to this Line Item, or leave the default values. 

9. You can enter quantity (Qty) and extended price which are only used for display purposes in the Order 
History. FlexNet Operations LLM also supports the ability to store and display License Codes. Contact your 
Project or Account Manager for more information.

10. If desired, you can click Add more line items to add additional line items to this Entitlement. Then repeats 
these steps for each item. 

11. Click Entitle account at the bottom of the screen.
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Accounts & Members

This section describes FlexNet Operations LLM Producer Portal internal users/accounts and how to manage user 
permissions.

• Internal Users/Internal Accounts

• Managing Accounts & Members

• Managing User Permissions

Internal Users/Internal Accounts
This section provides guidelines to FlexNet Operations LLM Producer Portal customers on setting up and 
managing internal users of their FlexNet Operations LLM Producer Portal site.

Electronic delivery of software through FlexNet Operations LLM Producer Portal is valuable to internal users for 
the following reasons:

• Access to the most current versions of the software

• Readily accessible from remote locations, such as customer sites

• Convenience

• Possible to see customer’s view of accessible software

Information about internal users/accounts is found in the following sections:

• Types of Internal Users/Accounts

• Options for Setup of Internal User Accounts

Types of Internal Users/Accounts
Many departmental users derive further benefits from the use of FlexNet Operations LLM Producer Portal. The 
following examples illustrate the multiple departments that take advantage of FlexNet Operations LLM Producer 
Portal and the unique benefits that they receive from the service:
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Administrative Internal Users
FlexNet Operations LLM Producer Portal users can perform advanced tasks:

• Access to the FlexNet Operations LLM administrative tools – Producer Portal and Reporter

• Reviewing and validating product hierarchy

• Testing the entitlement set up and download experience on FlexNet Operations LLM Producer Portal.

Departmental Internal Users
There are five types of departmental internal users, each with different sets of permissions.

Sales

• Access to current versions of all available software

• Access to Evaluation products

• The ability to access and demonstrate software to prospects

Professional Services / Solution Engineers

• Access to software available to particular customer accounts

• On line access to entire set of current product offerings, including latest releases, version and patches

• Installation of software on-site at customer location

Development

• Awareness of how products are presented to customers

• Online access to entire set of current product offerings

Quality Assurance

• Final validation of product quality as experienced by the end customer

Support

• Troubleshoot download experience for specific customer

• Awareness of how products are presented to customers

• Access to current versions of all available software
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Options for Setup of Internal User Accounts
The following table illustrates the options for setup of internal user accounts, describes the advantages and 
disadvantages of each option, and includes Revenera’s recommendation for the appropriate departmental use.

Additional Considerations 
• For Options A or B above, assign only 2-3 users with administrative privileges per internal account to better 

manage access. 

Table 3-1 • Options for Setup of Internal User Accounts

Option Description Advantages Limitations
Recommended 
Internal User Group

A Internal users setup 
on one internal 
FlexNet Operations 
LLM Producer Portal 
account with access 
to all available 
software

• Users able to access all 
available products and 
releases

• Low maintenance for 
Manufacturer—add all 
qualified users to one 
account

• Control of usage limited—
everyone can access 
everything

• Reporting not specific to 
customer when internal 
users download on 
customer behalf

• Administrative

• Development

• QA

• Support

B Internal users on 
internal account(s) 
with access to a 
predetermined 
subset(s) of software

• Users able to access 
applicable software

• Increased usage control— 
internal users are only 
provided access to 
applicable software

• Increased maintenance 
for Manufacturer—likely 
will need to support 
multiple internal accounts 
and manage user and 
software entitlement

• Sales

• Development

• QA

• Support

C Internal users added 
as users of customer 
account(s), as and 
when access is 
necessary

• Access to software limited 
to customer account 
entitlement

• Usage tracked by 
customer

• Increased maintenance 
for customer—need to 
add internal user

• Customer perception of 
intrusion by 
Manufacturer—internal 
users shown as account 
members

• Professional 
Services/SE

D Internal users 
proactively added to 
customer accounts

• Access to software limited 
to customer account 
entitlement

• Usage tracked by 
customer

• Reduced maintenance 
effort and inconvenience 
for customer

• Increased maintenance 
for Manufacturer—need 
to add internal users

• Customer perception of 
intrusion by 
manufacturer—internal 
users shown as account 
members

• Professional 
Services/SE

• Support



Chapter 3 Accounts & Members
Managing Accounts & Members

68  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

• For any of the Options selected, the FlexNet Operations LLM Producer Portal customer should define an 
internal plan with process on how internal members are set up. 

Managing Accounts & Members
This section explains how to manage accounts and members.

• About the Manage Accounts Menu

• Accounts

• Members

About the Manage Accounts Menu
You can use the items on the Manage Accounts menu of the FlexNet Operations LLM Producer Portal to create 
and edit Producer Portal accounts (generally equivalent to your “customer”) as well as Producer Portal members 
(generally equivalent to your “user”).

Figure 3-1: Manage Accounts Menu

You begin managing accounts and members by either searching for, or selecting, an existing account or member 
or by creating a new one. Since members must belong to an account ,you can't add a member without first 
selecting or creating an account.

You can use the Quick Search box on the FlexNet Operations Home page to  quickly find an account or member if 
you know the Account Name or ID or the Member Last Name or Email Address respectively. If your criteria match 
more than one account or member you will be given the opportunity to choose the account or member from a list. 
This function is not case sensitive and supports the use of the "*" character as a wildcard in most fields.

Accounts
The pages related to managing accounts are described in this section:
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• Search Accounts

• Add Account

• View Account

• Edit Account

• Merge Accounts

• View Transactions

• View Emails

Search Accounts
You can search for an account by the:

• Account Name—Descriptive name that your company uses to identify customers

• Account ID—Unique identifier that your company's internal systems may use to identify your customers

• System Account ID—Unique identifier created by the System when the account was first set up on Producer 
Portal

The Search Accounts function is not case sensitive and supports the use of the “*” character as a wildcard. 

Note • Wildcards cannot be used for System ID fields.

If your search criteria match more than one account, then you are given the opportunity to choose the account 
you are looking for from a list of those matching your criteria.

Add Account
The Producer Portal account is normally equivalent to your “customer”. When you make software available 
(entitle) to your customers through Producer Portal, you make it available to an account. An account may have 
many members and all of these members have access to the same software. They can see who else on the 
account has downloaded software. They can share notes between themselves. If they are administrators, they 
can add or delete other members to the account.

When you add an account you must provide:

• Account Name—Descriptive name that your company can use to identify this customer.

• Account ID—Unique identifier that your company’s internal systems may use to identify your customers.

• Additional fields—Any additional fields which are specific to your company and which your company 
identified as required when you set up your Producer Portal service. 

Note • Required fields are indicated by an * in the Producer Portal.

You may also provide:
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• Account Note—Optional free form text that you want to associate with this account. An example would be 
that this customer changed its name or the CEO is a particular friend of your CEO. Account notes are for 
internal use by your company and are only visible through Producer Portal and FlexNet Operations Reporter 
and do not show up on the FlexNet Producer Portal site.

• Additional fields—Any additional fields which are specific to your company and which your company defined 
identified as optional when you set up your Producer Portal service.

Once you have filled out the Add Account form, you may select:

• Add Account which will create the account and then display the account information along with options to 
modify the account, entitle the account to products, or add members to the account.

• Submit & Add Another Account which will create the account and then return you to a blank Add an Account 
screen where you can immediately add another account.

• Submit & Add Members to this Account which will create the account and then automatically take you to the 
Add Member screen where you can begin adding members to the account you just created.

View Account
When you search for or select an account, the system will display the View Account screen. The View Account 
screen displays all of the attributes of the account. 

Figure 3-2: View Account Screen

From this screen you can choose to:

• Edit—You can edit the account record by selecting Edit > Edit this Account. 

• Add members—You can add members to the account by selecting Edit > Add Member. 

• Entitle—You can entitle the account to software by selecting Entitle > Entitle Account. 
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• View entitlements—You can view all of the entitlements associated with the account  by selecting View > 
View Entitlements.

Edit Account
You can use the Edit Account page to modify the Account Name and Account Notes. The Edit Account page is 
essentially the same as the Add Account page.

When you are viewing an account, you are also shown a list of the members of the account. You can see detailed 
information for a member and switch to the View Member page by clicking on the member name. You can also 
click on the member email address to send them an email.

You can add new members to the account by selecting Edit > Add Member. 

Clicking Entitle > Entitle Account will take you to the Entitle Account page where you can create an Entitlement 
for this account. 

If you select View > View Entitlements, you will be shown a list of all the entitlements for the account. Selecting 
an entitlement lets you see the details of that entitlement and gives you the opportunity to edit the entitlement as 
well.

Merge Accounts
You can use the Edit > Merge this Account menu item on the View Account page to merge the accounts, 
members, and entitlements. 

View Entitlements
Select the View > View Entitlements menu item on the View Account page to display all entitlements for the 
account. Then click on an individual System Entitlement ID to view it. If no entitlements exist for the account the 
Search Entitlements page appears.

View Transactions
Select the View > View Transactions menu item on the View Account page to display all transactions for the 
account. Click on an individual System Transaction ID to view it. 

If no transactions exist for the account the Search Transactions page appears.

View Emails
Select the View > View Emails menu item on the View Account page to display all emails sent to the account. 
Click on an individual System Email ID to view it. 

If no emails exist for the account, the system will display a status message to that effect.
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Members
The pages related to managing members are described in this section:

• Search Members

• Add Member

• View Member

• Edit Member

• Member Preferences

• Member Permissions

• Inactivate/Reactivate Member

• View Transactions

• View Emails

• Resend Welcome Email

• Passwords

Search Members
On the Search Members page, you can search for a member using the following fields:

Table 3-2 • Search Members Fields

Field Description

Last name User's last name

First name User's first name

Email address In the form username@company.com

Domain name Part of the email address to the right of the "@"

Member ID Unique identifier that your company's internal systems may to identify end users within 
your customers

Member status You can search by one of the following:

• Active—Currently able to login to Producer Portal.

• Inactive—Members who have been administratively inactivated, either by 
someone in your company, or an administrator on the end user account.

• Both Active and Inactive

State Standard abbreviation for the U.S. state or Canadian province in which the user is 
located
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You can also limit your search to only those members who are administrators of at least one Producer Portal 
account by selecting the Member is Account Administrator check box.

The search member function is not case sensitive and supports the use of the "*" character as a wildcard. 

Note • Wildcards cannot be used for System ID fields.

To limit the member search to only a subset of the accounts within Producer Portal, you may also provide an 
Account Name, Account ID, or System Account ID as with the account search.

If your search criteria match more than one user, then Producer Portal will display a list of all the members who 
match all of the criteria you have provided. You can then pick an individual member from this list.

Add Member
Since members belong to accounts, you must select or create an account before you can add new members to 
the Producer Portal.

If you select Manage Accounts > Add Member without first having selected an account, you will be given the 
opportunity to select the account via the Find the Account to Add Members page. This page works just like the 
Search Accounts page.

Once you have selected an account, you use the Add Member page to actually add a user the Producer Portal 
system. You will enter:

• First and Last name—The first and last name of the Member, this is used in email templates, etc.

• Member ID—Unique identifier that your company's internal systems may use to identify end users within your 
customers.

• Email address—Of the form username@company.com (This becomes the Login ID to the Producer Portal 
service).

• Address information—Up to 4 lines.

• City

• State—U.S. state or Canadian Province.

• Postal Code

• Country

You can also add

• Job Title— Such as VP Engineering or Sr. Purchasing Manager

• Phone and/or Fax number

Country Name of the country in which the user is located

Table 3-2 • Search Members Fields

Field Description
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• Member Note—Optional free form text that you want to associate with this member, such as the fact that this 
member is willing to be a beta tester. Member notes are for internal use by your company and are only visible 
through Producer Portal and FlexNet Operations Reporter. They do not show up on your FlexNet Producer 
Portal site.

There are two permissions that you set for each member:

• Administrator—Allows user to manage the account he/she is associated with. Administration functions 
include, adding and removing users from the account, creating additional administrators, restricting access 
to specific products. The default for the administrator permission is "off". 

Note • This setting has no effect if you have disabled the administrative features on your site.

• Download—Allows user to download software. Users who do not have download permission can still be 
notified of updates and entitlements, but cannot download the software itself. The default for the download 
permission is “on”.

Note • Administrators can change this attribute for members of their accounts, including themselves.

• Send Welcome Email to this member—You can decide whether the system should send a welcome email by 
selecting the check box next to Send Welcome Email to this member. The Welcome Email template set up for 
your service will be used. 

Note • The member will only receive a welcome email if they do not already have a login to FlexNet Producer 
Portal.

Note • When adding a member to an account that has no entitlements, be sure to entitle the account immediately 
after adding the member(s). Entitling the account will ensure the new member(s) will be able to access software 
when they access their account for the first time.

Once you have filled out the Add Member page, you may select:

• Add Member—Which will create the create member and then display the member information along with 
options to make further changes to the member.

• Submit & Add Another Member—Which will create the member and then return you to a blank Add Member 
screen where you can immediately add another member to this account.

• Submit & Proceed to Entitle this Account—Which will create the member and then automatically take you to 
the Entitle Account screen where you can entitle the account you just created to software.

View Member
When you search for or select a member, the system will display the View Member screen. The View Member 
screen displays all of the attributes of the member. 

From this screen you can choose to Edit the member record or Add a new Member to the current account. You 
can also Inactivate and Reactivate the member.
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Edit Member
You can use the Edit Member page to modify any of the member attributes except the Member ID, Email Address, 
and the Login ID. These three are special values which are used by the system that are modified on separate 
screens.

Member Preferences
You can use the Member Preferences page, which is opened by selecting Edit > Set Preferences on the View 
Member page, to view and/or modify any of the member’s preferences. 

Note • The member can also change these preferences through the FlexNet Producer Portal website.

• Email Preferences—The Email Preferences determine at a high level if the member wants to receive emails 
and whether the member wants to receive update notifications. 

• Product Preferences—With the Product Preferences, the member can limit the list of products in 2 ways:

• View determines if the member will see the product when navigating or searching the FlexNet Producer 
Portal site. 

• Email determines if the member will receive Update Notifications for the product. The preference is set 
on the level of the Product Line and affects all the product that are belong to that Product Line.

Member Permissions
You can use the Set Permissions page to modify any of the member’s permissions. The permissions determine 
what functionality is available to a user of the Producer Portal. You can grant or revoke the following permissions.

Note • You need to supply the codes only if you are submitting an XML file.

Table 3-3 • Member Permissions

Users with this 
permission: Are able to: Code

Basic View Access See all of the information in the Producer Portal (read-only access.) 

Note • Required to log in to the Producer Portal and will be automatically 
assigned when any other permission is selected.

PTNR

UAT Access Access the User Acceptance Testing (UAT) environment for their site UATA
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Manage Accounts 
Management

Add, Edit, Inactivate, and Reactivate all Manage Accounts information, 
including Update Member Login, Re-Identify Member, and Re-Identify 
Account. 

Note • Required to be able to send a Welcome or Entitlement email from the 
Member/Entitlement pages.

ACMR

Limited Manage 
Accounts 
Management

Add, Edit, Inactivate, and Reactivate all Manage Accounts Information 
(excludes Update Member Login, Re-Identify Member and Re-Identify 
Account).

LACM

Merge Accounts Merge two Accounts into one Account, including Members and 
Entitlements.

MRGE

Reset Member 
Passwords

Regenerate a new password for an Enterprise Portal user without exposing 
the generated password.

PSWD

View As End User Login to the Enterprise Portal site as the end user in a read-only mode. VIEW

Entitlement 
Management

Enter new Entitlements, change existing Entitlements, and inactivate or 
reactivate Entitlement lines.

ORDE

Create Trial 
Entitlements

Create trial registration and submit/approve Trial entitlements in one step. 

Note • Only available if you are utilizing FlexNet Operations Registration Site 
functionality.

TENT

Licensing Support Generate, return, upgrade and re-host licenses on behalf of an End user 
from the View Licenses display. Includes ability to grant additional returns 
per Entitlement line. 

Note • Only available if you are utilizing a customized solution by Revenera.

LISU

Package Products Add and Edit all Catalog-related information, such as Catalog Items, 
Products, Files, Product Lines, Manufacturer, License Groups, and 
Agreements. 

Note • Includes RSTF functions below.

PDCT

Table 3-3 • Member Permissions

Users with this 
permission: Are able to: Code
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Deliver to Account Add a File, upload an Image, and restrict the File to an Account, so that you 
can distribute files for custom code or hot fixes to specific Accounts. 

Note • Sub-set of the PDCT permission above.

RSTF

Create Email 
Notifications

Create Update Notification Email messages that are sent to all members 
who have access to a specific File or Product.

NOTF

Queue Email Send emails that are created in the Producer Portal to a queue to be sent at 
a specified time. 

Note • Required to be able to resend a Welcome or Entitlement email from 
an email log.

QEML

Edit Unsent Emails Change Email content and distribution lists for unsent (Draft Status) Emails. 
Users with this permission can also copy the Email content and distribution 
lists of existing Email messages. 

Note • Required to be able to resend a Welcome or Entitlement email from 
an email log.

AEML

Submit XML 
Transactions

Submit XML transactions from the Upload Transaction File option in the 
Producer Portal, or through an XML feed.

OEMF

Maintain Email 
Templates

Edit the content of Email templates. TMPL

Maintain HTML 
Content

Update all of the documentation that is displayed as content on the FlexNet 
Operations site.

DOCS

Maintain UDF Values Add additional values to the drop-down list that appears for existing User 
Defined Fields (UDFs).

UDFV

Download File 
Images

Download File Images from the Producer Portal interface DNLD

Send Welcome Email Send Welcome Email without having full Account/Member permissions WELC

Reporter Access to the Reporter application REPT

Device Management Manage devices DVCM

Table 3-3 • Member Permissions

Users with this 
permission: Are able to: Code
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Transfer and Split 
Entitlements

Transfer and split entitlements to Allocation Groups. XFER

Move Devices/Hosts Move devices or hosts (servers) from one Account to another.

Create Ad-hoc Emails Create and send an email from the Producer Portal for a specific purpose, 
rather than one that is automatically triggered by a FlexNet Operations 
event, such as an Entitlement Confirmation or Product Notification.

Important • Requires Super Administrator permission. Contact your System 
Administrator or Revenera Support to request Producer Portal Administrator 
permission.

AHOC

Edit Sent Emails Edit an email after it is sent, so that the content displays correctly when 
viewed in the email log of FlexNet Operations.

Important • Requires Super Administrator permission. Contact your System 
Administrator or Revenera Support to request Producer Portal Administrator 
permission.

EDTR

Maintain UDF 
Definitions

Create new UDF definitions. Users with this permission can also make 
changes to existing UDF definitions, such as whether the field is mandatory 
or optional, or whether a list of pre-defined values is displayed.

Important • Requires Super Administrator permission. Contact your System 
Administrator or Revenera Support to request Producer Portal Administrator 
permission.

UDFT

Producer Portal 
Admin

Grant and revoke the Producer Portal permissions listed in this table to 
users with the exception of AHOC, EDTR and UDFT.

Important • Requires Super Administrator permission. Contact your System 
Administrator or Revenera Support to request Producer Portal Administrator 
permission.

SMAD

Table 3-3 • Member Permissions

Users with this 
permission: Are able to: Code
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Inactivate/Reactivate Member
If you choose to inactivate a member using the Inactivate Member function (by selecting Edit > Inactivate on the 
View Member page), the member will no longer be able to login to the service and will not get any further email 
updates. 

When you inactivate the member you are given the option of sending an email message notifying the user that 
she has been inactivated. The Inactivate Member Email template set up for your service will be used.

Note • The Enterprise Portal portions of Producer Portal use the term Cancel rather than Inactivate but the 
behavior is the same.

However, the member still exists in the system and you can reactivate it at will. To reactivate a member, search 
for and/or select the member and then select Edit > Reactivate on the View Member page. As with Inactivate, 
you have the option of sending a "welcome" email message to the user. 

Note • When reactivating a member, the same password will be used.

When you are working with a member record (such as updating the member) you can select View > View Account 
on the View Member page to view or make changes to the account to which this member belongs.

View Transactions
Select View > View Transactions on the View Member page to display all transactions for the member. Click on an 
individual System Transaction ID to view it. 

If no transactions exist for the member the Search Transactions page appears.

View Emails
Select View > View Emails on the View Member page to display all emails sent to the member. Click on an 
individual System Email ID to view it. 

If no emails exist for the member, the system will display a status message to that effect.

Resend Welcome Email
Select Edit > Send Welcome Email on the View Member page to have the system send a new welcome email to 
the member. The Welcome Email will use the current Welcome Email Template and the current member 
information, including the current password.

Passwords
If viewing your own member profile, select Edit > Change Password to change your Producer Portal Password to 
a new value that you specify. 
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If you are viewing another user's profile, select Edit > Reset Password to generate a new word#word password and 
have a Password Finder email sent.

Managing User Permissions
You are able to immediately grant permissions for FlexNet Operations LLM Producer Portal to others in your 
organization by using the Set Permissions option on the View Member screen. This document describes the 
process to set user permissions.

• Setting User Permissions

• User Permissions

• Security Considerations

Setting User Permissions
Permissions in FlexNet Operations LLM Producer Portal determine which functionality is available to a user. You 
must have the Producer Portal Administrator permission to manage permissions for your members. Contact your 
Revenera Customer Success Manager or Project Manager to enable this permission for you.

Task To manage permissions for your users:

1. View the member to whom you would like to grant permissions on the View Member page.

2. From the Edit menu, choose Set Permissions.
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3. Click check boxes to choose the applicable permissions, and then click Save.

Note • See User Permissions for more information.

Note • You need to supply the permission codes (last column) only if you are submitting transactions via 
Converter templates, XML, or Web Services.

User Permissions
FlexNet Operations has standard user permissions and administrative user permissions. Administrative 
permissions can only be assigned by a Revenera employee. 

• Standard User Permissions

• Administrative Permissions
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Standard User Permissions
The following are Standard user permissions.

Table 3-4 • Standard User Permissions

Permission Description Code

Basic View Access See all of the information in Producer Portal (read-only access.) 

Note • Required to log in to Producer Portal and will be automatically 
assigned when any other permission is selected.

PTNR

UAT Access Access the User Acceptance Testing (UAT) environment for the Enterprise 
Portal or Producer Portal.

UATA

Account and Member 
Management

Add, edit, inactivate, and reactivate all account and member information, 
including Update Member Login, Re-Identify Member, and Re-Identify 
Account.

Note • Required to be able to send a Welcome email (see WELC 
permission, below, for exception) or Order email from the Member/Order 
pages.

ACMR

Send Welcome Email Send Welcome email from the View Member page without requiring the 
Account and Member Management permission (ACMR).

WELC

Limited Account and 
Member Management

Add, edit, inactivate, and reactivate all account and member information 
(excludes Update Member Login, Re-Identify Member and Re-Identify 
Account).

LACM

Merge Accounts Merge two accounts into one account, including members and 
entitlements.

MRGE

Reset Member 
Passwords

Regenerate a new password for a FlexNet Operations end user without 
exposing the generated password.

PSWD

View as End User Log in to FlexNet Operations Enterprise Portal as the end user in a read- 
only mode.

VIEW

Entitlement 
Management

Enter new entitlements, change existing entitlements, and inactivate or 
reactivate entitlement lines.

ORDE
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Create Trial 
Entitlements

Create trial registration and submit/approve trial entitlements in one 
step. 

Note • Only available if you are utilizing a customized solution by 
Revenera.

TENT

Licensing Support Generate, return, upgrade and re-host licenses on behalf of an end user 
from the View Licenses display. Includes ability to grant additional 
returns per Entitlement line.

Note • Only available if you are utilizing a customized solution by 
Revenera.

LISU

Transfer and Split 
Entitlements

Allow a Producer Portal user to transfer and or split an entitlement on 
behalf of a customer.

XFER

Product Management Add and edit all catalog-related information, such as Catalog Items, 
Products, Files, Product Lines, Manufacturers, License Groups, and 
Agreements.

Also add and edit Device Capabilities, Device Series, and Device Models, 
and configure Add-Ons and License Model Additions.

Note • Includes RSTF functions below.

PDCT

Deliver to Account Add a file, upload an image, and restrict the file or product to an account, 
so that you can distribute files for custom code or hot fixes to specific 
accounts.

Note • Subset of the PDCT permission above.

RSTF

Delete File Image Delete file image previously loaded into Producer Portal. DELF

Download File Image Download file image in the Producer Portal. DNLD

Device Management Add and edit all device- and server-related information, such as devices, 
servers, mapping and removing add-ons, as well as generating capability 
responses.

DVCM

Move Devices/Hosts Allow a Producer Portal user to move devices and or hosts on behalf of a 
customer.

MOVE

Table 3-4 • Standard User Permissions

Permission Description Code
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Administrative Permissions
The following permissions can be assigned only by a Revenera employee.Contact your Customer Success 
Manager or Project Leader to request any of these permissions.

Create Email 
Notifications

Create Update Notification Email messages that are sent to all members 
who have access to a specific file or product.

NOTF

Queue Email Send emails that are created in the Producer Portal to a queue to be sent 
at a specified time.

Note • Required to be able to resend a Welcome or Order email from an 
email log.

QEML

Edit Unsent Emails Change email content and distribution lists for unsent (Draft Status) 
emails. Users with this permission can also copy the email content and 
distribution lists of existing email messages.

Note • Required to be able to resend a Welcome or Order email from an 
email log.

AEML

Submit XML 
Transactions

Submit XML transactions from the Upload Transaction File option in the 
Producer Portal, or through an XML feed.

OEMF

Maintain Email 
Templates

Edit the content of email templates. TMPL

Maintain HTML 
Content

Add and edit HTML Content pages that can be displayed as content on 
the FlexNet Operations Enterprise Portal site.

DOCS

Maintain UDF Values Add additional values to the drop-down list that appears for existing User 
Defined Fields (UDFs).

UDFV

Reporter Access the Reporter tool. For UAT, if set with the UAT permission, it also 
allows access to the UAT Reporter user for that customer.

REPT

Table 3-5 • Administrative Permissions

Permission Description Code

Maintain UDF Definitions Create new UDF definitions. Users with this permission can also 
make changes to existing UDF definitions, such as whether the 
field is mandatory or optional, or whether a list of pre-defined 
values is displayed.

UDFT

Table 3-4 • Standard User Permissions

Permission Description Code
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Security Considerations
Consider the following:

• Principal of least privilege—Apply the “Principal of Least Privilege” when granting permissions to FlexNet 
Operations.

• Procedures for immediate revocation—Make sure that procedures are in place to immediately revoke access 
for any user whose employment is terminated or who no longer requires access to the application.

• Periodic reviews—Periodically review user accounts and reconfirm that access levels are appropriate.

Manage FlexNet Secret 
Keys

View and download FlexNet Embedded binary identity files, edit 
FlexNet Embedded license models, view or upload FlexNet 
Embedded publisher.xml files, create or view FlexNet Publisher 
trusted configurations.

KEYS

Producer Portal 
Administrator

Grant and revoke the Producer Portal permissions listed in this 
table with the exception of those requiring Revenera intervention.

SMAD

Create Ad-hoc Emails Create and send an email from the Producer Portal for a specific 
purpose, rather than one that is automatically triggered by a 
FlexNet Operations event, such as an Order Confirmation or 
Product Notification.

AHOC

Edit Sent Emails Edit an email after it is sent, so that the content displays correctly 
when viewed in the FlexNet Operations email log.

EDTR

Password Check Bypass Exempts the user from the Producer Portal password reset policy. BYPS

Table 3-5 • Administrative Permissions

Permission Description Code



Chapter 3 Accounts & Members
Managing User Permissions

86  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide



4

FlexNet Operations LLM Producer Portal User Guide FNOLLM-PPUG02  87

Entitlements

FlexNet Operations LLM offers flexibility in managing the life cycle of software entitlements via automated or 
manual solutions. This chapter provides an explanation of the processes necessary for managing software 
Entitlements. 

To facilitate a streamlined process flow for managing Entitlements in FlexNet Operations LLM Producer Portal, 
this chapter also includes the best practice for processing Entitlement-related transactions.

Background
This section describes some of the concepts relevant to FlexNet Operations LLM.

• Entitlement—An Entitlement is sometimes referred to as the order giving access to a software product. The 
Entitlement captures data relevant to the order ID, order details (what the customer purchased), and who 
placed the order.

• Account—An Account is the company in your order system (for example, Acme Inc). The Account is identified 
in FlexNet Operations LLM Producer Portal by both an Account Name and Account ID.

• Member—Single or multiple Members belong to an Account (for example, John Smith). A Member is 
identified in FlexNet Operations LLM Producer Portal by the Member Name, Member ID, and contact 
information such as address, phone, and job title.

• FlexNet Operations LLM assigns Entitlements to Accounts. All the Members belonging to an Account have 
access to the software owned by the Account. 

The section includes the following topics:

• About Transactions

• Managing Entitlements

About Transactions
This section describes the transactions used in FlexNet Operations LLM:

• Transaction Methods
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• Transaction Elements

• Transaction Types

• Transaction Methods Summary

Transaction Methods
This section provides a summary of the methods - manual and automated processes - available to create 
transactions. 

You should be familiar with your own order processing system, products, and company revenue recognition and 
reporting requirements before you attempt to determine which transaction methods and processes are optimal 
for you. 

It is also best to determine in an early phase whether the volume of transactions and the level of manual or 
automated processes you want to implement make one of these methods more suitable for your long-term 
resource management.

Table 4-1 • Transaction Methods

Method When you required Who can use

FlexNet Operations LLM 
Producer Portal

Entitle one Account at a time in 
FlexNet Operations LLM Producer 
Portal. This method uses web 
forms to submit transactions.

Authorized users can use the web 
forms in FlexNet Operations LLM 
Producer Portal.

IXP Converter Entitle single or multiple 
Accounts to single or multiple 
Entitlements at a time. This 
method allows you to input data 
into an Excel template and 
convert it into XML format, to 
submit transactions.

Authorized users of FlexNet 
Operations LLM Producer Portal 
can use the IXP tool provided by 
Revenera. This requires the 
installation of an IXP Converter 
tool and additional training. 
Contact your Account Manager to 
gain access to this tool.

XML Transaction API Entitle single or multiple 
Accounts to single or multiple 
Entitlements at a time. This 
method uses Revenera’s XML 
Client or your own in-house XML 
client to build transactions 
directly from your database. You 
can automate this method for 
“real-time” processing or 
“batched” processing (during 
certain times of day).

These transactions are system- 
generated and automated, and 
therefore require authentication 
and IT implementation.
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Authorized users are those individuals who have completed training and have appropriate permissions to perform 
these functions. To grant authorization to someone in your organization, contact your Account Manager.

Transaction Elements
To decide which transaction elements to capture, consider the types of reporting data you require for revenue 
recognition purposes. This table illustrates a sample of the Transaction Data Elements per Transaction Type (for 
most commonly used transaction types).

Table 4-2 • Transaction Data Elements Per Transaction Type 

Field Name Max Length Process Order Add Account Add Member Add Order

Transaction Type 
Code

(code) ProcessOrder AddAccount AddMember AddOrder

Account ID* 100 X X X X

Account Name 100 X X X X

Member ID* 100 X X

Last Name 30 X X

Email Address 100 X X

Address Line 1 100 X X

City 30 X X

If Country USA or 
Canada; State

(code) X X

If Country USA or 
Canada; Postal Code

15 X X

Country ISO 3166

code

X X

Order ID* 25 X X

Line Number* Integer >0 X X

Catalog Item (SKU or 
Part Number)

40 X X

Entitlement Effective 
Date

yyyy-mm-dd X X
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Entitlement 
Expiration Date

yyyy-mm-dd X X

Quantity Integer >0 X X

Optional

Account Note 100 X X X X

First Name 30 X X

Job Title 50 X X

Phone Number 30 X X

Fax Number 30 X X

Address Line 2-4 100 X X

If country not USA or 
Canada; State

30 X X

If country not USA or 
Canada; Postal Cd

15 X X

Admin Privilege 
Indicator

true/false X X

Download Privilege 
Indicator

true/false X X

Member Note 100 X X

Suppress End User 
Email

true/false X X X

Order Date yyyy-mm-dd X X

Purchase Order ID 100 X X

Sales Rep 30 X X

Invoice ID 25 X X

Invoice Date yyyy-mm-dd X X

Price Float X X

Table 4-2 • Transaction Data Elements Per Transaction Type 

Field Name Max Length Process Order Add Account Add Member Add Order
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The Field Name displays data fields that may be required or optional, depending on the Transaction type. For 
example, the Add Account transaction type requires the fields for Account ID and Account Name.

Verify that all of the character maximum length limits of FlexNet Operations LLM fields will accommodate the 
data generated by your own system. 

Important • If your data exceeds the limits, notify your Account Manager in order to scope out alternatives or 
work to accommodate the new character lengths.

ID fields are not required when submitting transactions via upload or automated interface. However, if you do not 
use unique identifiers, it will be very difficult to manage your Account / Member / Entitlement data. You are 
strongly encouraged to use unique identifiers for this reason.

User Defined Fields (UDFs) are data fields that are set up during implementation. They may contain data not 
otherwise collected in FlexNet Operations LLM fields. Some examples of UDFs are: Contract numbers, Site IDs, 
tracking Evaluation vs. License customers. In some cases, you may want the UDF data to appear on the customer 
End User Portal (for example, contract number in the order history). Contact your Account Manager to scope out 
work for this type of customization.

Transaction Types
This section describes Use Case Scenarios and Transaction types that are best for the use case.

Before you begin to process any Order-related transactions, verify that the set up for Product Management is 
complete. Refer to Product Set Up and Management.

In order for FlexNet Operations LLM to send out Welcome and Order emails when processing these Entitlement 
transactions, the Email templates must be set to a “live” status and have the send indicator turned “on”. 

• Welcome Emails are system-generated and by default are sent to new Members added to FlexNet 
Operations LLM for the first time. 

• Order Emails are system-generated and sent to a specified Member of the Account. You have the option to 
send or suppress Order Emails in order-related transaction types, as well as bcc internal email aliases.

You have the option to send a Transaction Report to yourself or an alias internally that was created in advance. An 
email of the Transaction Report contains all the data submitted and the status of the transaction--failed or 
successfully processed in FlexNet Operations LLM.

License Code unlimited text X X

Order Note 100 X X

Account/Member/
Order/Line Item 
UserDefined Field

50 X X X X

Table 4-2 • Transaction Data Elements Per Transaction Type 

Field Name Max Length Process Order Add Account Add Member Add Order
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Use Case Scenarios
These transaction types have required Transaction Elements of data. Refer to the documentation section, 
Entitlement_Template, of the IXP Converter for the list of required and optional fields of data. The IXP Converter is 
available for download from https://tools.flexnetoperations.com. Contact your Account Manager to gain access.

Table 4-3 • Use Case Scenarios

Use Case Process to use Transaction Type Email

The order for an account exists in your 
order system, but the Account and 
Entitlement do not exist in FlexNet 
Operations LLM.

Create Account, 
Member, Order, in a 
single transaction type

Process Order Options: Send/suppress 
order email to end user.

Note • Bcc copies of 
email internally (for 
revenue recognition 
purposes).

You acquire a third party product and 
customer base.

The order for an account exists in your 
order system, but the Account and 
Entitlement do not exist in FlexNet 
Operations LLM.

Create Account, 
Member, Order, in a 
single transaction type

Process Order Options: Send/suppress 
order email to end user.

Note • Bcc copies of 
email internally (for 
revenue recognition 
purposes).

You have a zero dollar fulfillment or need 
to give an Account access to software 
electronically for a customer satisfaction 
issue (such as physical shipment on 
back-order.) The order for an account 
exists in your order system, but the 
Account and Entitlement do not exist in 
FlexNet Operations LLM.

Create Account, 
Member, Order, in a 
single transaction type

Process Order Options: Send/suppress 
order email to end user.

Note • Bcc copies of 
email internally (for 
revenue recognition 
purposes).

You identify a data entry problem and 
need to change the identifier of an 
existing Order. Account and Member 
already set up in FlexNet Operations 
LLM. This change is transparent to 
Member.

Change the identifier of 
an existing Order ID.

ReID Order No emails are system 
generated for this 
transaction type.

https://tools.flexnetoperations.com
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You have a credit/re-bill, or need to 
append license keys/correct other data 
on Order The Account exists in your order 
system, and is already set up for 
electronic access to software downloads 
in FlexNet Operations LLM.

Edit an existing Order in 
FlexNet Operations LLM 
in a single transaction 
type.

Edit Order Options: Send/suppress 
order email to end user.

Note • Bcc copies of 
email internally (for 
revenue recognition 
purposes).

You have a new order for additional 
product, or a maintenance renewal for an 
account in your order system. The 
Account already exists in FlexNet 
Operations LLM.

Add a new Order into 
FlexNet Operations LLM 
in a single transaction 
type.

Add Order Options: Send/suppress 
order email to end user.

Note • Bcc copies of 
email internally (for 
revenue recognition 
purposes).

You need to temporarily disable 
customer access to an Order because 
your Finance dept has the Account in 
collections. You want to keep the Order 
record intact within FlexNet Operations 
LLM and allow the Account continued 
access to the site for other products they 
own.

Reactivate line item on Order to reinstate 
access once Finance clears.

Inactivate an existing 
Order in FlexNet 
Operations LLM in a 
single transaction type.

Order Line Activation No emails are system 
generated for this 
transaction type.

Table 4-3 • Use Case Scenarios

Use Case Process to use Transaction Type Email
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Notes About Using the Process Order Transaction Type
If you specify any ID (Account/Member/Order):

• If the ID does NOT exist in FlexNet Operations LLM, the system will create it.

• If the ID exists in FlexNet Operations LLM, the system will edit (overwrite) the previous data.

This transaction type uses a combination of these other transaction types: AddAccount, EditAccount, 
AddMember, EditMember, AddOrder, and EditOrder.

• If an Account does NOT exist (by AccountID) in FlexNet Operations LLM, then the ProcessOrder transaction 
by default will use the transaction type AddAccount to create it.

• If the Account exists, then the ProcessOrder transaction by default will use the transaction type EditAccount 
to update the Account data (if the data is different in the most recent transaction).

• If the Member does NOT exist (by Member ID) in FlexNet Operations LLM, then the ProcessOrder transaction 
by default will use the transaction type AddMember to create it.

• If the Member exists in FlexNet Operations LLM, then the ProcessOrder transaction by default will use the 
transaction type EditMember to update the Member data (if the data is different in the most recent 
transaction).

• If the Entitlement does NOT exist (by Order ID) in FlexNet Operations LLM, then the ProcessOrder transaction 
by default will use the transaction type AddOrder to create it.

• If the Entitlement exists in FlexNet Operations LLM, then the ProcessOrder transaction by default will use the 
transaction type EditOrder to update the Entitlement data (if the data is different in the most recent 
transaction).

Transaction Methods Summary
In this section, the components of data Transaction Methods, Transaction Elements, and Transaction Types have 
been reviewed. Once you determine the frequency for each of the defined Use Case Scenarios of your 
organization, you can make an informed choice to implement the best Transaction Method (manual vs. 
automated) across all Transaction Types. 

Your decisions during implementation should be based on the resources available within your organization during 
the implementation phase and also in the longer term. If you consider these factors in advance, it will allow you to 
create and manage streamlined processes to manage Entitlements in FlexNet Operations LLM Producer Portal.

Managing Entitlements
This section describes how to manage entitlements in the FlexNet Operations LLM user interface:

• About the Entitlements Menu

• Search Entitlements

• Entitle Account Page

• View Entitlement Page

• Edit Entitlement Page
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• View Transaction Page

• View Emails Page

• Send Entitlement Notification Email Page

About the Entitlements Menu
Using the items on the Entitle Customers > Entitlements menu of the Producer Portal lets you view, create and 
edit Producer Portal entitlements - generally equivalent to an “order” but also used to grant direct access to 
software without an order.

Figure 4-1: Entitle Customers Menu

You begin working with entitlements by either searching for and selecting an existing entitlement or by creating a 
new one. Since entitlements are granted to an account you can't add an entitlement without first selecting or 
creating an account.

You can use the Entitlements tab on the Quick Search box on the Producer Portal Home page to quickly find an 
existing entitlement if you know the Entitlement ID or PO#. 
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Figure 4-2: Entitlements Tab of Quick Search Box

If your criteria match more than one entitlement, you will be given the opportunity to select the entitlement from 
a list. 

Note • Searching on the Quick Search box is not case sensitive and supports the use of the “*” character as a 
wildcard in most fields.

Search Entitlements
To view or edit existing entitlements either use the Entitlements tab of the Quick Search box or select Entitle 
Customers > Search Entitlements from the menu. 

On the Quick Search box, you can search based on Entitlement ID, Account Name or PO# and other fields.
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Figure 4-3: Entitlements Tab of Quick Search Box

On the Search Entitlements page, you can search for an existing entitlement based on the Entitlement ID, the 
System Entitlement ID, the Entitlement Date range, the Purchase Order Number, the Invoice ID, the Catalog Item 
ID, the Account Name, the Account ID, or the System Account ID. You can select the Entitlement you want to view 
or edit from the list that matches your search criteria.
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Figure 4-4: Search Entitlements Page

Entitle Account Page

Note • Entitle Account is also known as Process Order.

Since entitlements are granted to accounts, when you select Entitle Customers > Entitle Account from the menu, 
you are taken to the Find the Account to Entitle page so you can select the account you want to work on. 
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Figure 4-5: Find the Account to Entitle Page

This form is the same as the Search Accounts form except that once you select an account, you will be taken to 
the Entitle Account page. 
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Figure 4-6: Entitle Account

To remind you of the account you are working on, the Account Name, Account ID, and System Account ID are 
shown at the top of the Entitle Account page.

Send Entitlement Notification Email
When you entitle an account, you are given the opportunity to Send Entitlement Notification Email. You do this by 
entering email addresses in the CC and BCC fields. Note that this list doesn't affect who has access to the 
software, only who gets the email notification. You can also turn email notification on and off for this entitlement 
by selecting Don’t Send from the Select Entitlement Email list.
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Entitlement Details
Once you have selected which members will be notified when the entitlement is processed, you can enter 
additional information about the entitlement itself in the Entitlement Details area. This is particularly useful if you 
are treating the entitlement as an “order” or if it is related to an order within your company's internal systems. 
Most of these fields are also visible to your customers through the Entitlement History section of the Producer 
Portal, if it is enabled on your site. The fields you can enter under Entitlement Details are:

You can also enter values for any additional entitlement header fields unique to your company that were specified 
when your Producer Portal site was set up. 

Line Items
Once you have entered the appropriate entitlement header information, you can enter one or more line items. 
There is one line item for each Catalog Item ID that you want to deliver. For each line item the standard entries 
are:

Table 4-4 • Entitlement Details

Field Description

Entitlement ID One of the values you can use when searching for entitlements and when 
reconciling the Producer Portal system to your internal systems (note that 
this field is optional, but if it is used, it must be unique).

Entitlement Date Reference date for this entitlement, usually the current date but it may be 
the effective date of the Entitlement.

Sales Rep Name of the person who sold the entitlement. 

Purchase Order # Usually the purchase order that your customer supplied.

Invoice ID Usually your invoice number.

Invoice Date Date you invoiced your customer.

Entitlement Note Other information that your company would like associated with this 
entitlement, for example, that this entitlement was based on a call to 
customer support.

Table 4-5 • Line Item Properties

Property Description

Line # The line numbers will default to a sequence starting with one, but you can also 
specify them, for example if you are only using Producer Portal for some of the items 
on your company's order form
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If your company has specified any additional fields at the line item level they can also be entered on the form.

When the Entitle Account page is first displayed, only one line item is displayed. If an entitlement has more than 
one line item, you can create additional line items by entering the number you want, and clicking on Add more 
line items. Every line on the entitlement must have a valid Catalog Item ID and other required information. You 
can delete extra lines by clicking the red "X" button.

XML and Excel Submission Report
To have a copy of the submission report for this Entitlement, indicating whether the Entitlement was successful 
or not, emailed to you or to other people simply enter one or more email addresses in the Email for Report box.

Entitling the Account
Click Entitle Account at the bottom of the page for this entitlement to take effect.

Catalog Item ID Your company's part number for the product you sell as defined when setting up the 
product in Producer Portal, e.g., a one year maintenance contract for a particular 
product. If you enter a search term, including wildcards ("*"), in this field and then 
click "Find" the system will open a new window displaying a list of all the Catalog 
Item ID's matching your criteria. If you select one of these Catalog Item ID's the 
system will populate both the "Catalog Item ID " and the "Catalog Item Name" field on 
this Entitlement line. You can also directly type in an exact Catalog Item ID already in 
the system.

Catalog Item Name Your company's common or user friendly name for the product you sell as defined 
when setting up the product in Producer Portal. Select using Find or enter exact 
Catalog Item Name already in system.

Effective Date Date when should the user begin getting access to the product

Expiration Date Date when should the user stop having access to the product or to updates to the 
product depending on the Catalog Item type

Quantity The number sold. If your site is configured for it, the quantity determines the number 
of downloads that will be be allowed for Catalog Items that are set up as "limited 
download Catalog Items"

Price Informational field for you and your customer

License Code Serial number or license key which the end user will use to install or run the product. 
The license code is available to the end user through the Producer Portal site if the 
Catalog Item ID was set up to accept License Codes.

Table 4-5 • Line Item Properties

Property Description
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View Entitlement Page
When you search for or select an entitlement, the system will display the View Entitlement page, which displays 
all of the attributes of the entitlement. 

Figure 4-7: View Entitlement Page

On this page, you can choose to edit the entitlement record by selecting Edit > Edit this Entitlement.

Edit Entitlement Page
Once you have found an entitlement you can make changes to it by selecting Edit > Edit this Entitlement on the 
View Entitlement page.
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Figure 4-8: Edit Entitlement Page

On the Edit Entitlement page, you can modify many of the fields on the Entitlement. 

Note • You cannot edit the System Entitlement ID (the Producer Portal unique identifier for this entitlement) or 
the Entitlement ID you entered when you first created the entitlement because Producer Portal uses both of 
these values as key fields. 

You can create new lines and edit their line numbers but you can't change the line numbers for previously entered 
lines. 

You also cannot change the email settings since the emails were already sent when you originally submitted the 
Entitlement.
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With the exception of those listed above, you can edit all of the fields on the entitlement just as you did when you 
created the entitlement in the first place on the Entitle Account Page. When you click Save at the bottom of the 
form, the new values will replace the previous ones. In particular you can change the following properties:

If your company has specified any additional fields at the line item level, they can also be edited on the page.

You can also add additional line items to an entitlement the same way you do when creating an new entitlement.

Table 4-6 • Entitlement Properties

Property Description

Header information The header information will be updated with the new information you 
provide, e.g., you can change the Purchase Order Number if your customer 
changes their purchase order

Catalog Item ID Changing the Catalog Item ID changes the product which the account has 
access to by effectively canceling the old entitlement and creating a new 
one

Effective Date By changing this date you can alter what versions of your product the 
account has access to. Moving the date backwards can give the account 
access to earlier versions, moving it forward can have the opposite effect, 
removing early versions of the product from the account

Expiration Date The most common reason for changing the expiration date of an 
Entitlement line is to extend a maintenance agreement and continue letting 
the account receive updates. Conversely, by reducing the Expiration Date 
the you can keep the customer from getting future updates, or in the case 
of "time limited Catalog Items" from having further access to the product.

Quantity This value only affects the user if the entitlement line item is for a “limited 
download Catalog Items”, in which case changing it will change the total 
number of downloads allowed. The specific behavior depends on the 
Catalog Item itself and on how many downloads have already occurred. If 
the line item is not for a “limited download Catalog Item” then quantity is 
just informational and can be changed with no effect.

Price This is informational only and can be changed

License code Changing this value will change the license key displayed to the user when 
he clicks the License Key tab or link on the Producer Portal site

Status By changing the status from Active to Inactive you can effectively cancel 
the line item. Doing so will remove any access that was granted based on 
this entitlement line item. Changing the status from Inactive to Active has 
the reverse effect and restores access based on this line item.
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View Transaction Page
On the Edit Entitlement page, select View > View Transactions to display all transactions for the entitlement. The 
Search Results: Transactions page opens. 

Click on an individual System Transaction ID to view it on the View Transactions page.

Figure 4-9: View Transaction

View Emails Page
On the Edit Entitlement page, select View > View Emails to display all Entitlement Notification emails sent 
regarding this entitlement. 

Click on an individual System Email ID to view a particular email message. 

If no Emails exist for the Entitlement, the system will display a status message to that effect.

Send Entitlement Notification Email Page
You can send, or resend, an Entitlement Notification Email from the View Entitlement page by selecting Edit > 
Notify. The Send Entitlement Notification Email page opens.
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Figure 4-10: Send Entitlement Notification Email Page

On the Send Entitlement Notification Email page, you can enter one or more email addresses for each type of 
recipient (To:, CC:, BCC). 

If one or more emails were already sent for this Entitlement, the Send Entitlement Notification Email page will be 
pre-populated with the email addresses of all member who have been sent Entitlement Notifications for this 
Entitlement.
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Features

This chapter describes about the following features in FlexNet Operations LLM:

• Product Preferences

• Product Search

• Download Limited Functionality Summary

• Order History

• Bounced Email Handling

• Merge Accounts

• Email Template Options

• Standard Data Extract

• Custom Page Instructions Using Producer Portal HTML Content

• Password Token

• Order CDs

• Home Page

• Binary License File Support

• Localized Emails

• Single Sign-On Process
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Product Preferences
FlexNet Operations LLM Members may not wish to view or receive emails for every product to which they are 
entitled. The Product Preference functionality allows Members to be able to set their own personal preference to 
block Update Notification emails and/or hide Catalog Item Product Lines from their view on the FlexNet 
Operations LLM site. Please contact your Account Manager / Project Manager if you have any questions or if you 
are interested in making Product Preferences available for Members.

Functionalities
The Product Preference functionality is optionally available as a link from the left navigation bar of the FlexNet 
Operations LLM End User Enterprise Portal. It is a personal preference and works in conjunction with the Email 
Preferences link, also on the left navigation. 

Figure 5-1: Product Preferences in End User Portal

Members may choose to opt out from receiving Update Notification emails by Catalog Item Product Line. 
Additionally, Members may choose to hide the navigation for a selected Catalog Item Product Line on their 
FlexNet Operations LLM site. When users elect to hide the navigation for a particular Catalog Item Product Line, 
by default, they will also be restricted from receiving Update Notification emails for that Catalog Item Product 
Line.

Figure 5-2: Product Preferences Page End User Portal



Chapter 5 Features
Product Search

FlexNet Operations LLM Producer Portal User Guide FNOLLM-PPUG02  111

If the Member has Email Preferences set to not receive any emails, there is a message that appears above the 
choices to remind them that the Email Preferences have precedence over Product Preferences.

Once the Save button is clicked, a message is displayed if the end user has their Email Preference set not to send 
any emails.

If the Member has Email Preferences set to not receive any Update Notifications, there is a message that appears 
above the choices to remind them that the Email Preferences have precedence over Product Preferences.

Once the Submit Product Preferences is clicked, a message is displayed if the end user has their Email 
Preference set not to send any Update Notifications.

Customers who have FlexNet Operations LLM Producer Portal permissions to edit Member information can also 
edit Email Preferences and Product Preferences for the Member by utilizing the Set Preferences. This is available 
whether or not the Customer has elected to have the Product Preferences functionality available to Members on 
the FlexNet Operations LLM site. The following displays the FlexNet Operations LLM Producer Portal site:

Figure 5-3: Member Preferences Page in FlexNet Operations LLM Producer Portal

Product Search
Product Search allows FlexNet Operations LLM Enterprise Portal users to locate Products or Files to which they 
are entitled without having to navigate through the product hierarchy.
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This optional functionality can be added or removed from the site by scheduling with your Account Manager or 
Project Manager. When implemented, a link to the search page will be placed in the left-navigation bar. Users 
clicking on the link will be taken to a page with a search text box.

Product Search utilizes Lucene, which is open source software from Apache. Components of the search engine 
include an extraction from the FlexNet Operations LLM database (scheduled every hour), building and modifying 
the Index to include Account Entitlements and Product metadata, while allowing end users on the FlexNet 
Operations LLM Enterprise Portals to search the Index.

The following describes the functionalites of Product Search:

Basic Search Criteria
The Product Search functionality allows Enterprise Portal users to find Products and Files to which they are 
entitled, by using a familiar Internet-style search.

• Simply type a word or phrase in the text box and click the Search button.

• The search-term (also called “query”) will by default return results that will match ANY of the words entered 
(not ALL of the words).

• The search is not case-sensitive.

Advanced Search Criteria
The result set may be improved by using the following operators:

• Use double quotes to find an exact multi-word phrase.

• Use "+" before a term to require that a particular term be present. For example the criteria "+macintosh" will 
only find Products or Files that contain the term "macintosh".

• Use "*" as a wildcard in your search. It will match zero or more characters, and can be located anywhere in 
the word, except the beginning. This is particularly useful to search for part numbers or versions. For 
example the criteria "ABC*" will find terms "ABC", "ABC-123", "ABCDEF", etc.

• Use "AND" (in upper case) between words when you want to require that each of the words exists in the data 
that produces your results ("OR" is the default).

• Use "NOT" to exclude a word from being included in the data.

• Use "~" at the end of a search term to do a "fuzzy" search. For example the criteria "roam~" will find terms 
similar in spelling to "roam" like "foam" and "roams".

Search Fields
The criteria entered will be used to search through a data index that includes the following fields:

• Product ID

• Product Description

• Product Version

• Product Line

• File Name

• File Description
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• Product and File Level User Defined Fields (UDFs), if implemented

Displayed Results
• The returned results will contain links to a list of Files (either directly or via the Product page) which you are 

able to download, as well as a description of the result and the date that the Product or File was made 
available. Additionally, each of the results is scored, based on the quantity and location of your criteria within 
the indexed data.

• Before performing the search, Enterprise Portal users can select how to sort the results: by Relevance (the 
default scoring based on the quantity and location of the criteria on the indexed data) or by Date. When 
sorting by Relevance, higher scores will be displayed first. When sorting by Date, more recently created 
Products (or Files) will be displayed first.

Download Limited Functionality Summary
In order to better support certain customer requests, FlexNet Operations LLM has been modified to support the 
ability to set a limit on the number of times an Account can download a file.

Due to the impact to the end users, this functionality is not recommended unless specifically warranted. In 
general, license keys or contractual agreements should control limited access to software. Please talk to your 
Revenera Account Manager or Project Manager before implementing.

• Functionality for 7.0.2 Release of Download Limited Functionality

• Scenarios

Functionality for 7.0.2 Release of Download Limited 
Functionality

Download limits are determined at the following three levels:

• Entitlement—The ability to set a limit on the number of times an Account can download a File is driven by 
that Account’s entitlements. The limit is controlled by providing a value in the download limit attribute of the 
entitlement order line. Valid values are –1 or greater.

A default for this attribute will be set at time of FlexNet Operations LLM service set up. If not specified, the 
default setting in the Producer Portal is blank. When the default is blank, then there is a Catalog Item 
attribute called default download limit that will be used. This default download limit will be pre-populated in 
The Producer Portal but may be overridden whenever entitlement transactions are processed. 

If there is no download limit value specified in the entitlement, the value from the Catalog Item attribute will 
be used.

Note • Consider the following values for the download limit attribute:

• “–1” represents unlimited downloads.

• “0” represents zero downloads used in conjunction with the File attribute called ignore download limit, 
this could be used to grant access to certain files (like documentation) without giving access to others 
(like product binaries). 
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• Values greater than “0” represent the maximum number of times that each file can be downloaded by an 
Account.

• Catalog Item—The number of times an Account can download a File can also be determined by the Catalog 
Item attribute called default download limit.

The default download limit attribute will be overridden by the download limit attribute of the order line if one 
is provided. The default is set to blank and unlimited.

• File—Identify which Catalog Items should have limited downloads and how many downloads are allowed.

Changes to the Catalog Item default download limit do not affect existing entitlements. Whether an Account 
can have limited downloads for a File can also be determined by a File attribute called ignore download limit. 
This attribute indicates whether or not a download limit (set by the entitlement and/or Catalog Item) should 
be applied to a particular File. This is to allow for restricting the download of the product binary while 
allowing Files like documentation to be unlimited.

The limit (if any) specified in the entitlement and/or Catalog Item will be applied to all associated Files where 
the ignore download limit attribute is set to “yes”. The default for this attribute is “no” which means the File 
will accept the  download limits as set in the entitlement and/or Catalog Item. Changes to the File ignore 
download limit attribute affect existing entitlements for that File.

You are responsible for identifying which Files the download limitation should apply to. Edits to this attribute 
can be made at the Edit File List menu option under the Product menu in Product Management in the 
Producer Portal.

The FlexNet Operations LLM download page will not generate download links for any member on the Account for 
Files that have reached the download limit. A message indicating that the download limit has been reached will 
be displayed instead. The FTP link as well as the Advanced Download link will be disabled.

The FTP daemon and HTTPS download service will exclude Files that have reached the download limit from the 
directory hierarchy. In the case where the account has multiple entitlements to the same item, the entitlements 
will be cumulative - that is, the number of downloads that an account can perform will be the sum of the limits 
allowed by the individual entitlements. If the end user/account needs to download a File after the limit has been 
reached, a new entitlement must be processed.

Note • Consider the following:

• Split Files downloads are currently not supported (e.g., image0001, image0002 option in Advanced 
Download page).

• Refresh download page upon successful download completion is not supported.

• If multiple downloads started prior to successful download, jobs in progress will not be terminated.

Scenarios
There are following scenarios/conditions in which an account can download a file, based on the download limit 
attribute, default download limit, and ignore download limit inputs:

• Entitlement unlimited/Catalog Item unlimited—An account can have unlimited downloads due to the 
followings:

• Download limit attribute on entitlement line item is either blank or –1
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• Default download limit attribute on Catalog Item is blank

• File attribute ignore download limit setting is irrelevant—File has unlimited downloads.

• Entitlement unlimited (attribute is blank)/Catalog Item limited—An account can have both unlimited  and 
limited downloads due to the followings:

• Download limit attribute on entitlement line item is blank.

• Default download limit attribute on Catalog Item has a value 0 or higher.

• If File attribute ignore download limit is set to “yes”—File has unlimited downloads.

• If File attribute ignore download limit is set to “no”—File is limited to the Catalog Item attribute setting.

• Entitlement unlimited (attribute is -1)/Catalog Item limited—An account can have unlimited downloads due 
to the followings:

• Download limit attribute on entitlement line item is –1.

• Default download limit attribute on Catalog Item has a value 0 or higher.

• File attribute ignore download limit setting is irrelevant—File has unlimited downloads.

• Entitlement limited/Catalog Item unlimited—An account can have both unlimited and limited downloads due 
to the followings

• Download limit attribute on entitlement line item is 0 or higher.

• Default download limit attribute on Catalog Item is either blank or -1.

• If File attribute ignore download limit is set to “yes”—File has unlimited downloads.

• If File attribute ignore download limit is set to “no”—File is limited to entitlement attribute setting.

• Entitlement limited/Catalog Item limited—An account can have both unlimited and limited downloads due to 
the followings:

• Download limit attribute on entitlement line item has a value 0 or higher.

• Default download limit attribute on Catalog Item has a value 0 or higher.

• If File attribute ignore download limit is set to “yes”—File has unlimited downloads.

• If File attribute ignore download limit is set to “no”—File is limited to entitlement attribute setting.

• If a download limit is exhausted by cumulative downloads by members of an Account—When the download 
limit is reached, still the download can be intiate via: 

• A new entitlement could be processed to add more downloads for the Account

• The original entitlement could be extended to have more downloads by increasing the value of the 
download limit attribute.

Order History
The Order History feature in FlexNet Operations LLM provides end users with an order based view of their 
entitlements. This view enables users to navigate to their products and download through the actual order that 
was placed for them rather than through the product names or families.
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Order History Page Usage
If you choose to enable this feature, a link to Order History will be incorporated into the left-hand navigation bar 
on your site. Users clicking on the link will be taken to a page with the following text:

Below are sample screenshots of the standard Order History and standard Order Detail pages. The text on these 
screenshots is standard but some of it can be customized. Contact your Revenera Account Manager or Project 
Manager if you would like to implement these pages on your site and/or to discuss any customization requests to 
see if they are feasible.

Table 5-1 • Order History Page Text

Text Displayed Description

Order History <from date> The <from date> is not required but may be defined by your order system 
depending on accuracy of the order data.

Listed below are your orders. To 
view the details of a particular 
order, click on the order 
number. Canceled orders are 
not displayed.

• If there are no orders, “No orders available for this account.” is 
dispalyed.

• If there are orders, the display lists the orders associated with the end 
user's account. This display includes:

• Order Number (key)

• PO Number

• License Information link (if applicable)

• Download Order link (if the feature is turned on for your 
implementation)

(Link to the license) For manufacturers/products that deliver licenses through FlexNet 
Operations LLM, the order history page will also include a link to the 
license.

Link to Order Detail view A drill-down is available for each order to an Order Detail view. This detail 
view shows each of the line items on the order including:

• Line Number

• Product Description

• Manufacturer Part number

• Qty

• Download

• License Information link (if applicable)

• Download Order link (if the feature is turned on for your 
implementation) 
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Figure 5-4: Standard Order History Page

Figure 5-5: Standard Order Detail Page

Note • Order history information is updated at 8:00 am, 12:00 pm, 4:00 pm and 12:00 am each day.

Bounced Email Handling
The bounced email information that is available in FlexNet Operations LLM Producer Portal and Reporter relies on 
the DSN (delivery status notification) convention. Both DSN and non-DSN email bounces are captured by FlexNet 
Operations LLM. When the mail server used by FlexNet Operations LLM end users has DSN enabled, FlexNet 
Operations LLM is able to track and report whether the email was received or not, as well as the cause provided 
for any bounces. Unfortunately, not all mail servers support DSN, and often mail system administrators disable 
this service even if DSN is supported by the mail server.
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Bounced email information is available in the following formats:

• Reporter—DSN bounces are captured in two reports: Bounced Email Detailed or Bounced Email Summary.

• Producer Portal—Users can view non-DSN bounced email messages and acknowledge that they’ve reviewed 
the bounce (in the way failed transactions are acknowledged) using the View Bounced Email screen.

• Message Forwarding—Your FlexNet Operations LLM service can be configured so that all non-DSN email 
bounces are forwarded to a designated email alias.

The Email Sent Status is based on DSN responses Revenera receives:

• Unsent—Email was not sent from the Revenera email servers due to email preference setting for the end 
user or if the email is queued to be mailed in the future.

• Sent/Unconfirmed—The Revenera email servers sent the email and have not received a DSN response 
indicating the email was delivered.

• Sent/Confirmed—The Revenera email servers sent the email and received a DSN response indicating the 
email was delivered to the user’s mailbox.

• Sent/Failed—The Revenera email servers sent the email and have received a DSN response indicating the 
email was not delivered to the user’s mailbox.

Merge Accounts
FlexNet Operations LLM Producer Portal users can merge Accounts within The Producer Portal. This document 
describes how to enable this functionality for Producer Portal users and the process to merge accounts.

Task To enable merge accounts functionality for a user:

1. Assign the Merge Accounts permission to the appropriate Producer Portal users as displayed below:

2. Upon locating the Account that you would like to merge, select the Merge this Account option from the Edit 
menu as shown below:
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3. On the Merge Accounts page, search for the existing Account into which you would like to merge this 
Account. The following displays the Merge Account page:

This will open a new window and allow you to select the appropriate Account. 

4. Once the Account has been selected, press the Merge button as shown below:

5. After pressing the Merge button, the Members and Entitlements belonging to the Account at the top of the 
screen will be associated with the Account at the bottom of the screen. 
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If you need to retain the first Account’s ID for reporting purposes, please contact your Account Manager or Project 
Manager prior to merging any Accounts. We can assist you by adding an Account-level UDF to The Producer 
Portal which will enable you to still search for the first Account and also to process transactions against it.

Email Template Options
Customers that allow Account Administrators to add users from the FlexNet Operations LLM site may prefer to 
use a different email template than the standard Welcome Email and/or Cancel Member Email templates 
available today.

By default, there is only one template each for Welcome and Cancel Member Emails. Both of these are triggered 
by adding or inactivating a member either via the FlexNet Operations LLM site or via The Producer Portal.

Your site can be set up to use a separate Welcome Email template and/or Cancel Member Email template if the 
Member was added or inactivated by an Account Administrator from the FlexNet Operations LLM site.

Figure 5-6: List Email Templates Page

Contact your Revenera Account Manager or Project Manager to implement this option.

Standard Data Extract
FlexNet Operations LLM data can be integrated into customer systems using standard or custom data extracts. 
Below are specifications for the standard data extracts available. If you need a customized data extract, please 
contact your Revenera Account Manager or Project Manager for assistance.

• Overview of Data Extract Files

• Download Activity Data Fields

• License Activity Data Fields

• Member Activity Data Fields

• Entitlement Activity Data Fields

• Account Activity Data Fields
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Overview of Data Extract Files
The following are the available standard data extract files:

• Download Activity—Completed downloads.

• License Activity—New and updated Licenses.

• Account Activity—New and updated Accounts.

• Member Activity—New and updated Members.

• Entitlement Activity—New and updated Entitlements.

Note • Account, Member, and Entitlement Activity extracts are generally more appropriate for self registration 
sites such as an evaluation Try Before You Buy (TBYB) site integrated with a CRM system.

Revenera generates data extract files for the previous day after midnight Pacific Time. The files are posted on a 
password-protected FTP server and are automatically removed after 30 days.

Other criteria include:

• The extract is generated in a pipe-delimited format

• Fields are separated by the “pipe” character (“|”)

• Lines are separated by a CR/LF.

• Trailer records are not included in the file.

• A header record for the pipe delimited version is optional.

• An alternate XML formatted version is also available.

• Date fields are in a mm/dd/yyyy format.

• The filename is in this format:

XML: <PartnerCode>_DownloadActivity_yyyymmdd.xml
TEXT: <PartnerCode>_DownloadActivity_yyyymmdd.txt

The PartnerCode value and FTP server connection information can be provided by your Revenera Account 
Manager or Project Manager.

Download Activity Data Fields
The following table represents the data fields and data types for Download activity:

Table 5-2 • Download Activity Data Fields

Download Activity Data Field Data Type

IntrawareDownloadID INTEGER

DownloadType CHAR(4)
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StartDateTime DATETIME YEAR TO SECOND

EndDateTime DATETIME YEAR TO SECOND

DurationSeconds INTEGER

DownloadIPAddress CHAR(15)

IPAddressCountry CHAR(3)

Account / IntrawareAccountID CHAR(15)

Account / AccountID VARCHAR(100)

Account / AccountName VARCHAR(100)

Member / IntrawareMemberID INTEGER

Member / MemberID CHAR(100)

Member / LastName VARCHAR(30)

Member / FirstName VARCHAR(30)

Member / Email CHAR(100)

Member / Country CHAR(3)

Order / IntrawareOrderID INTEGER

Order / OrderID VARCHAR(100)

Order / OrderDate DATE

CatalogItem / IntrawareCatalogItemID INTEGER

CatalogItem / CatalogItemID CHAR(40)

CatalogItem / CatalogItemName VARCHAR(255)

Product / IntrawareProductID INTEGER

Product / ProductID CHAR(40)

Product / ProductName VARCHAR(255)

File / IntrawareFileID INTEGER

Table 5-2 • Download Activity Data Fields

Download Activity Data Field Data Type
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License Activity Data Fields
The following table represents the data fields and data types for License activity:

File / FileID CHAR(40)

File / FileName VARCHAR(255)

Table 5-3 • License Activity Data Fields

License Activity Data Field Data Type

IntrawareLicenseID INTEGER

LicenseGroupID VARCHAR(40)

LicenseGroupName VARCHAR(100)

Account / IntrawareAccountID CHAR(15)

Account / AccountID VARCHAR(100)

Account / AccountName VARCHAR(100)

Order / IntrawareOrderID INTEGER

Order / OrderID VARCHAR(100)

Order / PurchaseOrderID VARCHAR(50)

Order / OrderDate DATE

Order / LineNumber INT8

CatalogItem / IntrawareCatalogItemID INTEGER

CatalogItem / CatalogItemID CHAR(40)

CatalogItem / CatalogName VARCHAR(255)

CatalogItem / ProductLine / IntrawareProductLineID INTEGER

CatalogItem / ProductLine / ProductLineID CHAR(30)

CatalogItem / ProductLine / ProductLineName CHAR(100)

Table 5-2 • Download Activity Data Fields

Download Activity Data Field Data Type
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Member Activity Data Fields
The following table represents the data fields and data types for Member activity:

LicenseCode CHAR(3000)

LicenseFileName VARCHAR(255)

GeneratedDateTime DATETIME YEAR TO SECOND

GeneratedByEmail CHAR(100)

ReturnedDateTime DATETIME YEAR TO SECOND

ReturnedByEmail CHAR(100)

UpgradedDateTime DATETIME YEAR TO SECOND

UpgradedEmail CHAR(100)

Status CHAR(20)

CreateDateTime DATETIME YEAR TO SECOND

LastUpdateDateTime DATETIME YEAR TO SECOND

Table 5-4 • Member Activity Data Fields

Member Activity Data Field Data Type

Account /IntrawareAccountID VARCHAR(15)

Account / AccountID VARCHAR(100)

Account / AccountName VARCHAR(100)

IntrawareMemberID INTEGER

MemberID CHAR(100)

Email CHAR(100)

FirstName VARCHAR(30)

LastName VARCHAR(30)

Table 5-3 • License Activity Data Fields

License Activity Data Field Data Type
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Entitlement Activity Data Fields
The following table represents the data fields and data types for Entitlement activity:

JobTitle VARCHAR(30)

Phone VARCHAR(30)

Fax VARCHAR(30)

AddressLine 1 VARCHAR(100)

AddressLine 2 VARCHAR(100)

AddressLine 3 VARCHAR(100)

AddressLine4 VARCHAR(100)

City VARCHAR(40)

State CHAR(2)

PostalCode VARCHAR(15)

Country CHAR(3)

AdminPrivilege CHAR(1)

DownloadPrivilege CHAR(1)

MemberNote VARCHAR(255)

ExpirationDate DATE

UserDefinedField CHAR(255)

CreateDateTime DATETIME YEAR TO SECOND

LastUpdateDateTime DATETIME YEAR TO SECOND

Table 5-5 • Entitlement Activity Data Fields

Entitlement Activity Data Field Data Type

OrderID VARCHAR(100)

Table 5-4 • Member Activity Data Fields

Member Activity Data Field Data Type
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IntrawareOrderID INTEGER

OrderDate DATE

PurchaseOrderID VARCHAR(50)

SalesRep VARCHAR(50)

InvoiceID VARCHAR(25)

InvoiceDate DATE

LineItem / LineNumber INT8

LineItem / TemporaryOrderLine CHAR(1)

LineItem / Price MONEY(16,2)

LineItem / SKU CHAR(40)

LineItem /IntrawareCatalogItemID INTEGER

LineItem / EffectiveDate DATE

LineItem / ExpirationDate DATE

LineItem / Quantity INTEGER

LineItem / DownloadLimit INTEGER

LineItem / Status CHAR(20)

LineItem / UserDefinedField CHAR(255)

OrderNote VARCHAR(255)

UserDefinedField CHAR(255)

TO CHAR(5000)

Account / IntrawareAccountID CHAR(15)

Account / AccountID VARCHAR(100)

Account / AccountName VARCHAR(100)

CreateDateTime DATETIME YEAR TO SECOND

Table 5-5 • Entitlement Activity Data Fields

Entitlement Activity Data Field Data Type
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Account Activity Data Fields
The following table represents the data fields and data types for Account activity:

Custom Page Instructions Using Producer 
Portal HTML Content

Customers can modify the site page instructions (typically the content on top of the page just underneath the 
Page Title) by using the HTML Content functionality in Producer Portal application. This document describes how 
to enable this functionality for the Producer Portal users and the process to set up the custom HTML Content.

• Assigning Maintain HTML Content Permission

• Adding HTML Content

• Pages Supported for Custom HTML Content

• Page Locations for HTML Content

• Additional Pages Supported for Custom HTML Content

LastUpdateDateTime DATETIME YEAR TO SECOND

Table 5-6 • Account Activity Data Fields

Account Activity Data Field Data Type

AccountID VARCHAR(100)

IntrawareAccountID VARCHAR(15)

AccountName VARCHAR(100)

AccountNote VARCHAR(255)

Status CHAR(20)

UserDefinedField CHAR(255)

CreateDateTime DATETIME YEAR TO SECOND

LastUpdateDateTime DATETIME YEAR TO SECOND

Table 5-5 • Entitlement Activity Data Fields

Entitlement Activity Data Field Data Type
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Assigning Maintain HTML Content Permission
To enable this functionality, a Producer Portal Administrator must first assign the Maintain HTML Content (DOCS) 
permission to the appropriate Producer Portal users as shown in the following: 

Figure 5-7: Maintain HTML Content (DOCS) Permission

Adding HTML Content
The Producer Portal user with the Maintain HTML Content (DOCS) permission will have the ability to add HTML 
Content pages following the steps below:

Task To add the HTML content pages:

1. Login to Producer Portal and Select the Add HTML Content option on the Administer menu.

2. Create a document with the appropriate HTML Content ID. The pages that are supported are listed below and 
in Additional Pages Supported for Custom HTML Content. Click on the Preview & Save tab as indicated in the 
following:
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3. After reviewing the content, click on the Save as Live tab to save the content or Back to Edit link to continue 
making changes.

4. After you click the Save as Live tab, view the corresponding page on the end user site to verify the change. 
Note that the custom instructions will replace, not append, any existing instructions on the page.

Notes Regarding Adding Custom HTML Content
Consider the following while using the Producer Portal application:

• Localized Sites—To update page instructions for localized sites, you will need to create documents with a 
locale suffix in the HTML Content ID. For example, the login page instructions are stored in HTML Content ID 
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LoginContent for English sites. The login page instructions for a French site would be reside in a document 
with an ID of LoginContent-fr. 

• Turning Off—To revert page instructions back to the standard property driven content, the ‘Hide’ indicator on 
the document can be enabled. Under the Producer Portal Administer menu, select the HTML Content page 
you wish to edit and from the menu, select Edit > Edit HTML Content Data and select the Hide from end-user 
site?” field:

 

• Replacing standard content with nothing—An empty HTML Content document will not replace the existing 
standard content with nothing. To remove the standard page instructions, the HTML Content document 
should include only an HTML comment which is not visible on the end user site. Example: <!-- --> 

• Troubleshooting—To facilitate troubleshooting, the content stored in the document will have HTML 
comments pre-pended and appended during the display process. These comments are viewable using View 
Source on the page where the content is displayed. The comments are of the form: 

<!-- BEGIN HTMLContentID xxxx --> 

and 

<!--END HTMLContentID xxxx --> 

where xxxx is the Intraware Content ID 

Please contact your Client Relations or Project Manager if you have any questions
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Pages Supported for Custom HTML Content
The following table lists pages supported for custom HTML content.:

Table 5-7 • Supported Page

Page Name HTML Content ID Notes

Account Users MembersContent Displayed on the Account Members 
page to non- Administrative users who 
are not allowed to add or modify other 
Members.

MembersAdminContent Displayed on the Account Members 
page to Administrators who are 
allowed to add or modify other 
Members.

Account Administrators AdministratorsContent Displayed above the list of 
Administrators.

Download DownloadContent Displayed on the Download page. 

Note • Product specific content is still 
maintained via the Product 'Download 
Instructions' attribute.

Download Help DownloadHelp Displayed on the Download Help link 
from the site left navigation for 
additional help to troubleshoot 
download issues.

Download Order DownloadOrderContent Displayed on the Download Order page.

Download Preferences DownloadPrefContent Displayed on the Download 
Preferences page.

FAQ FAQ Displayed when clicking on the 
Frequently Asked Questions (FAQ) link 
on the left navigation.
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Index (Product List) ManufacturersContent Displayed when the user is presented 
with a list of Manufacturers. If only one 
Manufacturer is available, the user will 
be forwarded to the list of available 
Product Lines.

ProductSuiteContent Displayed when the Catalog Item 
Product Line selected contains 
Products that span multiple Product 
Product Lines. The user is presented 
with a list of child Product Lines from 
which to choose.

ProductLinesContent Displayed after the user has selected a 
Manufacturer (or the Manufacturer list 
page is bypassed) and the user has 
selected a Catalog Item Product Line 
(or the Catalog Item Product Line page 
is bypassed).

Login LoginContent Displayed above the username/
password input fields on the Login 
page.

LoginLowerContent Displayed below the username/
password fields on the Login page.

Offline Activation OfflineActivationContent Displayed on the Offline Activation 
page.

Order OrderContent Displayed on the Order Detail page.

Order History PurchasesContent Displayed on the Order History page.

Table 5-7 • Supported Page

Page Name HTML Content ID Notes
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Note • All pages are not available on all sites. Contact your Client Relations or Project Manager if you have 
questions about your implementation. Less frequently used pages are included in Additional Pages Supported for 
Custom HTML Content. 

Product (Product Information) ReleaseNewTabSoloContent Displayed when the Product Line 
selected contains no archived Products 
(only current Products).

ReleaseNewTabActiveContent Displayed when the current Product tab 
option is selected by the user and there 
are archive Products available for the 
Product Line selected.

ReleaseArchiveTabSoloContent Displayed when the Product Line 
selected contains no current Products 
(only archive Products).

ReleaseArchiveTabActiveContent Displayed when the archive Products 
tab option is selected by the user and 
there arecurrent Products available for 
the Product Line selected.

Profile MemberAddContent Displayed when an Administrator is 
adding a new Member.

MemberUpdateContent Displayed when updating Member 
information.

Search SearchContent Displayed on the Product Search page.

Support Support Displayed in the support section of the 
User Manual and includes download 
support and technical contact 
information, often linked from the site 
login page.

Switch Account SelectAccountContent Displayed when a Member is on more 
than one Account and must select from 
the list of Accounts after login to the 
end user site.

User Manual UserManual Displayed on the User Manual table of 
contents and subsequent sections.

Table 5-7 • Supported Page

Page Name HTML Content ID Notes
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Page Locations for HTML Content
This section lists the page locations for custom HTML content:

• MembersContent

• MembersAdminContent

• AdministratorsContent

• DownloadContent

• DownloadOrderContent

• DownloadPrefContent

• FAQ, User’s Manual, Support, and Download Help

• Manufacturers Content

• ProductSuiteContent

• ProductLinesContent

• LoginContent and LoginLowerContent

• OrderContent

• ReleaseNewTabSoloContent

• ReleaseNewTabActiveContent

• ReleaseArchiveTabSoloContent

• ReleaseArchiveTabActiveContent

• MemberAddContent

• MemberUpdateContent

• PurchasesContent

• SearchContent

• SelectAccountContent

MembersContent
The following displays the Page for the MembersContent:
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Figure 5-8: MembersContent

MembersAdminContent
The following displays the Page for the MembersAdminContent:

Figure 5-9: MembersAdminContent

AdministratorsContent
The following displays the Page for the AdministratorsContent:

Figure 5-10: AdministratorsContent
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DownloadContent
The following displays the Page for the DownloadContent:

Figure 5-11: DownloadContent

DownloadOrderContent
The following displays the Page for the DownloadOrderContent:

Figure 5-12: DownloadOrderContent

DownloadPrefContent
The following displays the Page for the DownloadPrefContent:
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Figure 5-13: DownloadPrefContent

FAQ, User’s Manual, Support, and Download Help
The following displays the Page for the FAQ, User’s Manual, Support and Download Help:

Figure 5-14: FAQ, User’s Manual, Support and Download Help
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Manufacturers Content
The following displays the Page for the ManufacturersContent:

Figure 5-15: ManufacturersContent

ProductSuiteContent
The following displays the Page for the ProductSuiteContent:

Figure 5-16: ProductSuiteContent

ProductLinesContent
The following displays the Page for the ProductLinesContent:

Figure 5-17: ProductLinesContent

LoginContent and LoginLowerContent
The following displays the Page for the LoginContent and LoginLowerContent:
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Figure 5-18: LoginContent and LoginLowerContent

OrderContent
The following displays the Page for the OrderContent:

Figure 5-19: LoginContent and OrderContent

ReleaseNewTabSoloContent
The following displays the Page for the ReleaseNewTabSoloContent:
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Figure 5-20: ReleaseNewTabSoloContent

ReleaseNewTabActiveContent
The following displays the Page for the ReleaseNewTabActiveContent:

Figure 5-21: ReleaseNewTabActiveContent

ReleaseArchiveTabSoloContent
The following displays the Page for the ReleaseArchiveTabSoloContent:
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Figure 5-22: ReleaseArchiveTabSoloContent

ReleaseArchiveTabActiveContent
The following displays the Page for the ReleaseArchiveTabActiveContent:

Figure 5-23: ReleaseArchiveTabActiveContent

MemberAddContent
The following displays the Page for the MemberAddContent:
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Figure 5-24: MemberAddContent

MemberUpdateContent
The following displays the Page for the MemberUpdateContent:

Figure 5-25: MemberUpdateContent

PurchasesContent
The following displays the Page for the PurchasesContent:

Figure 5-26: PurchasesContent
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SearchContent
The following displays the Page for the SearchContent:

Figure 5-27: SearchContent

SelectAccountContent
The following displays the Page for the SelectAccountContent:

Figure 5-28: SelectAccountContent

Additional Pages Supported for Custom HTML Content
The following table represents the details related to Additional supported pages:

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes

Advanced Download AdvDownloadContent Displayed on the Advanced 
Download Options page 
accessible from the Download 
page.
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Cancel Member MemberCancelContent Displayed on the Cancel Member 
page.

Restrict Access RestrictAccessContent Displayed on the Restrict Access 
page.

Download Log DownloadLogContent Displayed on the Download Log 
page.

Download Serial Number DloadSerialNumContent Displayed on License page 
accessible from the Download 
page.

Email Notice EmailNoticeContent Displayed on Email Notice page 
accessible via an update 
notification link.

License Order LicenseOrderContent Displayed on License page 
accessible from the Order page.

License Order Line LicenseOrderlineContent Displayed on License page 
accessible from the Order Detail 
page.

License Overview ** LicenseOverviewContent Displayed on License Overview 
page for specific license 
implementation option.

License Product Line LicensePlneContent Displayed on License page 
accessible from the Product Line 
(Index) page.

License Product LicenseProductContent Displayed on License page 
accessible from the Product 
(Version) page.

Manage License Host ** ManageLicenseHostContent Displayed on Manage License 
Host page.

Notification Log NotificationLogContent Displayed on the Notification Log 
accessible from the Download 
page.

Notification Preferences NotificationPreferencesContent Displayed on Email (Notification) 
Preferences page.

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes
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Order CD OrderCDContent Displayed on the Order CD page.

Order CD Confirmation OrderCDConfirmContent Displayed on the Order CD 
Confirmation page.

Password Finder PasswordFinderContent Displayed on the Password 
Finder page.

Password Finder Thanks PasswordFinderThanksContent Displayed on the Password 
Finder Thanks page.

Password Finder Token PasswordFinderToken1Content Displayed on the Password 
Finder Token page.

PasswordFinderToken2Content Displayed on the Password 
Finder Token page (second 
location).

Password Finder Token Thanks PasswordFinderTokenThanksCo
ntent

Displayed on the Password 
Finder Token Thanks page.

Product Preferences ProductPreferencesContent Displayed on the Product 
Preferences page.

Change / Reset Password ResetPasswordContent Displayed on the Change / Reset 
Password page.

Change / Reset Password Result ResetPasswordResultContent Displayed on the Change / Reset 
Password Result page.

Return Rehost Upgrade 
Confirmation **

ReturnRehostUpgradeConfirmCo
ntent

Displayed on the Return Rehost 
Upgrade Confirmation page.

Return Rehost Upgrade by Host 
**

RehostLicensesByHostContent Displayed on the Rehost License 
page.

ReturnLicensesByHostContent Displayed on the Return License 
page.

UpgradeLicensesByHostContent Displayed on the Upgrade 
License page.

Search License Host ** SearchLicenseHostsContent Displayed on the Search License 
by Host page.

Search License Host Result ** SearchLicenseHostResultConten
t

Displayed on the Search License 
by Host Result page.

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes
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Search Licenses SearchLicensesContent Displayed on the Search License 
page.

Search Line Items SearchLineItemsContent Displayed on the Search Line 
Items page.

View Cart ** ViewCartContent Displayed on the View Cart page.

ViewCartNotesContent Displayed on the View Cart page.

Agreement AgreementContent Displayed on the Agreement 
page.

Agreement Export AgreementExportContent Displayed on the Export 
Agreement page.

File Checkout ** FileCheckoutContent Displayed on the Order CD file 
checkout page for specific 
implementation.

Home HomeContent Displayed on the Home page.

Notes NotesContent Displayed on the Notes page.

NotesAddContent Displayed on the Add Notes 
page.

Register to Account ** RegisterToAccountContent Displayed on the Register to 
Account page for specific 
implementation.

Registration RegistrationContent Displayed on the Registration 
page for Try Before You Buy 
(TBYB) sites.

View Licenses by Generated 
User **

ViewAcctUsersGenLicensesCont
ent

Displayed on the View Licenses 
by Generated User page.

View Emails ** ViewEmailsContent Displayed on the View Emails 
page accessible from the Home 
page.

View License Host ** ViewLicenseHostLicensesConten
t

Displayed on the View License 
Host page.

View License Host Product Line 
**

ViewLicenseHostProductLinesCo
ntent

Displayed on the View License 
Host Product Line page.

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes
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Register to Account RegisterMemberToAccountIntro
duction

Displayed on Registration Page.

RegisterMemberToAccountThan
kYou

Displayed on Thank You Page.

View License Host Server ** ViewLicenseHostsServerContent Displayed on the View License 
Host Server page.

ViewLicenseHostsNodeContent Displayed on the View License 
Host Node page.

View License by Host Product 
Category **

ViewLicensesByHostPrdCatCont
ent

Displayed on the View License by 
Host Product page.

View License Tokens * ViewLicenseTokensContent Displayed on the View License 
Tokens page.

View Member Product Lines ** ViewMemberProductLinesConte
nt

Displayed on the View Member 
Product Lines page.

View Member Product Lines 
License **

ViewMemberProductLinesLicens
esContent

Displayed on the View Member 
Product Lines License page.

View Recent Files ViewRecentFilesContent Displayed on the View Recent 
Files page on the Home page for 
specific implementation.

Register Additional License 
Token **

RegisterAdditionalLicenseToken
sContent

Displayed on the Register 
Additional Token page.

Register Anonymous License 
Token **

RegisterAnonymousLicenseToke
nContent

Displayed on the Register 
Anonymous License Token page.

Register License Token ** RegisterLicenseTokenContent Displayed on the Register 
License Token page.

Register Order ** RegisterOrderContent Displayed on the Register Order 
page that requests Order ID and 
Authorization Code.

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes
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Signup SignupContent Displayed on the Signup page for 
Try Before You Buy (TBYB) sites 
with qualification.

SignupAdditionalInfo Displayed after the Signup form 
fields just before the submit 
button.

Product Notification 
Management

ProdNotifManagementContent Displayed on the Product 
Notification Management page.

Generate License Wizard ** GenerateLicenseWizardContent Displayed on the Generate 
License Wizard page.

Show Message ShowMessageContent Displayed on the Show Message 
page that appears for some 
errors.

Account List AccountListContent Displayed on the Account List 
page for administrators on 
multiple accounts to copy a 
member onto another account.

Order History Search PurchasesSearchInstructions Displayed on the Order History 
page in the search section.

View Recent Products RecentProductReleasesContent Displayed on the View Recent 
Products page.

Create Allocation Group ** CreateAllocationGroupContent Displayed on the Add Allocation 
Group page which can be 
reached from the Manage 
Groups link.

Search Servers ** SearchServersContent Displayed on the Search Servers 
page in the Devices section.

Search Devices ** SearchDevicesContent Displayed on the Search Devices 
page in the Devices section.

Claim Device ** ClaimDeviceContent Displayed on the Claim Device 
page in the Devices section.

Upload Capability Request ** CapabilityRequestContent Displayed on the Upload 
Capability Request page in the 
Devices section.

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes
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Note • Custom implementation. Not all pages are available on all sites. Contact your Client Relations or Project 
Manager if you have questions about your implementation.

Password Token
Customers can modify the FlexNet Operations LLM site password process to include a token rather than the 
password in specified emails. This document describes how to set up the password token link for Producer Portal 
users.

• Assigning Permission for Using Password Tokens

• Adding a Password Token to an Email Template

Assigning Permission for Using Password Tokens
To enable the password token functionality, a Producer Portal Administrator must first assign the Maintain Email 
Template (TMPL) permission to the appropriate Producer Portal users as shown below:

Search Served Clients ** ServedClientsContent Displayed on the Search Served 
Clients page in the Devices 
section.

Create Server ** CreateServerContent Displayed on the Create Server 
page in the Devices section.

Search Mapped Add-Ons ** SearchMappedAddOnsContent Displayed on the Search Mapped 
AddOns page.

Map Add-Ons ** MapAddOnsContent Displayed on the Map AddOns 
page right under the page 
header.

MapAddOnsSearchContent Displayed on the Map AddOns 
page right under the subpage 
header for the Search section.

Table 5-8 • Additional supported page

Page Name HTML Content ID Notes
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Figure 5-29: Assigning Maintain Email Templates (TMPL) Permission 

Adding a Password Token to an Email Template
The Producer Portal user with the Maintain Email Template (TMPL) permission will have the ability to add a 
password token to specific email templates following the steps below.
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Task To add a password token to an email template:

1. Login to FlexNet Operations LLM Producer Portal and Select the List Email Templates option under the 
Administer Menu: 

2. Select a template that includes password information such as the Welcome Email, Password Finder or 
Approved Entitlement Request (for Try Before You Buy sites) templates. Select the menu option Edit > Edit 
Live Content as shown the following:

3. Add token merge tag [[PASSWORD_FINDER_TOKEN]] in the specified format: 

4. After reviewing the content, click Preview and Save.

5. Next, do one of the following:

• To save the changes on the template for immediate use, click Save as Live. 

• To continue making changes, click Back to Edit. 

Format Example

Text Content https://PARTNER.flexnetoperations.com/service/PARTNERCODE/
passwordfindertoken?token=[[PASSWORD_FINDER_TOKEN]] 

HTML Content <a charset="UTF-8" href="https://PARTNER.flexnetoperations.com/service/
PARTNERCODE/passwordfindertoken?token=[[PASSWORD_FINDER_TOKEN]]">this link</a>
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• Click Save as Draft if you’d like to save this as a draft version to edit later.

Notes Regarding Adding a Password Token
Consider the following while adding a password token:

• Replace PARTNER and PARTNERCODE in the links with your site specific information. Example for Demo 
customer: 

https://demo.flexnetoperations.com/service/DEMO passwordfindertoken?token=[[PASSWORD_FINDER_TOKEN]] 

• Suggested content for the email template in Text section: 

• Please use the following link/URL to reset your password: 

https://PARTNER.flexnetoperations.com/service/PARTNERCODE/
passwordfindertoken?token=[[PASSWORD_FINDER_TOKEN]] 

• The generated token is valid for a period of ten minutes. If not used before it expires, you will need to 
request a new one 

(https://PARTNER.flexnetoperations.com/service/PARTNERCODE/password)

• The password token in the HTML content section of the email template should include charset reference as 
indicated below to address issues with a forward slash (/) in the resulting token: 

<a charset="UTF-8" href="https://PARTNER.flexnetoperations.com/service/PARTNERCODE/
passwordfindertoken?token=[[PASSWORD_FINDER_TOKEN]]">this link</a> 

• The password token expires after 10 minutes.

Note • Please contact your Revenera Account Manager or Project Manager if you have any questions.

Order CDs
Customers can allow end users to order product CDs from the FlexNet Operations LLM site for specified products. 
This document describes the specifications for this process. To enable this feature, contact your Revenera 
Account Manager or Project Manager.

• Ordering a CD

• Enabling CD Order Option

Ordering a CD
Once the Order CD feature is enabled, end users will be able to request product CDs by clicking a link added to 
the download page on the FlexNet Operations LLM site such as in the example below:
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Figure 5-30: Option to Order a CD

Use of this link by the end user will direct them to an Order CD page that displays their request and prompts them 
to confirm their request by clicking an Order CD button. FlexNet Operations LLM will display the following 
information, which the user may update before confirming the request:

• First Name

•  Last Name 

•  Email

• Job Title

• Phone

• Fax

• Street 1

• Street 2

• Street 3

• Street 4

• City

• State/Province

• Postal Code

• Country

The following is a sample order form for ordering a CD.
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Figure 5-31: Order CD Form

Once the end user clicks on the Order CD tab , Revenera will send the Order Product CD Request email to the 
predefined Customer email address or direct the user to a URL, including the user and product information 
submitted with the request.

Note the following regarding ordering a CD:

• Customer will provide either an email address or a URL to which the Order CD request will be sent.

• Customer will manage the Order Product CD Request email template if this is used instead of a URL. 

• Customer will manage the availability of the Order CD link via the Product attribute “Physical Distribution 
Available”.

Enabling CD Order Option
The Order CD link is only displayed for products that have been set up to be delivered physically. Producer Portal 
users with the Product Management permission will have the ability to add or edit products with this option by 
setting the Physical Distribution Available attribute on the product to Yes.
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Figure 5-32: Physical Distribution Available Option

Producer Portal users with the Maintain Email Template (TMPL) permission will have the ability to edit the Order 
Product CD Request email template (if being used.) 

If you require integration, tracking or confirmation for these processes, please contact your Revenera Account 
Manager or Project Manager to further define your requirements.

Home Page
Customers can display a home page instead of the standard index page to end users who have logged in to the 
FlexNet Operations LLM end user site. This document describes the sections included on this home page. To 
enable this feature, contact your Revenera Account Manager or Project Manager. 

• Sections on the Home Page

• Home Page Options

Sections on the Home Page
The home page includes the following three sections: 

• Recent Email Notifications—Emails sent to the end user within a specified number of days from today. For 
example, sent in last 30 days. 

• Recent Files Posted —Files uploaded within a specified number of days from today. For example, uploaded 
in the last 30 days. 
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• Browse My Software and Documentation—Products available with Manufacturer and Product Line 
navigation.

Figure 5-33: Sample End User Portal Home Page

Home Page Options
The following are the available options:

• The standard 30 day period can be altered to some other window of time as part of the implementation.

• The Recent Email Notifications and Recent Files Posted pages can be set up as their own pages with links 
from the left navigation.

Binary License File Support
Binary License File Support allows customers to issue licenses on the FlexNet Operations LLM site in any file 
format using Base64 encoding. Please contact your Revenera Account Manager or Project Manager if you are 
interested in this functionality.

Before you can use Binary License File Support, application configuration changes are required by Revenera. 
Once this feature is enabled, you will need to update the appropriate Catalog Item definitions to use this licensing 
scheme.

• FlexNet Operations LLM Producer Portal Changes to Enable Binary License File Support
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• XML Integration

• Viewing Binary Licenses in FlexNet Operations LLM

• Reporting on Binary License Files

FlexNet Operations LLM Producer Portal Changes to 
Enable Binary License File Support

There will be an option to upload license files for each entitlement line from the add or update entitlement pages 
in FlexNet Operations LLM Producer Portal. You will use the standard Browse functionality in your web browser to 
find and add the license file to the web form. The following displays uploading the license file:

Figure 5-34: Choosing a License File in the FlexNet Operations LLM Producer Portal

After you have processed the order, the filename will be displayed for future reference. By clicking on the file 
name, you can download the license file so that you can verify its content. The following indicates the license file 
name:
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Figure 5-35: License File Name Field with Uploaded License Name

XML Integration 
The order line element within the Order Transaction Schema has an additional field of <LicenseFileName>. To load 
a license file, set the filename field and populate the <LicenseCode> field with the Base64 encoded representation 
of the license file. For example: 

…
<SKU>MY-PART-NUMBER</SKU>
<Quantity>10</Quantity>
<LicenseFileName>license.txt</LicenseFileName>
<LicenseCode>bGljZW5zZSBmaWxlIGNvbnRlbnQ=</LicenseCode>
…

The filename you specify will be the filename used when the license file is downloaded to the end user.

Viewing Binary Licenses in FlexNet Operations LLM 
Binary License files are accessible in the FlexNet Operations LLM service in the same way the plain text licenses 
are made available. This can be from the License Key link on the download page, Order History page, or Index 
page, depending on your implementation. 

The two types of licenses are displayed differently. 

• Plain text licenses are displayed on the page. 

• Binary License files appear as a link from which you are able to download the file. 

The following displays the license file information:
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Figure 5-36: License File Information on End User Portal Site

Note • Depending on the user’s browser configuration for specific file types, some files may render directly in the 
browser, rather than display a Save As dialog box.

Reporting on Binary License Files 
Revenera will include a new Reporter data universe called Licenses Saved to include the date when members 
save binary license files. 

Contact your Revenera Account Manager or Project Manager if you are interested in this functionality.

Localized Emails
To maximize the end-user experience in every market and support global branding, customers can localize their 
sites, products and outgoing emails using the FlexNet Operations LLM service. Site and product localization 
requires separate implementation. To implement localized emails, contact your Revenera Account Manager or 
Project Manager, identifying the languages you would like to make available for emails. 
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Once the localized email feature has been implemented on FlexNet Operations LLM Producer Portal, the Member, 
Account Administrator and/or Manager user with the appropriate permissions will be able to set the language 
preference to be used for outgoing emails from FlexNet Operations LLM. 

• Enabling Email Localization

• How a Member Can Set Email Language Preference

• Setting Email Language Preference for a Member

• Language Sections in Email Template

• Considerations Regarding Language Preference

Enabling Email Localization
To implement, Revenera will set up a Member Level User Defined Field (UDF) called MBR_LANG with predefined 
languages / language codes used to set the member choice for localized emails. The following displays the View 
User Defined Field page:

Figure 5-37: MBR_LANG User Defined Field on View User Defined Field Page

How a Member Can Set Email Language Preference
The Member can set their email language preference on the Email Preferences page or their Profile page. The 
following displays the Email Preferences page:
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Figure 5-38: Language Field on Email Preferences Page

Setting Email Language Preference for a Member
An Account Administrator can set the email language preference for users via FlexNet Operations LLM on the Add 
Member or Edit Member page. The following displays the Add Member page: 

Figure 5-39: Language Setting on Add New Member Page
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The Manager user will be able to provide this information on the Add Member or Edit Member pages in the 
Producer Portal.

The following displays the Edit Member page: 

Figure 5-40: Language Setting on Edit Member Page

Language Sections in Email Template
All email templates will include new language sections for both Text and HTML content. The following displays 
the View Live Email Template page:
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Figure 5-41: Language Sections in Email Template

Considerations Regarding Language Preference
Consider the following regarding language preference:

• The language preference applies to all emails except the password finder emails. The language used for the 
password finder would be based on the site from which the request is submitted. If you do not have a 
localized site(s), the default is in English. 

• If there is no localized content provided in the email template, default displayed to the user is English. 

• Localized product fields become available in FlexNet Operations LLM Producer Portal with the localized email 
feature. These localized product fields are not displayed on the FlexNet Operations LLM site unless you have 
implemented localized sites (i.e. if your site is still only in English, adding Japanese product descriptions will 
not cause the alternate language of Japanese to appear for that product). 

• Localized sites are available. 

Contact your Revenera Account Manager or Project Manager to implement this feature.
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Single Sign-On Process
Single Sign-On for FlexNet Operations LLM will allow Customers to forward a user who has already been 
authenticated by the Customer to their FlexNet Operations LLM website without prompting the user to log in 
again.

• Revenera Obligations

• Customer’s Obligation

• Single Sign-On Considerations

Revenera Obligations
Revenera’s FlexNet Operations LLM application uses a login servlet, which when hit by a browser, will check that 
the referring URL of the request matches the domain specified by the Customer. If it does, it will attempt to log in 
the user using the username parameter passed to the login servlet (normally equivalent to the email address).

The username can be passed as a query string parameter within the URL or using HTTPS post.

For additional security, the username is encrypted by the Customer’s referring server by using the DESede 
algorithm and an agreed upon shared secret key, which FlexNet Operations LLM will use to recover the original 
username.

To prevent replay attacks, the Customer’s referring server may also include a time-based token which the FlexNet 
Operations LLM service will check before providing access to the user Account.

If the authentication fails, either because the referrer URL doesn't match or because some other component of 
the supplied credentials is invalid, the user will be redirected to a URL specified by the Customer.

If authentication completes successfully, the user will be forwarded to the FlexNet Operations LLM page 
specified in the URL (using the ‘nextURL’ parameter, e.g., a product download page).

The FlexNet Operations LLM application will log the user in and set two cookies in the browser of the user:

• A session cookie which includes the encoded username and password.

• A session cookie which carries the application server's session ID. On subsequent page hits to the FlexNet 
Operations LLM application, the user will be considered logged in if the authentication cookie is present, and 
if the session ID of the current session matches the session ID found in the session cookie.

Customer’s Obligation
Customer will participate in User Acceptance Testing for the requirements and will sign off once complete.

Customer will modify its website(s) so that the URL for the link(s) to the FlexNet Operations LLM site includes the 
FlexNet Operations LLM encrypted Login ID and time-base token, action parameter, and destination page. The 
format for the URL is:

https://<% customer name %>.flexnetoperations.com/control/<% customer code
%>/login?email=<% encrypted Login ID %>&encToken=<% encrypted timestamp
%>&action=authenticate&nextURL=index
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Customer will provide Revenera with a domain name/URL, which will be used to match the referring URL. If the 
referring URL is valid and the user credentials are correct, the user will be logged in.

Customer will provide Revenera with the URL of the page to which the user will be redirected if the Single Sign-On 
attempt fails, presumably either the Customer authentication page or the FlexNet Operations LLM login servlet. 
Note that this also becomes the default authentication mechanism for users who are directly accessing the 
Customer FlexNet Operations LLM site.

Customer will provide Revenera with the URL of the page to direct user upon logout.

The Customer may also choose to use the un–encrypted Single Sign-On approach. In this approach, the user 
credentials are not encrypted prior to inclusion in the request. The format of the URL is:

https://<% customer name %>.flexnetoperations.com/control/<% customer code
%>/login?email=<% Login ID %>action=authenticate&nextURL=index

Single Sign-On Considerations
Revenera’s secure Single Sign-On option is both flexible and available at a low cost. Our intent is to ease 
implementation across platforms without dependencies on other authentication mechanisms or technologies 
such as SAML, OAuth, OpenID, etc. Please advise your Account Manager if you are using a 3rd party to host your 
identity management services and also have interest in Revenera’s Single Sign On option.

Login ID Parameter
One decision that needs to be made is the determination of whether standard login via form post will be offered 
in addition to SSO. If both methods are implemented, the name of the parameter used to supply the Login ID in 
the request must be ‘email’. If SSO only is allowed, the parameter name must be ‘username’.

Passwords
By default, a FlexNet Operations LLM password is created and stored when a Member is created, so this will 
always occur.  In the case of SSO, we only use the password in a cookie which is relied on during the course of the 
session - it is not used for the initial authentication/authorization request in any way. In fact, the user does not 
need to know what it is or that we have it (unless he or she wants to use FTP download).

We do not maintain a copy of the Customer’s users’ passwords, so there’s no record of it in our data store and 
thus no cause for concern of it being compromised.
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Product Management

This section explains how to use items on the Package Products main menu and also includes other information 
that provides more insight on product management support:

• Packaging Products

• Product Management Support

Packaging Products
This section explains how to use the items on the Package Products main menu.

• About Package Products

• Catalog Items

• Product

• File

• Configure

About Package Products
The Package Products section of the Producer Portal lets you add product information to FlexNet Producer Portal, 
edit or update products that are already in the system, and upload the actual downloadable files.

You manage products at three different levels in the Producer Portal:

• Catalog Items (price list items) represent the things that your company sells. For example, a product or a 
maintenance agreement. Catalog Items have attributes such as default duration, whether the Catalog Item 
includes updates (maintenance), etc. Catalog Items generally reference one or more Products.

• Products (product releases) represent the things that your company wants delivered. For example, a specific 
version of a product. Products have attributes such as export licenses, version number, platform, archive 
dates, etc.. Products reference one or more Files.
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• Files (images) are the actual software files that the end user downloads. For example, the installation 
executable for a particular platform. A File may be associated to one or more Products.

The QuickSearch box lets you quickly find a Catalog Item or Product if you know the corresponding Name or ID. If 
your search criteria match more than one Catalog Item or Product, you will be given the opportunity to choose the 
Catalog Item or Product from a list. This function is not case sensitive and supports the use of the "*" character as 
a wildcard in most fields.

Catalog Items
The following sections describe the Catalog Items area of the Package Products section of the Producer Portal.

• Search Catalog Items

• Add Catalog Item

• View Catalog Item

• Edit Catalog Item

 Search Catalog Items
Catalog Items have a number of attributes which you can use to locate the Item(s) you are interested in:

The Search Catalog Item function is not case sensitive and supports the use of the "*" character as a wildcard. 

Note • Wildcards cannot be used for System ID fields.

Table 6-1 • Search Catalog Items

Item Description

Catalog Item ID Unique identifier that your company's internal systems may use to identify your 
price list items

System Catalog Item ID Unique identifier created by the System when the Catalog Item was created in 
the Producer Portal

Catalog Item Name Descriptive name that your company uses to identify your price list items

Catalog Manufacturer Either the company or a product group within the company

Catalog Product Line Identifier for a group of Catalog Items, usually the same as the Product Line 
under Product but may be different in the case of product bundles or suites

Status Catalog Items may be Active or Inactive, meaning these catalog items will be 
hidden from quick searches. If you want to prevent orders being processed for 
Inactive Catalog Items we can enable such a validation. Discuss this with 
Support or a Client Relationship Manager.
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If your search criteria match more than one Catalog Item, you will be given the opportunity to choose the one you 
are looking for from a list of those matching your criteria.

Once you have selected a Catalog Item you can use the CATALOG menu to:

• Edit the item—See Edit Catalog Item.

• Associate (or disassociate) products to (from) the Catalog Item—See Associate Product and Disassociate 
Product.

• Reidentify the Catalog Item—See Reidentify (ReID) Catalog Item.

• Inactivate/Reactivate the Catalog Item—See Inactivate.

• Copy the Catalog Item—Copy the Catalog Item as a short-cut to making a new Catalog Item with similar 
characteristics. See Copy Catalog Item.

Add Catalog Item
Catalog Items (price list items) represent the things that your company sells, for example, a product or a 
maintenance agreement. When you Entitle your customers (or process orders) in the Producer Portal, you entitle 
them to Catalog Items. Catalog Items, in turn, are normally associated with one or more Products.

To add a Catalog Item you provide the following information:

Table 6-2 • Catalog Item Properties

Item Description

Catalog Item ID Your company's unique identifier for this item; this will often be a sales catalog 
or price list ID. The Catalog Item ID is displayed on the FlexNet Producer Portal 
Entitlement History page.

Catalog Item Name Short description of the Catalog Item, such as "Product X with one year 
maintenance". The Catalog Item Name is displayed on the Entitlement History 
page and can be used in the Entitlement Notification email.

Catalog Item Type Catalog Item Type can be used to inform FlexNet Producer Portal not to 
process entitlement lines for this Catalog Item. In particular it is used when 
you need to process Entitlements (orders) for items that you don't want 
FlexNet Producer Portal to deliver, such as support contracts. The type has 
three possible values: 

• Normal—As the name implies, most of the Catalog Items will be Normal 
and this is what you should use unless your company has configured one 
of the other types. 

• Report Only—When FlexNet Producer Portal receives an entitlement for a 
Report Only Catalog Item, it reports the entitlement in FlexNet Operations 
Reporter but does not attempt to grant an entitlement to an Account. 

• Ignore—When FlexNet Producer Portal receives an Entitlement line for an 
Ignore Catalog Item, FlexNet Producer Portal will completely ignore the 
line.
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View Catalog Item
The View Catalog Item screen is accessed either by searching for and selecting an existing Catalog Item or by 
creating a new Catalog Item.

Subscription (Yes/No) Defaults to Yes. If No is selected (non-subscription Catalog Item) this Catalog 
Item will not be updated when you use the Associate Where feature to 
automatically give users access to a new product based on access to another 
product

Temporary (Yes/No) Defaults to No. If Yes is selected (temporary Catalog Item) then your customers 
will not continue to have access to the Products associated with this Catalog 
Item after the expiration date of their Entitlement. This is often used for try and 
buy evaluations.

Default Duration The default duration of an Entitlement to this Catalog Item. Default Duration is 
overridden by changing the Expiration Date on an Entitlement

Download Limit (Yes/No) Default is No. If Yes is selected the files associated with Products which are 
entitled through this Catalog Item may only be downloaded a limited number 
of times, otherwise the files may be downloaded an unlimited number of 
times.

Default Maximum Download 
Limit

Default value for the number of times files entitled through this Catalog Item 
can be downloaded. The default value can be overridden by explicitly providing 
a download limit on the entitlement. This only applies when the Download 
Limit attribute is set to Yes.

Catalog Manufacturer List of configured companies or product groups. Manufacturer is configured 
via the Configure menu.

Catalog Product Line List of configured product groupings. Catalog Product Line is configured via 
the Configure menu. The Catalog Product Line is displayed on the FlexNet 
Producer Portal index page.

License Group List of configured license key groups. If your company only supports one group 
you will only see one choice. License groups are normally configured when 
your site is first set up. If you need to configure additional license groups you 
should contact your Revenera Client Relations Manager.

Support Agreement List of configured agreements that may be associated with this Catalog Item. 
Each catalog item may be associated with one agreement. You can create or 
edit the Agreements through the "Configure" menu option. Note that your site 
must be configured to use Support Agreements for this to be meaningful. 
Please contact your Client Relations Manager for more information.

Table 6-2 • Catalog Item Properties

Item Description
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• The View Catalog Item screen displays the current values for the Catalog Item attributes. 

• This screen also shows the Product(s) associated with this Catalog Item. 

Clicking on a Product Name will take you to that Product's View Product page.

Edit Catalog Item
Use the Edit Catalog Item form to edit any of the catalog attributes except the Catalog Item ID. 

When you make changes to a Catalog Item already in production, existing entitlements based on the Catalog Item 
will remain in place. 

The new Catalog Item attributes will appear in FlexNet Operations Reporter and wherever displayed on the 
FlexNet Producer Portal site. To change the Catalog Item ID you need to use Reidentify.

Associate Product
To associate Products with a Catalog Item, you must first identify the Catalog Item either by searching for and 
selecting an existing Catalog Item, or by creating a new Catalog Item.

When you choose Associate Product from the CATALOG menu you will be prompted to search for the Product(s) 
you want to associate with this Catalog Item. 

• All Products which match your search criteria will be displayed. 

• Click on the check box of the one(s) you want to associate to the Catalog Item and then click the Associate 
button at the bottom of the form. 

• The Product(s) you selected will be added to the list of Products in this Catalog Item.

You can also add a specific product to one or more Catalog Items by using the Associate To Catalog menu item 
from the PRODUCT menu.

Disassociate Product
The Disassociate Product form prompts you to select one or more Products which are currently associated with 
the Catalog Item. 

When you click on Disassociate Product, the selected Products will no longer be associated with this Catalog 
Item and users who had access to the selected Products through this Catalog Item will no longer have access to 
them (unless access is provided through another Catalog Item).

Reidentify (ReID) Catalog Item
Use the Reidentify form to change the Catalog Item ID. 

All existing entitlements based on the Catalog Item will remain in place but will reflect the new Catalog Item ID in 
FlexNet Operations Reporter and wherever displayed on the FlexNet Producer Portal site (e.g., on the Entitlement 
History page).
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Inactivate
Select Inactivate from the CATALOG ITEM menu to change the status of a Catalog Item. 

When you select Inactivate, the Catalog Item's status changes to Inactivated. This catalog item will now be 
hidden from quick searches. Existing entitlements will not be affected. 

Note • If you want to prevent orders being processed for Inactive Catalog Items, Revenera can enable such a 
validation. Discuss this with Revenera Support.

Copy Catalog Item
If you want to create a new Catalog Item that is very similar to an existing one, you can use the Copy function on 
the CATALOG ITEM menu. 

The Copy function will copy all of the attribute values of the original Catalog Item into the corresponding fields of 
a new Add Catalog Item form. You can then make any changes necessary to distinguish the new Catalog Item 
from the original and then save the new Catalog Item.

Export Catalog Item
Export Catalog Item Tree will create a downloadable XML batch file with the transactions necessary to recreate or 
archive the Catalog Item Tree:

• AddCatalogItem

• AddProduct

• AddFile

• AddProductsToCatalogItems

• AddFilesToProducts

Export Catalog Item will create a downloadable XML batch file with the AddCatalog transaction necessary to 
recreate or archive the Catalog Item:

• AddCatalogItem

Note • The following must exist in the target environment. Otherwise, some transactions will fail, when the 
exported XML batch file is uploaded:

• Product Lines with the matching Product Line IDs.

• Manufacturers with the matching Manufacturer IDs.

• License Groups with the matching License Group IDs.

• Agreements with the matching System Agreement IDs.
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Additional information
• Readonly User Defined Fields will be excluded. These values are maintained by specific application 

processes.

• Catalog Items, Product and Files without IDs will be created, but, since there is no way to reference them, 
they will be excluded from the association transactions ( ex. AddProductsToCatalogItems and 
AddFilesToProducts ). The System IDs cannot be used, since they will be not be the same in the other 
environments.

• The export functionality is only available to Members with the Product Management (PDCT) permission.

Product
The following sections describe the Product area of the Package Products section of the Producer Portal.

• Search Products

• Add Product

• View Product

• Where Used

• Edit Product

• Edit File List (Sort Files)

• Associate/Disassociate: Associate File

• Associate/Disassociate: Disassociate File

• Associate/Disassociate: Associate to Catalog Item

• Associate/Disassociate: Disassociate from Catalog Item

• Associate/Disassociate: Associate Where

• Reidentify (ReID) Product

• Copy Product

• Copy to Catalog Item

• Notify

• View Emails
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Search Products
Products have a number of attributes which you can use to locate the product(s) you are interested in:

The Search Product function is not case sensitive and supports the use of the "*" character as a wildcard. Note 
that wildcards cannot be used for System ID fields.

If your search criteria match more than one Product then you are given the opportunity to choose the one you are 
looking for from a list of those matching your criteria.

Once you have selected a Product you can use the PRODUCT menu to:

• Where Used—Find all the Catalog Items which are associated with this Product (Where Used). See Where 
Used. 

• Edit—Edit the Product attributes, including the sort order of the Files associated with this Product. See Edit 
Product. 

• Associate (or disassociate) Files to (from) the Product—See Associate/Disassociate: Associate File or 
Associate/Disassociate: Disassociate File.

• Associate (or disassociate) the Product with a particular Catalog Item or Items—See Associate/Disassociate: 
Associate to Catalog Item or Associate/Disassociate: Disassociate from Catalog Item.

• Associate/Disassociate: Associate Where—Instruct FlexNet Producer Portal to use this Product in all the 
Catalog Items where some other Product is used -- e.g., use version 2.1.1 wherever version 2.1 is found. 
(Associate Where). See Associate/Disassociate: Associate Where. 

• Reidentify the Product—See Reidentify (ReID) Product.

• Copy—Copy the Product information as a short-cut to making a new Product with similar characteristics. See 
Copy Product.

Table 6-3 • Search Products Attributes

Attribute Description

Product ID Unique identifier that your company's internal systems may use to identify 
your shippable items, often called a “part number”.

System Product ID Unique identifier created by the System when the Product was created in 
the the Producer Portal system.

Product Name Descriptive name that your company uses to identify the products it ships 
(delivers electronically).

Product Manufacturer Either the company or a product group within the company.

Product Line Identifier for a group of Products.

Status Products may be Active, meaning that new entitlements can include these 
items, or Inactive, meaning that these items will not be included even if 
they are associated with Catalog Items which are entitled.
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• Copy to Catalog Item—Copy the Product information as a short-cut to making a new Catalog Item with similar 
characteristics. See Copy to Catalog Item.

• Notify—Send email notification to users who have entitlements which include this Product. See Notify.

Add Product
The Product that you add through the Producer Portal is a logical description of one or more downloadable files, 
often bundled together as a “release”. These “deliverable” Products are associated with one or more Catalog 
Items through which the Product is entitled.

To complete the Product Information section you enter the following information:

Table 6-4 • Product Properties

Property Description

Product ID Unique name or code that your company uses to identify this particular 
deliverable unit

Product Name A “user friendly” name for the product. The product name is displayed and 
used as navigation on the FlexNet Producer Portal site

Product Version May be numerical or text, the version distinguishes similar deliverable 
items from each other. The version is displayed on the FlexNet Producer 
Portal site.

Available Date This date is displayed on the FlexNet Producer Portal site and is usually the 
"official" release date for this version of the product. The Available Date 
affects whether end users can access the product via an overlap with their 
entitlement dates.

Archive Date Once this date has passed the product/version will be moved to the 
"Archive" tab on the FlexNet Producer Portal site. Users will still be able to 
download it if they have access through an overlap with their entitlement 
dates, but will not see it unless they click on the Archive tab on the FlexNet 
Producer Portal site. (New entitlements with beginning dates after the 
Expiration date will not have access to this product at all).

Product Manufacturer A list of configured companies or product groups. Product Manufacturer is 
configured via the "Configure" menu.

Product Line Product lines you choose from in this drop down box are specific to your 
company. Product Line is configured via the "Configure" menu.

End User License Agreement 
(EULA)

List of configured "click through" agreements which may be associated 
with a Catalog Item. EULA's are configured through the "Configure" menu. 
The EULA appears just before the download page in FlexNet Producer 
Portal.
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Once you have supplied the required information, you have several choices:

• Add Product—Add this Product and go to the View Product form for this Product (from which you can 
continue to edit the Product).

• Submit & Add Another Product—Add this Product and then go to a new pre-populated Add Product screen 
from which you can begin entering a new Product.

• Submit & Continue to Add File—Add this Product and go to the Add File form.

• Submit & Continue to Associate File—Add this Product and go the the Associate File form where you can 
associate an existing file with this Product.

• Submit & Copy Product to Catalog Item—Add this Product and go to a Add Catalog Item form which is pre-
populated with the relevant information from this Product (useful where you will have only one product per 
Catalog Item).

View Product
The View Product screen is accessed either by searching for and selecting an existing Product or by creating a 
new Product.

The View Product screen displays the current values for the particular Product’s attributes. This screen also 
shows the File(s) associated with this Product. Clicking on a File Description will take you to that File's View File 
page.

Where Used
The Where Used function displays a list of all of the Catalog Items with which this Product is associated. 

Download Instructions Supplemental information for the end user. The Product Note is displayed 
on the Product Download page of the FlexNet Producer Portal site.

Physical Distribution Available If your site has been configured to integrate with a physical distribution 
supplier then this attribute indicates that this particular Product is available 
in a physical medium in addition to the electronic delivery provided by 
FlexNet Producer Portal.

BIS Classification Consists of ECCN, ENC, CCATS codes. In order for FlexNet Producer Portal 
to enforce U.S. Dept. of Commerce export regulations you must provide 
information about the encryption levels and export licenses of the product. 
If you do not provide this information your product cannot be delivered 
outside of the United States. For more information about the Dept. of 
Commerce regulations and the meaning of these codes please refer to the 
Bureau of Industry and Standards web site at http://www.bis.doc.gov/ or 
contact your company's legal department.

Table 6-4 • Product Properties

Property Description
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Clicking on the name of a Catalog Item within this list will take you to the View Catalog Item screen from which 
you can also manage the Catalog Item

Edit Product
Once you have selected a Product, you can click on Edit to make changes to the Product attributes.

The Edit Product form behaves much like the Add Product form and allows you to modify all of the product 
information except the Product ID. If you need to change the "Product ID" use the Reidentify (ReID) form.

Edit File List (Sort Files)
The Edit File List form displays all of the files associated with this Product and allows you to create and edit the 
file sort order. 

• The files that are part of this product will be sorted in ascending order according to the numeric values you 
enter here. 

• If no sort order is specified or when more than one file has the same Sort Order number, then the files will be 
sorted in the alphabetical order of the File Short Description. 

• The file sort order only applies to this Product, so the same File used in more than one Product may have a 
different sort order value in different Products.

The Edit Files form also allows you to indicate which, if any, of the files in this Product should ignore download 
limits inherited from the Catalog Item.

Associate/Disassociate: Associate File
When you associate a file to a product you are indicating that the file is to be included within the product. If you 
choose Associate File you will be prompted to either enter the catalog item ID(s) or conduct a search for the 
Catalog Items(s) that you want to associate with this product. All files which match your search criteria will be 
displayed. 

Click on the check box of the one(s) you want to associate to the product and then click the Associate button on 
the bottom of the form. The files(s) you selected will be added to the list of Files in this Product.

You can also add a specific file to one or more products by using Associate To Product from the FILE menu.

Associate/Disassociate: Disassociate File
When you disassociate a file from a product you are indicating that the file is no longer included within the 
product. The Disassociate File form lists any files currently associated with this product. 

To disassociate one or more of these files from the selected product click on the Disassociate? check box next to 
the item(s) and then click on the Disassociate button at the bottom of the form. There is also a Disassociate ALL 
files from this Product option at the bottom of the form which allows you to disassociate all the files currently 
associated to the product without actually checking the Disassociate? check box.
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Associate/Disassociate: Associate to Catalog Item
When you associate a product to a catalog item you are indicating that the product is included within the catalog 
item. The Associate to Catalog function allows you to associate this product to one or more catalog items. 

You will be prompted to either enter the catalog item ID(s) or conduct a search for the catalog items(s) that you 
want to associate with this product. All Catalog Items which match your search criteria will be displayed. 

Click on the check box of the one(s) you want to associate to the Product and then click the Associate button on 
the bottom of the form. An existing customer with access to the Catalog Item would have immediate access to 
new products associated to the Catalog Item.

You can also add the Product to a specific catalog item by using Associate Product from the CATALOG menu.

Associate/Disassociate: Disassociate from Catalog Item
When you disassociate a product from a catalog item, you are indicating that the product is no longer included 
within the catalog item. Disassociating a product from a Catalog Item effectively cancels any access to the 
product which was based on entitlement to the catalog item. 

When you select this item you are presented with a list of all the catalog items to which this product is 
associated. Click on the Disassociate? check box of any catalog item(s) from which you wish to disassociate this 
product. 

There is also a Disassociate ALL Catalog Items from this Product at the bottom of the form which allows you to 
disassociate all the products currently associated to the catalog item without actually checking the Disassociate? 
check box. An existing customer with access to the product previously would not longer have access to the 
product disassociated from the Catalog Item.

Associate/Disassociate: Associate Where
If you do not want to explicitly select the catalog items to which you want a product associated, you can tell the 
Producer Portal to use this product wherever some other product is already being used. In other words, you can 
associate a product with all the catalog items with which another product is associated. 

When you click on Associate Where you will be presented with a product search screen. You can use the "*" 
wildcard to search for and select the product which will serve as the template for associating this product with 
catalog items. 

Note • Note that the Associate Where function will update all Catalog Items that contain the template Product 
unless the Catalog Item is a "non-Subscription" item. In order to associate a Product with a non-Subscription 
Catalog Item you must explicitly make the association.

Reidentify (ReID) Product
If for some reason you need to change the Product ID (Part number) of a product that already exists in the the 
Producer Portal system, you can do so by selecting Reidentify once you have selected a Product. The Reidentify 
form prompts you for a new Product ID.
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Copy Product
If you want to create a new Product that is very similar to an existing one you can use the Copy function on the 
Product menu. 

The Copy function will copy the values of all of the attributes of the original Product into the corresponding fields 
of a new Add Product form. You can then make any changes necessary to distinguish the new Product from the 
original and then save the new Product.

Copy to Catalog Item
Clicking on Copy to Catalog Item will take you to a new Add Catalog Item form in which the Item ID, Name, 
Manufacturer, and Product Line are pre-populated with the values from the corresponding fields in this Product. 
You will need to provide the additional required fields in order to create the Catalog Item.

This function is useful when you expect to have a 1:1 relationship between Products and Catalog Items.

Notify
The Notify function allows you to provide email text which will be sent to all users who have an entitlement which 
includes this Product. You will provide the subject line and the text of the email message. Email messages are 
queued by the Producer Portal and processed by the Revenera Operations Team. You may also use this form to 
send any special handling instructions to the Revenera Operations team.

View Emails
Select View Emails to display all Update Notification emails related to the Product. Click on an individual System 
Email ID to view a particular email message. 

If no Emails exist for the Product, the system will display a status message to that effect.

File
The following sections describe the File area of the Package Products section of the Producer Portal.

• Search Files

• Add File

• View File

• Where Used

• Edit File

• Upload File

• Associate to Product

• Disassociate From Product

• Associate Where
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• Reidentify (ReID) File

• Notify

• View Emails

Search Files
Files have a number of attributes which you can use to locate the file(s) you are interested in:

The Search Files function is not case sensitive (except the File Description) and supports the use of the "*" 
character as a wildcard. 

Note • Wildcards cannot be used for System ID fields.

If your search criteria match more than one File, then you are given the opportunity to choose the one you are 
looking for from a list of those matching your criteria.

Once you have selected a File, you can use the FILE menu to:

• Edit File—Edit the File information. See Edit File. 

• Upload File—Upload a file (that is, upload the actual bits associated with this File object). See Upload File. 

• Where Used—Find all the Products where this File is used (Where Used). See Where Used. 

• Associate to Product—Associate the File with one or more Products. See Associate to Product. 

• Inactivate/Reactivate—Inactivate/Reactivate the File.

• Associate Where—Instruct the Producer Portal to associate this File with all the Products which some other 
File is associated with (e.g., use Widget_2_1.ReadMe.txt wherever Widget_2_1.exe is found). See Associate 
Where.

Table 6-5 • Search Files Attributes

Attribute Description

File ID Unique value by which your company identifies individual files. The File ID may come 
from a release management or source code control system.

System File ID Unique identifier assigned by the the Producer Portal system when a new File object is 
created

File Description The name of the file that the user sees on the download page. File Description is not 
case sensitive.

File Status you can search all files, files for which an image has been loaded, or files for which an 
image hasn't been loaded.

File Name Actual system level name of the file, e.g., installer_2_7.zip
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Add File
Files are what the end user actually downloads. Files which are part of the same release are grouped together 
into one or more Products which are in turn entitled through Catalog Items.

To add a file to the Producer Portal you provide the following information:

Once you have supplied the required information, you have several choices:

• Add File—Add this file and go to the View File form for this file (from which you can continue to edit the file).

• Submit & Add Another File—Add this file and then go to a new pre-populated Add File screen from which you 
can begin entering a new file

• Submit & Continue to Upload File—Add this file and go to the Upload File form.

View File
The View File screen is accessed either by searching for and selecting an existing File or by creating a new File.

The View screen displays the current values for the particular File's attributes.

Where Used
The Where Used function displays a list of the Products which use this File. 

Table 6-6 • Add File Properties

Property Description

File ID Unique value by which your company identifies individual files. The File ID may 
come from a release management or source code control system.

File Description The name of the file that the user sees. It should be brief but descriptive, such as 
"Enterprise Server 2.4 Solaris" or "Enterprise Server 2.4 Documentation"

File name The Name of the as it will appear in FlexNet Producer Portal. 

Note • During the upload of a File, this field will be overwritten with the name of the 
file that is being uploaded.

Content Detail Additional information that is displayed when the end user clicks on the Estimated 
Time and Details link on the download page of the FlexNet Producer Portal site. 

You can use the Long Description to give additional installation or compatibility 
hints or to provide detailed information about the contents of the file. 

Note • If the file you provide is in a .zip or .jar format, then the Producer Portal will 
overwrite the contents of this field with the zipinfo during a File Upload.
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Clicking on the name of a Product within this list will take you to the View Product screen from which you can 
manage the Product.

Edit File
Once you have selected a File, you can click on Edit to modify the File's attributes

The Edit File form behaves much like the Add File form and allows you to modify much of the File information. The 
File ID can be changed through the ReIdentify File screen. 

Note • Some fields are maintained by the Application and can not be changed by the User.

Upload File
You can upload the actual File Image to an existing the Producer Portal File object by selecting Upload File from 
the FILE menu

The Upload File form displays the details of the File object you are uploading the File Image to. There are two 
ways to Upload the File:

• HTTP Upload—Click the Browse button to select the File that resides on your local file system or enter the 
path to the File (relative to your computer). When you click on Upload File from Local File System, the file will 
be uploaded to the Producer Portal system.

• FTP Upload—If the File is already loaded onto Revenera's FTP server, enter the filename and location. 

Note • You do not need to specify the FTP server name in the location, only directories that you may have 
created on the ftp server.

When you click on Upload File from Flexera FTP Server, the file will be uploaded to the the Producer Portal 
system.

Note • Uploaded files can not be downloaded until the Download Available? field in the View File page in the 
Producer Portal indicates Yes.

Associate to Product
The Associate to Product function allows you to associate this File with one or more Products. 

When you click on Associate to Product, you are presented with a Product Search screen. You can use the "*" 
wildcard to search for and select the Product(s) that you want to add this File to. All Products matching your 
search criteria will be displayed. 

Click the checkbox next to each Product that you want this File Associated with and then click on the Associate 
Files button to submit the form.
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Disassociate From Product
Disassociating a File from a Product means that users will no longer have access to that file(s) through the 
Product.

When you select Disassociate from Product, the Producer Portal will display a list of all the Products with which 
this File is associated. Click the Remove check box for all the Products from which you want this File 
disassociated and then click the Disassociate button at the bottom of the form.

Associate Where
In some cases, you do not want to explicitly select the Products to which you want this File associated. As an 
alternative you can tell the Producer Portal to use this File wherever some other File is already being used. That is, 
associate this File with all the Products with which another File is associated. 

When you click on Use Where, you will be presented with a File Search screen. You can use the "*" wildcard to 
search for and select the File(s) which will serve as the template for associating this File with Products. 

Note • The Use Where function will update all Products which contain the template File.

 Reidentify (ReID) File
Use the Reidentify form to change the File ID.

If for some reason you need to change the File ID of a file that already exists in the the Producer Portal system, 
you can do so by selecting ReID once you have selected a file. The Reidentify form prompts you for a new File ID 
or you can choose to leave it blank.

Notify
The Notify function allows you to provide email text which will be sent to all users who have an entitlement to a 
product(s) which includes this File. You will provide the subject line and the text of the email message. Email 
messages are queued by the Producer Portal and processed by the Revenera Operations Team. 

You may also use this form to send any special email handling instructions to the Revenera Operations team.

View Emails
Select View Emails to display all Update Notification emails related to the File. 

Click on an individual System Email ID to view a particular email message. If no Emails exist for the File, the 
system will display a status message to that effect.
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Configure
The Configure menu selection on the Package Products tab allows you to manage Product Lines, Manufacturers, 
License Groups and Agreements. The following sections describe the Configure area of the Package Products 
section of the Producer Portal.

• Product Lines

• Manufacturers

• License Groups

• Agreements

• Licensing

Product Lines
The following sections describe how to manage Product Lines:

• List Product Lines

• Add Product Line

• View Product Line

• Edit Product Line

List Product Lines
When you select Product Lines on the CONFIGURE menu, the Producer Portal displays a list of all the Product 
Lines your company has configured. 

Click on the Product Line name to view the Product Line information, and if necessary, modify it.

Add Product Line
When you select Product Lines from the CONFIGURE menu, you also have the option of adding a new Product Line 
by clicking on Add Product Line. You will be prompted to enter a unique Product Line ID, a Product Line Name, 
and a Description of the features of the Product Line. The description of the features will be displayed on the 
Product page of the FlexNet Producer Portal site.

Catalog Items and Products are both associated with Product Lines which are used as part of the navigation on 
the FlexNet Producer Portal site.

View Product Line
The View Product Line screen is accessed from the List Product Lines screen. It displays the current values for 
the particular Product's attributes.
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Edit Product Line
Once you have selected a Product Line, you can click on Edit to make changes to the Product's attributes.

Manufacturers
The following sections describe how to manage Manufacturers:

• List Manufacturers

• Add Manufacturer

• View Manufacturer

• Edit Manufacturer

List Manufacturers
Manufacturer is the highest level of organization of products within your FlexNet Producer Portal site. 

Many companies only use a single Manufacturer, though others use the Manufacturer attribute to distinguish 
between different product groups or families. 

When you select Manufacturers on the CONFIGURE menu, the Producer Portal displays a list of all the 
Manufacturers your company has configured. Click on the Manufacturer name to view the Manufacturer 
information, and if necessary, modify it.

Add Manufacturer
When you select "Manufacturer" from the CONFIGURE menu you also have the option of adding a new 
Manufacturer by clicking on Add Manufacturer. 

You will be prompted to enter a unique Manufacturer ID, a Manufacturer Name. If a user of your FlexNet Producer 
Portal site is entitled to products from more than one Manufacturer then the list of Manufacturer Names will be 
the first level of navigation on the site.

View Manufacturer
The View Manufacturer screen is accessed from the Manufacturers screen. It displays the current values for the 
particular Manufacturer's attributes.

Edit Manufacturer
Once you have selected a Manufacturer, you can click on Edit to make changes to the Manufacturer's attributes.

License Groups
The following sections describe how to manage License Groups:

• List License Groups
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• Add License Group

• View License Group

• Edit License Group

List License Groups
License Groups (also called Serial Pools) identify the blocks of license or serial numbers that will be assigned to a 
particular set of products.

There are two basic ways that FlexNet Producer Portal handles license keys: 

• You supply the license information when you create the entitlement, or 

• FlexNet Producer Portal generates a license either using an algorithm that your company has provided or by 
pulling licenses from a pool which you have provided.

In either case, you need to create a License Group and associate it with Catalog Items which require license keys. 
In the case that FlexNet Producer Portal is generating the license, your company also needs to provide additional 
information to Revenera. If this hasn't already been done, please contact your Client Relations Manager to begin 
the process.

You can click on the System License Group ID to view and edit the License Group Name.

Add License Group
When you select License Group from the CONFIGURE menu, you also have the option of adding a new License 
Group by clicking on Add License Group. You will be prompted to enter a License Group Name which will appear 
in the drop down box on the screens where you maintain Catalog Items. 

Once you have added a License Group, you can begin using it to identify license keys which you supply through 
the Entitle Account form. If you want FlexNet Producer Portal to automatically generate license keys for you, then 
you must set this up through your Client Relations Manager before FlexNet Producer Portal can begin issuing 
licenses.

View License Group
The View License Group screen is accessed from the List License Groups screen. It displays the current values for 
the particular License Group's attributes.

Edit License Group
Once you have selected a License Group, you can click on Edit to make changes to the License Group's attributes.

Agreements
The following sections describe how to manage Agreements:

• List Agreements
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• Add Agreement

• View Agreement

• Edit Agreement

List Agreements
Agreements are most commonly used as End User License Agreements (EULA's) also known as “click-wrap” or 
“click-through” agreements.

You can click on the Agreement Name to view and edit the Agreement Name or the Agreement Text.

Add Agreement
When you select Agreement from the CONFIGURE menu, you also have the option of adding a new Agreement by 
clicking on Add Agreement. 

You will be prompted to enter an Agreement Name which will appear in the drop down box on the screens where 
you maintain products. You will also enter text which will be displayed to the end user the first time he selects 
each product which is associated with this agreement.

View Agreement
The View Agreement screen is accessed from the List Agreements screen. It displays the current values for the 
particular Agreement's attributes.

Edit Agreement
Once you have selected an Agreement you can click on Edit to make changes to the Agreement's attributes.

Licensing
The following sections describe how to manage Licensing:

• String Replacement for FlexNet Embedded Licensing

• String Replacement for FlexNet Publisher Licensing

String Replacement for FlexNet Embedded Licensing
Detailed instructions follow this quick reference for the model.
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Data Model
The following table is a quick reference for the model.

Table 6-7 • Data Model

Item Subitems

account (both types) • iid (number)

• id

• name

• udfs (hash)

partner (both types) • name

manufacturer (order line type) • name

productLine (order line type) • name

orderLine (order line type) • order

• iid (number)

• id

• orderDate (date)

• poNumber

• udfs (hash)

• catalogItem

• iid (number)

• id

• name

• udfs (hash)

• quantity (number)

• effectiveDate (date)

• expirationDate (date)

• activationCode

• udfs (hash)



Chapter 6 Product Management
Packaging Products

FlexNet Operations LLM Producer Portal User Guide FNOLLM-PPUG02  189

The iid property is the internal (System) ID of the owning entity.

FlexNet Embedded License model string replacement uses FreeMarker with the above data model and the value 
from the license model as the template. The full FreeMarker manual is a useful reference, but some examples 
and a quick guide will be provided here.

Examples
• Licensed to ${account.name}

• minutes=${orderLine.udfs["MINUTES"]}

• ${device.model.series.name}

• ${fulfillmentDate?date?string.short}

• ${account.udfs["TIER"]!"Basic"}

General Comments
Not all parts of the data model are available for all license models. For example, ${device} will be missing in an 
order line license model, and ${orderLine} will be missing in a device license model. Remember also that if a 
device is unassigned, then ${account} will be null when trying to generate the base license for that device.

UDFs are accessed through a hash property of the object on which the UDF is set. The key to the hash is the UDF 
code. Some of the above examples demonstrate usage.

As you may guess from the examples, FreeMarker interpolation is triggered by ${} enclosing an expresssion. 
Expressions use dotted path notation to navigate a data model.

It is an error to call for something that is missing. (Null and unset are both interpreted as missing.) That error will 
cause a failure to generate the license. However, FreeMarker gives control over this behavior. If you want to 
proceed without error when a value is missing then you can use ! as in the last example. The FreeMarker manual 
gives details.

device (device type) • alias

• model

• name

• description

• series

— name
— description

fulfillmentDate (datetime) (both types)

mappedQuantity (number) (order line type)

Table 6-7 • Data Model

Item Subitems
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Dates, times, and numbers use default formatting, but the templating system gives control over the format. Note 
that a date does not have a time. This is different from a timestamp, which has a date and a time. Values which 
are dates, times, or numbers are called out in the data model reference above. Although formatting is highly 
configurable, the most common use cases will probably be served by the built-in date formats.

String Replacement for FlexNet Publisher Licensing
FlexNet Publisher allows for String Replacement to enable dynamic content into your licenses. This dynamic 
content is allowed both on the License Template and the License Variation, wherever you see "Fixed Value (with 
string replacement)". The tags below can be used to insert dynamic content.

Table 6-8 • List of Tags

Tag Content

[[PARTNER_NM]] Your Company Name

[[ACCOUNT_ID]] Account ID

[[ITRA_ACCOUNT_ID]] System Account ID

[[ACCOUNT_NM]] Account Name

[[ACCOUNT_UDF code='the code of the UDF']] The value of the Account UDF, Single quotes!!

[[ORDER_ID]] Entitlement ID

[[ITRA_ORDER_ID]] System Entitlement ID

[[PO_NUM]] PO Number

[[ORD_UDF code='the code of the UDF']] The value of the Order UDF, Single quotes!!

[[ENTL_DUR]] Difference (in number of days) between the orderline 
expiration date and effective date

[[ORD_LN_UDF code='the code of the UDF']] The value of the Order Line UDF, Single quotes!!

[[ACTIVATION_CODE]] (FNP Trusted Storage only) The activation code of the 
Order Line

[[CAT_DSCR]] Catalog Item Description

[[CAT_ID]] Catalog Item ID

[[CAT_UDF code='the code of the UDF']] The value of the Catalog Item UDF, Single quotes!!

[[PROD_DSCR]] Product Name

[[PROD_VER]] Product Version
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Product Management Support
This section includes the following to provide more insight on product management support:

• Temporary Catalog Items

• Treatment of Export Classification Control Numbers (ECCNs)

• Revenera Export Compliance Overview

• Deliver to Account

• Product Set Up and Management

• Load File Options

[[PRODUCT_UDF code='the code of the UDF']] The value of the Product UDF, Single quotes!!

[[USER_FIRST_NM]] First Name of the user generating the license

[[USER_LAST_NM]] Last Name of the user generating the license

[[USER_EMAIL]] Email Address of the user generating the license

[[LIC_QTY]] Quantity of the License

[[SERIAL_NUM]] Serial Number as generated by the application

[[HOST_ID]] Host ID

[[HOST_NM]] Host Name

[[HOST_DSCR]] Host Description

[[HOST_TYPE_PREFIX]] Prefix of the host id (like "INTERNET")

[[YYYYMMDDHHMMSS]]/[[YYYYMMDD]] Date or Date Time Stamp of license generation

[[PARAM code='code']] (FNP Trusted Storage only) Typical use is to capture 
information that came through in the VendorDictionary 
during an activation call. The code needs to exactly 
match the key in the VendorDictionary (case sensitive). 

Single quotes!!Example 
VENDOR_STRING="Longitude=[[PARAM code='Longitude']]"

[[LIC_DEF_NM]] License Definition Name

Table 6-8 • List of Tags

Tag Content
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Temporary Catalog Items
To better support trial downloads, you can create temporary Catalog Items that become unavailable when the 
associated entitlement expires. If you have any questions, please contact your Revenera Account Manager or 
Project Manager. 

By default, FlexNet Operations LLM makes all product software historically available to an end-user. In other 
words, a user will always be able to access older versions of their software, regardless of the expiration status of 
the software maintenance contract. If you want to modify this behavior, for example for a trial download, you can 
mark Catalog Items as “temporary.” Once an entitlement to a temporary Catalog Item expires, the associated 
products and files are no longer available to the users on that entitlement. 

Considerations for Using Temporary Catalog Items 
If you would like to use Temporary Catalog Items, please consider the following:

• You can set the Catalog Item Temporary indicator through FlexNet Operations LLM Producer Portal or via the 
XML / Web Services APIs.

• The Catalog Item Subscription indicator should be set to Yes. The temporary indicator has no meaning for 
non-subscription Catalog Items, because they never expire.

• You must provide the default duration for temporary Catalog Items.

• If no expiration date is provided on an entitlement for a temporary Catalog Item, the system determines the 
expiration date based on the default duration of the temporary Catalog Item.

• Once the expiration date is reached, FlexNet Operations LLM removes access to the temporary Catalog Item 
from end users’ accounts.

• To re-enable access to the Catalog Item, you can: 

• Extend the duration of the entitlement by changing the expiration date.

OR

• Submit a new entitlement to the same Catalog Item.

If you have any questions, please feel free to contact your Revenera Account Manager or Project Manager for 
assistance.

Treatment of Export Classification Control Numbers 
(ECCNs)

Important • The functionality of the Software Delivery software is to play a part of your export compliance 
programs but is not the sole methodology to be used for your export compliance program for your go to market 
solutions. You should review your export compliance program further with your export legal counsel.
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The following table displays the valid ECCN, License Exception, and Commodity Classification Automated 
Tracking System (CCATS) code combinations to comply with the Bureau of Industry and Security's (BIS) export 
rules.

Table 6-9 • ECCN Treatment

ECCN License Exception CCATS Export Rules

Unknown NO exports. Delivery to United States 
addresses only.

EAR99 NLR Self-Classified or 
Gxxxxxx

Exportable to all but the embargoed/
terrorist countries (Cuba, Iran, North Korea, 
Sudan, Syria, Crimea region of Ukraine)

3D002 TSR Self-Classified or 
Gxxxxxx

Exportable with a written letter of 
assurance to Country Group B. 

All other destinations require an export 
license.

3D991 NLR Self-Classified or 
Gxxxxxx

Exportable to all but the embargoed/
terrorist countries (Cuba, Iran, North Korea, 
Sudan, Syria, Crimea region of Ukraine)

4D993 NLR (General Rule) Self-Classified or 
Gxxxxxx

Special rules for China, Russia, and 
Venezuela: An export license is required if:

• The software is “program” proof and 
validation “software”, “software” 
allowing the automatic generation of 
“source codes”, and operating system 
“software” that are specially designed 
for real time processing equipment, 
AND

• You know the software is intended is 
intended, entirely or in part, for a 
'military end use' in the People's 
Republic of China or for a “military end 
use” or “military end user” in Russia or 
Venezuela.

Otherwise: Exportable to all but the 
embargoed/terrorist countries (Cuba, Iran, 
North Korea, Sudan, Syria, Crimea region of 
Ukraine).
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4D994 NLR (General Rule) Self- Classified or 
Gxxxxxx

Special rules for China, Russia, and 
Venezuela: An export license is required if:

• The software is specially designed or 
modified for the “development”, 
“production”, or “use” of equipment 
controlled by 4A101, AND.

• You know the software is intended is 
intended, entirely or in part, for a 
“military end use” in the People's 
Republic of China or for a “military end 
use” or “military end user” in Russia or 
Venezuela.

Otherwise: Exportable to all but the 
embargoed/terrorist countries (Cuba, Iran, 
North Korea, Sudan, Syria, Crimea region of 
Ukraine). 

5D001 CIV Self-Classified or 
Gxxxxxx

Eligible for export to Country Group D:1 
using License Exception CIV.

Not eligible for CIV (an export license is 
required) if the software is classified under 
ECCN 5D001.a and is “specially designed” 
for the “development” or “production” of 
items controlled by 5A001.b.5 and 
5A001.h.

 5D001 TSR Self-Classified or 
Gxxxxxx

Exportable with a written letter of 
assurance to Country Group B. All other 
destinations require an export license.

Not eligible for TSR if the software is 
controlled under ECCN 5D001.a and is 
“specially designed” for items controlled 
by 5A001.b.5 and 5A001.h.

Table 6-9 • ECCN Treatment

ECCN License Exception CCATS Export Rules
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5D991 NLR (General Rule) Self- Classified or 
Gxxxxxx

Special rules for China, Russia, and 
Venezuela: An export license is required if:

• The software is specially designed or 
modified for the “development”, 
“production”, or “use” of equipment 
controlled by 5A991.a., 5A991.b.7., 
and 5A991.f., or of “software” 
specially designed or modified for the 
“development”, “production”, or “use” 
of equipment controlled by 5A991.a., 
5A991.b.7., and 5A991.f. AND

• You know the software is intended is 
intended, entirely or in part, for a  
“military end use” in the People's 
Republic of China or for a “military end 
use” or “military end user” in Russia or 
Venezuela.

Otherwise: Exportable to all but the 
embargoed/terrorist countries (Cuba, Iran, 
North Korea, Sudan, Syria, Crimea region of 
Ukraine)

5D002 ENC / 740.17(b)(1) Self- Classified or 
Gxxxxxx

Exportable to all but the embargoed/
terrorist countries (Cuba, Iran, North Korea, 
Sudan, Syria, Crimea region of Ukraine).

5D002 [binary/
object code]

ENC / 740.17(b)(2) Gxxxxxx Exportable to:

• Non-Government End-Users in all 
countries.

• Government End-Users in Supp3 
Countries.

• If classified in accordance with 
Section 740.17(b)(2)(i)(A), the 
software is also exportable to “Less 
Sensitive” Government End Users in all 
countries except embargoed/terrorist 
countries.

Table 6-9 • ECCN Treatment

ECCN License Exception CCATS Export Rules
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Note • In the Producer Portal you can restrict downloads to the US and Canada by setting the “Restrict to US/
CANADA (NLR)” option to “Yes”.

Terms Used in ECCN Treatment
Refer the following terms while using the above table: 

5D002 [Source 
code]

ENC / 740.17(b)(2) Gxxxxxx Exportable to:

• Non-Government End-Users in all 
countries.

• Government End-Users in Supp3 
Countries.

5D002 ENC / 740.17(b)(3) Gxxxxxx Exportable to all but the embargoed/
terrorist countries (Cuba, Iran, North Korea, 
Sudan, Syria, Crimea region of Ukraine).

5D002 Publicly 
Available Source 
Code

TSU Notification 
Submitted to 
Commerce

Exportable to all but the embargoed/
terrorist countries (Cuba, Iran, North Korea, 
Sudan, Syria, Crimea region of Ukraine).

5D002 TMP [BETA under 
740.9(c)]

Exportable to all but Iran, North Korea, 
Sudan, Syria, and the Crimea region of 
Ukraine.

5D992.c NLR Self-Classified or 
Gxxxxxx

Exportable to all but the embargoed/
terrorist countries (Cuba, Iran, North Korea, 
Sudan, Syria, Crimea region of Ukraine).

Table 6-10 • Terms Used in ECCN Treatment

Term Description

Military End-Use The term “military end use" means: incorporation into a military item described on the U.S. Munitions List 
(USML) (22 CFR part 121, International Traffic in Arms Regulations); incorporation into a military item 
described on the Wassenaar Arrangement Munitions List (as set out on the Wassenaar Arrangement Web 
site at http://www.wassenaar.org); incorporation into items classified under ECCNs ending in “A018” or 
under “600 series” ECCNs; or for the “use,” “development,” or “production” of military items described 
on the USML or the Wassenaar Arrangement Munitions List, or items classified under ECCNs ending in 
“A018” or under “600 series” ECCNs. “Military end use” also means deployment of items classified 
under ECCN 9A991 as set forth in Supplement No. 2 to Part 744.

Table 6-9 • ECCN Treatment

ECCN License Exception CCATS Export Rules

http://www.wassenaar.org
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Military End-User The term “military end user” means the national armed services (army, navy, marine, air force, or coast 
guard), as well as the national guard and national police, government intelligence or reconnaissance 
organizations, or any person or entity whose actions or functions are intended to support “military end 
uses”.

Country Group B Afghanistan; Albania; Algeria; Andorra; Angola; Antigua and Barbuda; Argentina; Aruba; Australia; 
Austria; The Bahamas; Bahrain; Bangladesh; Barbados; Belgium; Belize; Benin; Bhutan; Bolivia; Bosnia & 
Herzegovina; Botswana; Brazil; Brunei; Bulgaria; Burkina Faso; Burundi; Cameroon; Canada; Cape Verde; 
Central African Republic; Chad; Chile Colombia; Comoros; Congo (Democratic Republic of the); Congo 
(Republic of the); Costa Rica; Cote d'Ivoire; Croatia; Curaçao; Cyprus; Czech Republic; Denmark; Djibouti; 
Dominica; Dominican Republic; Ecuador; Egypt; El Salvador; Equatorial Guinea; Eritrea; Estonia; Ethiopia; 
Fiji; Finland; France; Gabon; Gambia, The; Germany; Ghana; Greece; Grenada; Guatemala; Guinea; Guinea-
Bissau; Guyana; Haiti; Honduras; Hong Kong; Hungary; Iceland; India; Indonesia; Ireland; Israel; Italy; 
Jamaica; Japan; Jordan; Kenya; Kiribati; Kosovo; Kuwait; Latvia; Lebanon; Lesotho; Liberia; Lithuania; 
Luxembourg; Macedonia, The Former Yugoslav Republic of; Madagascar; Malawi; Malaysia; Maldives; 
Mali; Malta; Marshall Islands; Mauritania; Mauritius; Mexico; Micronesia, Federated States of; Monaco; 
Montenegro; Morocco; Mozambique; Namibia; Nauru; Nepal; Netherlands; New Zealand; Nicaragua; 
Niger; Nigeria; Norway; Oman; Pakistan; Palau; Panama; Papua New Guinea; Paraguay; Peru; Philippines; 
Poland; Portugal; Qatar; Romania; Rwanda; Saint Kitts & Nevis; Saint Lucia; Saint Vincent and the 
Grenadines; Samoa; San Marino; Sao Tome & Principe; Saudi Arabia; Senegal; Serbia; Seychelles; Sierra 
Leone; Singapore; Sint Maarten (the Dutch two-fifths of the island of Saint Martin); Slovakia; Slovenia; 
Solomon Islands; Somalia; South Africa; South Korea; South Sudan, (Republic of); Spain; Sri Lanka; 
Surinam; Swaziland; Sweden; Switzerland; Taiwan; Tanzania; Thailand; Timor-Leste; Togo; Tonga; 
Trinidad & Tobago; Tunisia; Turkey; Tuvalu; Uganda; United Arab Emirates; United Kingdom; United 
States; Uruguay; Vanuatu; Vatican City; Venezuela; Western Sahara; Yemen; Zambia; and Zimbabwe.

License Exception 
TSR

Written Letter of Assurance Required (see Section 740.6 of the EAR), then exports authorized to Country 
Group B.

License Exception 
CIV

Only available for civil end-users for civil end-uses. An export license is required if you know the software 
will be or is intended to be exported, reexported, or transferred (in-country) to military uses or military 
end-users.

Country Group D:1 Armenia, Azerbaijan, Belarus, Burma, Cambodia, China (PRC), Georgia, Iraq, Kazakhstan, Kyrgyzstan, 
Laos, Libya, Macau, Moldova, North Korea, Russia, Tajikistan, Turkmenistan, Ukraine, Uzbekistan, 
Vietnam.

Table 6-10 • Terms Used in ECCN Treatment

Term Description
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Government End-
Users

A government end user is any foreign central, regional or local government department, agency, or other 
entity performing governmental functions; including governmental research institutions, governmental 
corporations or their separate business units (as defined in part 772 of the EAR) which are engaged in 
the manufacture or distribution of items or services controlled on the Wassenaar Munitions List, and 
international governmental organizations. This term does not include: Utilities (including 
telecommunications companies and Internet service providers); banks and financial institutions; 
transportation; broadcast or entertainment; educational organizations (except public schools and 
universities); civil health and medical organizations (including public civilian hospitals); retail or 
wholesale firms; and manufacturing or industrial entities not engaged in the manufacture or distribution 
of items or services controlled on the Wassenaar Munitions List.

Supp3 Countries The countries listed in Supplement No. 3 to 15 CFR part 740, currently: Austria, Australia, Belgium, 
Bulgaria, Canada, Croatia, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, 
Hungary, Iceland, Ireland, Italy, Japan, Latvia, Lithuania, Luxembourg, Malta, Netherlands, New Zealand, 
Norway, Poland, Portugal, Romania, Slovakia, Slovenia, Spain, Sweden, Switzerland, Turkey and United 
Kingdom.

Table 6-10 • Terms Used in ECCN Treatment

Term Description
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“Less Sensitive” 
Government End 
Users

The following are considered “less sensitive” government end-users:

• Local/state/provincial “government end users” (departments, agencies and entities), including 
local/state/provincial executive, legislative, judicial, police, fire, rescue and public safety agencies.

• National/federal/royal “government end users” (departments, agencies and entities) providing the 
following civil government functions and services:

• Census and statistics services;

• Civil public works infrastructure services (construction, maintenance, repair, regulation and 
administration) as follows: Buildings, public transportation, roads and highways, trucking;

• Civil service administration and regulation, including human resources and personnel/labor 
management;

• Clean water infrastructure services (treatment, supply and testing);

• Economic (trade/commerce/investment), business and industrial development, promotion, 
regulation and administration, excluding the Agencies, departments, boards and councils for 
science and technology; Research, development and national laboratories (other than as 
specified measurements and standards services) and meteorology/weather/atmospheric 
services) of this definition (below); National telecommunications and information technology 
agencies, boards, councils and development authorities (including national information center, 
and Information Communications Technology (ICT)/telecommunications infrastructure/
spectrum planning, policy, regulation and testing);

• Elections, balloting and polling services;

• Energy regulation and administration, including oil, gas and mining sectors;

• Environmental/natural resources regulation, administration and protection, including wildlife, 
fisheries and national parks;

• Food/agriculture regulation and administration;

• Labor/community/social services planning, regulation and administration, including: housing 
and urban development, municipality and rural affairs;

• Measurements and standards services;

• Meteorology (weather, atmospheric) services;

• National archives/museums;

• Patents;

• Pilgrimage and religious affairs;

• Postal services;

• Public and higher education (excluding government research institutions and any agency, 
institution or affiliate engaged in the manufacture or distribution of items or services controlled 
on the Wassenaar Munitions List);

• Public health and medicine/pharmaceutical regulation and administration;

• Public libraries;

• Sports/culture (includes film, commercial broadcasting and the arts) promotion, regulation and 
administration;

• Travel/tourism promotion, regulation and administration.

Table 6-10 • Terms Used in ECCN Treatment

Term Description
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Revenera Export Compliance Overview

Important • The functionality of the Software Delivery software is to play a part of your export compliance 
programs but is not the sole methodology to be used for your export compliance program for your go to market 
solutions. You should review your export compliance program further with your export legal counsel.

Revenera exports third party software products as well as its own software products. Deliveries of software 
outside the United States are subject to the Export Administration Regulations, which are administered by the 
Department of Commerce Bureau of Industry and Security. In addition to the embargoed/terrorist countries and 
regions (currently Cuba, Iran, North Korea, Sudan, Syria, and the Crimea region), to which no products may be 
sold or delivered, a number of United States government agencies maintain lists of individuals and entities to 
which we are barred from selling or delivering software. We are prohibited from delivering to parties appearing 
on these lists, whether we are delivering from or to the United States or from or to another country.

To keep track of these constantly changing lists, Revenera uses a service called MK Denial (mkdenial.com). The 
MK Denial list contains all entity names of individuals who are restricted by various government agencies from 
obtaining exports. This list is checked regardless of the country.

Revenera’s FlexNet Operations Cloud service distinguishes and acts on the different BIS-approved processes, 
depending on the product classification of a particular software product.

Revenera checks the following data for any individual who initiates a download using the FlexNet Operations 
Cloud service:

• Member name on MK Denial list.

•  Member email address domain – check for country of origin/government.

• Member profile address – check for country of origin/government.

• Account name on MK Denial list.

• IP Address lookup through the third party look up service, ip2location.

• Domain from DNS lookup for IP Address (only used if check number 3 fails).

If any of these checks fail (the export is not allowed), access is denied. When a compliance check fails, an email 
is automatically generated and sent to an internal email alias and is optionally forwarded directly to a customer 
designated email address. Revenera then works with our customers to provide the relevant information about the 
denial.

Deliver to Account
The Deliver to Account feature can be used to either restrict or allow access of Files or Products to designated 
Accounts. This can be used when you want to distribute Files or Products with custom code or hot fixes to 
specific Accounts and do not want to change your product hierarchy. If you have any questions, please feel free 
to contact your Revenera Software Account Manager or Project Manager for assistance.
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FlexNet Operations LLM Producer Portal users with the Product Management or Deliver to Account permission 
can restrict or grant File or Product access to designated Accounts. To do so, the File or Product must be 
associated to a Catalog Item that the Account is entitled to. The Deliver Product to Account feature does not take 
the place of entitlements in general; it simplifies the process and eliminates the need to set up a separate 
Catalog/Product/File for a one-off delivery of custom code or a hot fix/patch.

The following steps are recommended in using the Deliver to Account feature:

1. Load the File using FlexNet Operations LLM Producer Portal or the XML API

2. Restrict Deny or Restrict Allow access of the File or Product to the appropriate Accounts

3. Associate the File to the Product and Product to Catalog Item

4. Generate notification email (if desired)

You should follow these steps in the order listed above to ensure that access is not granted to everyone for the 
period of time that it takes to you complete the restriction.

The examples that follow illustrate how to use Deliver to Account to restrict or allow access for a Product and File 
to designated Accounts from FlexNet Operations LLM Producer Portal.

• Deliver Product to Account

• Deliver File to Account

Deliver Product to Account
To deliver a product to an account, perform the following steps.

Task To deliver a product to an account:

1. From the View Product screen in the Producer Portal, select the Restrict option from the Edit menu to access 
the Restrict Product page as highlighted by the red arrow below:

The Restrict Product page enables you to search for Account ID, Intraware Account ID, and Account Name. 

2. Once you obtain your search results, select either Restrict Allow or Restrict Deny next to the Account to 
which you would like to change access for. The following shows the search results on the Restrict Product 
page:
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If you select the Restrict Deny, you will see the following screen:

All accounts that are entitled to this Product will have access to it except for the accounts you choose to the 
Restrict Deny access. 

If you select the Restrict Allow, you will see the following screen:
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Only the Account chosen above will have access to this product. All other Accounts that previously had 
access to this Product will have access removed if you choose to the Restrict Allow access*** 

The Restricted Product flag on the View Products page is now “Yes.” 

The Restrict Product pages shown above also allow you to remove previously selected Accounts.

Deliver File to Account
To deliver a file to an account, perform the following steps.
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Task To deliver a file to an account:

1. Once you have loaded the File, from the View File screen in the Producer Portal, select the Restrict option 
from the Edit menu to access the Restrict File page as highlighted by the red arrow below:

The Restrict File page enables you to search for Account ID, Intraware Account ID, and Account Name. 

2. Once you obtain your search results, select either Restrict Allow or Restrict Deny next to the Account to 
which you would like to change file access for. 

• If you chose Restrict Allow, the Account(s) that you selected will now have access to the File, and the 
File is restricted to only those Account(s) in the list. 

• If you chose Restrict Deny, the Account(s) that you selected will not have access to the file. Please note 
that the Restricted File flag is now Yes. 

The Restrict File page also allows you to remove previously selected Accounts. 

Note • Make sure to associate the File to a Product that is associated to a Catalog item for which the Account(s) 
selected have an entitlement. For example, if it is a hot fix for Product A, Version 1.0, which is delivered via an 
entitlement to Catalog Item Product A, you need to associate the file to Product A, Version 1.0 and ensure that the 
selected Account(s) have an entitlement to Product A.) 

If you have any questions, please feel free to contact your Revenera Account Manager or Project Manager for 
assistance. 

Product Set Up and Management
The Revenera FlexNet Operations LLM service offers considerable flexibility in how to set up product hierarchy. 
This document:

• Describes typical options for product hierarchy

• Recommends methods to optimize the planning and set up of products.

• Defines the best practice for processing transactions, and describes the required process flow for 
transactions by type (web form, web services, or XML). These processes apply to both initial product set up 
and updates in FlexNet Operations LLM Producer Portal.
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This section describes general product management concepts and definitions. The following are the key factors 
to consider when you determine the appropriate management of your products:

• Product Set Up Concepts

• Date Management

• Display Management and Product Hierarchy

• Recommendations for Creating a Product Hierarchy

• Steps in the Set Up and Management of Products

Product Set Up Concepts
FlexNet Operations LLM uses four primary objects to control the delivery of digital goods:

Date Management
There are two basic ways that a user gets access to the manufacturer’s product: 

• Through a new entitlement to a catalog item which has one or more products associated with it, or 

Table 6-11 • Primary Objects to Control Delivery of Digital Goods

Object Description

Entitlements (orders) • Use entitlements to grant customers access to software.

• Entitlements contain data that specify elements of the order, such as 
account, quantity, effective date, etc.

• Entitlements reference catalog items.

Catalog items (price list items) • What a manufacturer sells, for example, a product or a maintenance 
agreement.

• Have attributes such as default duration, whether the catalog item 
includes updates (maintenance).

• Catalog items reference one or more products.

Products (product releases) • What the manufacturer wants delivered, for example, a specific version 
of a product.

• Have attributes such as export licenses, version number, platform, or 
archive dates.

• Products reference one or more files.

Files (images) • Actual software files that the end user downloads, for example, the 
installation executable for a particular platform.

• A file may be associated to one or more products.

• Access to a file may be restricted by account.
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• Through a new product update to a subscription-based catalog item to which the user was previously 
entitled (see Figure 1 below.)

For subscription catalog items, which products the end user sees on their FlexNet Operations LLM site is 
determined by the effective dates defined for the product(s) and the effective period specified on the entitlement 
to the corresponding catalog item. The overlap between effective and expiration dates of the product and of the 
entitlement determines which product(s) the end user will have access to (see Data Management and its 
Relationship to Entitlements below.)

Typically, once the user has been given access to a product he will continue to have access indefinitely. However, 
the manufacturer may wish to limit the duration of access (temporary products, temporary catalog items), for 
example for evaluation software, or limit the number of downloads of one or more of the files (download-limited 
products.)

Figure 6-1: Data Management and its Relationship to Entitlements

To effectively set up the product hierarchy, you should understand the significance of dates on product items and 
entitlements. Date management is illustrated best by two model types, the non-subscription and subscription 
models.

• Non-Subscription Model

• Subscription Model
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Non-Subscription Model
Customer 1 has an entitlement to a catalog item for a specific version of a product, which does not grant future 
access to new product/bug fixes/patches automatically. The Subscription attribute on catalog item is set to No.

Subscription Model
For subscription catalog items, the products the end user sees on their FlexNet Operations LLM site are 
determined by the effective dates defined for the product(s) and the effective period specified on the entitlement 
to the corresponding catalog item. The Subscription attribute on catalog item is set to Yes. The products to which 
the end user has access are determined by the overlap between the effective and expiration dates of the product 
and the entitlement.

• Customer 2 has a three-year entitlement to a catalog item for the term 1/1/08-1/1/11. On 1/1/08, the 
customer has access to the current version of Product B version 6.0. On 1/1/09, version 6.1 becomes 
available and customer gains access to it. On 1/1/10, version 6.2 becomes available to the customer. The 
customer has access to all three versions because the product effective dates fall within the range of this 
customer’s entitlement period.

• Customer 3 has one year entitlement to a catalog item for the term 1/1/09-1/1/10. On 1/1/09, the customer 
has access to the current versions of Product B v6.0 and v6.1, because the Product effective dates fall within 
the range of this customer’s entitlement period.

• Customer 4 has one year entitlement to catalog item for the term 1/1/10-1/1/11. The duration of this 
customer’s entitlement allows access to Product B v6.0 and v6.2.

Generally, access remains indefinitely, unless you limit the duration of access by using the Temporary attribute on 
the catalog level. For example, you may want to limit access for evaluation software. You can also choose to limit 
the number of downloads of one or more of the files by using the Default Max Download Limit attribute on the 
catalog item. Access to a product is driven by the following:

• A new entitlement to a catalog item.

• A product update to a subscription catalog item.

• For subscription catalog items, access to software is determined by the overlap between:

• Effective dates of the product.

• Effective dates of the entitlement.

Display Management and Product Hierarchy 
For the purposes of end-user navigation, FlexNet Operations LLM supports a product hierarchy based on 
attributes associated with catalog items, products, and files. The following are the commonly used hierarchy:

• Manufacturer or product family

• Bundle or suite

• Product line

• Version

• Platform

• Language
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• Release number

• Optional product-specific end user license agreement the user must accept before reaching the download 
page.

• Component files (for example, documentation, executables, etc.).

These attributes are used to build a hierarchical site in which the user selects the file(s) he wants to download by 
choosing among the values at each level. For example, select the appropriate platform version.

Figure 6-2: Non-Subscription and Subscription Models Illustrating How a Product Hierarchy is Set Up for Each 
Model Type

Recommendations for Creating a Product Hierarchy
This section includes the following sub-sections for more insights:

• Products and Files

• Product Families, Bundles, Product Lines

• Catalog Items

• Summary Recommendations
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Products and Files 
The first decision in setting up a product hierarchy for FlexNet Operations LLM is to determine how granular the 
product level should be. For example, if your product is available on multiple platforms should those platform 
versions be different products in FlexNet Operations LLM, or should they simply be different executable files 
associated with the same product? As a general rule, if you want to use an attribute to be able to sell a product 
differently (or control access to it) then it must be represented at the product level.

Because product releases (versions) are generally date-related, and because effective and expiration dates are 
key attributes of a product, Revenera strongly recommends that different releases be set up as different 
products.

The files that are associated with a product should be organized to strike an optimal balance between providing 
the end user with the minimum number of downloads and keeping the download files as small as possible. 
Revenera recommends that all documentation be pulled together and made available as a single downloadable 
file (zipped or otherwise) since we have found that users frequently want to download just the documentation. 
Readme files may be kept separate to enable the end user to quickly access a high level overview of the software 
and its functionality prior to completing any product downloads. The base set of software should also be collated 
into a single file so that the user can successfully install the product without having to download multiple files. If 
platforms and languages are not treated as separate products then they should be packaged into different files 
to reduce the size of the file(s) that the user has to download in order to install the product on a particular system.

Product Families, Bundles, Product Lines
The purpose of product families, bundles, and product lines is to allow the manufacturer to create navigation 
which mirrors the sales and marketing descriptions and organization of your company’s product set. As a general 
guideline, you will want to set up your product hierarchy so that most users have between three and seven 
choices at each level. This approach reduces the number of “clicks” required to select a product but still keeps 
the FlexNet Operations LLM screens clear and readable.

Catalog Items
Generally you will create a catalog item for each item on your price list which has electronically deliverable 
components. You then associate one or more products with each catalog item.

The most common and most generally useful approach is to create subscription catalog items, which include 
ongoing product updates (maintenance). This type of catalog item is not version specific. It may include more 
than one product, each of which will be updated separately based on the effective and expiration dates of the 
product and the entitlement to the catalog item. It is not necessary to create a separate catalog item for the initial 
sale, which includes one year maintenance and the subsequent sale of maintenance agreements, since these 
catalog items will behave the same way. However, if you want to maintain a 1:1 mapping between your price list 
and the catalog items, you can create different catalog items with ID’s and names which correspond to your 
“initial sale” and “maintenance” price list items.

Under certain circumstances the manufacturer may also want to create catalog Items which specifically exclude 
updates (non-subscription catalog items), or make the associated products unavailable after the expiration date 
of the entitlement (temporary products), for example to deliver beta or evaluation versions.
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Summary Recommendations
Consider the following:

• Use as few levels of hierarchy as possible to reduce the number of “clicks”.

• Catalog items should not be version specific and should include updates.

• Major releases should be treated as separate products.

• Files should be bundled together to create single downloads for documentation and standard installations.

Steps in the Set Up and Management of Products
This section describes the best practices to set up each component. This recommended sequence of data 
transactions to complete catalog, product, and file data setup optimizes the process for data management.

There are four data transaction methods:

• FlexNet Operations LLM Producer Portal web forms for manual data entry

• XML data feed transactions for automated data entry

• Batch upload of XML-formatted file

• Web services

For example, you can convert .csv data templates into XML format with Revenera’s IXP Tool, and then upload the 
XML file through FlexNet Operations LLM Producer Portal.

Table 6-12 • Steps in the Set Up and Management of Products

Steps Task
FlexNet Operations On-Demand 
Producer Portal Web Form

XML Transaction/ Web 
Services API

Step 1 Add Manufacturer 

Standard feature, required field for 
catalog and product items (multiple 
manufacturers are uncommon).

Product Management > 
Configure > Manufacturers

Add Manufacturer

Step 2 Add Product Line(s) 

Standard feature, required field for 
catalog and product items.

Product Management > 
Configure > Product Lines

Add Product Line

Step 3 Add Agreement(s)

Standard feature, optional field for 
product Items. HTML formatting 
required.

Product Management > 
Configure > Agreements

Add Agreement (not 
available using web 
services)
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Step 4 Add License Group(s)

Standard feature. Optional field for 
catalog items. Allows transmission 
of license key with entitlement 
transaction data. The key will 
appear in the License Key tab on 
the End User Portal.

Product Management > 
Configure > License Groups

Add License Group

Add License to Pool (used 
if bulk loading licenses to 
a pool)

Step 5 Add Catalog Item

An entitlement to a catalog item will 
give the end user access to a single 
product or a suite of products in 
conjunction (overlap) with an active 
maintenance period. The status of 
catalog items (active or inactive) 
can be changed to reflect your 
current pricelist.

Product Management > Add 
Catalog Item

Add Catalog Item

Step 6 Add Product

One product can be associated to 
multiple catalog items. If you have a 
catalog item as a stand-alone 
license and a catalog suite that 
contains multiple stand-alone 
products, it is possible to create a 
single product to associate to both 
the stand-alone catalog item and 
catalog suite. When conducting an 
update, both the stand-alone and 
suite can receive the update at the 
same time if desired. (Refer to  
Optional Steps - Mass Updates)

Product Management > Add 
Product

Add Product

Step 7 Product Association 

(Product-to-Catalog association)

Product Management > View 
Product > Assoc > Associate to 
Catalog Item

Add Product to Catalog 
Item

Table 6-12 • Steps in the Set Up and Management of Products

Steps Task
FlexNet Operations On-Demand 
Producer Portal Web Form

XML Transaction/ Web 
Services API
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Step 8 Add File

One file can be associated to 
multiple products. If your binary 
packaging supports multiple 
platforms, we recommend loading 
a single file with a description to 
indicate cross platform support 
instead of loading the file binary ten 
times with ten descriptions. We 
recommend using maximum 
compression when creating file 
binaries to create the smallest file 
size possible.

Product Management > Add File Add File

Step 9 Upload File

Transfer the file binaries (CD 
images) to the ESD repository.

If you are using the FTP server to 
store files, the system scans for 
files older than 10 days (UAT and 
Production) and deletes them. The 
system does not verify the file was 
loaded into FlexNet Operations LLM 
Producer Portal before deleting it.

Product Management > Add File 
> Upload File

There are three methods: HTTPS, 
FTP (files must first be loaded to 
FTP staging server), High Speed 
Upload (requires installing 
browser plug-in; download by 
clicking high speed plug-in link).

Load File Image (not 
available as a web 
service)

Step 10 Optional - Restrict File 

Refer to Deliver to Account for 
details on how to use the Deliver to 
Accounts - Restricting a File 
functionality.

Product Management > View File 
> Edit > Restrict

Restrict File (not available 
as a web service)

Step 11 File Association 

(File-to-Product association)

Product Management > View File 
> Assoc > Restrict Associate to 
Products

Add File to Product

Step 12 Review / QA the Set Up View catalog item, click into the 
product Item, and click the file to 
confirm "loaded" status. Verify 
file-to- product and product-to -
catalog associations are 
accurate.

Table 6-12 • Steps in the Set Up and Management of Products

Steps Task
FlexNet Operations On-Demand 
Producer Portal Web Form

XML Transaction/ Web 
Services API
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Optional Steps - Mass Updates
This section describes how to use FlexNet Operations LLM Producer Portal to mass update existing catalog items 
with a new product Item. For example, you have five different catalog items and each contains the same Product 
Version 1. You have added Product Version 2 and want to make it available to anyone with access to Product 
Version 1. This shortcut method will allow you to mass associate a product across multiple catalog items.

Optional Steps - Update Email Notifications
This section describes how to notify existing members with active status and active entitlement that there is new 
product to download. Once you complete the step to update existing catalog items, Optional Steps - Mass 
Updates, you may use this method to send an update notification email. This method allows you to send an email 
to Members with an existing entitlement without having to process new entitlements for the new version of 
product.

Table 6-13 • Mass Updates

Update 
Subscriptions This function is available from FlexNet Operations LLM Producer Portal

Step 1 Associate Where

This function from the product menu allows 
you to add the new Product ID (in the example, 
the ID for the new version 2.0) to all catalog 
items containing an existing Product ID (the ID 
for version 1.0). This function is used to 
update multiple catalog items containing the 
same Product ID with a single transaction.

Product Management > Search Product > 
Associate / Disassociate submenu > 
Associate Where

Table 6-14 • Update Email Notifications

Update Email 
Notifications This function is available from FlexNet Operations LLM Producer Portal

Step 1 Create the email using search criteria to generate a distribution list:

1. From FlexNet Operations LLM Producer Portal, go to the Email tab.

2. Select Create Update Notification Email by Product.

3. In the field, Enter Product IDs of Products to Create a Notification, specify the Product 
ID(s) relevant to the content for the notification email. You may also use the search 
page on the lower half of the screen to find and select your products. Click Submit.

4. You can use the next display page to enter Distribution List Options for the email list 
you are about to generate: effective date of an entitlement, include expired 
entitlements, or exclude emails of a particular domain. Click Submit.

5. While the list is being generated by the system, you see the View Email display page.
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About URLs in the Update Notification Emails
The Update Notification email notifies users of specific product or file changes. By design, the URL in the email 
takes user to a landing page that displays only the specified product/file associations available at the point the 
email was generated. Therefore, all products/files must be set up completely prior to generating an Update 
Notification. If you associate a product/file to entitlements after generating an Update Notification email, the 
landing page URL from the email content will not display the product/file that was added later in the process. If a 
user navigates to the End User Portal without using URL links from an Update Notification email, the user will see 
the normal display for all product/file entitlements.

Summary
We have reviewed the components of data set up that are required to manage the concepts of date and display 
management. The defined data transaction types and sequence of events illustrated the required processes to 
manage data in FlexNet Operations LLM Producer Portal. You should follow these best practices to effectively 
create and manage a full product hierarchy for new entitlements and update subscriptions.

Step 2 Edit the content and distribution list, if necessary:

1. From the Email toolbar, select Edit Email to access the text/HTML fields, to enter/
update specific content to the Product release. (The template from Setup is the starting 
point for the standard/generic content.)

2. Once you create text/HTML content, select the appropriate Preview button from the 
bottom of the display page. Click Save when you are done formatting and entering 
content.

3. HIGHLY recommended: Send Preview Email to yourself.

4. If necessary, you may add/remove members from the distribution list. For example, you 
may want to CC yourself or an email alias at your company. Select Edit Distribution List 
from the Email toolbar

5. Add additional email addresses in the field provided, or check the delete box on an 
existing email address to remove, click Submit.

Step 3 Queue and Send the Email:

1. From the Email toolbar, select Send Email.

2. From the Send Email display page you have the option to Send Immediately (highly 
recommended) or Queue to be sent later in the day or on another day. Generally, you 
will send the email immediately after you are done editing the email. Click Submit.

3. FlexNet Operations LLM Producer Portal has a short period where the system validates 
email addresses before actually sending the email externally. If you return to the View 
Email display, you can see that the Status of the email is changed to Sent, to indicate 
that the email job is complete. This page does not automatically refresh; you may need 
to go to the Email toolbar and select View Email to refresh the display screen.

Table 6-14 • Update Email Notifications

Update Email 
Notifications This function is available from FlexNet Operations LLM Producer Portal
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Load File Options
If supported through your implementation, you can upload Files into the Producer Portal to be available for 
download. This document describes the different upload the assumption that the File metadata has already been 
added to the Producer Portal (AddFile).

Enabling User to Load Files
To allow a user to load files, a Producer Portal Administrator must first assign the Product Management (PDCT) or 
Deliver to Account (RSTF) permission to the appropriate Producer Portal users as shown below:

Figure 6-3: Product Management (PDCT) and Deliver to Account (RSTF) Permissions

Producer Portal users with appropriate permissions can upload files using one of the following methods:

• Upload File Page—The following tabs on the Upload File page can be used to load the individual files from 
the Producer Portal:

• HTTP

• FTP

• Remote FTP

• High Speed Upload
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• Upload Manager—Revenera client that will both Add File and Upload File with images from the Revenera 
upload server

• Converter Template—Spreadsheet to load a batch of UploadFile transactions

• Transactions—UploadFileImage with either XML or WebServices protocol

All fields described to upload a File are mandatory except the Expected MD5 Checksum. When the MD5 
Checksum is supplied the application will fail the transaction if the actual MD5 does not match.

The File Size, MD5 value and File Name are derived after a File has successfully been uploaded.

Note • Uploaded files cannot be downloaded until the Download Available? field in the View File page in the 
Producer Portal indicates yes.

The following provides more insight about the methods (mentioned above) to upload the files:

• Upload File Page

• Upload Manager

• Converter Template

• Transactions

Upload File Page
In the Producer Portal, locate the file you wish to upload and from the View File page, select Edit > Upload File.

Figure 6-4: Edit > Upload File Option

The Upload File page opens.
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Figure 6-5: Upload File Page

You can upload the individual files by using the following tabs on this page: 

• HTTP Upload

• FTP Upload

• Remote FTP Server

• High Speed Upload

HTTP Upload
File images residing at a location local to the end user’s machine can be loaded from the Producer Portal Upload 
File page via the browser. The following displays the HTTP Upload tab selected:

Figure 6-6: HTTP Upload Tab of Upload File Page
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FTP Upload
File images previously loaded the Revenera FTP upload server can be loaded from the Producer Portal Upload File 
page. The following displays the list of files in the Browse FTP box on the FTP Upload tab selected:

Figure 6-7: FTP Upload Tab of Upload File Page

The Revenera FTP upload servers mentioned below are temporary staging servers only and not intended for long 
term storage.

• Production—upload.flexnetoperations.com

• UAT—uploaduat.flexnetoperations.com

Credentials to access these upload servers would have been provided with your initial implementation. There is a 
cleanup script that will delete file images from these upload servers after they have been there for 30 days.

When Files are loaded into the Producer Portal using file images posted on the Revenera FTP upload server, they 
are automatically removed from the server after successfully loaded into the application.

Remote FTP Server
File images located on a remote non-Revenera FTP Server can be loaded from the Producer Portal Upload File 
page. The following displays the Remote FTP Server tab selected:
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Figure 6-8: Remote FTP Server Tab of Upload File Page

The application will pull the file from the remote FTP location specified. It requires that username and password 
information be supplied in the transaction to enable access to the Remote FTP server: 

ftp://[username]:[password]@[hostname]/[path and filename]

Only the FTP protocol is supported, not FTPS, HTTP or HTTPS.

If the FTP server allows for anonymous access, the username and password do not need to be supplied and If an 
FTP username and password are provided, they will be logged as an “*” to avoid exposing the credentials.

To address issues with special characters, you need to URLencode the components of the URL before placing 
them in the XML transaction.

High Speed Upload
File images residing at a location local to the end user’s machine can be loaded from the Producer Portal Upload 
File page via the browser using the Aspera plugin. The following displays the High Speed Upload tab selected:

Figure 6-9: High Speed Upload Tab of Upload File Page
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Upload Manager
The Upload Manager will allow you to load the file from the Revenera upload will result in adding File metadata 
along with loading of the File image.

Located in the Producer Portal > Package Products > Files > Upload Manager. The following displays the Upload 
Manager option selected:

Figure 6-10: Upload Manager

You will be prompted to login to the Revenera upload server:

Figure 6-11: Login to Upload Server

Once you’ve logged in, you can drop files from the server to the Add Files section of the Upload Manager. This will 
prompt you for File ID which will create a new File in the Producer Portal and include the File image. The following 
displays the Upload Manager: 
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Figure 6-12: Selecting Files Using Upload Manager

The following displays the File ID box:

Figure 6-13: File ID Dialog Box of Upload Manager

Converter Template
The Converter Template is located in the Producer Portal under Administer > Transactions > Converter Templates 
> Package Products Template. The following displays the Converter Template selected and Load File Image 
worksheet selected:
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Figure 6-14: Converter Template

The following displays the Load File Image worksheet selected:

Figure 6-15: Load File Image Worksheet

The Load File Image transaction will allow you to load the file from the Revenera upload server or remote FTP 
server:

• Include your File ID or IntrawareFileID (System File ID) for reference as the File metadata should already have 
been added to the application before you load the associated binary.

• FileID—The unique value by which your company identifies individual files. The File ID may come from a 
release management or source code control system. Cannot be used if IntrawareFileID is used.

• IntrawareFileID—The unique value by which Revenera identifies individual files. Cannot be used if 
FileID is used.
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• Retrieve From Location—This is the relative path to the file on the Revenera FT{ staging server. It should not 
begin with a forward slash (/) and is a Unix or URL style path (/ separates the directories).

• ExpectedCheckSum—The MD5 checksum for the file will always be a 32-digit hexadecimal value. If you 
calculate this before uploading to the ftp server and also pass it to the Producer Portal using this transaction, 
the Producer Portal can verify that the file was uploaded to the ftp server correctly.

• User Defined Fields (UDFs)—If your implementation includes any File level User Defined Fields (UDFs), these 
will also appear on the Converter Template when you accessed from the Producer Portal.

Transactions
If the File image is located on Revenera or Remote FTP servers, they can be loaded by submitting XML or 
WebServices transactions.

The following is sample XML:

<?xml version="1.0" encoding="UTF-8"?>
FlexNet Operations LLM Developer's Guide 66
<SnetTransactionsFile xmlns="http://www.intraware.com/schemas/2002/12/SnetTransactionsFile" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:schemaLocation="http://www.intraware.com/
schemas/2002/12/SnetTransactionsFile http://www.intraware.com/schemas/2002/12/
SnetTransactionsFile.xsd">
<LoadFileImage>
<File>
<FileID/>
<IntrawareFileID/>
</File>
<RetrieveFromLocation/>
<ExpectedCheckSum/>
</LoadFileImage>
</SnetTransactionsFile>

Additional information on transaction processing can be found in Entitlements.

Note • Please contact your Client Relations Manager, Project Manager or Support if you have any questions.
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Transactions

Every time you use FlexNet Operations LLM Producer Portal to make changes to the system, a transaction is 
created. You can use the Transactions section of FlexNet Operations LLM Producer Portal to view these 
transactions, and in the case of failed transactions to edit and resubmit them.

The Transactions section of FlexNet Operations LLM Producer Portal also lets you view and edit transactions 
which were submitted as XML documents either through the automated XML data feed or by uploading an XML 
file.

• Search Transactions

• Upload a Transaction File

• Converter Templates

• View Transactions

• Managing Failed Transactions

Search Transactions
In order to view or edit a transaction you must first find the one you want. You do this through the Search 
Transactions page, which is accessed directly from the Administer menu of FlexNet Operations LLM Producer 
Portal.
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Figure 7-1: Search Transactions Page

There are three ways to identify the transaction you are interested in:

• Enter the System Transaction ID

• Enter the System Batch ID

• Search

Enter the System Transaction ID
A System Transaction ID is created for every transaction, whether it is submitted via FlexNet Operations LLM 
Producer Portal, through the automated data feed, or via an uploaded XML file. If you know the System 
Transaction ID, you can enter it and then click Search by Transaction ID, and you can then begin working with the 
transaction.
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Enter the System Batch ID
FlexNet Operations assigns a unique System Batch ID to transactions submitted through the automated XML data 
feed or as part of an uploaded XML file. The System Batch ID is applied to all of the transactions within a single 
XML document. 

If you know the System Batch ID, you can enter it on the Search Transactions page and then click Search, and you 
will be shown a list of all the transactions that made up that batch. You can then drill down to an individual 
transaction.

Search
You can search for a transaction based on the:

• Transaction ID or System Batch ID

• Transaction Type, such as Add Member

• Date that the transaction was submitted, using the Submitted in Date Range fields

• Login ID of the user who submitted the transaction, using the Submitted by Login ID field

• Transaction Status, such as Successful, Failed - Open, or Failed - Acknowledged

• Account Name of the account to which the transaction applies

• Account ID of the account to which the transaction applies

• Member ID referenced within the transaction

• Email Address, the email address of a member referenced within the transaction

• Entitlement ID, the entitlement or order number within the transaction

• Product Management information including Catalog Item ID, System Catalog ID, Product ID, System Product 
ID, File ID, System File ID, Product Line ID, System Product Line ID, Manufacturer ID, System Manufacturer 
ID, License Group ID, and System License Group ID. 

If your criteria match more than one transaction, you will be shown a list of matching transactions and will be able 
to select the one you want.

Upload a Transaction File
An alternative method for submitting entitlement and product information is to create a transaction file and 
upload it to FlexNet Operations LLM Producer Portal. FlexNet Operations LLM Producer Portal allows you to 
upload a transaction file that conforms to FlexNet Operations’ XML schema.

To upload an XML transaction file, click Upload Transaction File on the Administer menu. The Upload a 
Transaction File page opens.
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Figure 7-2: Upload a Transaction File Page

To upload a transaction file, perform the following steps:

Task To upload a transaction file:

1. On the Administer menu, select Upload Transaction File. The Upload a Transaction File page opens. 

2. Click the Choose File button to open a system window which will let you choose the file using the file 
manager.

3. To have a copy of the submission report for this entitlement—indicating the success or failure of each 
transaction in the file—emailed to you or to other people, enter one or more email addresses in the Email for 
Report field. 

4. Click Submit file. FlexNet Operations LLM Producer Portal will upload the file through your browser and will 
immediately begin processing the transactions within the file. Each transaction will be given a unique 
System Transaction ID. The file submission will be given a unique System Batch ID.

For specifics on the XML document, see FlexNet Operations Transaction Processing Specification.
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Converter Templates
To use Excel to create a transaction file, FlexNet Operations LLM Producer Portal provides the following four 
templates:

To use a converter template, perform the following steps.

Task To select a converter template:

1. On the Administer menu, select Converter Templates. A popup opens providing links to the following four 
Microsoft Excel templates:

• Account Management Template

• Entitlement Management Template

• Package Products Template

• Device Management Template

• Setup Management Template

2. Click on the appropriate Excel spreadsheet for the transaction types in your batch to download the template.

3. In Microsoft Excel, open the Excel spreadsheet and populate it with data.

Note • If you do not want to provide values in a column, then it is recommended that you remove the column 
from the spreadsheet rather than include it and leave the values blank.

4. Select File > Save As and choose Unicode Text (*.txt) for the file type. 

Important • Avoid using the CSV (Comma delimited) export type. While it should work for data in a limited 
character set, Unicode Text should always be used instead.

Table 7-1 • Converter Templates

Name Description

Account Management Template Transactions for managing accounts and members.

Entitlement Management Template Transactions for managing Entitlements.

Package Products Template Transactions for managing product lines, manufacturer, catalog 
items, products, and files.

Device Management Template Transactions for managing FlexNet Embedded integration.

Setup Management Template Transactions for managing user-defined fields.
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5. Upload the saved file as described above. The processing will proceed in the same way as it does for an XML 
upload.

Entering Data
When entering data in the Excel spreadsheet, note the following:

• Numerical values—For numerical values, the preferred format is a string of digits with no thousands 
separators and with a period (.) separating the fractional part for non-integer values. 

• Dates—For dates, the preferred format is MM/DD/YYYY, such as 03/01/2024 for the first day of March 2024. 

• Boolean values—For Boolean (true/false) values, the preferred format is the literal lowercase strings true 
and false. Some other formats will be interpreted properly, but the above formats are the officially supported 
standard.

• Update and AddUpdate—Update and AddUpdate transactions may be blank data. If you upload a file 
containing transactions of these types, then any columns you include will be assumed to contain the desired 
value. 

• In particular, if a column contains all empty values, then the records will still be updated, and their 
values corresponding to that column will all be blanked. 

• If you wish to update only a select subset of fields, then make sure to delete the columns for attributes 
you do not want to update from the sheet.

Multiple-Valued Attributes
Multiple-valued attributes exist for many transaction types. The most available example is that you might want to 
have several line items on a single AddOrder transaction. This is not well-adapted to spreadsheets; it is 
essentially “expanding upon a row.” 

This problem is handled by putting as many rows as necessary in the spreadsheet, repeating any data that is 
single-valued and the same for all rows. Some subset of that data (which varies by transaction type) is used to 
identify when rows really belong to the same transaction. 

Data that is only needed once for the transaction type is taken from the first row, and data that can have multiple 
values is taken from the aggregation of the values given in all rows for that transaction. Consider the following 
example:

This example puts two SKUs on the same AddOrder transaction. It also sets two values of a multiple-valued 
UDF INVOICE-NOTES for the entitlement. 

This example also illustrates that the repeated rows can be used to collect multiple aggregated values 
simultaneously. 

Table 7-2 • Example of Multiple-Valued Attributes

Transaction Type OrderID SKU UDF[ORD|INVOICE-NOTES]

AddOrder 123 DBCLIENT Invoices can have notes

AddOrder 123 DBSERVER Even more than one note
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Note • There is no need to repeat each of the multiple UDF values for each of the multiple SKUs.

Of course, a real upload would probably have more columns. 

Important • It is imperative to always repeat the transaction type and a certain undocumented collection of IDs 
and is best to repeat every single-valued field (since which are essential is undocumented).

User-Defined Fields
User-defined fields are supported by this type of batch upload. The templates described above will include the 
user-defined fields you have configured. 

You will notice that user-defined fields appear in columns whose names follow the convention UDF[level|code], 
where:

• level is the UDF level code as defined in the XML schema.

• code is the UDF ID visible on the List All UDFs page. 

• The character between the level and the code is a pipe character. 

Important • It is important not to change these column names. If they are changed, the transactions will be 
processed anyway, but values in the column whose name has been changed will not get assigned to the 
corresponding UDF.

Creating a Delimited Text File By Means Other Than Excel Export
If you are creating a delimited text file by means other than an Excel export, then be aware of the details of the 
two supported formats:

Excel Unicode Text

• Fields are delimited by tabs and optionally enclosed by double quotes. 

• Literal double quotes within fields are escaped by doubling, not by backslashes. 

• The character encoding is UTF-16 little endian, and the file must begin with the byte order marker; this is how 
FlexNet Operations LLM Producer Portal will detect the tab-delimited format.

Excel CSV

• Fields are delimited by commas and optionally enclosed by double quotes. 

• Literal double quotes within fields are escaped by doubling, not by backslashes. 

• The character encoding is UTF-8, and the file does not begin with a byte order marker. This is not meant to 
suggest that the CSV export type in Excel will use UTF-8; it will not. It will export many non-ASCII characters 
as question marks. This format is only documented for the benefit of those using something other than Excel, 
for which UTF-8 CSV may work well.
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XML Transaction Files Are Preferred
While this processing of delimited text files can be convenient, XML transaction files are less error-prone. Highly 
automated solutions should be developed around XML rather than delimited text whenever possible.

View Transactions
When you select a transaction using the Search Transactions page—whether you select it directly using the 
Transaction ID or pick it from a list generated by a search—the transaction details are displayed on the View 
Transaction page.

Figure 7-3: View Transaction Page

The View Transaction page always displays header information including the Transaction ID, Transaction Type, 
and Status. It also includes:

• Process Start Date/Time and Process End Date/Time—Submission date and time.

• Submitted By—Who submitted the transaction.

• Submit Method—What method was used to submit the transaction.

The details of the transaction data are displayed, the specifics of which are determined by the Transaction Type.

Managing Failed Transactions
If the transaction failed, then the errors are listed and you are given the option to:

• Edit and Resubmit—If you can, and want to, resolve the issue(s) which caused the errors(s) you can click on 
Edit and Resubmit. The failed transaction will be displayed in the Edit Transaction form and you can edit the 
fields which caused the error.
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• Acknowledge—If you don't want to try and fix the transaction you can acknowledge it as a failed transaction 
by clicking the Acknowledge failed transactions link on the Search Results: Transactions page. This makes it 
easier to keep track of the transactions you do want to fix. 

If you change your mind later you can select the transaction and open it on the View Transaction page, where 
you can click the Undo Acknowledgment link.

• Force—Your site may be configured to allow you to “force” certain kinds of transaction failures. “Forceable” 
transactions are ones which have violated some business rule that your company set up but are acceptable 
to the FlexNet Operations LLM Producer Portal service.
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FlexNet Publisher Licensing

This chapter provides more insight about licensing via the following sections:

• FlexNet Operations LLM Quick Start for FlexNet Publisher Certificate Style Licensing

• Licensing Best Practices

FlexNet Operations LLM Quick Start for FlexNet 
Publisher Certificate Style Licensing

Before starting certificate style licensing, user make sure to have access to Producer Portal UAT, lmcrypt set up, 
and at least one license template must be set up by the Revenera Account Manager in consultation with product 
team. 

• Use Case Scenarios

• Use Cases

• Considerations

Use Case Scenarios
The following displays the Illustrative scenario:
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Figure 8-1: FlexNet Publisher Certificate Style Licensing Scenario

Scenario Assumptions
The following assumptions are made in this scenario:

• Customers that are current on maintenance will get EZ- Calculator 2.0 with features corresponding to the 
catalog item that they currently own (ie EZ-Calculator Basic or EZ-Calculator Professional). Catalog items are 
essentially subscription products.

• Licensed features inside a product binary are evolved in a manner that is backwards compatible. So, a 
license file created for v2.0 will also work for a v1.0 product binary. This is a pre-requisite for subscription 
products and is enabled nicely by FlexNet Publisher.

Use Cases
The following are the use case based scenarios that are demonstrated in this section:

• Initial Set Up of EZCalculator-Basic: Nodelocked Catalog Item

• Initial Set Up of EZCalculator-Professional: Floating Catalog Item

• EZ-Calculator 2.0 is Released - Upgrade Set Up of EZCalculator-Basic: Nodelocked Catalog Item

• EZ-Calculator 2.0 is Released - Upgrade Set Up of EZCalculator-Professional: Floating Catalog Item
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Initial Set Up of EZCalculator-Basic: Nodelocked Catalog Item
User configures the EZCalculator-Basic: Nodelocked catalog item. The following describes the procedure to 
configure:

Task To set up the EZCalculator-Basic: Nodelocked catalog item:

1. Create the product. In this example, the product version is set to 1.0. The following displays the product 
creation:

2. Remember to assign a license group to the product. The following displays the License Group selection:

Note • Consider the following information:

• License Groups pertain to the licensing technology used in your product. 

• FNP_Template_Based refers to FlexNet Publisher.

3. Create the catalog item. The following displays the catalog item creation:

4. Associate catalog item with product. The following displays the product association to catalog item:
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5. Now you are ready to set up FlexNet Publisher licensing for the product. Before configuring license for a 
product, it must be first associated with a Catalog Item. The following displays the View Flex Licensing 
option selection in the View Product page: 

6. Check the catalog item EZCalculator-Basic: Nodelocked and click on the Initial setup button. The following 
displays the EZCALC-BASIC-NL catalog item selection in the Catalog Items page:
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7. Assign a license template to the product and start adding features. To add/remove features click on “- +”. 
When done click on the Assign License Data button. The following shows the license template along with 
features addition:

Note • License templates are set up by the Revenera account team. 

8. The set up is now complete. In advanced use cases, you may want to click on the Details link to set up 
feature-specific overrides for your license model. For example, some ISVs might want to set a vendor string 
on each feature line of a FlexNet Publisher license. The following displays the License Details page:

9. For each Component/Feature you can indicate the type (package, increment, feature), and version (single 
feature shown). A vendor string can also be defined. The following shows the Add Variation Concepts option 
selection from the Licensing tab as well as the license component’s name and type: 



Chapter 8 FlexNet Publisher Licensing
FlexNet Operations LLM Quick Start for FlexNet Publisher Certificate Style Licensing

240  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Note • This is an optional step in this procedure. 

10. Create an entitlement line item for this catalog item. The following displays the Line Items page:

11. Click View > View License to launch the license fulfillment workflow. The following indicates the Generate 
button to generate the configured license:
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Initial Set Up of EZCalculator-Professional: Floating Catalog Item
User configures the EZCalculator-Professional: Floating catalog item. The following describes the procedure to 
configure:

Task To set up the EZCalculator-Professional: Floating catalog item: 

1. Create the product. 

2. Remember to assign a license group to the product.

3. Create the catalog item.

4. Associate catalog item with product.

5. Check the catalog item EZCalculator-Professional: Floating and click on the Initial Setup button.The 
following displays the EZCALC-PRO-FL catalog item selection under the Catalog Items list:

6. Assign a license template to the product and start adding features. To add/remove features click on “- +”. 
When done click on the Assign license data. The following shows a license template selection with a feature 
addition:



Chapter 8 FlexNet Publisher Licensing
FlexNet Operations LLM Quick Start for FlexNet Publisher Certificate Style Licensing

242  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Note • License templates are set up by the Revenera account team.

7. The set up is now complete. Here, following shows that two catalog items are associated with this product 
release: 

EZ-Calculator 2.0 is Released - Upgrade Set Up of EZCalculator-Basic: 
Nodelocked Catalog Item

User upgrades the configured EZCalculator-Basic: Nodelocked catalog item. The following describes the 
procedure to upgrade:
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Task To upgrade the EZCalculator-Basic: Nodelocked catalog item:

1. Create the new product release 2.0 by copying product release 1.0. The following displays the new product 
creation:

2. Associate the new product release to the existing catalog item EZ-Calculator Basic: Node Locked. The 
following displays the Associate Where option selection in the View Product page: 

3. Enter the product ID for version 1.0 and click on the Associate to Catalog Items of the Entered Products 
button. The following displays the Enter Product IDs page :

4. View Flex Licensing for this product release and click on the Upgrade button. The following shows the 
License Details page:



Chapter 8 FlexNet Publisher Licensing
FlexNet Operations LLM Quick Start for FlexNet Publisher Certificate Style Licensing

244  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

5. Check EZ-Calculator Basic: Node Locked and select Existing Content since there are no new features for this 
catalog item. Click on the Set up Flex Licensing as upgrade button. The following displays the Existing 
Content option selection:

6. Verify that the upgrade licensing has been set up for this association. This completes the upgrade set up as 
shown below:
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EZ-Calculator 2.0 is Released - Upgrade Set Up of EZCalculator-
Professional: Floating Catalog Item

User upgrades the configured EZCalculator-Professional: Floating catalog item. The following describes the 
procedure to upgrade:
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Task To upgrade the EZCalculator-Professional: Floating catalog item:

1. This catalog now includes a new feature called “average”. The catalog item is already associate with EZ-
Calculator 2.0. View Flex Licensing to get to the screen below. Click on the Upgrade button. The following 
displays the Product details, license details, and catalog Item:

2. Check the New Content option and list out the features in this catalog item. Click on the Set up Flex Licensing 
as upgrade button to complete set up. The following indicates the New Content lists and Set up Flex 
Licensing as upgrade button:
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3. Verify the completed set up shown below:

Considerations
For upgrade products, any new entitlements and fulfillments created will reference the latest feature content for 
the associated catalog items as described in this chapter. This is consistent with a subscription business model.

If your business model does not involve subscriptions, create new catalog items for each product release, and 
follow the steps for Initial Set Up as explained in Initial Set Up of EZCalculator-Basic: Nodelocked Catalog Item.
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Licensing Best Practices
The Revenera FlexNet Operations LLM service offers manufacturers ease of management and functionality to 
deliver, track, and report license keys. This document:

• Describes basic FlexNet Operations LLM functionality available to issue licenses to end users.

• Recommends some best practices to administer license keys using FlexNet Operations LLM.

• Provides considerations on how to approach customized license generation using FlexNet Operations LLM.

Licensing best practices are described in the following sections:

• FlexNet Operations LLM License Styles, Order-Based

• License Generators for Order-Based License Keys

• FlexNet Operations LLM License Styles – End User Based

• Token-Based Licensing

• Getting Started

• Electronic Licensing Summary

• Summary

FlexNet Operations LLM License Styles, Order-Based
In a standard FlexNet Operations LLM license implementation; there are following three different methods to 
send a License Key in the Order transaction to FlexNet Operations LLM.

• Entitlement Line Item License Code (Level Catalog Item) Style

• Entitlement License Pool (Level Catalog Item) Style

• Binary License File Style
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Entitlement Line Item License Code (Level Catalog Item) Style
In this method, the plain text License Key is sent by order line in an Order transaction to FlexNet Operations LLM 
(single or multiple plain text License Keys may be sent, as long as the data is sent in one field). If you need 
additional information on this feature, please contact your Account Manager/Project Manager.

Table 8-1 • Entitlement Line Item License Code (Level Catalog Item) Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal

Setup 1. Product Management

2. Configure

3. Add License Group

Create License Group and 
use the attribute for the 
License Style field, 
Entitlement Line Item 
License Code (Level Catalog 
Item).

4. Add / Edit Catalog Item and 
select the correlating 
License Group from the 
License Group Field.

Refer to IXP documentation:

1. Product Management 
template

2. Add-Update License Groups 
transaction.

3. Add-Update Catalog Item 
transaction.

Populate the Intraware 
License Group ID to the 
Catalog Item set up for the 
field header Intraware 
License Group ID.

N/A

Delivery Create Entitlement for an 
Account:

1. From the View Account 
display, select Entitle > 
Entitle Account.

2. Populate relevant fields to 
complete order submission, 
and enter License Key text 
to the field, License Code.

3. Submit form by clicking 
Entitle Account.

Refer to IXP documentation:

1. Entitlement Management 
Template

2. Populate the License Key 
text in the field, 
LicenseCode, to one of 
these transaction templates 
appropriate for your 
process:

• Add Order

• Edit Order 

• Process Order

During the Order transaction, the 
system by default will send the 
End User specified on the Order 
an Order Email. 

The Order Email template can be 
set up to contain a merge tag to 
display the License Key text in 
the customized email to the end 
user.
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Tracking/
Reporting

Options:

1. Send a real-time copy of the 
Order Email by using the 
option to Copy as BCC on the 
Entitle Account form.

2. View order history from the 
View Account display: View 
> View Entitlements.

3. Send a transaction record 
via email by using the Email 
for Report option on the 
Entitle Account form.

Options:

1. Send a real-time copy of the 
Order Email by using the 
field NotificationBCC on one 
of these transaction 
templates appropriate for 
your process:

• Add Order

• Edit Order

• Process OrdeR

2. Specify the email address to 
send transaction record by 
using the Email for Report 
option on the Upload a 
Transaction File function in 
FlexNet Operations LLM 
Producer Portal (IXP 
method).

3. Refer to the XML schema, 
located in the FlexNet 
Operations LLM Release 
Notes, for Setup, Delivery, 
and to specify a transaction 
record if using a Datafeed 
Client to submit XML 
transactions to FlexNet 
Operations LLM.

Once the Order transaction is 
successfully processed by 
FlexNet Operations LLM, the 
License Key is assessable from 
the “License Key” link on the 
Download page, Order History 
page, or Index page, depending 
on your implementation.

FlexNet Operations LLM Reporter: Create an Entitlement Report to 
obtain tracking of license keys by Account.

Table 8-1 • Entitlement Line Item License Code (Level Catalog Item) Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal
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Entitlement License Pool (Level Catalog Item) Style
In this method, pools of plain text License Keys are set up in advance to FlexNet Operations LLM Producer Portal. 
FlexNet Operations LLM Producer Portal automatically pulls a License Key from the pool during an order 
processing transaction. This License Group Style is unavailable by default, if you would like to enable License 
Pools Support, please contact your Account Manager/Project Manager.

Table 8-2 • Entitlement License Pool (Level Catalog Item) Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal

Setup Setting up the license pool:

1. Product Management

2. Configure

3. Add License Group 

4. Create License Group and 
use the attribute for the 
License Style field, 
Entitlement License Pool 
(Level Catalog Item).

5. Use IXP Product 
Management template, Add 
Licenses to Pool transaction 
(to initially add license keys 
or to refill license keys to 
pool).

6. Continue to Catalog ID 
setup.

Add / Edit Catalog Item and 
select the correlating 
License Group from the 
License Group Field.

Refer to IXP documentation:

1. Product Management 
template

2. Add-Update License Groups 
transaction.

3. Add Licenses to Pool 
transaction (initial license 
key load or refill).

4. Add-Update Catalog Item 
transaction.

Populate the Intraware 
License Group ID to the 
Catalog Item set up for the 
field header Intraware 
License Group ID.

N/A
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Delivery Create Entitlement for an 
Account:

1. From the View Account 
display, select Entitle, > 
Entitle Account.

2. Populate relevant fields to 
complete order submission, 
and submit form by clicking 
Entitle Account.

3. For Catalog Items set up 
with a License Group pool, 
the FlexNet Operations LLM 
Producer Portal system will 
automatically pull a key from 
the pool for the Order line.

Refer to IXP documentation:

1. Entitlement Management 
Template

2. Use one of these transaction 
templates appropriate for 
your process: 

• Add Order

• Edit Order 

• Process Order

3. For Catalog Items set up 
with a License Group pool, 
the FlexNet Operations LLM 
system will automatically 
pull a key from the pool for 
the Order line.

During the Order transaction, the 
FlexNet Operations LLM system 
by default will send the End User 
specified on the Order an Order 
Email. 

The Order Email template can be 
set up to contain a merge tag to 
display the License Key text in 
the customized email to the end 
user.

Table 8-2 • Entitlement License Pool (Level Catalog Item) Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal
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Tracking/
Reporting

Options:

1. Send a real-time copy of the 
Order Email by using the 
option to Copy as BCC on 
the Entitle Account form.

2. View order history from the 
View Account display (View 
> View Entitlements).

3.  Send a transaction record 
via email by using the Email 
for Report option on the 
Entitle Account form.

Options:

1. Send a real-time copy of the 
Order Email; use the field 
NotificationBCC on one of 
these transaction templates 
appropriate for your 
process:

• Add Order

• Edit Order

• Process Order

2. Specify the email address to 
send transaction record by 
using the Email for Report 
option on the Upload a 
Transaction File function in 
FlexNet Operations LLM 
Producer Portal (IXP 
method).

3. Refer to XML schema, 
located in the FlexNet 
Operations LLM Release 
Notes, for Setup, Delivery, 
and to specify a transaction 
record.

Once the Order transaction is 
successfully processed by 
FlexNet Operations LLM, the 
License Key is assessable from 
the License Key link on the 
Download page, Order History 
page, or Index page, depending 
on your implementation.

FlexNet Operations LLM Reporter: Create an Entitlement Report to 
obtain tracking of license keys by Account.

Table 8-2 • Entitlement License Pool (Level Catalog Item) Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal
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Binary License File Style
In this method, a Binary License File is sent by order line in an Order transaction to FlexNet Operations LLM (one 
key per Catalog Item ordered). Revenera charges a fee for implementation of this functionality. If you would like 
to enable Binary License File Support, or would like additional information on this feature, please contact your 
Account Manager/Project Manager.

Table 8-3 • Binary License File Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal

Setup 1. Product Management

2. Configure

3. Add License Group

4. Create License Group and 
use the attribute for the 
License Style field, 
Entitlement Binary License 
Key (Level Catalog Item)

5. Add / Edit Catalog Item and 
select the correlating 
License Group from the 
License Group Field.

Refer to IXP documentation:

1. Product Management 
template

2. Add-Update License Groups 
transaction

3. Add-Update Catalog Item 
transaction.

Populate the Intraware 
License Group ID to the 
Catalog Item set up for the 
field header Intraware 
License Group ID.

N/A

Delivery Upload license files for each 
Order line from the Entitle 
Account form in FlexNet 
Operations LLM Producer Portal:

1. Use the standard Browse 
functionality from your web 
browser to find and add the 
license file to the Entitle 
Account form.

The order line element within the 
Order Transaction Schema has 
an additional field of 
<LicenseFileName>. 

To load a license file, set the 
filename field and populate the 
<LicenseCode> field with the 
Base64 encoded representation 
of the license file. For example:

<SKU>MY-PART-NUMBER</SKU>
<Quantity>10</Quantity>
<LicenseFileName>license.txt
</LicenseFileName>
<LicenseCode>bGljZW5zZSBm 
aWxlIGNvbnRlbnQ=</LicenseCode>

The filename you specify will be 
the filename used when the 
license file is downloaded to the 
end user.

Binary License files are 
accessible in the FlexNet 
Operations LLM service in the 
same way the plain text licenses 
are made available. This can be 
from the License Key link on the 
Download page, Order History 
page, or Index page, depending 
on your implementation.

There are following two types of 
licenses that are displayed 
differently:

• Plain text licenses are 
displayed on the page

• Binary license files appear 
as a link from which you are 
able to download the file.
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License Generators for Order-Based License Keys
Revenera also offers customizations to generate License Keys when triggered by an Order transaction to FlexNet 
Operations LLM. Some variations of customized styles include:

• FlexLM where the license generator is hosted by the manufacturer.

• Revenera-hosted license generators.

• Revenera-hosted license generation for ‘home-grown’ license styles.

Revenera charges a fee for implementation of this functionality. If you would like to enable this functionality, or 
would like additional information on this feature, please contact your Account Manager/Project Manager. You 
can also review the Getting Started considerations below.

FlexNet Operations LLM License Styles – End User Based
Revenera customizes different solutions that give End Users the capability to generate Licenses on demand from 
the End User Portal. Permission-based privileges can also grant Administrators the ability to generate License 
Keys on behalf of the End User from FlexNet Operations LLM Producer Portal. Once implemented by Revenera, 
some definitions will need to be set up on the Product ID level to use the functionality. Some variations of 
customized styles include:

• Setting up purchase limits by Account, along with usual Entitlements. The cost of the license is subtracted 
from the purchase balance of the Account. The FlexNet Operations LLM application will prevent the user from 
generating a license if there insufficient funds available in their balance.

• FlexLM floating license with or without host ID

• FlexNet Operations

• Revenera-hosted license generation for “home-grown” license styles allowing for customer data entry if 
needed.

Revenera charges a fee for implementation of this functionality. If you would like to enable this functionality, or 
would like additional information on this feature, please contact your Account Manager/Project Manager.

Tracking After you have processed the 
order, the filename will be 
displayed for future reference.

By clicking on the filename, you 
can download the license file so 
that you can verify its content.

Refer to XML schema, located in 
the FlexNet Operations LLM 
Release Notes, on how to specify 
a transaction record if using a 
Datafeed Client to submit XML 
transactions to FlexNet 
Operations LLM.

Depending on the user’s browser 
configuration for specific file 
types, some files may render 
directly in the browser, rather 
than display a Save As dialog 
box.

Table 8-3 • Binary License File Style

Process
FlexNet Operations LLM 
Producer Portal

XML Transaction or IXP 
Processor End User Portal
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Token-Based Licensing
As part of Revenera's solution to support licensing, a component will exist to support token based licensing. The 
concept of token based licensing is to allow end user access to licenses via a code or token. The token will 
contain all of the information necessary to entitle a user to a specific license. Upon registration with the Token a 
normal Entitlement will be created based upon the information entered with the Token. 

Revenera supports two methods of token based licensing:

• Anonymous Token Licensing (ATL)—The first method is Anonymous Token Licensing (ATL) where an end user 
does not have to provide any information besides the token in order to obtain a license.

• Registered Token Licensing (RTL)—The second method of token based licensing is Registered Token 
Licensing (RTL) in which case the end user is required to create a user profile and provide the information 
from the token before being able to obtain a license.

Getting Started
This section contains questions to help you identify the business process and processes involved for the actual 
generation of the license. It is not unusual to use home grown or multiple licensing styles across different 
product lines. Your answers to these considerations will facilitate the Engineering discussion to scope out the 
planning and effort to manage your different licensing styles from FlexNet Operations LLM.

• General Considerations

• Business Process / Use Case Considerations

General Considerations
The following table lists general considerations for licensing.

Table 8-4 • General Considerations

Licensing Question Notes

Provide a high level description of the current 
license generation process.

How many different license generators?

How many different licensing keys does each 
generator produce?

Is there current documentation describing the 
current

If no, proceed to Business Process / Use Case 
Considerations.
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Business Process / Use Case Considerations
The following table lists business process / use case considerations for licensing.

Table 8-5 • Business Process / Use Case Considerations

Licensing Question Notes

What type of licenses do you distinguish 
(concurrent, served, node-locked, etc)?

How long is a license valid for?

What end user information is needed to generate a 
license?

How do you determine what kind of license to 
generate?

Where does all the input information come from?

What information is stored in the product (and 
therefore the same for every customer that 
purchases it)?

What information is stored in the order (and 
therefore different for every customer)?

Is the license a separate Order Line or part of the 
SKU that is being purchased?

Is the user allowed to re-host a license? What are 
the limitations?

When a new release becomes available: Does the 
user need a new license?

Is the user entitled to a new license?

Does a new release require an additional order?

If the license key has an expiration date, what is the 
maintenance process (renewal) entail?

Does the user pay another year and receive a new 
license key?

What is the process to purchase additional seats?
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Electronic Licensing Summary
This following sections provides more insight about the difficulties of license management and advantages of 
using Electronic Licensing:

• Challenges

• Benefits

Challenges
The larger challenge of license management occurs from a combination of factors that can also make licensing 
confusing to customers:

• Acquisitions

• Home-grown solutions

• Multiple digital rights management vendors

• Export controls

• Customer input parameters

• Manual generation / distribution

Benefits
The benefits of Electronic License Delivery include:

License Keys
• Unlock functional software modules

• Allow software to run for a certain period

• Can specify who is authorized to use

Locksmith Role
• Generate the right keys for each customer

• Understanding rules to create the keys

Electronic Delivery
• Instantaneous and accurate

• Convenient on-demand generation

• Reportable
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Summary
This document provides the best practices for standard Electronic License Delivery from FlexNet Operations LLM. 
Your insight to the business processes and use cases relevant to your organization will help determine the most 
efficient approach to integrating your various licensing schemas to FlexNet Operations LLM. 

FlexNet Operations LLM offers the use of License templates and enforcement rules for License generation which 
will simplify labor intensive and manual administration. As such, FlexNet Operations LLM goes beyond home-
grown or 3rd party alternatives for Entitlement-control access to licenses. 

FlexNet Operations LLM is capable of plugging in any license technology. By these means, integrating Electronic 
License Delivery as part of the overall FlexNet Operations LLM end user experience will also allow you to operate 
and maintain ELD with the same service levels as Electronic Software Delivery from FlexNet Operations LLM.
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FlexNet Embedded Licensing

FlexNet Operations enables high-tech hardware and software manufacturers to increase revenues, reduce 
support costs, and simplify customer relationships. It provides a single entitlement management system, 
enabling manufacturers to quickly create versatile product configurations and manage multiple licensing 
technologies.

FlexNet Operations also enables you to flexibly price, package, protect, and update your product offerings while 
profitably managing licenses throughout their lifecycle.

This guide explains the basic concepts and tasks you need to package a product and generate license rights 
using FlexNet Embedded technology. It also provides information about managing the lifecycle of a device and 
other advanced topics.

Table 9-1 • Getting Started With FlexNet Embedded Licensing

Section Description

Overview Provides an overview of the Getting Started information, FlexNet Embedded 
License Technology, and tasks to complete before you begin using FlexNet 
Operations.

Quick Start Example Provides basic procedures to set up a device series, device model, and 
device with licensing using sample data. This section also includes 
procedures to test the licensing.

Managing Devices Provides instructions for typical tasks you might perform while managing 
devices throughout their lifecycle.

Managing Servers Discusses the use and management of FlexNet Embedded license servers.

Advanced Topics Provides explanation for more advanced FlexNet Embedded and FlexNet 
Operations concepts and procedures for more complex configurations.
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Overview
Before performing the FlexNet Embedded Licensing exercises, review the following information.

• Intended Audience

• FlexNet Embedded License Concepts

• Before You Begin

Intended Audience
The primary audience for this section includes FlexNet Embedded developers and other IT operations personnel 
responsible for setting up devices and licenses using FlexNet Operations. This guide is also intended to support 
product marketing.

FlexNet Embedded License Concepts
FlexNet Embedded license technology is intended for but not limited to use with high-tech hardware devices with 
these characteristics:

• A limited amount of volatile and non-volatile memory.

• A limited runtime environment.

• Limited or no network connectivity.

• Typically uses a real-time operating system like Windows CE, Embedded Linux, or VxWorks.

• Possibly no keyboard or display. Without user intervention, the device automatically checks its license rights 
to determine its behavior and functionality.

Software on each device controls the feature set expressed on the particular device model. If the device has 
internet connectivity, it can connect directly to the FlexNet Operations back office and receive the license for its 
particular feature set. You can also activate a device offline or using a FlexNet Embedded license server. The 
following diagram shows the relationship between the FlexNet Operations back office, FlexNet Embedded 
clients, and a FlexNet Embedded license server.
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Figure 9-1: FlexNet Embedded License Technology

Note • See Managing Servers for more information about using FlexNet Embedded license servers and Offline 
Activation for more information about Offline Activation.

You can also use FlexNet Embedded license technology for traditional software applications. FlexNet Embedded 
can be easily integrated into publisher software to make it capable of enforcing software license models such as 
perpetual license, subscription license, or demo license.

When a FlexNet Embedded client or server communicates with the FlexNet Operations back office to install or 
update dynamic license rights, the communications involve capability requests and capability responses.

• A capability request is generated when a device directly requests features or a server requests a pool of 
features to serve to devices. The request data contains some combination of a device identifier, one or more 
rights identifiers, and any other manufacturer-defined data to pass to the back office.

• The back office then processes the request, reading the various identifiers and custom data. If the back 
office determines the device rights should be fulfilled or updated, it generates a capability response. The 
response data contains current license rights available for the device. The capability response is then 
conveyed back to the device, and the license rights are stored in trusted storage and can be acquired.

Before You Begin
Before using a FlexNet Embedded license technology, you must first install and configure the FlexNet Embedded 
toolkit and the cloud-hosted edition of FlexNet Operations to work together. Before you continue, make sure you 
have access to the following applications:

• FlexNet Operations LLM Producer Portal and Enterprise Portal

Note • You must also make sure you have the necessary permissions to perform specific processes using the 
Producer Portal. Permissions provides a list of permissions required for each process.
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• FlexNet Embedded Licensing Toolkit

• .NET Toolbox Device application

Quick Start Example
The purpose of this section is to walk you through the basic steps required to add and configure a standalone 
device that connects to the FlexNet Operations back office over the Internet.

Roadmap for Lifecycle Management Tasks and Advanced Topics
For information on roadmap lifecycle management tasks and advanced topics, see the following:

• See Managing Devices for tasks related to managing devices over their lifecycle.

• See Managing Servers for more advanced tasks and topics, including using FlexNet Embedded licensing 
servers.

• See Advanced Topics for additional device creation and activation strategies, license model options, and 
more.

Table 9-2 • Quick Start Example

Section Description

Setup Describes the tasks to prepare for creating a device, including setting 
up an identity and publisher and downloading the FlexNet Embedded 
toolkit.

Creating an Account and a Member Describes the steps to create an account and add yourself as a 
member.

Adding Device Capabilities Describes the steps to add device capabilities.

Creating a Device Describes the steps to create a device and assign the device to an 
account.

Creating and Configuring Add-Ons Describes the steps to create a manufacturer, product line, and a 
catalog item with add-ons and how to configure FlexNet licensing for 
that catalog item.

Entitling an Account and Mapping 
an Add-On

Describes the steps to entitle a specific account to a catalog item and 
map an add-on to a device.

Using the Enterprise Portal Describes how to test a license using the .NET Toolbox Device 
application.
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Setup
Before using a FlexNet Embedded license technology, you must first access the FlexNet Operations LLM Producer 
Portal to set up a publisher and identity. A publisher identity is binary data that contains a publisher or 
manufacturer name and encryption data. A publisher is needed to identify who the licenses belong to and who 
can validate the license. An identity is used to secure communication between back office and device.

• Accessing the FlexNet Operations Producer Portal

• Setting Up a Publisher

• Setting Up an Identity

• Setting Up the FlexNet Embedded Toolkit

Accessing the FlexNet Operations Producer Portal
Use the following steps to access the FlexNet Operations Producer Portal.

Figure 9-2: FlexNet Operations Producer Portal

Task To Access the Producer Portal

1. Open a web browser and enter the following URL: 

https://manageruat.flexnetoperations.com

Note • The URL for the production environment is https://manager.flexnetoperations.com. When you perform 
the tasks for this Quick Start example, use the user acceptance test (UAT) environment URL provided in 
Step 1.

https://manageruat.flexnetoperations.com
https://manager.flexnetoperations.com
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2. Enter your username and password then click Log In to UAT.

Note • Use the username and password that was provided by Revenera. If you forget your password, click 
I’ve forgotten my password. If you no longer have your username, contact Revenera Support.

Setting Up a Publisher
Revenera supplies you with a unique publisher name and a series of five publisher keys. You use this name and 
these keys to set up a publisher. The keys cannot be regenerated or duplicated. Contact Revenera if you do not 
have your publisher keys. Use the following steps to set up a publisher.

Task To set up a publisher:

1. Select the Manage Hosts menu then click Add Publisher.

2. Type the name Revenera provided for your company in the Publisher Name field.

3. Type the full name of your organization in the Notes field.

4. Type the publisher keys Revenera provided into the Publisher Keys fields.

5. Click Add Publisher.

Setting Up an Identity
A publisher can define any number of identities, each providing a different level of security for different classes of 
devices or licenses. For example, a line of high-end devices may have higher security than a line of low-end 
devices. Use the following steps to set up an identity.
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Figure 9-3: Add Identity

Task To set up an identity:

1. Select the Manage Hosts menu then click Add Identity.

2. Select the publisher you created from the Publisher drop-down menu.

3. Type a unique name in the Identity Name field. You will refer to this identity name when you create a device 
model.

4. Type any additional details you want to list about the identity in the Notes field. This field is optional.

5. Select an algorithm used to generate digital signatures from the Signature Algorithm drop-down menu.

Note • For this example, select any algorithm. For further details regarding digital signatures and algorithms, 
see Digital Signature Algorithm. Also, the Custom IdentityBackOffice.bin field is not mandatory. For this 
example, leave it blank.

6. Click Add Identity.

Setting Up the FlexNet Embedded Toolkit
You need to install and configure the FlexNet Embedded Licensing Toolkit. This requires the following tasks:

• Installing and Configuring the Toolkit

• Building Product Binaries

• Open the .NET Toolbox Device Application
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Installing and Configuring the Toolkit
Install and configure the FlexNet Embedded Licensing Toolkit as explained in the FlexNet Embedded 
documentation. Consult the user guide and getting started guide for your FlexNet Embedded toolkit. For 
example, if you are using the FlexNet Embedded C SDK, consult the FlexNet Embedded & FlexNet Connect C SDK 
User Guide and the FlexNet Embedded C SDK Getting Started Guide.

Building Product Binaries
Using the FlexNet Embedded Toolkit, your development team needs to create Flex-enabled product binaries that 
are able to take advantage of the FlexNet licensing technology. Some sample license-enabled code is included in 
your FlexNet Embedded toolkit. Consult the user guide for your FlexNet Embedded toolkit for details.

Open the .NET Toolbox Device Application
The .NET Toolbox is a pre-built executable with which you can explore various licensing processes and scenarios. 
For more information on using the .NET Toolbox device application, see the FlexNet Embedded .NET XT SDK User 
Guide.

Creating an Account and a Member
After you complete the initial setup for FlexNet Operations, you need to create a test account and add yourself as 
a member. Revenera created an account for you, but you will create a test account for this quick start example. 
Use the following steps to add an account and a member associated with that account. Use default settings 
whenever they appear.

Figure 9-4: Add an Account

Task To add an account and a member:

1. Select the Manage Accounts menu then click Add Account.

2. If you have your own unique identifier that you would like to use for this account, type the unique back office 
identifier for the account in the Account ID field. This field is optional.

3. Type a description in the Account Name field. The account name is typically the name of your end customer.
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4. Click Submit & Add Members to this Account. The Producer Portal opens the Add a Member page.

5. Populate the following fields to add a member to the account you just created:

• First Name

• Last Name

• Email Address

6. Select an existing address from the Choose Existing Address drop-down menu or populate the following 
fields:

• Address Line 1

• City

• State

• Postal Code

• Country

7. Click Add Member.

Adding Device Capabilities
Device capabilities are the licensed features contained within the license that are used to tell the device what 
features are available to the user and in what capacities. A feature can be counted, meaning that acquisitions of 
that feature may succeed or fail based on a count to be acquired, or uncounted, meaning that acquisitions of 
arbitrary count of that feature are allowed as long as the feature is present.
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Note • For more explanation about counted and uncounted features, see Counted and Uncounted Capabilities.

This task includes some example suggestions based on the example presented in Device Series and Device 
Model Concepts, For this quick start example, use the following steps to add three device capabilities:

• Simultaneous Users (counted)

• Encryption Throughput (counted)

• Redundancy (uncounted)

Task To add device capabilities:

1. Select the Manage Hosts menu then click Add Capability.

2. Type a name for the capability in the Feature Name field. For this example, use SimultaneousUsers.

3. Type a description for the capability in the Description field. For this example, use Number of Simultaneous 
Users.

4. Type a version number for the capability in the Feature Version field. For this example, use 1.0.

5. Select the Counted Yes radio button to indicate acquisitions of this capability may succeed or fail based on a 
count.

6. Click Add Capability. The Producer Portal opens the List Capabilities page and shows a message to indicate 
that the capability was created successfully.

7. On the List Capabilities page, use the fields under Add Capabilities to add the Encryption Throughput 
capability. Type a name for the capability in the Feature Name field. For this example, use 
Encryption_Throughput.
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8. Type a version number for the capability in the Feature Version field. For this example, use 1.0.

9. Type a description for the capability in the Description field. For this example, use Encryption Throughput in 
Mbps.

10. Select the Counted radio button to indicate acquisitions of this capability may succeed or fail based on a 
count.

11. Click Add. The capability is added to the list of Existing Capabilities.

12. On the List Capabilities page, use the fields under Add Capabilities to add the Redundancy capability. Type a 
name for the capability in the Feature Name field. For this example, use Redundancy.

13. Type a version number for the capability in the Feature Version field. For this example, use 1.0.

14. Type a description for the capability in the Description field. For this example, use Redundancy.

15. Select the Uncounted radio button to indicate this is a capability that is not counted but rather turned on or 
off.

16. Click Add. The capability is added to the list of Existing Capabilities.

Creating a Device
You are now ready to add a device and assign it to an account. The following tasks are required.

These tasks include some example suggestions based on the example presented in Device Series and Device 
Model Concepts.

Adding a Device
Use the following steps to add a device. For settings on the Add Device page that are not specified in the steps, 
below, no changes are necessary.

Table 9-3 • Creating a Device

Task Description

Adding a Device Describes the steps for adding a device in the Producer Portal.

Assigning a Device to an 
Account

Explains how to assign a device to an account in the Producer Portal.

Testing the Base License Using 
the .NET Toolbox Device 
Application

Discusses the use of the .NET Toolbox device application to test the base 
license.
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Task To add a device:

1. Select the Manage Hosts menu then click Add Device.

2. Type a unique identifier for the device in the Device ID field. For this example, use VPN5050-1.

3. Type a description for the device in the Alias field. For this example, use VPN 5050 1.

4. Select the identity you created earlier from the Identity drop-down menu. In this example, we have used 
demo.

5. Type additional information as needed in the Notes field. This is optional.

6. Click Add Device. A message appears indicating that the device was added successfully.

Assigning a Device to an Account
Use the following steps to assign an account to the device you added.

Tip • Devices can also self-register to an account during the activation process. For further details on this, see 
Device Creation.

Note • The following steps assume that you just completed the steps in Adding a Device and ended up on the 
View Device page for your device. If not, use the Search Devices page to locate your device (Manage Hosts > 
Search Devices) and then click its Device ID to open the View Device page.
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Task To assign a device to an account:

1. On the View Device page, select the Edit menu then click Assign Owner.

2. Click the search icon next to the System Account ID field.

3. Type the account name for the account in the Account Name field then click Search. Use the account you 
created in Creating an Account and a Member.

4. Click the account name. The system account ID, account ID, and account name appear in the applicable 
fields.

5. Click Assign Owner.

Testing the Base License Using the .NET Toolbox Device Application
To test device licensing using the .NET Toolbox device application, you must install and configure the .NET 
Toolbox device application. Use the following steps to test device licensing using the .NET Toolbox device 
application.

Task To test device licensing using the .NET Toolbox device application:

1. From the Producer Portal, select the Manage Hosts menu then click List Identities.

2. Click the Identity Name. This opens the identity’s View Identity page.

3. Under Identity Files, find Download Client Identity and click Binary File. Download behavior varies depending 
on the web browser you are using.

4. Save the binary client identity file (IdentityClient.bin) to your machine.

5. Open the .NET Toolbox device application from <installdir>\bin\demo\toolbox\DotNetDemo.exe. The Setup 
tab appears.
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6. Click the folder icon next to the Identity File field and browse the location where you saved the client identity 
.bin file. Double-click the .bin file. The file path is populated in the Storage Path field.

7. Click Set. When the identity data is set, the Host Identification fields are enabled.

8. For Host ID Type, select Custom string.

9. For Host ID, type the Device ID of the device you created in Adding a Device. For this example, use VPN5050-1. 
Click Set.

10. Type the device model name in the Host Type field. For this example, use the default device model name, 
FLX_CLIENT.

11. Type the device alias in the Host Name field. For this example, use VPN 5050 1.

12. Click the Server Requests tab.
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13. Select FlexNet Operations On-Demand from the Server Type drop-down menu. The Host, Port and Endpoint 
fields are updated.

14. Type <your_site_name>uat.flexnetoperations.com into the Host field.

15. Click the Response tab then click Send. The device details appear, including capabilities included in the base 
license for the device model.

Creating and Configuring Add-Ons
Add-ons are catalog items you create to represent a license change that grants additional capabilities or capacity 
for a device. Following the description in Device Series and Device Model Concepts, for example, an add-on 
catalog item for a device in the VPN5000 series would be additional simultaneous users or additional throughput.

You must create a manufacturer and product line before you can create an add-on catalog item. After you create 
an add-on, you configure FlexNet licensing for that catalog item. The following tasks are required:

• Creating a Manufacturer and a Product Line

• Adding a Catalog Item

• Configuring FlexNet Licensing for a Catalog Item

These tasks include some example suggestions based on the example presented in Device Series and Device 
Model Concepts.
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Creating a Manufacturer and a Product Line
Before you create a catalog item, you must create a manufacturer and a product line. They are required attributes 
for creating catalog items but have no impact on licensing functionality. The following tasks are required to add a 
manufacturer and product line.

• Adding a Manufacturer

• Adding a Product Line

These tasks include some example suggestions based on the example presented in Device Series and Device 
Model Concepts.

Adding a Manufacturer
Use the following steps to add a manufacturer. Once you have created a manufacturer, it appears as a selection 
in the drop-down menus on pages you use to create catalog items.

Task To add a manufacturer:

1. Select the Package Products menu then click Add Manufacturer.

2. Type a unique identifier for the manufacturer in the Manufacturer ID field. For this example, use 
AcmeNetworks2014.

Note • The Manufacturer ID must be alphanumeric format and must match the following regular expression: 
[A-Za-z0-9]+. For example, BS92 is acceptable, but BS_92 is not.

3. Type a short description for the manufacturer in the Manufacturer Name field. For this example, use Acme 
Networks, Inc.

4. Click Add Manufacturer.

Adding a Product Line
A product line defines the hierarchy of products and the navigation within the FlexNet Operations Enterprise 
Portal. Use the following steps to add a product line.
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Task To add a product line:

1. Select the Package Products menu then click Add Product Line.

2. Type a short description for the product line in the Product Line ID field. For this example, use 
AcmeNetworksVPN.

3. Type a detailed description of the product line in the Product Line Name field. For this example, use 
Acme Networks, Inc. VPN.

4. Click Add Product Line.

Adding a Catalog Item
Use the following steps to create an add-on using a catalog item. For this example, you will create a catalog item 
for additional encryption throughput.
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Figure 9-5: Add a Catalog Item - VPN 5000 Encryption Throughput (10Mbps)

Task To add a catalog item:

1. Select the Package Products menu then click Add Catalog Item.

2. Type a unique ID for the catalog item in the Catalog ID field. The Catalog ID is typically your internal Part 
Number/Stock Keeping Unit (SKU) for the add-on. For this example, use 10MbpsVPN5000.

3. Type a short description for the catalog item in the Catalog Item Name field. For this example, use Acme VPN 
5000 Encryption Throughput (10 Mbps).

4. Select a manufacturer from the Catalog Manufacturer drop-down menu. For this example, select Acme 
Networks, Inc.

5. Select a product line from the Catalog Product Line drop-down menu. For this example, select Acme 
Networks, Inc. VPN. Use defaults for all other fields.

6. Click Submit & Configure FlexNet Licensing. A message appears indicating that the catalog item was 
successfully added, and the Producer Portal opens the Configure FlexNet Licensing page.

Configuring FlexNet Licensing for a Catalog Item
Use the following steps to configure FlexNet licensing for a catalog item.
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Note • The following steps assume you are on the View Catalog Item page having just completed the task in 
Adding a Catalog Item. If not, use the Search Catalog Items page (Package Products > Search Catalog Items) to 
locate your catalog item and then click its system catalog item ID in the search results. This link opens the View 
Catalog Item page for your catalog item. Then, on the View Catalog Item page, click Edit > Configure FlexNet 
Licensing.

Task To Configure FlexNet Licensing for a Catalog Item

1. On the Configure FlexNet Licensing page, use the Features control to select the device capability to which 
this catalog item is related, and then click Add. For this example, select Encryption_Throughput.

2. Type the amount of additional units associated with the specific capability for this catalog item in the Units in 
Catalog Item field. For this example, use 10. (This value represents a 10 Mbps increase.)

Note • You can add multiple capabilities or features to a single catalog item.

• Keep the default license model—Default Order Line License Model—in the Linked License Models drop-
down menu then click Add.

3. Click Configure. The Producer Portal shows a message confirming that FlexNet Licensing was successfully 
configured.

Entitling an Account and Mapping an Add-On
You can entitle an account to a specific catalog item. A catalog item has one, pre-defined set of FlexNet 
Embedded licenses. The terms of these licenses are defined for each customer using line items. Then you can 
map the add-on to a specific device. Use the following tasks to entitle an account and map an add-on to a device:

• Entitling an Account



Chapter 9 FlexNet Embedded Licensing
Quick Start Example

280  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

• Mapping an Add-On to a Device

• Testing an Add-On Using the .NET Toolbox Device Application

Entitling an Account
Use the following steps to entitle an account to a catalog item.

Figure 9-6: Account Search

Task To entitle an account:

1. Select the Entitle Customers menu then click Entitle Account.

2. Type the account name in the Account Name field then click Search. Use the account you created in Creating 
an Account and a Member.

3. In the search results, click the account name. The Entitle Account screen appears.
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4. In the Line Items section, click the Search icon next to the Catalog ID field. Use the ID for the catalog item you 
created in Creating and Configuring Add-Ons.

5. Type the name of the catalog item in the Description field then click Search.

6. Click the Catalog Item ID. The Catalog Item ID appears in the Line Item row.

7. Choose whether to send an Entitlement Notification Email message:

• If you want to send an entitlement notification email, choose one or more available members and choose 
an email template from the Select Entitlement Email drop-down menu.

Note • If you want to include additional recipients, type their email addresses into the CC or BCC field.

• If you don’t want to send an order notification email, select Don’t Send from the Select Entitlement Email 
drop-down menu.

8. Click Entitle Account.

Mapping an Add-On to a Device
Use the following steps to map an add-on to the device you added using the Producer Portal.

Note • You can also map an add-on using an activation ID. See Mapping an Add-On Using an Activation Code for 
more details.



Chapter 9 FlexNet Embedded Licensing
Quick Start Example

282  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Task To map an add-on for a device:

1. Select the Manage Hosts menu then click Search Devices.

2. In the Device ID field, type the device ID for the device to which you want to map the add-on, and then click 
Search.

3. In the search results, click the Device ID. The View Device screen appears.

4. Select the Add-Ons menu then click Map Add-Ons.

5. Type a number in the Units to Configure field. For this example, use 1.

6. Click Map Add-Ons. A message appears indicating the add-on was mapped successfully.

Testing an Add-On Using the .NET Toolbox Device Application
To test device licensing using the .NET Toolbox device application, you must install and configure the .NET 
Toolbox device application. Use the following steps to test the add-on using the .NET Toolbox device application.

Task To test an add-on using the .NET Toolbox device application:

1. From the Producer Portal, select the Manage Hosts menu then click List Identities.

2. Click the Identity Name. This opens the identity’s View Identity page.

3. Under Identity Files, find Download Client Identity and click Binary File. Download behavior varies depending 
on the web browser you are using.

4. Save the binary client identity file (IdentityClient.bin) to your machine.

5. Open the .NET Toolbox device application from <installdir>\bin\demo\toolbox\DotNetDemo.exe. The Setup 
tab appears.
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6. Click the folder icon next to the Identity File field and browse the location where you saved the client identity 
.bin file. Double-click the .bin file. The file path is populated in the Storage Path field.

7. Click Set. When the identity data is set, the Host Identification fields are enabled.

8. For Host ID Type, select Custom string.

9. For Host ID, type the Device ID of the device you created inAdding a Device. For this example, use VPN5050-1. 
Click Set.

10. Type the device model name in the Host Type field. For this example, use the default device model name, 
FLX_CLIENT.

11. Type the device alias in the Host Name field. For this example, use VPN 5050 1.

12. Click the Server Requests tab.
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13. Select FlexNet Operations On-Demand from the Server Type drop-down menu. The Host, Port and Endpoint 
fields are updated.

14. Type <your_site_name>uat.flexnetoperations.com into the Host field.

15. Click the Response tab then click Send. The device details appear, including capabilities included in a base 
license and any add-on capabilities that have been mapped.

Using the Enterprise Portal
This section includes the following tasks:

• Accessing the FlexNet Operations Enterprise Portal

• Viewing Devices Using the Enterprise Portal

Note • The Enterprise Portal interface is often customized and distinctively branded for each producer. As a 
result, your Enterprise Portal pages may look different from the screen captures in this guide, but the core 
functionality described here is the same.

Accessing the FlexNet Operations Enterprise Portal
You can validate that the base license and any add-ons you mapped have been successfully created for a device 
using the FlexNet Operations Enterprise Portal. Use the following steps to access the Enterprise Portal.
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Task To access the Enterprise Portal:

1. Open a web browser and enter the following URL: 

https://<your_site_name>uat.flexnetoperations.com

Note • The URL in step 1 is a typical URL for a customer’s Enterprise Portal. If you do not know the URL 
assigned to your company, contact Revenera Support.

2. If you are associated with more than one account, you are asked to choose which account you want to use. 
Click the Company Name for the account you want to use. The Enterprise Portal opens.

Viewing Devices Using the Enterprise Portal
You can validate that the base license and any add-ons you mapped have been successfully created for a device 
using the FlexNet Operations Enterprise Portal. Use the following steps to view the device you created and verify 
its licensing.
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Task To view a device:

1. From the Enterprise Portal, select Search Devices from the Devices menu. An unfiltered list of devices 
appears.

2. Click the Device ID. The View Device page displays the device details, including the core information that 
identifies and categorizes the device, vendor dictionary (if any), model and base license details for the 
device, and all add-ons that have been added to the device after initial purchase.
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Managing Devices
The purpose of this section is to walk you through typical tasks your customer might perform while managing 
devices throughout their lifecycle using the Enterprise Portal.

You can also execute all of these tasks on behalf of your customer using the Producer Portal.

Viewing Device Details and History
Use the FlexNet Operations Enterprise Portal to view details about a device such as device ID, status, host type, 
as well as details about any pre-built or add-on licenses. You can also view the history specific to a single device. 
The device history page lists all the device events including device creation, account changes, and activation 
requests. Use the following steps to view device details.

Table 9-4 • Managing Devices

Section Description

Viewing Device Details and 
History

Describes the steps to view device details and history using the Enterprise 
Portal.

Claiming a Device Describes the steps to register or claim a device using the Enterprise Portal.

Upgrading Devices Describes the steps to upgrade a device with additional capabilities or 
capacities using the Enterprise Portal.

Transferring Licenses Describes the steps to transfer a license from one device to another using 
the Enterprise Portal.

Managing Returns and RMA Describes the steps to manage returns and Return Material Authorization 
(RMA) using the Enterprise Portal.
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Task To view device details and history:

1. From the Enterprise Portal, select Search Devices from the Devices menu. An unfiltered list of devices 
appears.

2. Click the Device ID. The View Device page displays the device details, including the core information that 
identifies and categorizes the device, vendor dictionary (if any), model and base license details for the 
device, and all add-ons that have been added to the device after initial purchase.

3. To view the device history, click View History.
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Filtering the Device History List
By default, the device history list shows all the device-related activities for a specified device. You can filter the 
device history list using the following parameters:

• Use the Event Type drop-down menu to show a subset of activities based on the type of activity.

• Use the Date Range Start and Date Range End fields to show activities restricted to a specific time frame.

Claiming a Device
Your customer can register or claim devices using the Enterprise Portal. You can also claim a device without 
using the Enterprise Portal. See Device Creation for more details. Use the following steps to claim a device using 
the Enterprise Portal.

Figure 9-7: Claim Device

Task To claim a device:

1. From the Enterprise Portal, select Claim Device from the Devices menu.

2. Type the device ID in the Device ID field. For example, use VPN5050-3.
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3. Optionally, type a name for the device in the Alias field or type additional information in the Notes field.

4. Click Claim Device.

Upgrading Devices
An upgrade is defined as moving a customer from a specified version of a product to an improved version with 
new or expanded capabilities. First, in the Producer Portal, create a Catalog Item for the add-on, configure 
FlexNet licensing for that item, and entitle it to your account. Then, use the following steps to upgrade a device 
using the Enterprise Portal.

Task To upgrade a device

1. From the Enterprise Portal, select Search Devices from the Devices menu. An unfiltered list of devices 
appears.

2. Click the Device ID. For this example, use VPN5050-1. The device details appear.

3. Click Map Add-Ons. The Map Add-Ons screen opens.

4. Type 1 in the Qty to Add field then click Map Add-Ons. A message appears, indicating that the add-on was 
mapped successfully.

5. Send a capability request using the .NET Toolbox Device Application for the changes to take effect. Refer to 
Testing the Base License Using the .NET Toolbox Device Application for detailed steps.

Transferring Licenses
Transferring licenses is defined as the process of moving licenses from one machine to another. Use the 
following steps to transfer a license.

Task To transfer a license:

1. From the Enterprise Portal, select Search Devices from the Devices menu. An unfiltered list of devices 
appears.

2. Click the Device ID. The device details appear.
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3. Type 1 in the Quantity to Remove field for each add-on associated with the device then click Remove 
Add-Ons.

4. Send a capability request using the .NET Toolbox Device Application for the changes to take effect. Refer to 
Testing the Base License Using the .NET Toolbox Device Application for detailed steps.

5. Create a new device with the same characteristics as the old but use a new Device ID (VPN5050-2).

6. Map the add-on capabilities removed from the old device to the new device.

7. Click Save. A newly authorized device has been created in FlexNet Operations.

8. Send a capability request using the .NET Toolbox Device Application for the changes to take effect. Refer to 
Testing the Base License Using the .NET Toolbox Device Application for detailed steps. 

Managing Returns and RMA
A customer may need to return a malfunctioning device to a manufacturer or reseller. This process is known as 
Return Material Authorization (RMA). During the return process, you have the option to move all its licenses to a 
replacement device. If you do not move a license, the license is returned to the unused pool and you can allocate 
it later to another device. Once you have determined that a device needs to be returned and a new one replace it, 
use the following steps to process an RMA.

Task To process an RMA:

1. From the Enterprise Portal, select Search Devices from the Devices menu. An unfiltered list of devices 
appears.

2. Click the Device ID. The device details appear.

3. Click Return Device.
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Important • Returning a device is an irrevocable action. It is intended for cases where this device ID will 
never again need to receive a capability response or license file.

4. To transfer the license for the device you are returning to another device, type the ID for the existing device in 
the Destination Device to transfer add-ons field. For this example, use VPN5050-4.

5. If you have a return authorization material number, type it in the Return Authorization Material (RMA) 
Number field. This is not required.

6. Click Confirm. The device details appear showing the device as returned.

Managing Servers
This section provides information on managing FlexNet Embedded (FNE) license servers, such as adding a server 
using the FlexNet Operations Enterprise Portal, viewing served clients, usage summary, and license server 
request history.

This section includes the following topics.

Table 9-5 • Managing Servers

Topic Description

About FlexNet Embedded 
License Servers

Discusses the use of FlexNet Embedded license servers and their role in the 
FlexNet Embedded architecture.

Adding a FlexNet Embedded 
Server

Provides instructions for adding a license server in the Enterprise Portal.

Mapping an Add-On to a Server Explains how to map add-ons to a server in the Enterprise Portal.

Viewing Served Clients Shows how to view the devices (served clients) served by the license server.

Activating an Unregistered 
FlexNet Embedded License 
Server

Explains how to activate unregistered FlexNet Embedded license servers.
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About FlexNet Embedded License Servers
FlexNet Embedded license servers communicate with FlexNet Operations to manage devices and features for a 
collection of served clients. If you are using a FlexNet Embedded server, your client devices connect with this 
server rather than connecting directly to FlexNet Operations.

The FlexNet Embedded license server provides functionality for serving and monitoring a counted pool of licenses 
for intelligent device or software clients. The server application is designed to administer licenses, enforce usage 
count, and provide served-license status information in conjunction with client code that incorporates FlexNet 
Embedded.

FlexNet Embedded license servers can be hosted in the Revenera cloud (Cloud License Service) or locally 
deployed into your customer’s enterprise. The hosting approach you choose for your FlexNet Embedded license 
servers depends on your organization’s deployment needs. Figure 4-1 shows the FlexNet Embedded Server’s role 
in the FlexNet Embedded architecture. For more details, consult the FlexNet Embedded License Server User 
Guide.

Figure 9-8: FlexNet Embedded License Server’s Role in FlexNet Embedded Architecture

Adding a FlexNet Embedded Server
You can add a FlexNet Embedded server using the Producer Portal or the Enterprise Portal. For this example, use 
the following steps to create a server using the Enterprise Portal.

Using Server Sync to Send 
License Transaction Data to the 
Back Office

Discusses the use of the server sync process to provide visibility into server 
and client license transactions in the FlexNet Operations back office.

Table 9-5 • Managing Servers

Topic Description
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Figure 9-9: Create Server

Task To add a FlexNet Embedded server:

1. From the Enterprise Portal, select Create Server from the Devices menu.

2. Type a unique ID for the license server in the Device ID field. For this example, use the MAC address of the 
machine that is being used as the License Server.

3. Select an ID type from the ID Type drop-down menu. For this example, leave ETHERNET selected.

4. Select a host type from the Type drop-down menu. For this example, leave the default selected.

5. Type a description for the server in the Alias field. For this example, use FNE Server for Acme VPN 5000.

6. Click Create Server.

Mapping an Add-On to a Server
You map add-ons to a server the same way you map add-ons directly to a device. Once the server activates with 
FlexNet Operations, it then has those capabilities which can be used to serve local devices. Use the following 
steps to map an add-on for the server you created.

Task To map an add-on for a server:

1. From the Enterprise Portal, select Search Servers from the Devices menu. An unfiltered list of license servers 
appears.

2. Click the License Server ID. The server details appear.

3. Click Map Add-Ons.
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4. Type a number in the Units to Configure field. For this example, use 1.

5. Click Map Add-Ons. A message appears indicating the add-on was mapped successfully.

6. Send a capability request using the .NET Toolbox Device Application for the changes to take effect. Refer to 
Testing the Base License Using the .NET Toolbox Device Application for detailed steps. 

Viewing Served Clients
Served clients refer to FlexNet Embedded devices that are managed by a FlexNet Embedded Server. In FlexNet 
Operations, served client devices are read-only entities. Use the following steps to view the clients served by a 
specific FlexNet Embedded server using the Enterprise Portal.

Note • For FlexNet Embedded license server users who deploy license servers into their customers’ enterprise, 
the served client data is only available when the server is syncing with the FlexNet Operations back office. See 
Using Server Sync to Send License Transaction Data to the Back Office. (License servers hosted in the Revenera 
cloud automatically sync with the back office.)

Task To view clients served by a license server:

1. From the Enterprise Portal, select Search Servers from the Devices menu. An unfiltered list of license servers 
appears.
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Note • If you search for the server using the Alias field, note that the alias is not a unique ID. The same alias 
can be used for multiple servers.

2. Click the License Server ID to view server details.

3. Click View Served Clients. The page lists the devices that are managed by the server you selected.

Activating an Unregistered FlexNet Embedded License 
Server

You can add a FlexNet Embedded license server in the Producer Portal or in the Enterprise Portal, but you can 
also create an unregistered server by submitting an activation request to the FlexNet Operations back office. The 
request must include an activation code and host information. When it receives such a request, the back office 
creates the license server and maps the activation code to that server with the requested quantity.

The back office processes activation requests from unregistered servers by using the default server host type 
(typically, FLX_SERVER). FlexNet Operations ties that server host type to each license server created through this 
process—thereby defining the server’s identity.

Note • The pre-defined server host type, FLX_SERVER, is associated, by default, with the first identity a producer 
creates.

Using Server Sync to Send License Transaction Data to the 
Back Office

As transactions occur between FlexNet Embedded servers and FlexNet Embedded devices, the FlexNet 
Embedded server incrementally updates the data it stores about the status and activations of its devices. When 
syncing is enabled, the server syncs with FlexNet Operations. The transmittal of sync data to FlexNet Operations 
is configured by device manufacturers when configuring the FlexNet Embedded license server.

With each sync, you gain valuable visibility—in the FlexNet Operations back office—into how your customers are 
using the served client devices and what features they are using on them.
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Note • You can view the sync messages by viewing the device’s history. The history of a FlexNet Embedded server 
shows sync messages related to all its served clients while the history of a served client shows only the 
messages specific to that client device

Advanced Topics
This section provides information on advanced topics.

Table 9-6 • Advanced Topics

Section Description

Device Series and Device Model 
Concepts

Illustrates the role of device series and device models in FlexNet 
Operations.

Creating Device Series and 
Device Models

Describes the steps to create a device series and a device model.

Mapping an Add-On Using an 
Activation Code

Describes the steps to map an add-on using an activation code and the 
.NET Toolbox device application.

Your Endpoint Explains the endpoint value to use with FlexNet Embedded devices that 
communicate with the FlexNet Operations back office.

Device Creation Describes the ways a device can be created.

Offline Activation Describes the steps to use offline activation for a device that is not 
connected to the Internet.

FlexNet Embedded License 
Models

Describes the steps to create a customized FlexNet Embedded license 
model.

Digital Signature Algorithm Describes the digital signature concept and which algorithms are 
supported.

Counted and Uncounted 
Capabilities

Describes the difference between counted and uncounted capabilities.

License Formats Defines the two ways to save license data and compares the three options 
to configure license format when creating a device model.

Viewing Device and License 
Server Request History

Shows how to view the request history in the Producer Portal

Vendor Dictionary Describes the vendor dictionary and the steps for how to view it.
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Device Series and Device Model Concepts
To understand the basic concepts of using FlexNet Embedded licensing in the cloud-hosted edition of FlexNet 
Operations, use the following example use case where Acme Networks, Inc. is a manufacturer that has created a 
series of VPN devices that includes three device models. The procedures to follow in Quick Start Example  
reference this example to explain how to create these device series and device models and then map capabilities 
to customers.

Figure 9-10: Device Series and Device Models

• Device Series—A collection of device models that are physically identical but upgradable in the field through 
license changes and add-on capabilities. In the Device Series and Device Models figure, VPN 5000 is an 
example of a device series.

A device series sets the maximum limits for device capabilities and capacities. In this example, all device 
models within the VPN 5000 device series can have

• No more than 10,000 simultaneous users

• No more than 100 Mbps of throughput

• Redundancy enabled or disabled

• Device Model—A base model for a device that manufacturers use to create a base license. A base license 
defines a set of capabilities within the maximum limits for the device series. The device model with that 
particular base license represents a purchasable configuration for a device. In In the Device Series and 
Device Models figure, VPN 5005, VPN 5020, and VPN 5050 are all device models and part of the VPN 5000 
device series. They each define and represent a different set of capabilities.

In this example, the VPN 5050 device model includes:

• 5,000 simultaneous users

• 50 Mbps of throughput
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• Redundancy Enabled

• Add-On—A catalog item you create to represent a license change that grants additional capabilities or 
capacity for a device. In this example, an add-on might include 1,000 simultaneous users and 10 Mbps of 
throughput.

Creating Device Series and Device Models
This section describes the tasks to create a Device Series and Device Model using the Producer Portal.

• Adding a Device Series

• Adding a Device Model

These tasks include some example suggestions based on the example presented in Device Series and Device 
Model Concepts.

Adding a Device Series
A device series is a collection of device models that are physically identical but upgradable in the field through 
license changes and add-on capabilities. A device series sets the maximum limits for device capabilities and 
capacities.

Tip • A pre-defined device series, FLX_CLIENT_SERIES, is provided for all producers. Those producers who do not 
require the additional complexity of defining multiple device series and device models can leverage the 
FLX_CLIENT_SERIES instead of creating their own device series.

Use the following steps to add a device series using the capabilities you created.



Chapter 9 FlexNet Embedded Licensing
Advanced Topics

300  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Task To add a device series:

1. Select the Manage Hosts menu then click Add Device Series.

2. Type a unique identifier for the device series in the Name field. For this example, use VPN5000.

3. Type a description in the Alias field. For this example, use VPN5000 series.

4. Under Add Capabilities, click the arrow next to the drop-down menu then select each capability you created 
then click Add (SimultaneousUsers, EncryptionThroughput, Redundancy).

5. Type the maximum units for each counted capability for the Device Series. For this example, type 10,000 for 
SimultaneousUsers, and type 100 for EncryptionThroughput.

Note • The maximum unit for uncounted capabilities, like the Redundancy capability, defaults to Enabled.

6. Click Submit and Add a Device Model.

Adding a Device Model
A device model is a base model for a device that producers use to create a base license. A base license defines a 
set of capabilities within the maximum limits for the device series. The device model with that particular base 
license represents a purchasable configuration for a device. If a model has a certain capability, that capability can 
be increased to what is defined as the maximum in the series.
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Tip • A pre-defined device model, FLX_CLIENT, is provided for all producers. Those producers who do not require 
the additional complexity of defining multiple device series and device models can leverage the FLX_CLIENT 
instead of creating their own device models.

Figure 9-11: Add Device Model - VPN5050

Note • The following steps assume you have just completed the steps in Adding a Device Series and clicked 
Submit and Add a Device Model to open the Add Device Model page. If not, you must first open the Add Device 
Model page by clicking Manage Hosts > Add Device Model.
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Task To add a device model:

1. Type a unique identifier for the device model in the Model Name field. For this example, use VPN5050.

2. Type a short description of the device model in the Alias field. For this example, use VPN5050.

3. Select a Default Host ID Type. For this example, use STRING.

4. Select a license format using the License Format radio buttons. For this example, choose Base license and 
add-ons in trusted storage.

Note • For more information about license formats, see License Formats.

5. Select a device series from the Device Series drop-down menu. For this example, select VPN5000.

6. Select a publisher from the Publisher Identity drop-down menu. Use the publisher you created in Setting Up 
a Publisher.

7. Select Default Device License Model from the License Model drop-down menu.

Note • The license model you choose here is used as the license model for all devices of this model. For more 
information on creating and using license models, see FlexNet Embedded License Models.

8. Under Capabilities, configure the capabilities associated with this device model. For this example, type 5000 
for Number of Simultaneous Users, 50 for Encryption Throughput, and select the Redundancy checkbox.

Note • For this example, leave the Default checkbox unchecked. Checking Default would make this device 
model the default device model for all devices created without specifying a device model.

Important • Once you add a device model, most device model settings become fixed. For existing device 
models, you can alter only the Notes and Alias fields and the Default checkbox.

9. Click Add Device Model.

Mapping an Add-On Using an Activation Code
Using the .NET Toolbox device application, you can map an add-on with an activation code. Use the following 
steps to map an add-on with an activation code.

Task To map an add-on using an activation code:

1. From the Producer Portal, select the Manage Hosts menu then click List Identities.

2. Click the Identity Name. This opens the identity’s View Identity page.
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3. Under Identity Files, find Download Client Identity and click Binary File. Download behavior varies depending 
on the web browser you are using.

4. Save the binary client identity file (IdentityClient.bin) to your machine.

5. Open the .NET Toolbox device application from <installdir>\bin\demo\toolbox\DotNetDemo.exe. The Setup 
tab appears.

6. Click the folder icon next to the Identity File field and browse the location where you saved the client identity 
.bin file. Double-click the .bin file. The file path is populated in the Storage Path field.

7. Click Set. When the identity data is set, the Host Identification fields are enabled.

8. For Host ID Type, select Custom string.

9. For Host ID, type the Device ID of the device you created in Adding a Device. For this example, use VPN5050-1. 
Click Set.

10. Type the device model name in the Host Type field. For this example, use the default device model name, 
FLX_CLIENT.

11. Type the device alias in the Host Name field. For this example, use VPN 5050 1.

12. Click the Server Requests tab.
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13. Select FlexNet Operations On-Demand from the Server Type drop-down menu. The Host, Port and Endpoint 
fields are updated.

14. Type <your_site_name>uat.flexnetoperations.com into the Host field.

15. Type the activation code for a particular add-on in the Rights IDs field and type the number of units in the 
Count field.

Note • This example shows 934A-8B48-CF66-7134 for the activation code and 1 for the count. This is an 
example only. You need to type the unique activation code for the add-on you are mapping.

16. Click Add. The activation code appears in the Rights ID column.

17. Click Send to send the request.

Your Endpoint
When you configure your FlexNet Embedded devices and servers, you must set the endpoint through which its 
communication with the FlexNet Operations back office will take place.

This endpoint is part of your FlexNet Operations Enterprise Portal, and the endpoint’s address may differ 
depending on your deployment model. FlexNet Embedded devices can communicate directly with the FlexNet 
Operations back office or they can communicate with a FlexNet Embedded server. That server can be hosted in 
Revenera’s Cloud License Service or deployed locally into your customer’s enterprises, and a local license server 
can communicate with the back office as well.

In the examples in this guide, we have used the demo Enterprise Portal endpoint:
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demouat.flexnetoperations.com/control/demo/deviceservices

In this case, the partner name, demo, is a key part of the address that distinguishes your portal from other 
producers.

When you create your own devices, you must use the endpoint specific to your organization. Your specific 
endpoint will follow the structures shown below, substituting your partner code and specifying an instance ID as 
necessary:

Device Creation
There are multiple ways to create a device. This section covers two typical scenarios for how a device is created.

Producer Creates Device
A producer creates a device using the Producer Portal. After creating the device using the Producer Portal, an 
owner can start using the device with one of the following methods:

• The customer claims the device through the Enterprise Portal using the Device ID.

Table 9-7 • Endpoint Examples

Structure Endpoint Examples

Device 
Communicating 
Directly With the 
FlexNet Operations 
Back Office

https://<partner_name>.compliance.flexnetoperations.com/deviceservices/

https://demo.compliance.flexnetoperations.com/deviceservices

Note • In this example, the partner name is demo.

Local License Server 
Communicating With 
the FlexNet 
Operations Back 
Office

https://<partner_name>.compliance.flexnetoperations.com/deviceservices/

https://demo.compliance.flexnetoperations.com/deviceservices 

Note • In this example, the partner name is demo.

The address that client devices use to communicate with a local license server depends 
on how the server was deployed. See the FlexNet Embedded License Server User Guide 
for more information.

Device 
Communicating With 
a Cloud-Based 
License Server

https://<partner_name>.compliance.flexnetoperations.com/instances/<instance_ID>

https://demo.compliance.flexnetoperations.com/instances/1N84CJQKFDB0 

Note • In this example, the partner name is demo and the license server ID (instance ID) is 
1N84CJQKFDB0.

Cloud-based license servers do not require any additional configuration to communicate 
with the back office.
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• The producer assigns a device owner through the Producer Portal after which the customer is able to access 
this device using their Enterprise Portal without claiming it.

Customer Claims an Unknown Device
A producer has made arrangements with Revenera to allow a process where a customer can claim an unknown 
device—a device that was not created using the Producer Portal. An unknown device can be claimed with one of 
the following methods:

• A device makes a capability request to the FlexNet Operations back office. This request contains both the 
device ID and the device model name.

• The customer claims the device through the Enterprise Portal using the Device ID. In this case, the 
assumption is that the device model can be derived from the device ID.

Offline Activation
Some devices may follow an offline activation model in which the device generates a binary license request file 
for an add-on license that can be manually uploaded on the FlexNet Operations Enterprise Portal.

FlexNet Operations processes the request file to generate a license appropriate for the request. If the license 
request is made for an existing device, FlexNet Operations generates a regenerative license. This means that 
each new response will contain the complete intended state of capabilities for the client and that calling the 
FlexNet Embedded library to process that response will overwrite any previous state which might have existed. 
Each capability response completely replaces any previous responses.

If the request is made for a new device, FlexNet Operations enters the device into the system, adds the 
corresponding add-on, and generates a license for it.

Task To upload a capability request file:

1. Generate a capability request file on the offline device and save to external storage.

Note • For more information on generating a capability request for offline devices, see the user guide for 
your FlexNet Embedded toolkit.

2. From the Enterprise Portal, select Upload Capability Request from the Devices menu.
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3. Click Browse.

4. Navigate to the capability request file where you saved it then click Open.

5. Click Send. You are prompted to download the activation response. 

6. Save it and load it into your application to activate.

FlexNet Embedded License Models
A FlexNet Embedded license model assigns default parameters for either a base license that is used to create a 
device model or add-on capabilities that are used to entitle an account. A license model specifies sources for the 
values of feature record properties in generated licenses.

Linking multiple license models to a single catalog item is allowed. If multiple license models are linked to a 
catalog item it will always be required to specify, at the time an order line is created, which of those multiple 
license models applies to the order line. If only a single license model is linked, then it is used by default.

Note • The ability to create or edit license models requires the right permissions. Only users with the Product 
Management (PDCT) permission can create license models. Only users with the Manage FlexNet Secret Keys 
(KEYS) permission can edit existing license models.

Use the following steps to add an FlexNet Embedded license model.
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Task To add a FlexNet Embedded license model:

1. From the Producer Portal, select the Manage Hosts menu then click Add FNE License Model.

2. Select one of the following License model for radio buttons, depending on the type of license model you 
want to create:

• Device base license—Use this when creating a base license for a device model.

• Entitlement line (including add-ons)—Use this when creating an add-on for account entitlement.

3. Type a short description for the license model in the Name field.

4. Make selections for the following parameters:

• Feature Version

• Expiration Date

• Start Date

• Issuer

• Notice

• Vendor String

• Serial Number

• Virtualization
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Note • Select Unused for parameters that are not used in your license model. Select Replacement String and 
type a string replacement for parameters that you want to refer to a variable. For example, type 
${account.name}. For more information about string replacements, see the help text.

5. Click Create Order Line License Model or Device License Model, depending on which license model type you 
selected.

Digital Signature Algorithm
When you create an identity, you select a digital signature algorithm, which will create a digital signature 
designed to prevent forgery and tampering on the device. FlexNet Operations and FlexNet Embedded support the 
following digital signature algorithms:

• License Key (LK)—48-bit proprietary algorithm

• Tamper-Resistant Licenses (TRL)—163-bit, or 239-bit elliptic curve encryption

• RSA—512-bit, 1024-bit, or 2048-bit RSA encryption

Counted and Uncounted Capabilities
When you create a capability, you configure it as one of two types: counted or uncounted. This configuration 
indicates whether the capability is limited to a specific number of units or is a capability that is turned on or off.

A feature can be counted, meaning that acquisitions of that feature may succeed or fail based on a count to be 
acquired, or uncounted, meaning that acquisitions of arbitrary count of that feature are allowed as long as the 
feature is present.

• Counted—This capability is limited to a specific number of units. The count is specified during the 
entitlement process.

• Uncounted—There is no limit to the number of times this capability can be deployed. It is a capability that is 
either enabled or disabled.

License Formats
FlexNet Embedded supports different ways of representing license rights on a system. A producer can create 
customized device models by combining the two different ways to store licenses: Binary Licenses and Trusted 
Storage.



Chapter 9 FlexNet Embedded Licensing
Advanced Topics

310  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Figure 9-12: License Formats

The following are the two ways you can store licenses:

• Binary License—Licenses can be stored as an array of bytes, either imported by license-enabled code during 
execution or compiled into the executable code. This type of license is typically node-locked to a particular 
device, and may contain an expiration date.

• Trusted Storage—License rights can be fulfilled or upgraded by a back office server, either online or offline. 
This type of license right is stored in trusted storage, a secure location bound to a particular device, and 
which supports verifiable returns to the back office server and subsequent transfer to a different device.

When you create a device model in FlexNet Operations, you can select one of three license formats:

• Base license in file, add-ons in trusted storage—The base license is stored to a binary file, and add-on 
capabilities are stored in trusted storage.

• Base license and add-ons in file—The base license and add-on capabilities are stored in a binary file.

• Base license and add-ons in trusted storage—The base license and add-on capabilities are stored in trusted 
storage.

These license formats are options on the Add Device Model screen:
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Figure 9-13: Adding a Device Model - License Formats

Viewing Device and License Server Request History
Use the following steps to view the history of all device and license server requests using the Producer Portal.

Viewing License Server Request History
To view license server request history, perform the following steps. 

Task To view license server request history:

From the Producer Portal, select the Manage Hosts menu then click Request History. The FlexNet Embedded 
Request History page displays the complete record of requests.

• The Request History page shows all requests but the results appear in a pages. You can set the number of 
requests per page to 25 (default), 50, 100, or 200.

• Request history results can be filtered by date or by ID. By default, the Request History page shows requests 
for all dates and request IDs.
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Filtering Request History Results
To filter the Request History results, perform the following steps.

Task To filter the Request History results:

1. On the Request History page, enter any date or ID values you want to use to filter the request history results.

• Max Request Time—Determines how recent the requests include in the request history results will be. 
No requests that occurred after the specified date are included in the results.

• Max Request ID—Limits the request history results according to the request ID. No requests with a 
request ID number higher than the specified request ID are included in the results. (Only numbers are 
possible in the Max Request ID field, and wildcards are not permitted.)

2. Click Get History.

The Producer Portal refreshes the Request History page to show only the requests that match the filters.
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Vendor Dictionary
The FlexNet Embedded capability request allows a device to communicate a vendor dictionary. This is a collection 
of name value parameters that are defined by the producer, such as GPS coordinates, time zone, and region. The 
vendor dictionary provides an interface for an implementer to send custom data in addition to the FlexNet 
Embedded–specific data from the device to server or vice versa. This data can be used in license-enabled code 
and the back office server to send information back and forth for any manufacturer-defined purposes, as needed.

Task To view a vendor dictionary for a device:

On the View Device page, select View Vendor Dictionary from the View menu.

Permissions
To perform specific processes using the Producer Portal, you must ensure you have the necessary permissions. 
The following table provides a list of permissions required for each process.

Table 9-8 • Permissions Required for FlexNet Operations Processes

Process Permissions

List Publishers Manage FlexNet Secret Keys (KEYS)

Add Publisher Manage FlexNet Secret Keys (KEYS)

List Publisher Identities Manage FlexNet Secret Keys (KEYS)

View Publisher Identity Manage FlexNet Secret Keys (KEYS)

Add Publisher Identity Manage FlexNet Secret Keys (KEYS)

Download Identity File Manage FlexNet Secret Keys (KEYS)

List Capabilities Basic View Access (PTNR)

Add Capability Product Management (PDCT)



Chapter 9 FlexNet Embedded Licensing
Permissions

314  FNOLLM-PPUG02 FlexNet Operations LLM Producer Portal User Guide

Update Capability Product Management (PDCT)

List Device Series Basic View Access (PTNR)

View Device Series Basic View Access (PTNR)

Add Device Series Product Management (PDCT)

Edit Device Series Product Management (PDCT)

Search Device Models Basic View Access (PTNR)

View Device Model Basic View Access (PTNR)

Add Device Model Product Management (PDCT)

Edit Device Model Product Management (PDCT)

Add Device Device Management (DVCM)

Search Devices Basic View Access (PTNR)

View Device Basic View Access (PTNR)

View Device History Basic View Access (PTNR)

Edit Device Device Management (DVCM)

Assign Device Owner Device Management (DVCM)

Return Device Device Management (DVCM)

Obsolete Device Device Management (DVCM)

Move Device Device Management (DVCM)

Generate License File Device Management (DVCM)

Download License File Basic View Access (PTNR)

View (Print) License File Basic View Access (PTNR)

Generate Capability Response Device Management (DVCM)

Upload Capability Request Device Management (DVCM)

Download Response Basic View Access (PTNR)

Table 9-8 • Permissions Required for FlexNet Operations Processes

Process Permissions
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View (Print) Response Basic View Access (PTNR)

Configure Add-On Product Management (PDCT)

Map Add-Ons Device Management (DVCM)

Remove Add-Ons Device Management (DVCM)

Add License Model Product Management (PDCT)

Edit License Model Manage FlexNet Secret Keys (KEYS)

List License Models Basic View Access (PTNR)

View License Model Basic View Access (PTNR)

Add Server Device Management (DVCM)

Search Servers Basic View Access (PTNR)

View Server Basic View Access (PTNR)

View Server History Basic View Access (PTNR)

Edit Server Device Management (DVCM)

Update Server Owner Device Management (DVCM)

Map Add-Ons Device Management (DVCM)

Remove Add-Ons Device Management (DVCM)

Obsolete Server Device Management (DVCM)

Move Server Device Management (DVCM)

Generate Capability Response Device Management (DVCM)

Upload Capability Request Device Management (DVCM)

Download Response Basic View Access (PTNR)

View (Print) Response Basic View Access (PTNR)

List Server Host Type Basic View Access (PTNR)

Add Server Host Type Device Management (DVCM)

Table 9-8 • Permissions Required for FlexNet Operations Processes

Process Permissions
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View Server Host Type Device Management (DVCM)

Edit Server Host Type Device Management (DVCM)

Table 9-8 • Permissions Required for FlexNet Operations Processes

Process Permissions
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Usage Search

You can use Usage Search, which is opened by selecting Track Usage > Usage Search, to find the usage and drill 
down to various statistics and graphs.

Figure 10-1: Usage Search Panel

You can search by:

• Account ID—The Account ID from the customer account.

• Usage Threshold—Minimum usage percentage (number between 1 and 100).

• As of Date—The date limit for usage reports. Reports that occur after the specified As of Date value are 
excluded from the search results. 

• Product Line—The product line for which you want to see usage.

• Meter Name—The name of the meter (typically feature name) for which you want to see usage.
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Note • You cannot leave the As of Date field empty, but the other fields can be left blank.

After filling in the search field and clicking Search, results are displayed on the Usage Search page:

Figure 10-2: Usage Search Page
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User Defined Fields (UDFs)

User Defined Fields (UDFs) are additional customized fields that may be added to expand the FlexNet Operations 
LLM service. They can be displayed to End Users through your FlexNet Operations LLM site or simply be used for 
reporting purposes. UDFs can be set at the following levels: Account, Member, Entitlement, Order Line, Catalog 
Item, Product, and File. The purpose of this document is to provide some examples of how UDFs have been used 
by our Customers to-date, which are described in the following sections: 

• File Sorting and Filtering on Download Page (File Level UDFs)

• Additional Site Navigation (File Level UDFs)

• Additional File Display Option (File Level UDFs)

• Keywords (Product Level UDFs)

• Documentation Only Members (Member Level UDFs & File Level UDFs)

• Contract Number (Entitlement Level UDFs)

• Geographic Location Indicator (Account Level UDF)

Please contact your Account Manager / Project Manager if you have any questions or if you are interested setting 
up UDFs. Please note that adding UDFs and/or changing your FlexNet Operations LLM service (as described 
below) could possibly incur professional services fees. 

File Sorting and Filtering on Download Page 
(File Level UDFs)

When Customers have a large number of Files associated to a Product, the Download Page can become 
cumbersome for the end user. To assist in locating Files, the Customer can create any number of File level UDFs 
that can be used to filter what is displayed on the Download Page. The end user will be able to select from a list of 
potential values for these fields, one value per field, and filter the Files displayed on the Download Page by what 
they have selected (this approach is sometimes also known as parametric search). In addition, the value for each 
of the newly added fields will be displayed in new columns in the File information section of the Download Page, 
and all columns on the Download Page will be sortable by clicking on the column header, or clicking again to 
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reverse sort order. Scenario: End users could locate Files with a critical priority for the Windows platform (where 
priority is a File level UDF with possible values of critical, high, standard and where platform is a File level UDF 
with possible values of Windows, Solaris, Linux, etc.).

Additional Site Navigation (File Level UDFs)
When Customers have Products that they entitle to end-users that contain more Files than may apply to each 
individual end user, they may wish to add additional pages of navigation between the Product Page and the 
Download Page. For example, if a single Product contains Files for many different OS platforms and database 
platforms, the end user may only wish to see Files that apply to Windows 2000 and Oracle. To do this, the 
Customer may create any number of File level UDFs and add one layer of navigation between the Product and 
Download Pages for each of those File UDFs.

Additional File Display Option (File Level UDFs)
Customers may wish to have different File types displayed on different pages. For example, a File level UDF could 
be used to distinguish between software and documentation. The end users would be able to view these 
documentation and software Files on separate page views, with a toggle to view Files of the other type. 

Keywords (Product Level UDFs)
Customers may wish to include additional information for end users to be able to search for Products on the 
FlexNet Operations LLM service. Product level UDFs could be used to allow inclusion of multiple Keywords and 
the search indexes could be updated to include these Keywords.

Documentation Only Members (Member Level 
UDFs & File Level UDFs)

Customers may wish to prevent certain end users from viewing particular Files. A File level UDF could be used to 
distinguish between software and documentation and a Member level UDF could be used to distinguish which 
end users can view documentation only Files.

Contract Number (Entitlement Level UDFs)
Customers may wish to include additional references for an Entitlement. An Entitlement level UDF can be used to 
represent a contract number between the Customer and the Customer’s Accounts.
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Geographic Location Indicator (Account Level 
UDF)

Customers may wish to include additional information about their Accounts. An Account level UDF can be used to 
represent the geographic location of the Account and be used for reporting purposes to view regional activity.
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FlexNet Operations LLM Support 
Process

Revenera supports all issues related to the FlexNet Operations LLM service. Revenera attempts to provide 
vendor-neutral support - that is, the Member requesting support is not aware that the support is being provided 
by a third party entity, rather than the Customer. Revenera encourages collaboration with the Customer’s support 
group to facilitate effective transition of incidents to the appropriate point of resolution and to expedite issue 
closure. This document is a high level summary of the Revenera FlexNet Operations LLM support process.

In the case that a section in this document does not apply to you, please consult your contract for your specific 
information.

• Accessing Support

• Support Commitments

• Escalations Between Revenera and Customer Support Groups

• Tools for Your Customer Support Organization

• Support Reports

Accessing Support
Members of FlexNet Operations LLM are provided an intuitive user interface, FAQs and a User’s Manual as self-
help tools to address questions they may have about the service. In the event that the user cannot resolve their 
question or issue, information is provided in the FAQs and User’s Manual on how to access a support 
organization—the Customer’s support group, or Revenera’s support group. Additionally, if the user experiences 
an error situation within the service, they are always provided the option to contact support about the issue. 
Typically, the following text is presented to the Member as part of the User’s Manual:

Contacting [Customer] for Support

For [Customer] product-related questions, contact [Customer’s Support Organization] by email 
[support@customer.com] or call [customer 800 phone number] (from within the U.S.) or [customer 800 
phone number] (from outside the U.S.).
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For help downloading or questions regarding your [FlexNet Operations LLM Service Name] account, contact 
[customer]@flexnetoperations.com or call 1-888-715-4687 (from within the U.S.) or 1-408-642-3965 (from 
outside of the U.S.).

For urgent download issues outside of U.S. business hours, you can page the on-call support representative 
by calling the phone numbers listed above.

Support Commitments
Revenera Support will provide a combination of email-based and telephone-based support on issues related to 
the FlexNet Operations LLM site up to and including product download. 

Customers and FlexNet Operations LLM Members may contact Revenera Support by email or telephone at any 
time, 24x7x365. Revenera Support staff will be available for live-answer telephone and email support between 
the hours of 6:00 PM Sunday – 6:00 PM Friday Pacific Time on U.S. business days. 

Revenera will provide telephone responses to after-hours pager notifications for critical issues on weekends and 
U.S. holidays. Revenera will respond to the FlexNet Operations LLM Member page within 30 minutes of receipt 
and will begin research and resolution within 30 minutes of discussing the incident with the Member. 

Non-urgent voicemail will be returned during the day or starting at 6:00 PM Pacific Time the day before the next 
business day if the voicemail is from the weekend or holiday. Email will be returned within 24 business hours of 
receipt. Support will be provided in English.

FlexNet Operations LLM Members contacting Revenera regarding technical support for Customer Products will be 
referred to the appropriate Customer’s technical support organization, thereby transferring resolution ownership.

Phone Routing
Inbound telephone calls are received on a dedicated Revenera Support line (with an additional toll-free number 
available for all US callers). During business hours, all support calls to these numbers will be automatically 
directed to the Revenera Download Support representative who is “next-available” on the phone system. If all 
representatives are busy assisting other callers, or if call is placed outside of business hours, the caller will be 
directed to a dedicated Download Support voice mailbox, where they can leave a message. The voice message 
also contains instructions on how to page the on-call Download Support representative.

Note • Any incident involving a suspected security breach or outage of the FlexNet Operations LLM Application 
should be reported immediately, using the Revenera Customer Support line or pager, as needed.

Email Routing
Email is directed to the Support group through a Customer-specific email alias listed on multiple pages on the co-
branded web sites (example: [customer]@flexnetoperations.com). All Support email correspondence for the 
Customer’s FlexNet Operations LLM site will be done through the Customer-specific email alias, and will contain 
instructions specific to the inquiry.
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Incident Tracking
All telephone calls and emails will be entered into the Support Incident Tracker system and assigned to a support 
representative. This support representative will be responsible for tracking and reporting on each incident until 
resolved. All events are documented in the Resolution field of the Incident Tracker and the field is updated as 
status changes.

For a list and descriptions of incident types tracked by the Revenera Support group, see the end of this 
document.

Internal Escalation Process
Incidents that are not resolved during the initial contact with a Revenera Support representative will be escalated 
to internal technical experts based upon severity level. The support staff will manage escalated incidents. If a 
FlexNet Operations LLM Member is dissatisfied with the response from their initial support staff, they may 
contact a Support team leader. If the Support team leader is unable to resolve the issue, the Member may contact 
the Senior Manager of Client Services, and ultimately the Director responsible for the Revenera Download Support 
group.

Escalations Between Revenera and Customer 
Support Groups

The Revenera Support group will take responsibility for resolving incidents directly related to the FlexNet 
Operations LLM service itself. Incidents regarding product technical information, product entitlement, or Member 
accounts will be directed to the Customer’s appropriate support group. Similarly, incidents that the Customers’ 
support group(s) receives related to the FlexNet Operations LLM service are typically forwarded to Revenera 
Support for resolution.

Tools for Your Customer Support Organization
Your Customer Support organization has the ability to use FlexNet Operations LLM Producer Portal to log in, see 
product hierarchy, and access clickable links in the same way that your End User (member) can.

The following displays the FlexNet Operations LLM Producer Portal interface:

 

Figure 12-1: View As End User Option
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Once you select the View as End User menu option, a new window opens with a read only view of the End User’s 
FlexNet Operations LLM account. In this window, you can see everything that the member can see, such as 
Product List, Files, any applicable License Information, and left navigation bar options, etc. This view allows you 
to bypass an End User License Agreement to see the product list page. The license agreement remains in place 
for the member. The following displays the user interface wrapper: 

Figure 12-2: End User Portal Example

Note • This is a permission-based view.

Support Reports
All support incidents recorded by Revenera Support for a Customer can be viewed by the Customer by requesting 
a report from the Customer Account Manager that will be generated from Revenera’s Customer Support Center. 
Data in the reports is live and always up to date.
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Revenera Support Incident Types
This table lists out the incident types used by the Revenera Support group to classify all support incidents 
received by phone or email. A brief description of how each incident type is used is also included.

Table 12-1 • Type of Incident 

Incident Type Brief Description

Add Members to Account • Add/replace member on existing account requests.

• Service access requests and account for company already in 
system.

• Add other person(s) to email notification mailing list.

Com/Ques on Site, Srvc or Nav

Connection Prob/SSO Issues • Site down.

• Member network issue.

• SSL issue (member can not connect to secure site).

• Single sign on issues.

Download Accelerator Issue  Accelerator not installing/working.

Download Difficulties • Download not completing/too slow.

• FTP access restricted by member's firewall.

• Help with advanced download options.

Edit Profile Edit member profile (company name, address, name, and phone 
numbers).

Email Address Change Change/correct member email address.

Email Pref Change / Notify Ques • Unsubscribe from update notifications (turn emails off).

• Not receiving update notifications (turn emails back on).

Enhancement Request  Request change on the SNet site.

Entitlement Question • New account request (incl. request for service access and 
account for company is NOT already in system).

• Product/version missing from account.

• Order inquiry (e.g. what was order for, when was it placed, 
etc.)

• Entitlement date change/inquiry.

• Limited downloads issues/inquires.
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Export Compliance Issue • Restricted entity/person blocked from downloading.

• Temporary/Restrictive export classification for product 
blocking downloads.

• Missing/Wrong export classification for product blocking 
downloads.

License Generation Issue • Does not understand how to generate license.

• Cannot find license file once generated.

• Wants to return/regenerate license and cannot.

Media Order Question Physical media requests/order inquires.

Merge Accounts • Merge multiple accounts for same company.

• Move member added to wrong account.

New Account Request Add account to service.

Non-SNet Related Issue • Inquiries not related to service or products on service (e.g. 
company information queries, etc.).

• Inquiry that should have been answered by customer’s 
support and was misrouted to us.

Operator Error

Password • Has not received/has forgotten password (incl. request for 
service access and member is already set up with access).

• Password change/re-set requests/inquiries.

Privacy Inquires Privacy statement inquiries.

Privilege Change • Add/Remove download privileges and administrative 
privileges.

• Restrict access to software inquires/requests.

Product Information Query • Product availability/release schedule.

• Product functionality/compatibility questions.

Re / Deactivate Acct or Member Reactivate/Deactivate member(s) on account (or entire 
account).

Registration Issue For registration only sites.

Table 12-1 • Type of Incident 

Incident Type Brief Description
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Request Copy of Invoice/Order Wants a printed copy of invoice or order.

Reset Download Limit Requests for more downloads after reaching their download 
limit.

Sales Question Wants to place order/renew license agreement.

Serial Number • Serial/License/Installation Key/Code/Number requests.

• Can locate serial number on site.

• Have not been sent serial number/re-send request.

• Does not know which serial number to use/serial number 
does not work.

• Serial number missing from site.

Site Problem/File Issues • Product hierarchy/image set up issues.

• Site problems (e.g. web site bugs, broken functionality, 
unexpected errors, etc.)

FlexNet Operations On-Demand 
Producer Portal

• Issues/Inquiries pertaining to the FlexNet Operations On-
Demand Producer Portal site.

• Entitlement process issues (incl. issues with automated 
transaction feed).

FlexNet Operations On-Demand 
Reporter

Issues/Inquiries pertaining to the FlexNet Operations On-
Demand Reporter site.

Technical Support • Issues that occur past the point of download completion.

• Technical product issues/questions.

Unzip Difficulties Requires help unzipping or uncompressing acompressed file 
downloaded from SNet.

Table 12-1 • Type of Incident 

Incident Type Brief Description
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Administer

If you have appropriate permissions, you can use items on the Administer menu to perform the following tasks:

Email
FlexNet Producer Portal can generate many types of email messages. This section of QA Producer Portal allows 
you to view, edit, copy, and resend those messages. You can also create and send Product and File Update 
Notification Messages.

The QuickSearch Box lets you search for emails based on the recipients' email address, on the email status (Draft, 
Queued, or Sent), and on the Email Type (e.g., Entitlement Email, Password Finder, etc.). If you enter more than 
one search criteria the QuickSearch will find the messages that meet all of the criteria you entered.

FlexNet Producer Portal can generate email messages based on a number of events. If you want to view, copy, or 
edit emails you can find the ones you are looking for based on a number of attributes, either using the 
"QuickSearch" bar above or by selecting Search Emails and using the full search functionality.

Table 13-1 • Administer Menu

Item Description

Email Access the email templates which QA Producer Portal uses to build the 
messages that are sent to your customers.

Email Templates Manage email templates. 

HTML Content Access additional HTML content that is used in customizations of your 
FlexNet Producer Portal service.

User Defined Fields Manage the User Defined Fields which can be added to expand your QA 
Producer Portal service.
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When you are working with an email message you will see the EMAIL menu at the top of the screen. Depending 
on your personal permissions, the EMAIL menu allows you to View or Copy an email message. If the message 
hasn't been sent you can also Edit the Email, or Edit the Distribution List. If the message has been queued but not 
yet sent, you can remove it from the queue to edit.

Search Emails
In order to view or edit an email message you must first find the one you want. You do this through the Search 
Emails form which is accessed directly from the menu of the "Email" tab of QA Producer Portal.

You can search for a transaction based on any of the following groups of attributes. 

Attributes of the Email Message
• Unique System Email ID

• Email Type (such as Welcome Email, Product Notification, etc.)

• Email Subject

• Status - Draft, Queued, Sent

• Send Date

Attributes of the Member Receiving the Email
• Member ID

• System Member ID

• Email address (e.g., member@company.com)

• Receipt status (Not Sent, Sent Unconfirmed, Sent Confirmed, Sent Failed, User Email Preference off)

Attributes of the Product or File (for Update Notifications)
• Product/File ID

• System Product/File ID

• Product Name

• File Description

Attributes of the Entitlement (for Entitlement-Related Emails)
• Entitlement ID

• System Entitlement ID

You can use the "*" wildcard except in the numeric System ID fields. Click on the Search button on the bottom of 
the form to start your search. If your criteria match more than one email message you will be shown a list of 
matching transactions and will be able to select the one you want.
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Create Product/File Notification Email
You can create Product or File Notification emails which are sent to users who have entitlement to one or more 
Products or Files, respectively, typically to inform them of updates to the products they own.

To send an update notification you first build a distribution list - the list of Members who will receive the email. 
Since the distribution list is based on entitlement to Products or Files you first have to identify which Products or 
Files you want to use. You are given the choice of either listing them explicitly or searching.

You can search for Products based on:

• Product ID

• System Product ID

• Product Name

• Version

• Availability (Archived, Currently Available, Not Yet Available)

• Product Manufacturer

• Product Line

• Date Created

You can search for Files based on:

• File ID

• System File ID

• File Description

• File Name

• File Status (Loaded or Not Loaded)

• Date Created

If you choose to search for Products/Files matching some criteria, the system will display a list of the search 
results. Click on the Notify checkbox for each of the ones you want to use in building your distribution list. Once 
you click on the Submit button on the bottom of the form you are given some additional distribution list options.

The Distribution List Options form displays the default message headers and the list of Products/Files used to 
build the distribution list. You can set the effective date, namely the date when a member's entitlement must be 
active in order for them to receive this email message. If you plan to send this email in the future, you should 
specify the date when the email will be sent out to ensure any members that have entitlements that are not yet 
active will be included in the distribution list. You can also include expired entitlements by clicking on the 
checkbox.

Finally, you can list one or more email addresses to be excluded from the distribution list Email address filters use 
* as the wildcard and multiple filters can be included separated by commas, such as: *@intraware.com, *.gov.

When you click the Submit button on the bottom of the form, the system will combine the pre-defined email 
template with the distribution list you have built and begin generating the list of member email addresses for the 
distribution list. In the meantime the system will display the draft message in the View Email screen. 
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At this point, you can send the message in its current format or you can Edit the Distribution List, Edit the Email 
itself, send a preview copy of the message, or make a Copy of the Email to work on separately.

Create Email
If you want to send an AdHoc Email and want it to be logged in the QA Producer Portal application, you can 
choose Create Email. You can enter the Subject and the Body Content and will also have to add the email 
addreses that you want to receive the email.

By default, the recipients of AdHoc Emails are all BCC'd since they would otherwise see each other's names on 
their copy of the email message. You should generally not directly address or “CC” a large number of recipients 
because one or more may accidentally “reply to all” which will generate copies of the reply to everyone on the 
distribution list.

View Email
The View Email page shows the Email header and related information, including the Status of the Email - which 
can be Draft, Queued, or Sent. The View Email page also shows the Distribution List, namely the list of Members 
who should get the email message.

For each recipient on the Distribution List the View Email page shows the:

• Type—Whether this recipient is a To, CC, or BCC.

• Email address—The actual Internet email address that the system sends the message to.

• Send Status—Sent, Not Sent, Email Preference Off.

• Response Status—Confirmed, Failed, or Unconfirmed.

Both the Text and HTML version of the message Content (if they exist) are displayed on the View Email screen. 
Note that users will generally only see one of these, depending on how their email client is configured.

The View Email screen also lets you send a Preview copy of the email message. To send yourself or someone else 
a copy of the message enter one or more valid email addresses in the text box. This is a useful final check 
particularly if you are working with an email that will be sent to a large number of members.

Edit Email
If an email message has not been sent (i.e., the status is Draft) you can edit the content of the email by selecting 
Edit Email from the EMAIL menu. 

Note • To edit an Email which is Queued but hasn't been sent, you can use the EMAIL menu to Remove Email 
From Queue and then Edit Email. Once an email has been sent, you can neither Edit the Email nor Edit the 
Distribution List.

The Edit Email screen lets you modify the content of the Subject line as well as the Text and HTML version of the 
content. You can also edit the Note, which lets you add descriptive text to help you manage your email messages.
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When you click on the Preview Text and Preview HTML buttons the system displays a preview of each type of 
message respectively. 

• Click on the Save Changes button to save your changes and return to the View Email page. 

• Click on the Cancel button to abandon your edits. 

Note that unless you click on the Save Changes button, your edits will NOT be saved.

Edit Distribution List
Recipients of an email message my either be directly addressed (To), copied (CC), or blind copied (BCC). By 
default the recipients of Update Notifications are all BCC'd since they would otherwise see each other's names on 
their copy of the email message. You should generally not directly address or CC a large number of recipients 
because one or more may accidentally “reply to all” which will generate copies of the reply to everyone on the 
distribution list.

You can add one or more additional recipients for an email message by typing their email address(es) and 
clicking the Add button. Each time you click the Add button the names you just entered are added to the list and 
you are given the opportunity to add more names. You will need to add each type of recipient, To, CC, and BCC, 
separately.

You can change the recipient type for each email address on the distribution list using the Type dropdown box 
next to the user's email address.

To delete a user from the distribution list click on the Delete checkbox next to the user's email address.

You must click on the Submit button on the bottom of the form for your edits to take effect.

Note • You may not be able to edit a distribution list immediately after creating a Product or File notification since 
it may take a few minutes to generate the distribution list and a distribution list can't be edited while it is still 
being generated.

Copy Email
The Copy Email form allows you to make a new copy of both the content and the distribution list of an existing 
email message. When you click on Copy Email from the EMAIL menu you are presented with a Copy Email form 
that lets you filter the distribution list based on the recipient status before making the copy. You can choose to 
include/exclude:

• Not Sent

• Sent and Confirmed

• Sent and Unconfirmed

• Sent and Failed

• Email Preference Off

When you click Submit at the bottom of the form, you will see your new message in the View Email screen. You 
will also see a status message informing you that the email was successfully copied. In the System Email ID field 
you will see both the new message's ID as well as the ID of the message from which it was copied.
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Send Email
You can schedule email messages to be sent immediately or you can queue them to be sent at a later date and 
time. Before you can actually send the message you are forced to preview the message in the Send Email - 
Preview screen.

From the Send Email - Preview screen you can choose to Cancel the sending of the message, in which case you'll 
be taken back to the View Email screen, or you can proceed to Queue the Email message. If you scheduled the 
email to be sent immediately it will be picked up from the queue the next time the process runs (every few 
minutes). If you scheduled the email to be sent at a later date or time it will be picked up the first time the process 
runs after the scheduled date and time.

When you click on the Queue Email button you are taken back to the View Email screen. The screen also displays 
a confirmation that the message has been successfully queued.

As with the View Email screen, you can send a preview copy of your message to one or more email addresses 
using the Send Preview Email function at the bottom of the screen.

Remove Email From Queue
Whenever a queued message is displayed on the View Email screen the EMAIL menu includes the Remove Email 
From Queue option. If you select this option the View Email screen will be updated and you will see a status 
message informing you that the email has been removed from the queue. You may now Edit the email content 
and/or the distribution list. In order to re-queue the message select Send Email from the EMAIL menu.

Email Templates
The QA Producer Portal application allows you to change the templates that are used by the QA Producer Portal 
application to send email to the end user, your customer.

QA Producer Portal offers you flexibility in editing your Email Templates. Create the new text in draft and print for 
approval. In the mean time your template is saved in a Draft Status. Want to go back to the previous version? Look 
in your archived versions and change it into the Live version again.

There are three statuses that you need to know about

• Live—This template is used by the application to send out an email. There can only be one live template at a 
time.

• Draft—This template is in progress. Changes have been made but it is not ready to be used as the live 
template yet. You can only have one Draft.

• Archived—These templates were once live but have been replaced by newer versions. The system will keep 
these archived versions of your templates so you can always revert to an old version if needed.

You can also add new HTML content by clicking on Add HTML Content in the menu. However, this new content 
will not be used in your FlexNet Producer Portal service until customizations are made that use this new content. 
For information on how this content can be used contact your Client Relations Manager.
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Editing an Email Template
Select the template that you want to change. If you want to make changes to the Email Template version that is 
currently live, select the live version by either clicking on the word Live or on the Email Template ID in the first 
column.

If you were already working on a draft, you can select that one to continue your work, by clicking on the word 
Draft from the list. If you need to revert to an archived one, first select the Email Template by clicking on the Email 
Template ID and from the menu that then appears, select List All Versions. From this list you can select the 
archived version that you want to revert to and then select the option Edit as New Version from the Menu. 

Note • If you have saved a draft Template Version and you edit a live or archived version, you run the risk of 
overwriting the current draft version. The system will warn you about this.

An Email Template consists of:

• Address Information—You cannot change this information through this application. If you need changes, 
please contact your Client Relations Manager.

• From—Whom the email is sent from. The application uses an email alias specific to your site for this.

• Reply-to—Typically the same as the From. When the user replies to the email sent out by the system, this 
is the email address the email will be sent to.

• CC—Who will be CC-ed on outgoing emails, typically you find email addresses from your company as 
well as from Revenera on this. All people that want to monitor the correct working of your site.

• BCC—Same as CC and not be visible to the receiver of the email.

• Subject—The subject of the email, you can change this field.

• Body—The body of the email which you can also change. The body can be HTML content or text content. 
Depending on your preferences you can use one or the other. When you use HTML make sure you enter valid 
HTML since it will be sent out as HTML. (You can also write this content with an external HTML editor and 
then copy it into the body field). You can also choose to fill out both types of content in which case the 
receiver, your customer, will receive both types of content as well.

The text of the Body and the Subject consists of two types:

• Fixed text—Text that will be the same for all the receivers of the email, this is text that you can change.

• User dependent information—Information that will be different for each receiver of the email, like first and 
last name, company name, order number etc. This information is shown as a Merge Tag. 

• The email template contains the Merge Tags, and before the email is actually sent, these Merge Tags are 
replaced with the data specific to the recipient of the email. 

• You can place the Merge Tags in the body and the subject of the email. 

• The application lists the Merge Tags that are available for this email below the body of the email. To 
make sure you are not making any typos, we recommend that you copy the Merge Tag from the list and 
paste it in the body/subject. 

• Sometimes Merge Tags are required, meaning that you need to use the tag at least once in the body of 
the email.
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Repeating Blocks
The application allows you to set up repeating blocks of content, for example to display an order with multiple 
order lines. To do this, start by creating the content that you need for one order line. Then put the [[for-each]] tag 
at the beginning of this block and the [[end for-each]] at the end of the block. Here are three examples:

Nr Quantity Sku Description
[[FOR-EACH TAG="ORDERLINE"]]
[[LINE_NUMBER]] [[QUANTITY]] [[SKU]] [[SKU_DESCRIPTION]]
[[END FOR-EACH]]

Displaying Conditional Text Using IF
[[FOR-EACH TAG="ORDERLINE"]]
[[IF TAG="SKU" VALUE="cat1"]]
Thank you for ordering Catalog Item 1. Catalog Item 1 helps you get started
with XXXXXX Software. You need to install this software before installing any
other product from XXXXXXX.
[[END IF]]
[[IF TAG="SKU" VALUE="cat2"]]
Thank you for ordering Catalog Item 2.
[[END IF]]
[[IF TAG="SKU" VALUE="cat3"]]
Thank you for ordering Catalog Item 3. After downloading the software, contact
your vendor for the key code.
[[END IF]]
[[END FOR-EACH]]

Using the "no value" clause:

[[IF TAG="ORDER_UDF" CODE="ImmediateShip" VALUE="Yes"]] Here is the content for
the order emails with the ImmediateShip UDF set to Yes. [[END IF]]

[[IF TAG="ORDER_UDF" CODE="ImmediateShip" VALUENOT="Yes"]] Here is the content
for the order emails with the ImmediateShip UDF not set to Yes. [[END IF]]

[[IFNULL TAG="ORDER_UDF" CODE="ImmediateShip"]] Here is the content for the
order emails with no value (null) for the ImmediateShip UDF (when no
ImmediateShip UDF exists for the Entitlement). [[END IFNULL]]

IF tags can also contain nested ELSIF or ELSE sections. It is important to note that the ELSEIF and ELSE sections 
contain an END ELESEIF or END ELSE tag before the enclosing END IF. Below are some examples:

[[IF TAG="MEMBER_UDF" CODE="MBR_COUNTRY_CODE" VALUE="FR"]]
Bonjour!
[[ELSEIF TAG="MEMBER_UDF" CODE="MBR_COUNTRY_CODE" VALUE="DE"]]
Guten Tag!
[[END ELSEIF]]
[[ELSE]]
Hello!
[[END ELSE]]
[[END IF]]
[[IF TAG="ADMIN_PRIV" VALUENOT="true"]]
You must contact your site administrator for administrative privileges.
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[[ELSE]]
You are an administrator.
[[END ELSE]]
[[END IF]]

Displaying Conditional Text Using CHOOSE
CHOOSE blocks are an alternate way of expressing conditional logic. CHOOSE blocks are composed of WHEN sections 
where a tag can have a VALUE or VALUENOT test which behaves the same as IF conditions. CHOOSE blocks also have 
an OTHERWISE section. The text in the OTHERWISE section is included if none of the WHEN sections matched.

It is important that the WHEN and OTHERWISE sections have matching END WHEN and END OTHERWISE tags. Any tags or 
text that are included in between the CHOOSE and END CHOOSE tags that are not in a WHEN or OTHERWISE block are 
ignored.

Below are some examples.

[[CHOOSE]]
[[WHEN TAG="MEMBER_UDF" CODE="MBR_COUNTRY_CODE" VALUE="FR"]]
Bonjour!
[[END WHEN]]
[[WHEN TAG="MEMBER_UDF" CODE="MBR_COUNTRY_CODE" VALUE="DE"]]
Guten Tag!
[[END WHEN]]
[[OTHERWISE]]
Hello!
[[END OTHERWISE]]
[[END CHOOSE]]
[[CHOOSE]]
[[WHEN TAG="ADMIN_PRIV" VALUENOT="true"]]
You must contact your site administrator for administrative privileges.
[[END WHEN]]
[[OTHERWISE]]
You are an administrator.
[[END OTHERWISE]]
[[END CHOOSE]]

User Defined Fields in Email Templates
If you are using User Defined Fields (UDFs), you can also use these in your Emails. Look in the list of Merge Tags 
and see if you find a tag like this [[ORDER_UDF]] (for Member it will be MEMBER_UDF, account ACCOUNT_UDF 
etc.). If that tag is in the list of allowed tags, you can add any UDF that is defined on that level in your Email 
Template (in the example that would mean you can use Entitlement UDFs but not Member UDFs).

Since you can have many UDFs, you need to add the UDF-ID to the tag which UDF you want to use. If you don't 
know the value of the UDF-ID, go to the User Defined Fields section in the Producer Portal and select List UDFs. 
Here is an example showing how to use a member UDF to localize an email:

[[IF TAG="MEMBER_UDF" CODE="LANGUAGE_PREFERENCE" VALUE="US"]] Dear
[[FIRST_NAME]] [[LAST_NAME]],
Welcome to the XXXXXXXX Download Center, an online software delivery service
that helps you manage and stay current with your XXXXXXXX products. You are
receiving this email because [[ACCOUNT_NAME]] has purchased XXXXXXXX products.
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Here is the login and password to [[ACCOUNT_NAME]]'s XXXXXXXX Download Center
site:
Login ID: [[MEMBER_LOGIN]]
Password: [[MEMBER_PASSWORD]]
You may now access your software at https://XXXXXXXX.flexnetoperations.com/
The XXXXXXXX Download Center service provides the following features....
[[END IF]]
[[IF TAG="MEMBER_UDF" CODE="LANGUAGE_PREFERENCE" VALUE="FR"]] Cher, chère
[[FIRST_NAME]] [[LAST_NAME]],
Bienvenue sur le centre de téléchargement de XXXXXXXX, un service de livraison
de logiciel en ligne qui vous aide à gérer vos produits XXXXXXXX tout en
suivant de près leur évolution. Vous recevez cet e-mail car [[ACCOUNT_NAME]]
a fait l'acquisition de produits XXXXXXXX.
Voici l'identifiant et le mot de passe de [[ACCOUNT_NAME]] permettant
d'accéder au site du centre de téléchargement de XXXXXXXX:
Identifiant : [[MEMBER_LOGIN]]
Mot de passe : [[MEMBER_PASSWORD]]
Vous pouvez maintenant accéder à votre logiciel à l'adresse suivante
https://XXXXXXXX.flexnetoperations.com/control/XXXX_FR/index
Le centre de téléchargement de XXXXXXXX propose les fonctionnalités
suivantes....
[[END IF]]

Previewing an Email Template
Edit the Body and Subject and click Preview and Save. You cannot save an Email Template without previewing the 
Email. This allows you to see the email the same way an end user would receive it.

Before saving an Email Template, you are asked to preview the way the final mail message will appear to the 
recipient. During the preview we also check to make sure that you are not using Merge Tags that the application 
does not allow, and we make sure that required Merge Tags are placed at least once in the body of the email. If 
this is not the case, you are sent back to the Edit Email screen and no preview will be shown. If no errors are 
found, the application will show you what the email will look like for the end user, replacing the Merge Tags with 
preview values and in the case it is an HTML template, displaying it that way. Here are some common questions 
about this page:

• All the extra white space (like returns and extra lines) is not showing?—You are writing HTML mail and 
therefore you will need to use the <br> and <p> tag to create your line breaks and paragraph breaks.

• I want to include an image from my company, how can I do that?—Just use the image tag like you would on 
an HTML page but make sure that the SRC parameter is a full path that points to the image on your own 
webserver. There is no need to upload images to our webservers.

• I still see a Merge Tag. I thought they would be all replaced?—There is probably a typo in the brackets and 
therefore the application does not consider it a Merge Tag and will leave it unchanged. The Merge Tag needs 
to be opened and closed with a double square bracket like this [[MERGE_TAG]].

Look carefully through the email and make sure that all the Merge Tags are replaced with a preview value. Make 
sure that the sentences still make sense now that there is real content where the Merge Tag used to be. If you are 
happy with the result, you can save the Email Template, you have the choice to save it as a Live or as a Draft 
template. 

• Live—When you save it as a Live Template the QA Producer Portal application will use it for all the email of 
that type from then on. 
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• Draft—If you save it as Draft, you can go back to this version at a later time and (change it) and push it live. If 
you want to make more changes click Back to Edit.

HTML Content
This section of QA Producer Portal allows you to view, add, and edit HTML content that is used in customizations 
made to your FlexNet Producer Portal service.

You can list all HTML content available by clicking on List HTML Content, and can view the versions of this content 
by clicking on the System HTML Content ID of the content. The draft version of the content can be viewed by 
clicking on View Draft, and past versions can be viewed by clicking on List All Versions and then clicking on the 
Status of the version you want to view.

Like Email Templates, HTML content gives you the flexibility of saving a version in a draft status so you can 
continue work on the version later without affecting the current live content. If you need to revert to an older 
version, you can go back to a previous version and save it as a new live version.

There are three statuses you need to know about

• Live—This is the current version of content that appears on your FlexNet Producer Portal service. Only one 
version of each HTML content can be live at a time.

• Draft—This version is in progress. Changes have been made to this version, but those changes don't yet 
appear on your FlexNet Producer Portal service. Only one version can be draft at a time.

• Archived—These versions were once live but have been replaced with newer ersions.

You can also add new HTML content by clicking on Add HTML Content in the menu. However, this new content 
will not be used in your FlexNet Producer Portal service until customizations are made that use this new content. 
For information on how this content can be used contact your Client Relations Manager.

User Defined Fields
The User Defined Fields section of QA Producer Portal is used to manage additional fields beyond the standard 
set in QA Producer Portal.

Initially you can display a list of existing fields, sort the existing fields, or add new fields by clicking on List 
UDFs, Sort UDFs, or Add UDFs respectively. To view or edit a specific UDF, click on its UDF ID in the list. 

Contact your Client Relations Manager for more information on how to set up and maintain UDFs.

List User Defined Fields
User defined fields (UDFs) are grouped by their section (which is specified as “level” when adding or editing a 
UDF) in QA Producer Portal and are listed in sort order. To change the sort order, click on Sort UDFs in the menu. 
You can view and edit an individual UDF by clicking on its ID.
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Sort User Defined Fields
User defined fields (UDFs) are sorted by section (i.e., level) in QA Producer Portal. To change the order, enter 
numbers in the sort order boxes corresponding to the order in which the UDFs should display. This change will be 
reflected in QA Producer Portal and in the FlexNet Producer Portal site (if UDFs are available there). 

The ascending sequence of the numbers is what is evaluated to determine sort order. So, for example, entering 
the values of 1, 2, and 3 respectively in three fields will have the same sort order as the values 109, 114, and 
124. Click on the sort button for each individual section to re-sort that section.

Add User Defined Field
To create a new user defined field enter an ID and Name. Select which section or Level that the UDF belongs to. If 
the new UDF requires a value to be entered at the time of user input click on Yes for Required?. Two other options 
may be set: Multiple Values Allowed? and Predefined Values?. The table below demonstrates how the new UDF 
field will display in QA Producer Portal based on the entries in both of these options:

Once you have filled out the Add UDF form, submit it using one of the following buttons:

• Add UDF—Will create the UDF and then display it in view mode; a menu containing options to edit the UDF 
will appear.

• Submit & Add Another UDF—Will create the UDF and then return you to a blank Add UDF screen where you 
can then add another UDF.

• Submit & Add Values to this UDF—which will create the UDF and then automatically take you to the Add 
Predefined Values screen where you can begin adding values to the UDF you just created.

View User-Defined Fields
When you click on a UDF ID from the List UDFs page, the system will display the View UDF page. The view page 
displays all of the attributes of the UDF including any predefined values if they exist. 

From this page, you can choose to Edit the UDF, Edit Predefined Values, or Add Predefined Values from the View 
UDF menu.

Table 13-2 • Add User Defined Field

Multiple Values Allowed? Predefined Values? Field Type

No No Single text entry box

Yes No Multiple text entry boxes with a button to add more

No Yes Pulldown select list

Yes Yes Multi-select list box
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Edit User-Defined Fields
You can use the Edit UDF form to modify UDF Name, Required?, Multiple Values Allowed?, Readonly?, UDF Data 
Type, Validation Pattern, and Predefined Values?. The UDF ID is a special unique value which cannot be modified. 
Sort Order is only changed via Sort UDFs as the order of UDF display is in relation to other UDFs. See the Add User 
Defined Field section of this document for a table of implication on changing Multiple Values Allowed? and 
Predefined Values?.

Add Predefined Values
To create a new UDF predefined value enter a Value ID, Value Name and click on the Add Predefined 
Value button. To set the sort order and default value click Edit Predefined Values.

Edit Predefined Values
You can change the Value Name and Sort Order, inactivate and reactivate, and set the Default? of UDF predefined 
values on the Edit Predefined Values page.

To change the Value ID or Value Name simply enter in the new values and click the Edit Predefined Values button.

To change the order of display of the predefined values in the pulldown or multi-select box simply enter a number 
in the Sort Order column next to each predefined value that corresponds to the order of display. The ascending 
sequence of the numbers is what is evaluated to determine sort order. So, for example, entering the values of 1, 
2, and 3 respectively in three fields will have the same sort order as the values 109, 114, and 124. Click the Edit 
Predefined Values button to re-sort.

If a predefined value is active there will be a check mark in the Active? box next to the UDF predefined value. If 
there is no check mark it is inactive. You can change the status by checking or unchecking the Active? box. 

Note • You cannot inactivate all predefined values. If you need to disable a UDF contact, contact Revenera 
Support. Click the Edit Predefined Values button to inactivate or reactivate your selections.

The default predefined value is displayed in the pulldown menu. Click on the radio button of a predefined value to 
make it the default. Click the Edit Predefined Values button to set the default.
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Technical Reference

This chapter includes the following sections which lists the various State/Province codes with their full names 
and countries codes:

• State and Province Codes for the US and Canada

• Country Codes

State and Province Codes for the US and Canada
Below is a list of valid State and Province codes for the US and Canada. They are listed alphabetically by Country 
Code, then State/Province Full Name.

Table 14-1 • State/Province Code and Full Name

Country Code State/Province Code State / Province Full Name

CA AB Alberta

CA BC British Columbia

CA MB Manitoba

CA NB New Brunswick

CA NL Newfoundland and Labrador

CA NS Nova Scotia

CA NT Northwest Territories

CA NU Nunavut

CA ON Ontario
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CA PE Prince Edward Island

CA QC Quebec

CA SK Saskatchewan

CA YT Yukon

US AA Armed

US AE Armed Forces Europe/Canada/
Africa/M East

US AK Alaska

US AL Alabama

US AP Armed Forces Pacific

US AR Arkansas

US AS America Samoa

US AZ Arizona

US CA California

US CO Colorado

US CT Connecticut

US DC District of Columia

US DE Delaware

US FL Florida

US GA Georgia

US GU Guam

US HI Hawaii

US IA Iowa

US ID Idaho

Table 14-1 • State/Province Code and Full Name

Country Code State/Province Code State / Province Full Name
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US IL Illinois

US IN Indiana

US KS Kansas

US KY Kentucky

US LA Louisiana

US MA Massachusetts

US MD Maryland

US ME Maine

US MI Michigan

US MN Minnesota

US MO Missouri

US MP Northern Mariana Islands

US MS Mississippi

US MT Montana

US NC North Carolina

US ND North Dakota

US NE Nebraska

US NH New Hampshire

US NJ New Jersey

US NM New Mexico

US NV Nevada

US NY New York

US OH Ohio

US OK Oklahoma

Table 14-1 • State/Province Code and Full Name

Country Code State/Province Code State / Province Full Name
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Country Codes
Below is a list of valid Country Codes. They are listed alphabetically by Country Full Name.

US OR Oregon

US PA Pennsylvania

US PR Puerto Rico

US RI Rhode Island

US SC South Carolina

US SD South Dakota

US TN Tennessee

US TX Texas

US UT Utah

US VA Virginia

US VI Virgin Islands

US VT Vermont

US WA Washington

US WI Wisconsin

US WV West Virginia

US WY Wyoming

Table 14-2 • Country Code

Code Country Full Name

AD Andorra

AE United Arab Emirates

AF Afghanistan

Table 14-1 • State/Province Code and Full Name

Country Code State/Province Code State / Province Full Name
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AG Antigua & Barbuda

AI Anguilla

AL Albania

AM Armenia

AN Netherlands Antilles

AO Angola

AQ Antarctica

AR Argentina

AS American Samoa

AT Austria

AU Australia

AW Aruba

AX Aland Islands

AZ Azerbaijan

BA Bosnia and Herzegovina

BB Barbados

BD Bangladesh

BE Belgium

BF Burkina Faso

BG Bulgaria

BH Bahrain

BI Burundi

BJ Benin

BL Saint Barthelemy

Table 14-2 • Country Code

Code Country Full Name
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BM Bermuda

BN Brunei

BO Bolivia

BQ Bonaire, Sint Eustatius, and Saba

BR Brazil

BS Bahamas

BT Bhutan

BV Bouvet Island

BW Botswana

BY Belarus

BZ Belize

CA Canada

CC Cocos (Keeling) Islands

CD Congo, The Democratic Republic of The

CF Central African Republic

CG Congo

CH Switzerland

CI Ivory Coast

CK Cook Islands

CL Chile

CM Cameroon

CN China

CO Colombia

CR Costa Rica

Table 14-2 • Country Code

Code Country Full Name
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CS Serbia and Montenegro

CU Cuba

CV Cape Verde

CW Curacao

CX Christmas Island

CY Cyprus

CZ Czech Republic

DE Germany

DJ Djibouti

DK Denmark

DM Dominica

DO Dominican Republic

DZ Algeria

EC Ecuador

EE Estonia

EG Egypt

EH Western Sahara

ER Eritrea

ES Spain

ET Ethiopia

FI Finland

FJ Fiji

FK Falkland Islands

FM Federated States of Micronesia

Table 14-2 • Country Code

Code Country Full Name
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FO Faroe Islands

FR France

GA Gabon

GB United Kingdom

GD Grenada

GE Georgia

GF French Guiana

GG Guernsey

GH Ghana

GI Gibraltar

GL Greenland

GM Gambia

GN Guinea

GP Guadeloupe

GQ Equatorial Guinea

GR Greece

GS S. Georgia & S. Sandwich Islands

GT Guatemala

GU Guam

GW Guinea-Bissau

GY Guyana

HK Hong Kong

HM Heard and Mcdonald Islands

HN Honduras

Table 14-2 • Country Code

Code Country Full Name



Chapter 14 Technical Reference
Country Codes

FlexNet Operations LLM Producer Portal User Guide FNOLLM-PPUG02  353

HR Croatia

HT Haiti

HU Hungary

ID Indonesia

IE Ireland

IL Israel

IM Isle of Man

IN India

IO British Indian Ocean Territory

IQ Iraq

IR Iran

IS Iceland

IT Italy

JE Jersey

JM Jamaica

JO Jordan

JP Japan

KE Kenya

KG Kyrgyzstan

KH Cambodia

KI Kiribati

KM Comoros

KN St. Kitts and Nevis

KP North Korea

Table 14-2 • Country Code

Code Country Full Name
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KR South Korea

KW Kuwait

KY Cayman Islands

KZ Kazakhstan

LA Laos

LB Lebanon

LC St. Lucia

LI Liechtenstein

LK Sri Lanka

LR Liberia

LS Lesotho

LT Lithuania

LU Luxembourg

LV Latvia

LY Libya

MA Morocco

MC Monaco

MD Moldova

ME Montenegro

MF Saint Martin (French Part)

MG Madagascar

MH Marshall Islands

MK FYROM

ML Mali

Table 14-2 • Country Code

Code Country Full Name
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MM Myanmar (Burma)

MN Mongolia

MO Macau

MP Northern Mariana Islands

MQ Martinique

MR Mauritania

MS Montserrat

MT Malta

MU Mauritius

MV Maldives

MW Malawi

MX Mexico

MY Malaysia

MZ Mozambique

NA Namibia

NC New Caledonia

NE Niger

NF Norfolk Island

NG Nigeria

NI Nicaragua

NL Netherlands

NO Norway

NP Nepal

NR Nauru

Table 14-2 • Country Code

Code Country Full Name
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NU Niue

NZ New Zealand

OM Oman

PA Panama

PE Peru

PF French Polynesia

PG Papua New Guinea

PH Philippines

PK Pakistan

PL Poland

PM St. Pierre and Miquelon

PN Pitcairn

PR Puerto Rico

PS Palestine, State Of

PT Portugal

PW Palau

PY Paraguay

QA Qatar

RE Reunion

RO Romania

RS Serbia

RU Russia

RW Rwanda

SA Saudi Arabia

Table 14-2 • Country Code

Code Country Full Name
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SB Solomon Islands

SC Seychelles

SD Sudan

SE Sweden

SG Singapore

SH Saint Helena

SI Slovenia

SJ Svalbard and Jan Mayen

SK Slovakia

SL Sierra Leone

SM San Marino

SN Senegal

SO Somalia

SR Suriname

SS South Sudan, Republic of

ST St. Tome and Principe

SV El Salvador

SX Sint Maarten (Dutch Part)

SY Syria

SZ Swaziland

TC Turks & Caicos Islands (BWI)

TD Chad

TF French Southern Territories

TG Togo

Table 14-2 • Country Code

Code Country Full Name
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TH Thailand

TJ Tajikistan

TK Tokelau

TL Timor-Leste

TM Turkmenistan

TN Tunisia

TO Tonga

TP East Timor

TR Turkey

TT Trinidad and Tobago

TV Tuvalu

TW Taiwan

TZ Tanzania

UA Ukraine

UG Uganda

UM US Minor Outlying Islands

US USA

UY Uruguay

UZ Uzbekistan

VA Vatican City

VC St. Vincent and the Grenadines

VE Venezuela

VG Virgin Islands (British)

VI Virgin Islands

Table 14-2 • Country Code

Code Country Full Name
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VN Viet Nam

VU Vanuatu

WF Wallis & Futuna Islands

WS Samoa

XK Kosovo ( User-defined XK )

YE Yemen Republic

YT Mayotte

YU Yugoslavia

ZA South Africa

ZM Zambia

ZW Zimbabwe

ZZ Unknown

Table 14-2 • Country Code

Code Country Full Name
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FlexNet Operations LLM 
Web Services Implementation

This section provides information regarding the web service calls that have been implemented in FlexNet 
Operations LLM for various transactions. 

The web service API (SWSAPI) allows customers to manage data related to Accounts and Members, Entitlements, 
and Product hierarchy entities within the FlexNet Operations service from external ERP and CRM systems. The API 
uses Simple Object Access Protocol (SOAP) objects generated from a Web Services Definitional Language (WSDL) 
file.

This section includes the following information:

API Operations
This section describes the following API operations:

• Add

• Add Update

• Associate

• Changed Since

• Disassociate

• Find Requests

Table 15-1 • Web Services Implementation Topics

Section Description

API Operations Descriptions of the supported API operations.

Sample SOAP Calls Link to download a sample XML file that can be used to transfer a session ID 
programmatically between two requests.
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• FNE Requests

• Get Requests

• License Requests

• Merge Account

• Reidentify

• Restrict Product / File

• Unrestrict Product / File

• Transfer Order

• Update

Add
This section describes the Add API operation.

•  Login (Add)

• Add Product

• Add Account

• Add Order

• Add Order (with Member, w/o FlexLicenseModel)

• Add Catalog

• Add Product

• Add License Token

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Add)
The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">

<soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
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         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Add Product
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Header>
<uri:OptionsHeader/>
<uri:SessionHeader>

<uri:SessionID></uri:SessionID>
</uri:SessionHeader>

</soapenv:Header>
<soapenv:Body>

<Add xmlns="uri:webservice.subscribenet.intraware.com">
<SubscribeNetObject xsi:type="uri1:Product" xmlns:uri1="uri:subscribenet.intraware.com">

<uri1:Reference xsi:type="uri1:ProductReference">
<uri1:ID>WSProduct2</uri1:ID>

</uri1:Reference>
<uri1:Description>Product definition</uri1:Description>
<uri1:Version>10</uri1:Version>
<uri1:EffectiveDate>2021-01-01</uri1:EffectiveDate>
<uri1:ExpirationDate>2021-12-31</uri1:ExpirationDate>
<uri1:ArchiveDate>2022-01-01</uri1:ArchiveDate> 
<uri1:SortGroup>1</uri1:SortGroup>
<uri1:ExtendedDescription>WS Product</uri1:ExtendedDescription>
<uri1:ExportComplianceClassification>

<!-- For NLR, T = Yes, F = No -->
<uri1:NLR>F</uri1:NLR>
<!-- Expected values for ECCNCode: NO_EXPORT, NOT_APPLICABLE, UNKNOWN, 3D002, 3D991 -->
<uri1:ECCNCode>UNKNOWN</uri1:ECCNCode>
<!--uri1:ENCCode></uri1:ENCCode>
<uri1:CCATSCode></uri1:CCATSCode-->

</uri1:ExportComplianceClassification> 
<uri1:ProductManufacturer>

<uri1:ID>MANU_DOWNLOAD</uri1:ID>
</uri1:ProductManufacturer>
<uri1:ProductLine>

<uri1:ID>PLNE_DOWNLOAD</uri1:ID>
</uri1:ProductLine> 
<!--uri1:LicenseGroup>
<uri1:ID>FNP_Template_Base</uri1:ID>
</uri1:LicenseGroup-->
<!--uri1:EndUserLicenseAgreement>
<uri1:AgreementName>ExportComplianceTestAgreement</uri1:AgreementName>
</uri1:EndUserLicenseAgreement-->
<!--Product note = Download Instructions -->
<uri1:ProductNote>ProductNote</uri1:ProductNote>

<uri1:PhysicalDistributionAvailable>0</uri1:PhysicalDistributionAvailable>
<!--uri1:UserDefinedField code="QA_UDF">Created by QA</uri1:UserDefinedField-->

</SubscribeNetObject>
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</Add>
</soapenv:Body>

</soapenv:Envelope>

Add Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<soapenv:Header>
<SessionHeader>

<uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
</SessionHeader>

</soapenv:Header>
<soapenv:Body>

<Add xmlns="uri:webservice.subscribenet.intraware.com">
<SubscribeNetObject xsi:type="uri1:Account" xmlns:uri1="uri:subscribenet.intraware.com">

<uri1:Reference xsi:type="uri1:AccountReference">
<uri1:ID xsi:type="xsd:string">TestAccount</uri1:ID>

</uri1:Reference>
<uri1:AccountName xsi:type="xsd:string">TestAccount</uri1:AccountName>
<uri1:AccountNote xsi:type="xsd:string">TESTNOTE Active Account</uri1:AccountNote>
<uri1:Status>ACTIVE</uri1:Status>

</SubscribeNetObject>
</Add>

</soapenv:Body>
</soapenv:Envelope>

Add Order
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<soapenv:Header>
<SessionHeader>

<uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
</SessionHeader>    

</soapenv:Header>
<soapenv:Body>

<uri:Add xmlns:uri="uri:webservice.subscribenet.intraware.com">
<SubscribeNetObject xsi:type="uri1:Order" xmlns:uri1="uri:subscribenet.intraware.com">

<uri1:Reference xsi:type="uri1:OrderReference">
<uri1:ID xsi:type="uri1:string">DEMO_Order01</uri1:ID>

</uri1:Reference><uri1:Account xsi:type="uri1:AccountReference">
<uri1:IntrawareID>36838975</uri1:IntrawareID></uri1:Account>
<uri1:OrderDate xsi:type="xs:date">2011-02-06</uri1:OrderDate>
<uri1:PurchaseOrderID xsi:type="xsd:string">DEMO_Order01</uri1:PurchaseOrderID>
<uri1:SalesRep>TestRep</uri1:SalesRep>
<uri1:InvoiceID xsi:type="xsd:string">WSOrder01</uri1:InvoiceID>
<uri1:InvoiceDate xsi:type="xs:date">2012-12-12</uri1:InvoiceDate>
<uri1:OrderNote>WS Order</uri1:OrderNote>
<uri1:OrderLine xsi:type="uri1:OrderLine">

<uri1:LineNumber>1</uri1:LineNumber>
<uri1:TemporaryOrderLine>FALSE</uri1:TemporaryOrderLine>
<uri1:Price>0</uri1:Price>
<uri1:SKU>QATest_DRS_Feature_1_AddOn</uri1:SKU>
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<uri1:EffectiveDate>2012-02-06</uri1:EffectiveDate>
<uri1:ExpirationDate>2012-12-31</uri1:ExpirationDate>
<uri1:Quantity>10</uri1:Quantity>
<uri1:DownloadLimit>1</uri1:DownloadLimit>
<uri1:LicenseCode></uri1:LicenseCode>
<uri1:LicenseFileName></uri1:LicenseFileName>
<uri1:LicenseFileCode></uri1:LicenseFileCode>
<uri1:FlexLicenseModel xsi:type="uri1:LicenseModelIdentifier">

<uri1:Code>DATABASE</uri1:Code>
<uri1:Name>AS_DurationBased_Feature</uri1:Name>
<uri1:IntrawareLicenseModelID>3</uri1:IntrawareLicenseModelID>

</uri1:FlexLicenseModel>
<uri1:Status>ACTIVE</uri1:Status>

</uri1:OrderLine>
<uri1:TO>system@example.com</uri1:TO>

</SubscribeNetObject>
</uri:Add>

</soapenv:Body>
</soapenv:Envelope>

Add Order (with Member, w/o FlexLicenseModel)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
 <soapenv:Header>
 <SessionHeader>
 <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
 </SessionHeader> 
 </soapenv:Header>
 <soapenv:Body>
 <uri:Add xmlns:uri="uri:webservice.subscribenet.intraware.com">
 <SubscribeNetObject xsi:type="uri1:Order" xmlns:uri1="uri:subscribenet.intraware.com">
 <uri1:Reference xsi:type="uri1:OrderReference">
 <uri1:ID xsi:type="uri1:string">DEMO_Order01</uri1:ID>
 </uri1:Reference>
 <uri1:Account xsi:type="uri1:AccountReference">
 <uri1:IntrawareID>7124712</uri1:IntrawareID>
 </uri1:Account>
 <uri1:Member xsi:type="uri1:MemberReference">
 <uri1:Email xsi:type="xsd:string">dturtle@intraware.com</uri1:Email>
 <uri1:AccountReference xsi:type="uri1:AccountReference">
 <uri1:IntrawareID xsi:type="xsd:string">7124712</uri1:IntrawareID>
 </uri1:AccountReference>
 </uri1:Member>
 <uri1:OrderDate xsi:type="xs:date">2011-02-06</uri1:OrderDate>
 <uri1:PurchaseOrderID xsi:type="xsd:string">DEMO_Order01</uri1:PurchaseOrderID>
 <uri1:SalesRep>TestRep</uri1:SalesRep>
 <uri1:InvoiceID xsi:type="xsd:string">WSOrder01</uri1:InvoiceID>
 <uri1:InvoiceDate xsi:type="xs:date">2012-12-12</uri1:InvoiceDate>
 <uri1:OrderNote>WS Order</uri1:OrderNote>
 <uri1:OrderLine xsi:type="uri1:OrderLine">
 <uri1:LineNumber>1</uri1:LineNumber>
 <uri1:TemporaryOrderLine>FALSE</uri1:TemporaryOrderLine>
 <uri1:Price>0</uri1:Price>
 <uri1:SKU>testCatalog20130423a</uri1:SKU>
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 <uri1:EffectiveDate>2012-02-06</uri1:EffectiveDate>
 <uri1:ExpirationDate>2012-12-31</uri1:ExpirationDate>
 <uri1:Quantity>10</uri1:Quantity>
 <uri1:DownloadLimit>1</uri1:DownloadLimit>
 <uri1:LicenseCode></uri1:LicenseCode>
 <uri1:LicenseFileName></uri1:LicenseFileName>
 <uri1:LicenseFileCode></uri1:LicenseFileCode>
 <uri1:Status>ACTIVE</uri1:Status>
 </uri1:OrderLine>
 </SubscribeNetObject>
 </uri:Add>
 </soapenv:Body>
</soapenv:Envelope>

Add Catalog
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Add xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:CatalogItem" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:CatalogItemReference">
                <uri1:ID xsi:type="xsd:string">AS_Test_Catalog_1</uri1:ID>
            </uri1:Reference>
            <uri1:Description>Catalog definition</uri1:Description>
            <uri1:Type>NORMAL</uri1:Type>
            <uri1:Subscription>FALSE</uri1:Subscription>
            <uri1:Temporary>FALSE</uri1:Temporary>
            <uri1:DefaultDurationYear>1</uri1:DefaultDurationYear>
            <uri1:DefaultDurationMonth>7</uri1:DefaultDurationMonth>    
            <uri1:DefaultDurationDay>15</uri1:DefaultDurationDay>
            <uri1:CatalogManufacturer>
                <uri1:ID>QAAUTOManufacturer</uri1:ID>
            </uri1:CatalogManufacturer>
            <uri1:CatalogProductLine>
                <uri1:ID>QAAUTOPlne</uri1:ID>
            </uri1:CatalogProductLine>        
        </SubscribeNetObject>
      </uri:Add>
   </soapenv:Body>
</soapenv:Envelope>

Add Product
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
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   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID>b8439903-afe3-445d-9c52-c15c5621678bc7unuY8f9cpUIcZWoOUpVW9EVXb3yA==</
uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <Add xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:Product" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:ProductReference">
                <uri1:ID>WSProduct2</uri1:ID>
            </uri1:Reference>
            <uri1:Description>Product definition</uri1:Description>
            <uri1:Version>10</uri1:Version>
            <uri1:EffectiveDate>2014-03-31</uri1:EffectiveDate>
            <uri1:ExpirationDate>2014-12-31</uri1:ExpirationDate>
            <uri1:ArchiveDate>2015-01-01</uri1:ArchiveDate>    
            <uri1:SortGroup>1</uri1:SortGroup>
            <uri1:ExtendedDescription>WS Product</uri1:ExtendedDescription>
            <uri1:ExportComplianceClassification>
                <!-- For NLR, T = Yes, F = No -->
                <uri1:NLR>F</uri1:NLR>
                <!-- Expected values for ECCNCode: NO_EXPORT, NOT_APPLICABLE, UNKNOWN, 3D002, 3D991 etc 
--> 
                <uri1:ECCNCode>UNKNOWN</uri1:ECCNCode>
                <!--uri1:ENCCode></uri1:ENCCode>
                <uri1:CCATSCode></uri1:CCATSCode-->
            </uri1:ExportComplianceClassification>    
            <uri1:ProductManufacturer>
                <uri1:ID>FW123</uri1:ID>
            </uri1:ProductManufacturer>
            <uri1:ProductLine>
                <uri1:ID>FW-Win</uri1:ID>
            </uri1:ProductLine>    
            <uri1:LicenseGroup>
                <uri1:ID>FNP_Template_Base</uri1:ID>
            </uri1:LicenseGroup>
            <uri1:EndUserLicenseAgreement>
                <uri1:AgreementName>ExportComplianceTestAgreement</uri1:AgreementName>
            </uri1:EndUserLicenseAgreement>
            <uri1:EvaluationEndUserLicenseAgreement>
                <uri1:AgreementName>Kelly's Agreement</uri1:AgreementName>
            </uri1:EvaluationEndUserLicenseAgreement>
            <!--Product note = Download Instructions -->
            <uri1:ProductNote>ProductNote</uri1:ProductNote>
            <uri1:PhysicalDistributionAvailable>0</uri1:PhysicalDistributionAvailable>
            <uri1:UserDefinedField code="QA_UDF">Created by QA</uri1:UserDefinedField>
        </SubscribeNetObject>
    </Add>
   </soapenv:Body>
</soapenv:Envelope>
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Add License Token
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <Add xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:LicenseToken" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference>
                <uri1:ID xsi:type="xsd:string">TKN01</uri1:ID>
            </uri1:Reference>
            <uri1:CatalogItem xsi:type="uri1:CatalogItemReference">
                <uri1:ID>QATEST_FNPCert_Package</uri1:ID>
            </uri1:CatalogItem>
            <uri1:Product xsi:type="uri1:ProductReference">
                <uri1:ID>QATEST_FNPCert_Package</uri1:ID>
            </uri1:Product>
            <uri1:EntitlementEffectiveDate xsi:type="xsd:date">2013-07-31</
uri1:EntitlementEffectiveDate>
            <uri1:EntitlementExpirationDate xsi:type="xsd:date">2014-07-30</
uri1:EntitlementExpirationDate>
            <uri1:EntitlementQuantity xsi:type="xsd:positiveInteger">5</uri1:EntitlementQuantity>
            <uri1:Register xsi:type="uri1:RegisterType">REQUIRED</uri1:Register>
            <uri1:AdminPrivilege>TRUE</uri1:AdminPrivilege>
            <uri1:DownloadPrivilege>TRUE</uri1:DownloadPrivilege>
            <uri1:ExpirationDate xsi:type="xsd:date">2014-07-30</uri1:ExpirationDate>
            <uri1:Status>ACTIVE</uri1:Status>
            <uri1:DownloadLimit>1</uri1:DownloadLimit>
            <uri1:UserDefinedField code="ACCOUNT-ACCT_LOGO">http://logo.com/image/main.png</
uri1:UserDefinedField>
            <uri1:UserDefinedField code="ORDER-CHANNEL-PARTNER-ID">TST2</uri1:UserDefinedField>
            <uri1:UserDefinedField code="ORDERLINE-LIC_EXP_DATE">2015-07-31</uri1:UserDefinedField>
            <uri1:UserDefinedField code="TOKEN_NOTIF_TO">system@example.com</uri1:UserDefinedField>
            <uri1:UserDefinedField code="TOKEN_NOTIF_CC">testuser@test.com</uri1:UserDefinedField>
            <uri1:UserDefinedField code="TOKEN_NOTIF_BCC">anothertestuser@test.com</
uri1:UserDefinedField>
        </SubscribeNetObject>
    </Add>
   </soapenv:Body>
</soapenv:Envelope>

Add Update
This section describes the Add Update API operation.

• Login (Add Update)

• Add Update Order

• Add Update Account
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• Add Update Member

• Add Update Catalog

• Add Update Product

• Add Update File

• Add Update License Token

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Add Update)
The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Add Update Order
Order Email Directive can be DEFAULT, FORCE, SUPPRESS.
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
<soapenv:Header>
<SessionHeader>
<uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com">session ID from login response</
uri:SessionID>
</SessionHeader>
<OptionsHeader>
<uri:OrderEmailDirective>DEFAULT</uri:OrderEmailDirective>
<uri:OrderEmailVariation>QA_Order_Variation</uri:OrderEmailVariation>
</OptionsHeader>
</soapenv:Header>
<soapenv:Body>
<AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
<SubscribeNetObject xsi:type="uri1:Order" xmlns:uri1="uri:subscribenet.intraware.com">
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<uri1:Reference xsi:type="uri1:OrderReference">
<uri1:ID xsi:type="uri1:string">WSOrder01</uri1:ID>
</uri1:Reference>
<uri1:Account xsi:type="uri1:AccountReference">
<uri1:IntrawareID>35854451</uri1:IntrawareID>
</uri1:Account>
<uri1:OrderDate xsi:type="xs:date">2011-12-12</uri1:OrderDate>
<uri1:PurchaseOrderID xsi:type="xsd:string">WSOrder01</uri1:PurchaseOrderID>
<uri1:SalesRep>TestRep</uri1:SalesRep>
<uri1:InvoiceID xsi:type="xsd:string">WSOrder01</uri1:InvoiceID>
<uri1:InvoiceDate xsi:type="xs:date">2011-12-12</uri1:InvoiceDate>
<uri1:OrderNote>WS Order</uri1:OrderNote>
<uri1:OrderLine xsi:type="uri1:OrderLine">
<uri1:LineNumber>1</uri1:LineNumber>
<uri1:TemporaryOrderLine>FALSE</uri1:TemporaryOrderLine>
<uri1:Price>0</uri1:Price>
<uri1:SKU>Catalog01</uri1:SKU>
<uri1:EffectiveDate>2011-12-12</uri1:EffectiveDate>
<uri1:ExpirationDate>2013-12-31</uri1:ExpirationDate>
<uri1:Quantity>10</uri1:Quantity>
<uri1:DownloadLimit>1</uri1:DownloadLimit>
<uri1:LicenseCode></uri1:LicenseCode>
<uri1:LicenseFileName></uri1:LicenseFileName>
<uri1:LicenseFileCode></uri1:LicenseFileCode>
<uri1:Status>ACTIVE</uri1:Status>
</uri1:OrderLine>
<uri1:TO>system@example.com</uri1:TO>
</SubscribeNetObject>
</AddUpdate>
</soapenv:Body>
</soapenv:Envelope>

Add Update Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<soapenv:Header>
<SessionHeader>
<uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
</SessionHeader>
</soapenv:Header>
<soapenv:Body>
<AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
<SubscribeNetObject xsi:type="uri1:Account" xmlns:uri1="uri:subscribenet.intraware.com">
<!-- If changes need to be made to a particular account enter Intraware ID. If new account needs to be 
added, supply Account ID against the ID tag -->
<!-- <uri1:Reference xsi:type="uri1:AccountReference">
<uri1:IntrawareID>IntrawareID</uri1:IntrawareID> 
<uri1:ID>AccountID</uri1:ID>
</uri1:Reference> -->
<uri1:AccountName xsi:type="xsd:string">TestAccount01</uri1:AccountName>
<uri1:AccountNote xsi:type="xsd:string">TESTNOTE5</uri1:AccountNote>
<uri1:Status>ACTIVE</uri1:Status>
<uri1:UserDefinedField code = "qa_test_udf">qa</uri1:UserDefinedField>
</SubscribeNetObject>
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</AddUpdate>
</soapenv:Body>
</soapenv:Envelope>

Add Update Member
Member Email Directive can be DEFAULT, FORCE, SUPPRESS
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <SessionHeader>
            <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
        </SessionHeader>
        <OptionsHeader>
            <uri:MemberEmailDirective>DEFAULT</uri:MemberEmailDirective>
            <uri:MemberEmailVariation>QA_Variation_01</uri:MemberEmailVariation>
        </OptionsHeader>
    </soapenv:Header>
    <soapenv:Body>
        <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObject xsi:type="uri1:Member" xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Reference xsi:type="uri1:MemberReference">
                    <uri1:Email xsi:type="xsd:string">testuser_456@test.com</uri1:Email>
                    <uri1:ID xsi:type="uri1:string">testuser_456@test.com</uri1:ID>
                    <uri1:AccountReference xsi:type="uri1:AccountReference">
                        <uri1:IntrawareID>37591627</uri1:IntrawareID>
                    </uri1:AccountReference>
                </uri1:Reference>
                <uri1:FirstName xsi:type="xsd:string">TestUser</uri1:FirstName>
                <uri1:LastName xsi:type="xsd:string">LastName</uri1:LastName>
                <uri1:JobTitle>TestJobTitle</uri1:JobTitle>
                <uri1:Phone>8474664603</uri1:Phone>
                <uri1:Fax>8474664604</uri1:Fax>
                <uri1:AddressLine1>1000 E Woodfield Road</uri1:AddressLine1>
                <uri1:AddressLine2></uri1:AddressLine2>
                <uri1:AddressLine3></uri1:AddressLine3>
                <uri1:AddressLine4></uri1:AddressLine4>
                <uri1:City>Schaumburg</uri1:City>
                <uri1:State>IL</uri1:State>
                <uri1:PostalCode>60173</uri1:PostalCode>
                <uri1:Country>US</uri1:Country>
                <uri1:AdminPrivilege>TRUE</uri1:AdminPrivilege>
                <uri1:DownloadPrivilege>TRUE</uri1:DownloadPrivilege>
                <uri1:MemberNote>TestNote</uri1:MemberNote>
                <uri1:Status>ACTIVE</uri1:Status>
                <uri1:UserDefinedField code="QaUser?">Yes</uri1:UserDefinedField>
            </SubscribeNetObject>
        </AddUpdate>
    </soapenv:Body>
</soapenv:Envelope>
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Add Update Catalog
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:CatalogItem" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:CatalogItemReference">
                <uri1:IntrawareID>4011461</uri1:IntrawareID>
            </uri1:Reference>
            <uri1:Description>Catalog definition</uri1:Description>
            <uri1:Type>NORMAL</uri1:Type>
            <uri1:Subscription>FALSE</uri1:Subscription>
            <uri1:Temporary>FALSE</uri1:Temporary>
            <uri1:DefaultDurationYear>1</uri1:DefaultDurationYear>
            <uri1:DefaultDurationMonth>7</uri1:DefaultDurationMonth>    
            <uri1:DefaultDurationDay>15</uri1:DefaultDurationDay>
            <uri1:CatalogManufacturer>
                <uri1:ID>QAAUTOManufacturer</uri1:ID>
            </uri1:CatalogManufacturer>
            <uri1:CatalogProductLine>
                <uri1:ID>QAAUTOPlne</uri1:ID>
            </uri1:CatalogProductLine>    
            <uri1:StatusCode>INACTIVE</uri1:StatusCode>
        </SubscribeNetObject>
    </AddUpdate>
   </soapenv:Body>
</soapenv:Envelope>

Add Update Product
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:Product" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:ProductReference">
                <uri1:ID>WSProduct1</uri1:ID>
            </uri1:Reference>
            <uri1:Description>Product definition</uri1:Description>
            <uri1:Version>10</uri1:Version>
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            <uri1:EffectiveDate>2014-03-31</uri1:EffectiveDate>
            <uri1:ExpirationDate>2014-12-31</uri1:ExpirationDate>
            <uri1:ArchiveDate>2015-01-01</uri1:ArchiveDate>    
            <uri1:SortGroup>1</uri1:SortGroup>
            <uri1:ExtendedDescription>WS Product</uri1:ExtendedDescription>
            <uri1:ExportComplianceClassification>
                <!-- For NLR, T = Yes, F = No -->
                <uri1:NLR>F</uri1:NLR>
                <!-- Expected values for ECCNCode: NO_EXPORT, NOT_APPLICABLE, UNKNOWN, 3D002, 3D991 etc 
--> 
                <uri1:ECCNCode>UNKNOWN</uri1:ECCNCode>
                <!--uri1:ENCCode></uri1:ENCCode>
                <uri1:CCATSCode></uri1:CCATSCode-->
            </uri1:ExportComplianceClassification>    
            <uri1:ProductManufacturer>
                <uri1:ID>FW123</uri1:ID>
            </uri1:ProductManufacturer>
            <uri1:ProductLine>
                <uri1:ID>FW-Win</uri1:ID>
            </uri1:ProductLine>    
            <uri1:LicenseGroup>
                <uri1:ID>FNP_Template_Base</uri1:ID>
            </uri1:LicenseGroup>
            <uri1:EndUserLicenseAgreement>
                <uri1:AgreementName>ExportComplianceTestAgreement</uri1:AgreementName>
            </uri1:EndUserLicenseAgreement>
            <uri1:EvaluationEndUserLicenseAgreement>
                <uri1:AgreementName>Kelly's Agreement</uri1:AgreementName>
            </uri1:EvaluationEndUserLicenseAgreement>
            <!--Product note = Download Instructions -->
            <uri1:ProductNote>ProductNote</uri1:ProductNote>
            <uri1:PhysicalDistributionAvailable>0</uri1:PhysicalDistributionAvailable>
            <uri1:UserDefinedField code="QA_UDF">Created by QA</uri1:UserDefinedField>
        </SubscribeNetObject>
    </AddUpdate>
   </soapenv:Body>
</soapenv:Envelope>

Add Update File
<soapenv:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:soapenv="http://
schemas.xmlsoap.org/soap/envelope/" xmlns:uri="uri:subscribenet.intraware.com"> <soapenv:Header> 
   <uri:SessionHeader> 
     <uri:SessionID></uri:SessionID> 
   </uri:SessionHeader> 
   </soapenv:Header> 
   <soapenv:Body> 
     <uri:AddUpdate xmlns="uri:webservice.subscribenet.intraware.com"> 
        <SubscribeNetObject xmlns:uri1="uri:subscribenet.intraware.com" xsi:type="uri:File"> 
            <uri:Reference> 
                   <uri:ID>JBFileID</uri:ID> 
           </uri:Reference> 
                  <uri:Description>JB Test File</uri:Description> 
                  <uri:ExtendedDescription>Extended Description</uri:ExtendedDescription> 
        </SubscribeNetObject> 
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     </uri:AddUpdate> 
  </soapenv:Body> 
</soapenv:Envelope> 
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
         <uri:OptionsHeader/>
         <uri:SessionHeader>
               <uri:SessionID></uri:SessionID>
         </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
          <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
               <SubscribeNetObject xsi:type="uri1:File" xmlns:uri1="uri:subscribenet.intraware.com">
                      <uri1:Reference xsi:type="uri1:FileReference">
                              <uri1:ID>File_4011461</uri1:ID>
                      </uri1:Reference>
                      <uri1:Description>MyFileDescription</uri1:Description>
                      <uri1:ExtendedDescription>File definition</uri1:ExtendedDescription>
                      <uri1:FileName>MytestFile.txt</uri1:FileName>
                      <uri1:UserDefinedField code="<UDF-ID>">1</uri1:UserDefinedField>
              </SubscribeNetObject>
        </AddUpdate>
    </soapenv:Body>
</soapenv:Envelope>

Add Update License Token
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <SessionHeader>
            <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
        </SessionHeader>
        <OptionsHeader>
            <uri:OrderEmailDirective>DEFAULT</uri:OrderEmailDirective>
            <uri:OrderEmailVariation>DEFAULT</uri:OrderEmailVariation>
        </OptionsHeader>
    </soapenv:Header>
    <soapenv:Body>
        <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObject xsi:type="uri1:LicenseToken" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Reference>
                    <uri1:ID xsi:type="xsd:string">TestLicToken20130807f</uri1:ID>
                </uri1:Reference>
                <uri1:CatalogItem xsi:type="uri1:CatalogItemReference">
<!--                    For DEMO -->
                    <uri1:ID>QATEST_FNPCert_Package</uri1:ID>
<!--                    <uri1:ID>ASTestCatalog-A</uri1:ID> -->
<!--                    For SYBS 
                    <uri1:ID>10098</uri1:ID> -->
                </uri1:CatalogItem>
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                <uri1:Product xsi:type="uri1:ProductReference">
<!--                    For DEMO -->
                    <uri1:ID>QATEST_FNPCert_Package</uri1:ID>
<!--                    <uri1:ID>ASTestProduct-A</uri1:ID> -->
<!--                    For SYBS 
                    <uri1:ID>10098-75-1500-41</uri1:ID> -->
                </uri1:Product>
                <uri1:EntitlementEffectiveDate xsi:type="xsd:date">2013-07-31</
uri1:EntitlementEffectiveDate>
                <uri1:EntitlementExpirationDate xsi:type="xsd:date">2014-07-30</
uri1:EntitlementExpirationDate>
                <uri1:EntitlementQuantity xsi:type="xsd:positiveInteger">5</uri1:EntitlementQuantity>
                <uri1:Register xsi:type="uri1:RegisterType">NOT_ALLOWED</uri1:Register>
                <uri1:AdminPrivilege>TRUE</uri1:AdminPrivilege>
                <uri1:DownloadPrivilege>TRUE</uri1:DownloadPrivilege>
                <uri1:ExpirationDate xsi:type="xsd:date">2014-07-30</uri1:ExpirationDate>
                <uri1:Status>ACTIVE</uri1:Status>
                <uri1:DownloadLimit>1</uri1:DownloadLimit>
<!--    In SYBS            <uri1:UserDefinedField code="ORDERLINE-LICENSE-TYPE">ST</
uri1:UserDefinedField>-->
            </SubscribeNetObject>            
        </AddUpdate>
    </soapenv:Body>
</soapenv:Envelope>

Associate
This section describes the Associate API operation.

• Login (Associate)

• Associate Product to Catalog

• Associate File to Product

Important • Can only associate one entity at a time.

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Associate)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 
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<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Associate Product to Catalog
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
        <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Associate>
        <!-- Catalog Item -->
        <uri:SubscribeNetObjectReference xsi:type="uri1:CatalogItemReference">
            <uri1:ID>AS_XMLCatalog_07</uri1:ID>
         </uri:SubscribeNetObjectReference>
        <!--Can add only one file at a time–>
        <!-- Product to be associated -->
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:ProductInCatReference">
            <uri1:ID>AS_FNP_Nodelocked</uri1:ID>
         </uri:SubscribeNetObjectReferenceAss>
      </uri:Associate>
   </soapenv:Body>
</soapenv:Envelope>

Associate File to Product
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
        <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Associate>
        <!-- Product -->
         <uri:SubscribeNetObjectReference xsi:type="uri1:ProductReference">
            <uri1:ID>AS_FNP_Nodelocked</uri1:ID>
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         </uri:SubscribeNetObjectReference>
          <!--Can add only one file at a time–>
           <!-- File to be associated -->
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:FileInProductReference">
            <uri1:ID>AS_File_11101</uri1:ID>
         </uri:SubscribeNetObjectReferenceAss>
      </uri:Associate>
   </soapenv:Body>
</soapenv:Envelope>

Changed Since
This section describes the Changed Since API operation.

The changedSince web service request is used to retrieve an entity/object that changed within a specified time-
frame.

• Limitations

• Endpoints

Limitations
• Can check only within a 30 day period. An exception is thrown if the duration exceeds this time-frame.

• Start and End dates are required.

• Will return the IDs for the entities that changed - no other additional information is returned in the response

• As of 2016.05 R2 release, this has been implemented only for the following entities 

• Account

• Member

• Catalog Item

Endpoints
The following are the endpoints for Changed Since API operation:

Disassociate
This section describes the Disassociate API operation.

Table 15-2 • Changed Since Endpoints

Environment Endpoint

UAT https://manageruat.flexnetoperations.com/service/snetmgr/services/SubscribeNet

PROD https://manager.flexnetoperations.com/service/snetmgr/services/SubscribeNet
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• Login (Disassociate)

• Disassociate Product from Catalog

• Disassociate File from Product

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Important • Can only disassociate one entity at a time.

Login (Disassociate)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Disassociate Product from Catalog
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
        <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Disassociate>
        <!-- Catalog Item -->
        <uri:SubscribeNetObjectReference xsi:type="uri1:CatalogItemReference">
            <uri1:ID>AS_XMLCatalog_07</uri1:ID>
         </uri:SubscribeNetObjectReference>
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        <!--Can remove only one file at a time–>
        <!-- Product to be disassociated -->
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:ProductInCatReference">
            <uri1:ID>AS_FNP_Nodelocked</uri1:ID>
         </uri:SubscribeNetObjectReferenceAss>
      </uri:Disassociate>
   </soapenv:Body>
</soapenv:Envelope>

Disassociate File from Product
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
        <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Disassociate>
        <!-- Product -->
         <uri:SubscribeNetObjectReference xsi:type="uri1:ProductReference">
            <uri1:ID>AS_FNP_Nodelocked</uri1:ID>
         </uri:SubscribeNetObjectReference>
          <!--Can remove only one file at a time–>
           <!-- File to be disassociated -->
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:FileInProductReference">
            <uri1:ID>AS_File_11101</uri1:ID>
         </uri:SubscribeNetObjectReferenceAss>
      </uri:Disassociate>
   </soapenv:Body>
</soapenv:Envelope>
 

Find Requests
This section describes the Find Requests API operation.

• Find Orders

• Find Orders by UDF

• Find Orders by Order Line UDF

Find Orders
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
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            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:Find xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"  
xsi:type="AccountOrderReferencesReference">
                <uri1:IntrawareID>35854451</uri1:IntrawareID>
            </uri:SubscribeNetObjectReference>
        </uri:Find>
    </soapenv:Body>
</soapenv:Envelope>

Find Orders by UDF
Finds orders based on Order level UDF
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Find xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="OrderUdfReference">
            <uri1:UdfCode>ORD-UDF-3</uri1:UdfCode>
            <uri1:UdfValue>AS Test Value</uri1:UdfValue>
        </uri:SubscribeNetObjectReference>
    </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

Find Orders by Order Line UDF

Note • Can use System UDF ID and/or UDF ID for UdfCode.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Find xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="OrderLineUdfReference">
            <uri1:UdfCode>SystemUDFID</uri1:UdfCode>
                                  <!-- AND/OR -->
            <uri1:UdfCode>UDFID</uri1:UdfCode>
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            <uri1:UdfValue>value</uri1:UdfValue>
        </uri:SubscribeNetObjectReference>
    </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

Find Members
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com"  xmlns:uri1="uri:subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:Find xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="AccountMembersReference">
                <uri1:IntrawareID>35854451</uri1:IntrawareID>
                <uri1:ActiveOnly>false</uri1:ActiveOnly>
            </uri:SubscribeNetObjectReference>
        </uri:Find>
    </soapenv:Body>
</soapenv:Envelope>

Find License Model
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">

<soapenv:Header>
<uri:SessionHeader>

<uri:SessionID></uri:SessionID>
</uri:SessionHeader>

</soapenv:Header>
<soapenv:Body>

<uri:Find xmlns="uri:subscribenet.intraware.com">
<uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xsi:type="LicenseModelReference">
</uri:SubscribeNetObjectReference>

</uri:Find>
</soapenv:Body>

</soapenv:Envelope>
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LicenseReference / Request
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">

<soapenv:Header>
<uri:SessionHeader>

<uri:SessionID>711fbd3f-66f1-4199-aeaf-6c34a35b5a7ccx3fJZ0ZNAjqzjeitsxtPaI=</uri:SessionID>
</uri:SessionHeader>

</soapenv:Header>
<soapenv:Body>

<uri:Find xmlns="uri:subscribenet.intraware.com">
<uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xsi:type="LicenseReference">
<uri1:ActivationCode>3692-0C4B-3DD3-6040</uri1:ActivationCode>
<uri1:AccountID>=HYPERLINK("https://whsec.us","click here")</uri1:AccountID>
<uri1:OrderID>ENT_test1</uri1:OrderID>
<uri1:ProductID>prod_n2</uri1:ProductID>
<uri1:LineNumber>1</uri1:LineNumber>

</uri:SubscribeNetObjectReference>
</uri:Find>

</soapenv:Body>
</soapenv:Envelope>

LicenseReference / Response
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:soapenc="http://
schemas.xmlsoap.org/soap/encoding/" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance">

<soapenv:Header/>
<soapenv:Body>

<p130:FindResponse xmlns:p130="uri:webservice.subscribenet.intraware.com">
<p130:SubscribeNetObject xsi:type="p1:License" xmlns:p1="uri:subscribenet.intraware.com">

<p1:Reference>
<p1:ID>67702482</p1:ID>

</p1:Reference>
<p1:OrderID>ENT_test1</p1:OrderID>
<p1:OrderLineNumber>1</p1:OrderLineNumber>
<p1:GeneratedByMember>Anonymous Anonymous (anonymous-snet@flexnetoperations.com)</

p1:GeneratedByMember>
<p1:HostID>5BB0EA2C9306A287810F5F3CDA7ED17DC83FCDEB</p1:HostID>
<p1:LicenseQuantity>1</p1:LicenseQuantity>
<p1:LicenseFileName xsi:nil="true"/>
<p1:LicenseKey xsi:nil="true"/>
<p1:LicenseByteKey/>

</p130:SubscribeNetObject>
</p130:FindResponse>

</soapenv:Body>
</soapenv:Envelope>

FNE Requests
This section describes the FNE Requests API operation.

• Login (FNE Requests)

• Get Requests
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• Find Requests

• Add Requests

• AddUpdate Requests

• Update Requests

• Associate Requests

• Disassociate Requests

• Move Device

• Move Server

• Return Device

Login (FNE Requests)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Get Requests
• Get Server

• Get Catalog Flex Licensing

• Get Default Hosted Server

• Get Device

• Get FNE Trusted Storage

Get Server
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
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xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <soapenv:Header>
          <uri:SessionHeader>
             <uri:SessionID></uri:SessionID>
          </uri:SessionHeader>
        </soapenv:Header>
    <soapenv:Body>
          <uri:Get xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xsi:type="uri1:FNEServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:ID>AS_FNEServer_1</uri1:ID>
                <uri1:PublisherName>fnedemo</uri1:PublisherName>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
                    </uri:SubscribeNetObjectReference>
           </uri:Get>
    </soapenv:Body>
</soapenv:Envelope>
(OR)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
<soapenv:Header>
<uri:SessionHeader>
<uri:SessionID>????</uri:SessionID>
</uri:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<uri:Get xmlns="uri:subscribenet.intraware.com">
<uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="FNEServerReference"> 
<uri1:ID>3E4FE2L9MN5Z</uri1:ID>
<uri1:PublisherName>fnedemo</uri1:PublisherName>
<uri1:HostIDType>STRING</uri1:HostIDType>
</uri:SubscribeNetObjectReference>
</uri:Get>
</soapenv:Body>
</soapenv:Envelope>

Get Catalog Flex Licensing
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID> </uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Get xmlns="uri:subscribenet.intraware.com">
             <uri1:SubscribeNetObjectReference xsi:type="uri1:CatalogFlexLicensingReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:IntrawareID>4001401</uri1:IntrawareID>
     </uri1:SubscribeNetObjectReference>
      </uri:Get>
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   </soapenv:Body>
</soapenv:Envelope>

Get Default Hosted Server
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <soapenv:Header>
          <uri:SessionHeader>
             <uri:SessionID>56b5ee3d-3273-4bc1-afa5-724587455274ZUmBH4HHxqagXraXPclMg==</uri:SessionID>
          </uri:SessionHeader>
        </soapenv:Header>
    <soapenv:Body>
          <uri:Get xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xsi:type="uri1:DefaultHostedServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Account xsi:type="uri1:AccountReference">
                    <uri1:IntrawareID>35210013</uri1:IntrawareID>
                </uri1:Account>
                </uri:SubscribeNetObjectReference>
           </uri:Get>
    </soapenv:Body>
</soapenv:Envelope>

Get Device
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Get xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="DeviceReference">
                <uri1:ID>Dev01</uri1:ID>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
                <uri1:PublisherName>hwclient</uri1:PublisherName>
        </uri:SubscribeNetObjectReference>
    </uri:Get>
   </soapenv:Body>
</soapenv:Envelope>

Get FNE Trusted Storage
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <soapenv:Header>
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          <uri:SessionHeader>
             <uri:SessionID></uri:SessionID>
          </uri:SessionHeader>
        </soapenv:Header>
    <soapenv:Body>
          <uri:Get xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xsi:type="uri1:FNEHostTrustedStorageReference">
                <uri1:ID>AS_WSDev_03</uri1:ID>
                <uri1:PublisherName>fnedemo</uri1:PublisherName>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
            </uri:SubscribeNetObjectReference>
           </uri:Get>
    </soapenv:Body>
</soapenv:Envelope>

Find Requests
• Find Device

• Find Server

• Find Feature

Find Device

By ID
Passing Device ID will find all devices with that ID (multiple host ID types)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Find xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="DeviceReference">
            <uri1:ID>Dev01</uri1:ID>
        </uri:SubscribeNetObjectReference>
    </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

By other parameters
Passing one of Account ID, AddOn SKU, Activation Code and Order ID will find all devices with that value. 
It is also possible to find a device for a combination of these parameters.
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
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         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Find>
         <uri:SubscribeNetObjectReference xsi:type="uri1:DeviceReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:AccountID>AS_AddOnAccount</uri1:AccountID>
        <uri1:AddOnSKU>AXSCards-hwc</uri1:AddOnSKU> 
        <uri1:ActivationCode>7B99-E6B9-8646-6BE6</uri1:ActivationCode> 
        <uri1:OrderID>AddOn_AXSCards-hwc</uri1:OrderID>
        </uri:SubscribeNetObjectReference>
      </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

Find Server

By ID
Passing Server ID will find all Servers with that ID (multiple host ID types)
From 2013.11 release, can also pass Backup Server ID.
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Find xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="FNEServerReference">
            <uri1:ID>PrimaryServer_01</uri1:ID>
            <uri1:HostIDType>ETHERNET</uri1:HostIDType>
            <uri1:PublisherName>hwclient</uri1:PublisherName>
        </uri:SubscribeNetObjectReference>
    </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

By Account ID
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
          <uri:SessionID>810651c9-e779-4a2b-a63f-e383c6622dadLRWxuVlu6r2OeiGUDU3lPQBEkE=</
uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
          <uri:Find>
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                <uri:SubscribeNetObjectReference xsi:type="uri1:FNEServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                       <uri1:AccountID>AS_AddOnAccount</uri1:AccountID>
                </uri:SubscribeNetObjectReference>
         </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

By Activation Code
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
      <soapenv:Header>
            <uri:SessionHeader>
                     <uri:SessionID>810651c9-e779-4a2b-a63f-e383c6622dadLRWxuVlu6r2OeiGUDU3lPQBEkE=</
uri:SessionID>
            </uri:SessionHeader>
      </soapenv:Header>
      <soapenv:Body>
              <uri:Find>
                    <uri:SubscribeNetObjectReference xsi:type="uri1:FNEServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                            <uri1:ActivationCode>CB1E-ACE6-0455-0AE6</uri1:ActivationCode> 
                    </uri:SubscribeNetObjectReference>
              </uri:Find>
     </soapenv:Body>
</soapenv:Envelope>

By Order ID
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
    <soapenv:Header>
           <uri:SessionHeader>
                   <uri:SessionID>810651c9-e779-4a2b-a63f-e383c6622dadLRWxuVlu6r2OeiGUDU3lPQBEkE=</
uri:SessionID>
           </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
            <uri:Find>
                  <uri:SubscribeNetObjectReference xsi:type="uri1:FNEServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                         <uri1:OrderID>WSOrder02102020-i</uri1:OrderID> 
                  </uri:SubscribeNetObjectReference>
            </uri:Find>
    </soapenv:Body>
</soapenv:Envelope>
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Find Feature

Retrieve All
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Find xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="FlexFeatureReference">
        </uri:SubscribeNetObjectReference>
    </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

Retrieve Specific
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Find xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="FlexFeatureReference">
            <uri1:FeatureName>Bin1</uri1:FeatureName>
            <uri1:Version>1.0</uri1:Version>
        </uri:SubscribeNetObjectReference>
    </uri:Find>
   </soapenv:Body>
</soapenv:Envelope>

Add Requests
• Add Feature

• Add Server Host Type

• Add Server

• Add CLS

• Add Device
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Add Feature
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Add xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:FlexFeature" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference>
                <uri1:FeatureName>AS_Test_Feature_1</uri1:FeatureName>
                <uri1:Version>1.0000</uri1:Version>
            </uri1:Reference>
            <uri1:Description>Feature created via web service</uri1:Description>
            <uri1:Counted>TRUE</uri1:Counted>
            <uri1:Scale>10</uri1:Scale>
            <uri1:Reusable>FALSE</uri1:Reusable>
        </SubscribeNetObject>
      </uri:Add>
   </soapenv:Body>
</soapenv:Envelope>

Add Server Host Type

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Add xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEServerHostType" xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:Reference xsi:type="uri1:FNEServerHostTypeReference">
            <uri1:ID xsi:type="xsd:string">AS_FNEServerHostType_2</uri1:ID>
        </uri1:Reference>
        <uri1:Name>AS_FNEServerHostType_2</uri1:Name>
        <uri1:PublisherName>fnedemo</uri1:PublisherName>
        <uri1:IdentityName>fnedemo</uri1:IdentityName>
     </SubscribeNetObject>
      </uri:Add>
   </soapenv:Body>
</soapenv:Envelope>
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Add Server

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
       <uri:Add xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEServer" xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:Reference>
            <uri1:ID>PrimaryServer_01</uri1:ID>
            <uri1:HostIDType>ETHERNET</uri1:HostIDType>
        </uri1:Reference>
        <uri1:BackupID>BackupServer_01</uri1:BackupID>
        <uri1:FNEServerHostType>
            <uri1:Reference>
                <uri1:ID>hosttypeID1</uri1:ID>
            </uri1:Reference>
        </uri1:FNEServerHostType>
        <uri1:Alias>Server_01</uri1:Alias>
        <uri1:Notes>DEMO Test Server</uri1:Notes>
        <uri1:Owner>
            <uri1:ID>TestAccount</uri1:ID>
            <uri1:IntrawareID>37647181</uri1:IntrawareID>
        </uri1:Owner>        
     </SubscribeNetObject>
      </uri:Add>
   </soapenv:Body>
</soapenv:Envelope>

Add CLS
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   <uri:OptionsHeader/></soapenv:Header>
   <soapenv:Body>
       <uri:Add xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEServer" xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:Deployment>CLOUD</uri1:Deployment>
        <uri1:Alias>Owned by: system@example.com</uri1:Alias>
        <uri1:Notes>UsesDefaultHostType</uri1:Notes>
        <uri1:SiteName>AS-Itasca</uri1:SiteName>
        <!-- If you want to specify a server host type, use this. Not specifying a host type will create 
the CLS with default host type -->
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        <!--uri1:FNEServerHostType>
            <uri1:Reference>
                <uri1:ID>FLX_SERVER</uri1:ID>
            </uri1:Reference>
        </uri1:FNEServerHostType-->
        <uri1:Owner>
                        <uri1:ID>AS_AddOnAccount</uri1:ID>
                        <!--uri1:IntrawareID>37647181</uri1:IntrawareID-->
                </uri1:Owner>  
     </SubscribeNetObject>
      </uri:Add>
   </soapenv:Body>
</soapenv:Envelope>

Add Device
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
       <uri:Add xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:Device" xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:Reference xsi:type="uri1:DeviceReference">
            <uri1:ID>Dev01</uri1:ID>
            <uri1:PublisherName>hwclient</uri1:PublisherName>
            <uri1:HostIDType>FLEXID10</uri1:HostIDType>
        </uri1:Reference>
        <uri1:Alias>Dev01</uri1:Alias>
        <uri1:Notes>WebServicesTest-set host id type in add device request</uri1:Notes>
        <uri1:DeviceModel>
             <!-- Intraware IDs no longer displayed -->
            <!--uri1:IntrawareID>283</uri1:IntrawareID> -->
            <uri1:ID>FLX_CLIENT</uri1:ID>
         </uri1:DeviceModel>
        <uri1:LicenseModel>
            <uri1:Code>DEFAULT_BASE</uri1:Code>
<!--            Uncomment to use user defined device base license model -->
<!--            <uri1:Code>DATABASE</uri1:Code>
            <uri1:IntrawareLicenseModelID>511</uri1:IntrawareLicenseModelID> -->
        </uri1:LicenseModel>
     </SubscribeNetObject>
      </uri:Add>
   </soapenv:Body>
</soapenv:Envelope>
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AddUpdate Requests
• AddUpdate Flex Feature

AddUpdate Flex Feature
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
          <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:FlexFeature" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference>
                <uri1:FeatureName>AS_Test_Feature_1</uri1:FeatureName>
                <uri1:Version>1.0000</uri1:Version>
                <uri1:VendorName>demo</uri1:VendorName>
            </uri1:Reference>
            <uri1:Description>Feature Updated via addupdate web service</uri1:Description>
            <uri1:Counted>TRUE</uri1:Counted>
            <uri1:Reusable>FALSE</uri1:Reusable>
        </SubscribeNetObject>
</AddUpdate>
   </soapenv:Body>
</soapenv:Envelope>

Update Requests
• Update Catalog for Flex Licensing

• Update Device Alias

• Update Server Alias

• Update Server - Map AddOns

• Update Device – Map AddOns

• Update FNE Trusted Storage - Server

• Update FNE Trusted Storage - Device

• Update Device Owner

• Update Server Owner

• Update Device License File
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Update Catalog for Flex Licensing
(As of 2014.02 release, vendor name has been removed)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:CatalogFlexLicensing" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:CatalogItem>
                <uri1:IntrawareID>3609763</uri1:IntrawareID>
                <uri1:ID xsi:type="xsd:string">Catalog-A</uri1:ID>
            </uri1:CatalogItem>
            <uri1:CountedFeature>
                <uri1:Feature>
                    <uri1:FeatureName>AS_Accounts</uri1:FeatureName>
                    <uri1:Version>1.0</uri1:Version>
                    <!--uri1:VendorName>fnedemo</uri1:VendorName-->
                </uri1:Feature>
                <uri1:Count>1</uri1:Count>
            </uri1:CountedFeature>
            <uri1:LicenseModel>
                <!-- If you want to use default order line license model, uncomment "ONLY" the following 
line-->
                <!--uri1:Code>DEFAULT_ORDERLINE</uri1:Code-->
                <!-- If you want to use user defined license model, uncomment the following TWO lines-->
                <!--uri1:Code>DATABASE</uri1:Code-->
                <!--uri1:IntrawareLicenseModelID>1613</uri1:IntrawareLicenseModelID-->
            </uri1:LicenseModel>
            <!--uri1:UsageModelID>2</uri1:UsageModelID-->
         </SubscribeNetObject>
      </uri:Update>
   </soapenv:Body>
</soapenv:Envelope>

Update Device Alias
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
  <soapenv:Header>
       <uri:SessionHeader>
             <uri:SessionID>3eec80b4-ec1f-4796-94b5-
225f87f25daf6iVANUoaQ0vz4bAPf6oG4xxiE1doju4LOhH2lIcG4cK7</uri:SessionID>
       </uri:SessionHeader>
       <uri:OptionsHeader/>
  </soapenv:Header>
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  <soapenv:Body>
         <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
              <SubscribeNetObject xsi:type="uri1:Device" xmlns:uri1="uri:subscribenet.intraware.com">
                  <uri1:Reference xsi:type="uri1:DeviceReference">
                      <uri1:ID>AS_Device_Aug2015</uri1:ID>
                      <uri1:PublisherName>fnedemo</uri1:PublisherName>
                      <uri1:HostIDType>STRING</uri1:HostIDType>
                  </uri1:Reference>
                  <uri1:Alias>Europe Region</uri1:Alias>
              </SubscribeNetObject>
         </uri:Update>
  </soapenv:Body>
</soapenv:Envelope>

Update Server Alias
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
  <soapenv:Header>
       <uri:SessionHeader>
             <uri:SessionID>3eec80b4-ec1f-4796-94b5-
225f87f25daf6iVANUoaQ0vz4bAPf6oG4xxiE1doju4LOhH2lIcG4cK7</uri:SessionID>
       </uri:SessionHeader>
       <uri:OptionsHeader/>
  </soapenv:Header>
  <soapenv:Body>
         <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
              <SubscribeNetObject xsi:type="uri1:Device" xmlns:uri1="uri:subscribenet.intraware.com">
                  <uri1:Reference xsi:type="uri1:FNEServerReference">
                      <uri1:ID>Server123</uri1:ID>
                      <uri1:PublisherName>fnedemo</uri1:PublisherName>
                      <uri1:HostIDType>STRING</uri1:HostIDType>
                  </uri1:Reference>
                  <uri1:Alias>NAM Region</uri1:Alias>
              </SubscribeNetObject>
         </uri:Update>
  </soapenv:Body>
</soapenv:Envelope>

Update Server - Map AddOns
Note: Backup Server ID is also accepted (since 2013.11 release)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
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      <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEHostAddOnCounts" 
xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:Host xsi:type="uri1:FNEServerReference">
            <uri1:ID>AS_FNEServer_3</uri1:ID>
            <uri1:IntrawareID>1489</uri1:IntrawareID>
            <uri1:HostIDType>ETHERNET</uri1:HostIDType>
        </uri1:Host>        
        <uri1:AddOnCounts>
            <uri1:AddOn xsi:type="uri1:AddOn">
                <uri1:ActivationCode>0F30-6797-AA77-B685</uri1:ActivationCode>
                <uri1:Count>10</uri1:Count>
            </uri1:AddOn>
        </uri1:AddOnCounts>
        <uri1:Reset>FALSE</uri1:Reset>                
     </SubscribeNetObject>
      </uri:Update>
   </soapenv:Body>
</soapenv:Envelope>

Update Device – Map AddOns
(When add-ons are first mapped, use Associate AddOns call. For subsequent mapping of addons to the same 
device, use this call)

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEHostAddOnCounts" 
xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:Host xsi:type="uri1:DeviceReference">
            <uri1:ID>Dev02</uri1:ID>
            <uri1:HostIDType>FLEXID10</uri1:HostIDType>
            <uri1:PublisherName>hwclient</uri1:PublisherName>
        </uri1:Host>        
        <uri1:AddOnCounts>
            <uri1:AddOn xsi:type="uri1:AddOn">
                <uri1:ActivationCode>7B99-E6B9-8646-6BE6</uri1:ActivationCode>
                <uri1:Count>5</uri1:Count>
            </uri1:AddOn>
        </uri1:AddOnCounts>
        <uri1:Reset>FALSE</uri1:Reset>                
     </SubscribeNetObject>
      </uri:Update>
   </soapenv:Body>
</soapenv:Envelope>
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Update FNE Trusted Storage - Server

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xs="http://www.w3.org/2001/XMLSchema">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
         <SubscribeNetObject xsi:type="uri1:FNEHostTrustedStorage" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Host xsi:type="uri1:FNEServerReference">
                <uri1:IntrawareID>1480</uri1:IntrawareID>
            </uri1:Host>
            <uri1:Request xsi:type="xs:base64Binary">AAAA+AAAhir/////
AAAACwABAAAAAAIAAAAoAK0FAAAACwCuAAAAAAQAAAALAK8AAAAABQAAAAsAsAAAAAAAAAAACwDKAAAAAAUAAAAPAAcCZm5lZGVtbwA
AAAALAFwAUAcCygAAAAsAXQAAAAAAAAAAFgBNAkFTX0ZORVNlcnZlcl8xAAAAAAsApgAAAAADAAAACwDOAAAAAAAAAAALANIAAAAAAQ
AAAA8AgAJmbmVkZW1vAAAAAEMAagUAAAALAGwAAAAABQAAAAsAkgAAAAACAAAACwBTAAAAAAAAAAAbAGsL8CgcdWnIqeBKFQkUsDYRh
E0SJoU=</uri1:Request>
         </SubscribeNetObject>
</uri:Update>
   </soapenv:Body>
</soapenv:Envelope>

Request is base64 encoding of request.bin file. Follow these steps to generate the binary and base64 
encoding
These commands require FNE Toolkit to be installed. The toolkit can be obtained from 
(\\nfs\fnebuild\release\4.6.0). Extract the toolkit to local drive. Execute the following commands from 
\bin\tools folder.

· Generate request.bin file
caprequestutil.bat -id IdentityClient.bin -idtype ServerIDType -device ServerID -server request.bin

· Convert request.bin into base64 binary
printbin -base64 request.bin

Update FNE Trusted Storage - Device

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xs="http://www.w3.org/2001/XMLSchema">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
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         <SubscribeNetObject xsi:type="uri1:FNEHostTrustedStorage" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Host xsi:type="uri1:DeviceReference">
                <uri1:ID>Dev02</uri1:ID>
                <uri1:PublisherName>hwclient</uri1:PublisherName>
                <uri1:HostIDType>FLEXID10</uri1:HostIDType>
            </uri1:Host>
         </SubscribeNetObject>
</uri:Update>
   </soapenv:Body>
</soapenv:Envelope>
 

Update Device Owner
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
 <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEHostOwner" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:DeviceReference">
                <uri1:ID>Dev01</uri1:ID>
                <uri1:PublisherName>hwclient</uri1:PublisherName>
                <uri1:HostIDType>FLEXID9</uri1:HostIDType>
            </uri1:Reference>
            <uri1:Owner>
                <uri1:ID>AS_AddOnAccount</uri1:ID>
                <uri1:IntrawareID>35207123</uri1:IntrawareID>
            </uri1:Owner>
     </SubscribeNetObject>
      </uri:Update>
   </soapenv:Body>
</soapenv:Envelope>

Update Server Owner
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
      <uri:OptionsHeader/>
   </soapenv:Header>
   <soapenv:Body>
 <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
     <SubscribeNetObject xsi:type="uri1:FNEHostOwner" xmlns:uri1="uri:subscribenet.intraware.com">
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            <uri1:Reference xsi:type="uri1:FNEServerReference">
                <uri1:ID>ServerID</uri1:ID>
                <uri1:PublisherName>PublisherName</uri1:PublisherName>
                <uri1:HostIDType>ServerIDType</uri1:HostIDType>
                <!--uri1:IntrawareID>intrawareID</uri1:IntrawareID-->
            </uri1:Reference>
            <uri1:Owner>
                <uri1:ID>AccountID</uri1:ID>
            </uri1:Owner>
     </SubscribeNetObject>
      </uri:Update>
   </soapenv:Body>
</soapenv:Envelope>

Update Device License File
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
    <soapenv:Header>
         <uri:SessionHeader>
                 <uri:SessionID></uri:SessionID>
          </uri:SessionHeader>
       </soapenv:Header>
       <soapenv:Body>
         <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
             <SubscribeNetObject xsi:type="uri1:DeviceLicenseFile" 
xmlns:uri1="uri:subscribenet.intraware.com">
                  <uri1:Reference xsi:type="uri1:DeviceLicenseFileReference">
                       <uri1:ID>AS_WSDev_03</uri1:ID>
                       <uri1:PublisherName>fnedemo</uri1:PublisherName>
                       <uri1:HostIDType>STRING</uri1:HostIDType>
                </uri1:Reference>
             </SubscribeNetObject>
          </uri:Update>
      </soapenv:Body>
</soapenv:Envelope>

Associate Requests
• Associate AddOns - Server

• Associate AddOns - Device

Associate AddOns - Server

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
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         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Associate xmlns="uri:webservice.subscribenet.intraware.com">
            <uri1:SubscribeNetObjectReference xsi:type="uri1:FNEServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:ID>AS_FNEServer_1</uri1:ID>
                <uri1:PublisherName>fnedemo</uri1:PublisherName>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
                </uri1:SubscribeNetObjectReference>
                        <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AddOnCounts">
                <uri1:AddOn xsi:type="uri1:AddOn">
                    <uri1:ActivationCode>0F30-6797-AA77-B685</uri1:ActivationCode>
                    <uri1:Count>15</uri1:Count>
                </uri1:AddOn>
                </uri1:SubscribeNetObjectReferenceAss>
      </uri:Associate>
   </soapenv:Body>
</soapenv:Envelope>

Associate AddOns - Device
(To associate AddOns for the first time, use this request)
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Associate xmlns="uri:webservice.subscribenet.intraware.com">
            <uri1:SubscribeNetObjectReference xsi:type="uri1:DeviceReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:ID>Dev01</uri1:ID>
                <uri1:PublisherName>fnedemo</uri1:PublisherName>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
                </uri1:SubscribeNetObjectReference>
                <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AddOnCounts">
                <uri1:AddOn xsi:type="uri1:AddOn">
                    <uri1:ActivationCode>C4E7-9B68-6E26-D1B2</uri1:ActivationCode>
                    <uri1:Count>2</uri1:Count>
                </uri1:AddOn>
                </uri1:SubscribeNetObjectReferenceAss>
      </uri:Associate>
   </soapenv:Body>
</soapenv:Envelope>

Disassociate Requests
• Disassociate AddOns - Server
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• Disassociate AddOns - Device

Disassociate AddOns - Server
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
         <uri:Disassociate xmlns="uri:webservice.subscribenet.intraware.com">
            <uri1:SubscribeNetObjectReference xsi:type="uri1:FNEServerReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:ID>AS_FNEServer_1</uri1:ID>
                <uri1:PublisherName>fnedemo</uri1:PublisherName>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
                </uri1:SubscribeNetObjectReference>
                        <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AddOnCounts">
                <uri1:AddOn xsi:type="uri1:AddOn">
                    <uri1:ActivationCode>0F30-6797-AA77-B685</uri1:ActivationCode>
                    <uri1:Count>15</uri1:Count>
                </uri1:AddOn>
                </uri1:SubscribeNetObjectReferenceAss>
          </uri:Disassociate>
   </soapenv:Body>
</soapenv:Envelope>

Disassociate AddOns - Device
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
      <soapenv:Body>
      <uri:Disassociate xmlns="uri:webservice.subscribenet.intraware.com">
            <uri1:SubscribeNetObjectReference xsi:type="uri1:DeviceReference" 
xmlns:uri1="uri:subscribenet.intraware.com">            
                <uri1:ID>Dev01</uri1:ID>
                <uri1:PublisherName>hwclient</uri1:PublisherName>
                <uri1:HostIdType>ETHERNET</uri1:HostIDType>
                    </uri1:SubscribeNetObjectReference>
                    <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AddOnCounts">
                <uri1:AddOn xsi:type="uri1:AddOn">
                    <uri1:ActivationCode>50C4-CDBE-C7AD-0523</uri1:ActivationCode>
                    <uri1:Count>2</uri1:Count>
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                </uri1:AddOn>
             </uri1:SubscribeNetObjectReferenceAss>
      </uri:Disassociate>
   </soapenv:Body>
</soapenv:Envelope>

Move Device
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance"  xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID>6ababf72-d22d-44fa-b710-5c8457e20beahtfBaMWn/
gVuydvprAk583Y2Spob0raQ4FXGO3YTxsT1</uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:MoveDevice xmlns="uri:webservice.subscribenet.intraware.com">
         <uri:SubscribeNetObject xsi:type="uri1:MoveDevice" 
xmlns:uri1="uri:subscribenet.intraware.com">
             <uri1:MoveDeviceReference xsi:type="uri1:DeviceReference">
              <uri1:ID xsi:type="xsd:string">FlexeraQADevice4</uri1:ID>
              <uri1:PublisherName xsi:type="xsd:string">fnedemo</uri1:PublisherName>
              <uri1:HostIDType xsi:type="xsd:string">STRING</uri1:HostIDType>
            </uri1:MoveDeviceReference>
         </uri:SubscribeNetObject>
         <uri:SubscribeNetObjectReference xsi:type="uri2:AccountReference" 
xmlns:uri2="uri:subscribenet.intraware.com">
                 <!-- Specify the Device Owner Account here, either the Account ID or System Account ID 
-->
                 <uri2:ID>FlexQAESDSourceAccount</uri2:ID>
          </uri:SubscribeNetObjectReference>
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri3:AccountNoShareIDReference" 
xmlns:uri3="uri:subscribenet.intraware.com">
              <!-- Specify the new account that should own the device after move -->
              <uri3:ID>FlexeraQATargetAccount</uri3:ID>
         </uri:SubscribeNetObjectReferenceAss>
      </uri:MoveDevice>
   </soapenv:Body>
</soapenv:Envelope>

Move Server
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance"  xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID>12bc5c1e-92a6-4838-acc5-28a0f256035eYDn9zcg5IPxD6hq8NzfV8E3dG4rrpJZrRPKRzQU=</
uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
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      <uri:MoveServer xmlns="uri:webservice.subscribenet.intraware.com">
         <uri:SubscribeNetObject xsi:type="uri1:MoveDevice" 
xmlns:uri1="uri:subscribenet.intraware.com">
             <uri1:MoveDeviceReference xsi:type="uri1:DeviceReference">
              <uri1:ID xsi:type="xsd:string">FlexeraQATestServer0422</uri1:ID>
              <uri1:PublisherName xsi:type="xsd:string">fnedemo</uri1:PublisherName>
              <uri1:HostIDType xsi:type="xsd:string">ETHERNET</uri1:HostIDType>
            </uri1:MoveDeviceReference>
         </uri:SubscribeNetObject>
         <uri:SubscribeNetObjectReference xsi:type="uri1:AccountReference" 
xmlns:uri2="uri:subscribenet.intraware.com">
                       <!-- Specify the Server Owner Account here, either the Account ID or System 
Account ID -->
                       <!--uri1:IntrawareID>35412913</uri1:IntrawareID-->
                       <uri2:ID>AS_AddOnAccount</uri2:ID>
          </uri:SubscribeNetObjectReference>
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference" 
xmlns:uri3="uri:subscribenet.intraware.com">
              <!-- Specify the new account that should own the server after move -->
              <uri1:ID>AS_TargetAccount</uri1:ID>
              <!--uri1:IntrawareID>35412913</uri1:IntrawareID-->
         </uri:SubscribeNetObjectReferenceAss>
      </uri:MoveServer>
   </soapenv:Body>
</soapenv:Envelope>

Return Device
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
        <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <uri:ReturnDevice xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:ReturnDevice" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:ReturnDeviceReference xsi:type="uri1:DeviceReference">
                <uri1:ID>AS_Dev0_10206</uri1:ID>
                <uri1:PublisherName>fnedemo</uri1:PublisherName>
                <uri1:HostIDType>ETHERNET</uri1:HostIDType>
            </uri1:ReturnDeviceReference>
          <uri1:Rma>RMA100602</uri1:Rma>                       
            <!--<uri1:TargetDeviceReference xsi:type="uri1:DeviceReference">
                <uri1:ID></uri1:ID>
                <uri1:PublisherName></uri1:PublisherName>
                <uri1:HostIDType></uri1:HostIDType>
            </uri1:TargetDeviceReference> -->
        </SubscribeNetObject>
      </uri:ReturnDevice>
   </soapenv:Body>
</soapenv:Envelope>
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Get Requests
This section describes the Get Requests API operation.

• Login (Get Requests)

• Get License Token

• Get Order Line

• Get Order - using Activation Code

• Get Account

• Get Member

• Get CatalogItem

Login (Get Requests)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Get License Token
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Get>
         <uri1:SubscribeNetObjectReference xsi:type="uri1:LicenseTokenReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
          <uri1:ID></uri1:ID>
          <uri1:IntrawareID></uri1:IntrawareID>
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     </uri1:SubscribeNetObjectReference>
      </uri:Get>
   </soapenv:Body>
</soapenv:Envelope>

Get Order Line

Note • Use Line Number along with System Order ID and/or Order ID to get the order line information.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Get xmlns="uri:subscribenet.intraware.com">
           <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="OrderLineReference">
         <uri1:IntrawareID>SystemEntitlementID</uri1:IntrawareID>
            <!-- AND/OR -->
         <uri1:ID>EntitlementID</uri1:ID>
         <uri1:LineNumber>linenumber</uri1:LineNumber>
           </uri:SubscribeNetObjectReference>
       </uri:Get>
   </soapenv:Body>
</soapenv:Envelope>

Get Order - using Activation Code
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID>Session ID</uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Get xmlns="uri:subscribenet.intraware.com">
           <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="OrderActivationCodeReference">
              <!-- OPTIONAL -->
              <!-- <uri1:ID>EntitlementID</uri1:ID>
              <uri1:IntrawareID>SystemEntitlementID</uri1:IntrawareID> -->
             <uri1:ActivationCode>ActivationCode</uri1:ActivationCode>
           </uri:SubscribeNetObjectReference>
       </uri:Get>
   </soapenv:Body>
</soapenv:Envelope>
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Get Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
    <soapenv:Header>
         <uri:SessionHeader>
             <uri:SessionID>810651c9-e779-4a2b-a63f-e383c6622dadLRWxuVlu6r2OeiGUDU3lPQBEkE=</
uri:SessionID>
         </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
           <uri:Get xmlns="uri:subscribenet.intraware.com">
                   <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xsi:type="AccountReference">
                             <uri1:ID xsi:type="xsd:string">AS_AddOnAccount</uri1:ID>
                   </uri:SubscribeNetObjectReference>
           </uri:Get>
    </soapenv:Body>
</soapenv:Envelope>

Get Member
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Get xmlns="uri:subscribenet.intraware.com">
        <uri:SubscribeNetObjectReference xsi:type="uri1:MemberReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:AccountReference xsi:type="uri1:AccountReference">
                <uri1:IntrawareID>SystemAccountID</uri1:IntrawareID>
            </uri1:AccountReference>
<!-- If Account does not have an Account ID, use System Member ID -->            
            <uri1:IntrawareID>SystemMemberID</uri1:IntrawareID>
            <uri1:ID xsi:type="xsd:string">MemberID</uri1:ID>
<!--    OPTIONAL  -->
            <uri1:Email xsi:type="xsd:string">Email</uri1:Email> -->
         </uri:SubscribeNetObjectReference>
       </uri:Get>
  </soapenv:Body>
</soapenv:Envelope>

Get CatalogItem
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <soapenv:Header>
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        <uri:SessionHeader>
            <uri1:SessionID></uri1:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:Get xmlns="uri:subscribenet.intraware.com">
            <uri1:SubscribeNetObjectReference xsi:type="uri1:CatalogItemReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:IntrawareID>123456789</uri1:IntrawareID>
                <!--uri1:ID>1e3ce632-6784-4735-8a71-b819928415f8</uri1:ID-->
            </uri1:SubscribeNetObjectReference>
        </uri:Get>
    </soapenv:Body>
</soapenv:Envelope>

License Requests
This section describes the License Requests API operation.

• Generate Licenses (FNP Certificate Only)

• Find Licenses

• Return Licenses

• Rehost Licenses

• Retrieve Licenses From FNOC Pool

Generate Licenses (FNP Certificate Only)
• Node License

• Server License

• Lexmark License

• Paccar License

• IXIA BreakingPoint License

Node License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance"  xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:GenerateLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri1="uri:subscribenet.intraware.com"  xsi:type="GenerateLicense">
                <uri1:ActivationCode>5E8E-8EE0-70B4-A3BB</uri1:ActivationCode>
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                <uri1:LicenseQuantity>1</uri1:LicenseQuantity>
                <uri1:ProductID>LXKI_Node_Product_01</uri1:ProductID>
                <uri1:OverDraftQuantity>11</uri1:OverDraftQuantity>
                <uri1:IssueDate xsi:type="xs:date">2012-01-05></uri1:IssueDate>
                <uri1:FlexTmplNodeLicense xmlns="uri:subscribenet.intraware.com">
                    <uri1:NodeHostIdType>HST_TYP_ETHER</uri1:NodeHostIdType>
                    <uri1:NodeHostId>11223388</uri1:NodeHostId>
                    <uri1:NodeHostDscr>TestHost</uri1:NodeHostDscr>
                    <uri1:NodeHostName>Example11223388</uri1:NodeHostName>
                    <uri1:NodeHostQuantity>1</uri1:NodeHostQuantity>
                </uri1:FlexTmplNodeLicense>
            </uri:SubscribeNetObjectReference>
        </uri:GenerateLicense>
    </soapenv:Body>
</soapenv:Envelope>

Server License

Note • Activation Code is optional.  Only for Certificate licenses. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance"  xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:GenerateLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri1="uri:subscribenet.intraware.com"  xsi:type="GenerateLicense">
<!--                 <uri1:ActivationCode>31BF-B46A-59A6-E529</uri1:ActivationCode>  -->
                <uri1:OrderID>AS_TestOrder_02</uri1:OrderID>
                <uri1:LineNumber>1</uri1:LineNumber>
                <uri1:ProductID>Agilent_GC</uri1:ProductID>
                <uri1:LicenseQuantity>1</uri1:LicenseQuantity>
                <uri1:IssueDate xsi:type="xs:date">2012-03-15</uri1:IssueDate>
                <uri1:FlexTmplServerLicense xmlns="uri:subscribenet.intraware.com">
                    <uri1:ServerHostIdType0>HST_TYP_ETHER</uri1:ServerHostIdType0>
                    <uri1:ServerHostId0>1111111111</uri1:ServerHostId0>
                    <uri1:ServerHostDscr0>Server1111111111</uri1:ServerHostDscr0>
                    <uri1:ServerHostName0>Server1111111111</uri1:ServerHostName0>
                    <uri1:ServerHostPort0>8080</uri1:ServerHostPort0>
                    <uri1:ServerHostIdType1>HST_TYP_ETHER</uri1:ServerHostIdType1>
                    <uri1:ServerHostId1>2222222222</uri1:ServerHostId1>
                    <uri1:ServerHostDscr1>Server2222222222</uri1:ServerHostDscr1>
                    <uri1:ServerHostName1>Server2222222222</uri1:ServerHostName1>
                    <uri1:ServerHostPort1>8081</uri1:ServerHostPort1>
                    <uri1:ServerHostIdType2>HST_TYP_ETHER</uri1:ServerHostIdType2>
                    <uri1:ServerHostId2>3333333333</uri1:ServerHostId2>
                    <uri1:ServerHostDscr2>Server3333333333</uri1:ServerHostDscr2>
                    <uri1:ServerHostName2>Server3333333333</uri1:ServerHostName2>
                    <uri1:ServerHostPort2>8082</uri1:ServerHostPort2>
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                </uri1:FlexTmplServerLicense>
            </uri:SubscribeNetObjectReference>
        </uri:GenerateLicense>
    </soapenv:Body>
</soapenv:Envelope>

Lexmark License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance" xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:GenerateLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri1="uri:subscribenet.intraware.com" xsi:type="GenerateLicense">
                <uri1:ActivationCode>5C68-CBAA-8961-A23C</uri1:ActivationCode>
                <uri1:LicenseQuantity>520</uri1:LicenseQuantity>
                <uri1:ProductID>82M0903-001</uri1:ProductID>
                <!--<uri1:OverDraftQuantity>11</uri1:OverDraftQuantity>-->
                <uri1:IssueDate xsi:type="xs:date">2012-07-16></uri1:IssueDate>
                <uri1:LexmarkLicense xmlns="uri:subscribenet.intraware.com">
                    <uri1:requestId>Req11223321</uri1:requestId>
                    <uri1:NodeHostId>11223321</uri1:NodeHostId>
                </uri1:LexmarkLicense>
            </uri:SubscribeNetObjectReference>
        </uri:GenerateLicense>
    </soapenv:Body>
</soapenv:Envelope>

Paccar License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance" xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:GenerateLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri1="uri:subscribenet.intraware.com" xsi:type="GenerateLicense">
<!--                <uri1:ActivationCode>F0D1-C689-1EAD-35A0</uri1:ActivationCode> -->
                <uri1:OrderID>AS_PaccarOrder_01</uri1:OrderID>
                <uri1:LineNumber>1</uri1:LineNumber>
                <uri1:LicenseQuantity>1</uri1:LicenseQuantity>
                <uri1:IssueDate xsi:type="xs:date">2012-09-12></uri1:IssueDate>
                <uri1:PaccarLicense xmlns="uri:webservice.subscribenet.intraware.com">
                    <uri1:LicenseHostID>20120912</uri1:LicenseHostID>
                    <uri1:LicenseHostName>AS_LicenseHost</uri1:LicenseHostName>
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                </uri1:PaccarLicense>
            </uri:SubscribeNetObjectReference>
        </uri:GenerateLicense>
    </soapenv:Body>
</soapenv:Envelope>

IXIA BreakingPoint License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <SessionHeader>
            <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com">session ID from login 
response</uri:SessionID>
        </SessionHeader>
        <OptionsHeader>
            <uri:OrderEmailDirective>DEFAULT</uri:OrderEmailDirective>
            <uri:OrderEmailVariation>DEFAULT</uri:OrderEmailVariation>
        </OptionsHeader>
    </soapenv:Header>
    <soapenv:Body>
        <AddUpdate xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObject xsi:type="uri1:Order" xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Reference xsi:type="uri1:OrderReference">
                    <uri1:ID xsi:type="uri1:string">BreakingPoint_Order01</uri1:ID>
                </uri1:Reference>
                <uri1:Account xsi:type="uri1:AccountReference">
                    <uri1:IntrawareID>35219323</uri1:IntrawareID>
                </uri1:Account>
                <uri1:OrderDate xsi:type="xs:date">2013-01-09</uri1:OrderDate>
                <uri1:PurchaseOrderID xsi:type="xsd:string">BreakingPoint_Order01</
uri1:PurchaseOrderID>
                <uri1:SalesRep>Online Order</uri1:SalesRep>
                <uri1:InvoiceID xsi:type="xsd:string">BreakingPoint_Order01</uri1:InvoiceID>
                <uri1:InvoiceDate xsi:type="xs:date">2013-01-09</uri1:InvoiceDate>
                <uri1:OrderNote>Order for Ixia Breaking Point License Issuer</uri1:OrderNote>
                <uri1:OrderLine xsi:type="uri1:OrderLine">
                    <uri1:LineNumber>1</uri1:LineNumber>
                    <uri1:SKU>IxiaBreakingPointCatalog_01</uri1:SKU>
                    <uri1:Quantity>1</uri1:Quantity>
                </uri1:OrderLine>
                <uri1:UserDefinedField code="HOST_ID">Example-Host</uri1:UserDefinedField>
                <uri1:UserDefinedField code="HOST_NAME">WebServicesHost1122334466</
uri1:UserDefinedField>
                <uri1:TO>system@example.com</uri1:TO>
            </SubscribeNetObject>
        </AddUpdate>
    </soapenv:Body>
</soapenv:Envelope>

Find Licenses
• Find Node Licenses
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• Find License by License ID

• Find Server License

Find Node Licenses
To find licenses by Activation Code:
Pass Activation Code and Account ID parameters. All other parameters are not necessary
To find licenses by Order ID:
Pass Order ID along with Account ID
To find licenes for an order line:
Pass Order ID, Account ID, ProductID, Line Number
To find licenses by Host:
Pass Account ID, Order ID, HostID
Find license by License ID:
It is also possible to find licenses by License ID. The next request explains this in detail.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com"  xmlns:uri1="uri:subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
                 <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:Find xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="LicenseReference">
                <uri1:ActivationCode>233F-FFF1-6204-0674</uri1:ActivationCode>
                <uri1:AccountID>webservice1201</uri1:AccountID>
                <uri1:OrderID>webservice-node1201</uri1:OrderID>
                <uri1:ProductID>LXKI_Node_Product</uri1:ProductID>
                <uri1:LineNumber>1</uri1:LineNumber>
                <uri1:HostID>Example11223344</uri1:HostID>
                <uri1:IncludeLicenseFile>True</uri1:IncludeLicenseFile>
            </uri:SubscribeNetObjectReference>
        </uri:Find>
    </soapenv:Body>
</soapenv:Envelope>

Find License by License ID
The License ID can be obtained from the Reference ID tag in the soap response for Generate License. 
Another way to obtain license ID is to find the license using Activation Code or Order ID. The soap response will 
contain the Reference ID.

 After the implementation of Bug 15062, partner code validation is in place - the session ID used in the Find 
License call must match the session ID of the partner to whom the license belongs. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
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        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:Find xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="LicenseReference">
                    <uri1:ID>39644283</uri1:ID>
            </uri:SubscribeNetObjectReference>
        </uri:Find>
    </soapenv:Body>
</soapenv:Envelope>

Find Server License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com"  xmlns:uri1="uri:subscribenet.intraware.com">    
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>    
    <soapenv:Body>
<uri:Find xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="LicenseReference">
                <uri1:AccountID>webservice1201</uri1:AccountID>
                <uri1:OrderID>webservice-server1201</uri1:OrderID>
                <uri1:ProductID>LXKI_Server_Product_01</uri1:ProductID>
                <uri1:LineNumber>1</uri1:LineNumber>
            </uri:SubscribeNetObjectReference>
        </uri:Find>
    </soapenv:Body>
</soapenv:Envelope>

Return Licenses
• Both Node and Server

Both Node and Server
The License ID can be obtained from the Reference ID tag in the soap response for Generate License.

Another way to obtain license ID is to find the license using Activation Code or Order ID. The soap response will 
contain the Reference ID.

Partner code validation is in place - apart from the correct session ID, need to pass both Activation Code and 
Order ID in order to ensure that the license for another partner is not returned inadvertently.

Note • Return is only for Certificate licenses.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com"  xmlns:uri1="uri:subscribenet.intraware.com">
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    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:ReturnLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:type="LicenseReference">
                <uri1:ActivationCode></uri1:ActivationCode>
                <uri1:OrderID></uri1:OrderID>
                <uri1:ID></uri1:ID>
            </uri:SubscribeNetObjectReference>
        </uri:ReturnLicense>
    </soapenv:Body>
</soapenv:Envelope>

Rehost Licenses
• Node License

• Server License

Node License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance"  xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:RehostLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri1="uri:subscribenet.intraware.com"  xsi:type="RehostLicense">
                <uri1:LicenseID>37771951</uri1:LicenseID>
                <uri1:FlexTmplNodeLicense xmlns="uri:subscribenet.intraware.com">
                    <uri1:NodeHostIdType>HST_TYP_ETHER</uri1:NodeHostIdType>
                    <uri1:NodeHostId>11223388</uri1:NodeHostId>
                    <uri1:NodeHostDscr>TestHost</uri1:NodeHostDscr>
                    <uri1:NodeHostName>Example11223388</uri1:NodeHostName>
                    <uri1:NodeHostQuantity>1</uri1:NodeHostQuantity>
                </uri1:FlexTmplNodeLicense>
            </uri:SubscribeNetObjectReference>
        </uri:RehostLicense>
    </soapenv:Body>
</soapenv:Envelope>

Server License
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance"  xmlns:uri="uri:webservice.subscribenet.intraware.com">
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    <soapenv:Header>
        <uri:SessionHeader>
            <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header>
    <soapenv:Body>
        <uri:RehostLicense xmlns="uri:subscribenet.intraware.com">
            <uri:SubscribeNetObjectReference xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri1="uri:subscribenet.intraware.com"  xsi:type="RehostLicense">
                <uri1:LicenseID>37771960</uri1:LicenseID>
                <uri1:FlexTmplServerLicense xmlns="uri:subscribenet.intraware.com">
                    <uri1:ServerHostIdType0>HST_TYP_ETHER</uri1:ServerHostIdType0>
                    <uri1:ServerHostId0>4444444444</uri1:ServerHostId0>
                    <uri1:ServerHostDscr0>Server4444444444</uri1:ServerHostDscr0>
                    <uri1:ServerHostName0>Server4444444444</uri1:ServerHostName0>
                    <uri1:ServerHostPort0>8080</uri1:ServerHostPort0>
                    <uri1:ServerHostIdType1>HST_TYP_ETHER</uri1:ServerHostIdType1>
                    <uri1:ServerHostId1>5555555555</uri1:ServerHostId1>
                    <uri1:ServerHostDscr1>Server5555555555</uri1:ServerHostDscr1>
                    <uri1:ServerHostName1>Server5555555555</uri1:ServerHostName1>
                    <uri1:ServerHostPort1>8081</uri1:ServerHostPort1>
                    <uri1:ServerHostIdType2>HST_TYP_ETHER</uri1:ServerHostIdType2>
                    <uri1:ServerHostId2>6666666666</uri1:ServerHostId2>
                    <uri1:ServerHostDscr2>Server6666666666</uri1:ServerHostDscr2>
                    <uri1:ServerHostName2>Server6666666666</uri1:ServerHostName2>
                    <uri1:ServerHostPort2>8082</uri1:ServerHostPort2>
                </uri1:FlexTmplServerLicense>
            </uri:SubscribeNetObjectReference>
        </uri:RehostLicense>
    </soapenv:Body>
</soapenv:Envelope>

Retrieve Licenses From FNOC Pool
Endpoint: http://managerqa1.isys.intraware.com:80/service/snetmgr/services/License
WSDL: http://managerqa1.isys.intraware.com/service/snetmgr/services/License?wsdl
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.license.subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID>e6bb804c-81ef-4b30-8c21-b0b7163a0ad1afwn1aYWYL8Px3Mai3rhJdI5jailVhFV</
uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:GetEntitlementKeyFromPool>
         <uri:ActivationCode>1d86-ff60-a884-42e0-b09e-ed83-a695-2365</uri:ActivationCode>
         <uri:Quantity>2</uri:Quantity>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:GetEntitlementKeyFromPool>
   </soapenv:Body>
</soapenv:Envelope>
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Merge Account
This section describes the Merge Account API operation.

• Login (Merge Account)

• Merge Account

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Merge Account)
The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Merge Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:OptionsHeader>
      </uri:OptionsHeader>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Merge>
         <uri:SubscribeNetObjectReference xsi:type="uri1:AccountReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <!--Account that will be merged -->
            <!-- Account ID -->  
            <uri1:ID>AS-MergeFromAccount-0202</uri1:ID>
            <!-- System Account ID -->
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            <!--uri1:IntrawareID>?</uri1:IntrawareID>
            <uri1:SharePartnerID>?</uri1:SharePartnerID-->
         </uri:SubscribeNetObjectReference>
         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference">
         <!-- Merge To Account -->
            <!-- Account ID -->  
            <uri1:ID>AS-MergeToAccount-0202</uri1:ID>
            <!-- System Account ID -->
            <!--uri1:IntrawareID>?</uri1:IntrawareID-->
         </uri:SubscribeNetObjectReferenceAss>
      </uri:Merge>
   </soapenv:Body>
</soapenv:Envelope>

Reidentify
This section describes the Reidentify API operation.

• Login (Reidentify)

• Reidentify Member

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Reidentify)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>
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Reidentify Member
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
        <uri:OptionsHeader/>
        <uri:SessionHeader>
        <uri:SessionID></uri:SessionID>
        </uri:SessionHeader>
    </soapenv:Header> 
    <soapenv:Body>
        <Reidentify xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObjectReference xsi:type="ns2:MemberReference" 
xmlns:ns2="uri:subscribenet.intraware.com">
                <ns2:ID xsi:type="xsd:string"></ns2:ID>
                <ns2:AccountReference xsi:type="ns2:AccountReference">
                    <ns2:IntrawareID xsi:type="xsd:string"></ns2:IntrawareID>
                </ns2:AccountReference>
            </SubscribeNetObjectReference>
            <NewID></NewID>
        </Reidentify>
    </soapenv:Body>
</soapenv:Envelope>

Restrict Product / File
This section describes the Restrict Product / File API operation.

• Login (Restrict Product / File)

• Restrict Product to Account

• Restrict File to Account

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Note • Can only associate one entity at a time.

Login (Restrict Product / File)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important •  Change PartnerCode to the specific partner where the SOAP call is intended to be run. 
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<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Restrict Product to Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Restrict xmlns="uri:webservice.subscribenet.intraware.com">
    <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
        <uri1:IntrawareID>35210413</uri1:IntrawareID>
        <!--uri1:ID></ID-->
    </uri1:SubscribeNetObjectReferenceAss>
         <uri:SubscribeNetObjectReferenceRst xsi:type="uri1:RestrictProductReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:ID>AS_FlexTemplateProduct_01</uri1:ID>
            <!--uri1:IntrawareID></uri1:IntrawareID-->
       <!-- Allowed codes: Allow: A; Deny: D -->
        <uri1:RestrictCode>A</uri1:RestrictCode>
         </uri:SubscribeNetObjectReferenceRst>
      </uri:Restrict>
   </soapenv:Body>
</soapenv:Envelope>

Restrict File to Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   <uri:OptionsHeader/></soapenv:Header>
   <soapenv:Body>
      <uri:Restrict xmlns="uri:webservice.subscribenet.intraware.com">
    <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference">
            <uri1:IntrawareID>35210413</uri1:IntrawareID>
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        <!-- <uri1:ID>35254963</uri1:ID> -->
    </uri1:SubscribeNetObjectReferenceAss>
         <uri:SubscribeNetObjectReferenceRst xsi:type="uri1:RestrictFileReference">
            <uri1:IntrawareID>5261063</uri1:IntrawareID>
        <uri1:RestrictCode>D</uri1:RestrictCode>
         </uri:SubscribeNetObjectReferenceRst>
      </uri:Restrict>
   </soapenv:Body>
</soapenv:Envelope>

Unrestrict Product / File
This section describes the Unrestrict Product / File API operation.

• Login (Unrestrict Product / File)

• Unrestrict Product from Account

• Unrestrict File From Account

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=)

Note • Can only associate one entity at a time.

Login (Unrestrict Product / File)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>
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Unrestrict Product from Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Unrestrict xmlns="uri:webservice.subscribenet.intraware.com">
    <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:IntrawareID>35210413</uri1:IntrawareID>
    </uri1:SubscribeNetObjectReferenceAss>
         <uri:SubscribeNetObjectReference xsi:type="uri1:ProductReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:ID>AS_FlexTemplateProduct_01</uri1:ID>
         </uri:SubscribeNetObjectReference>
      </uri:Unrestrict>
   </soapenv:Body>
</soapenv:Envelope>

Unrestrict File From Account
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID>4850d702-3f80-4dac-8b1f-b9ea0544f07dGEZmvhaDo4YZt/
Ddmg72U3a4KxBwVwNvNwBcyZuz5mtJ4OB4=</uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Unrestrict xmlns="uri:webservice.subscribenet.intraware.com">
    <uri1:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:IntrawareID>35210413</uri1:IntrawareID>
    </uri1:SubscribeNetObjectReferenceAss>
         <uri:SubscribeNetObjectReference xsi:type="uri1:FileReference" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:IntrawareID>5240093</uri1:IntrawareID>
         </uri:SubscribeNetObjectReference>
      </uri:Unrestrict>
   </soapenv:Body>
</soapenv:Envelope>

Transfer Order
This section describes the Transfer Order API operation.

•
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• Login (Transfer Order)

• Transfer Order

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Transfer Order)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>

Transfer Order
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:uri1="uri:subscribenet.intraware.com">
   <soapenv:Header>
      <uri:SessionHeader>
         <uri:SessionID>fc41cffc-db07-4ec2-9f97-8370ed2e35353viVGd2JvHQd0vwk0Z/
ijVxyOqzrfeevo8U0Am1V3vCt2u4LoBZlCA==</uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:TransferOrder>
         <uri:SubscribeNetObject xsi:type="uri1:Order" xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Reference xsi:type="uri1:OrderReference">
                    <uri1:ID xsi:type="uri1:string">AS_FNE_ENT-11301</uri1:ID>
                </uri1:Reference>
        </uri:SubscribeNetObject>
         <uri:SubscribeNetObjectReference xsi:type="uri1:AccountReference" 
xmlns:uri3="uri:subscribenet.intraware.com">
        <uri1:ID>AS_AddOnAccount</uri1:ID>    
         </uri:SubscribeNetObjectReference>
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         <uri:SubscribeNetObjectReferenceAss xsi:type="uri1:AccountNoShareIDReference" 
xmlns:uri3="uri:subscribenet.intraware.com">
                <uri1:ID>AS_Account_10142</uri1:ID>
         </uri:SubscribeNetObjectReferenceAss>
      </uri:TransferOrder>
   </soapenv:Body>
</soapenv:Envelope>

Update
This section describes the Update API operation.

• Login (Update)

• Update Catalog

• Update Product

• Update Order

• Update License Token

• Update Member

Note • Execute the login call to obtain the session ID. Paste the session ID from the Login Response to proceed. 
Session ID would resemble:

c6f115ca-d46a-4ef5-8c70-2bb9c40faa52DWoR1Bxa3/QWCpaaqMbh0/KVLpN7LSUKT6t66RAL8JijHnUuT/wpHrM=

Login (Update)

Note • The login call needs to be executed to obtain the session ID for all other SOAP calls.

Important • Change PartnerCode to the specific partner where the SOAP call is intended to be run. 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
   <soapenv:Header/>
   <soapenv:Body>
      <uri:Login>
         <uri:Username>system@example.com</uri:Username>
         <uri:Password>password1</uri:Password>
         <uri:PartnerCode>TEST</uri:PartnerCode>
      </uri:Login>
   </soapenv:Body>
</soapenv:Envelope>
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Update Catalog
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
      <uri:Update xmlns="uri:webservice.subscribenet.intraware.com">
         <uri1:SubscribeNetObject xsi:type="uri1:CatalogItem" 
xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:CatalogItemReference">
                <uri1:IntrawareID>4011461</uri1:IntrawareID>
            </uri1:Reference>
            <uri1:Description>Catalog definition</uri1:Description>
            <uri1:Type>NORMAL</uri1:Type>
            <uri1:Subscription>FALSE</uri1:Subscription>
            <uri1:Temporary>FALSE</uri1:Temporary>
            <uri1:DefaultDurationYear>1</uri1:DefaultDurationYear>
            <uri1:DefaultDurationMonth>7</uri1:DefaultDurationMonth>    
            <uri1:DefaultDurationDay>15</uri1:DefaultDurationDay>
            <uri1:CatalogManufacturer>
                <uri1:ID>QAAUTOManufacturer</uri1:ID>
            </uri1:CatalogManufacturer>
            <uri1:CatalogProductLine>
                <uri1:ID>QAAUTOPlne</uri1:ID>
            </uri1:CatalogProductLine>    
            <uri1:StatusCode>INACTIVE</uri1:StatusCode>
    </uri1:SubscribeNetObject>
      </uri:Update>
   </soapenv:Body>
</soapenv:Envelope>

Update Product
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:uri="uri:webservice.subscribenet.intraware.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Header>
      <uri:OptionsHeader/>
      <uri:SessionHeader>
         <uri:SessionID></uri:SessionID>
      </uri:SessionHeader>
   </soapenv:Header>
   <soapenv:Body>
    <Update xmlns="uri:webservice.subscribenet.intraware.com">
        <SubscribeNetObject xsi:type="uri1:Product" xmlns:uri1="uri:subscribenet.intraware.com">
            <uri1:Reference xsi:type="uri1:ProductReference">
                <uri1:IntrawareID>3634313</uri1:IntrawareID>
            </uri1:Reference>
            <uri1:Description>Product definition</uri1:Description>
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            <uri1:ExportComplianceClassification>
                <!-- For NLR, T = Yes, F = No -->
                <uri1:NLR>T</uri1:NLR>
                <!-- Expected values for ECCNCode: NO_EXPORT, NOT_APPLICABLE, UNKNOWN, 3D002, 3D991 
etc --> 
                <uri1:ECCNCode>UNKNOWN</uri1:ECCNCode>
                <!--uri1:ENCCode></uri1:ENCCode>
                <uri1:CCATSCode></uri1:CCATSCode-->
            </uri1:ExportComplianceClassification>    
            <uri1:EndUserLicenseAgreement>
                <uri1:AgreementName>ExportComplianceTestAgreement</uri1:AgreementName>
            </uri1:EndUserLicenseAgreement>
            <uri1:EvaluationEndUserLicenseAgreement>
                <uri1:AgreementName>Kelly's Agreement</uri1:AgreementName>
            </uri1:EvaluationEndUserLicenseAgreement>
            <!--Product note = Download Instructions -->
            <uri1:ProductNote>ProductNote</uri1:ProductNote>
            <uri1:PhysicalDistributionAvailable>0</uri1:PhysicalDistributionAvailable>
            <uri1:UserDefinedField code="QA_UDF">Created by QA</uri1:UserDefinedField>
        </SubscribeNetObject>
    </Update>
   </soapenv:Body>
</soapenv:Envelope>

Update Order
The email will be sent when updating an order with an additional line item. Updating an existing order line will not 
trigger an email when using the DEFAULT directive. If an email needs to be triggered, the directive that should be 
used is FORCE.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <SessionHeader>
            <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
        </SessionHeader>
        <OptionsHeader>
            <uri:OrderEmailDirective>DEFAULT</uri:OrderEmailDirective>
            <uri:OrderEmailVariation>DEFAULT</uri:OrderEmailVariation>
        </OptionsHeader>
    </soapenv:Header>
    <soapenv:Body>
        <Update xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObject xsi:type="uri1:Order" xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Reference xsi:type="uri1:OrderReference">
                    <uri1:ID xsi:type="uri1:string">WSOrder0202</uri1:ID>
                </uri1:Reference>
                <uri1:Account xsi:type="uri1:AccountReference">
                    <uri1:IntrawareID>7030277</uri1:IntrawareID>
                </uri1:Account>
                <uri1:OrderDate xsi:type="xs:date">2011-11-19</uri1:OrderDate>
                <uri1:PurchaseOrderID xsi:type="xsd:string">WSOrder0202</uri1:PurchaseOrderID>
                <uri1:SalesRep>System User</uri1:SalesRep>
                <uri1:InvoiceID xsi:type="xsd:string">WSOrder0202</uri1:InvoiceID>
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                <uri1:InvoiceDate xsi:type="xs:date">2012-11-19</uri1:InvoiceDate>
                <uri1:OrderNote>WS Order</uri1:OrderNote>
                <uri1:OrderLine xsi:type="uri1:OrderLine">
                    <uri1:LineNumber>1</uri1:LineNumber>
                    <uri1:SKU>AddOn_Users</uri1:SKU>
                    <uri1:Quantity>10</uri1:Quantity>
                    <uri1:EffectiveDate>2013-05-07</uri1:EffectiveDate>
                    <uri1:ExpirationDate>2014-05-06</uri1:ExpirationDate>
                    <uri1:FlexLicenseModel xsi:type="uri1:LicenseModelIdentifier">
                        <uri1:Code>DEFAULT_ORDERLINE</uri1:Code>
<!--                        <uri1:Name>AS_DurationBased_Feature</uri1:Name>
                        <uri1:IntrawareLicenseModelID>33</uri1:IntrawareLicenseModelID> -->
                    </uri1:FlexLicenseModel>
                </uri1:OrderLine>
                <uri1:TO>system@example.com</uri1:TO>
            </SubscribeNetObject>
        </Update>
    </soapenv:Body>
</soapenv:Envelope>

Update License Token
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <SessionHeader>
            <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com"></uri:SessionID>
        </SessionHeader>
        <OptionsHeader>
            <uri:OrderEmailDirective>DEFAULT</uri:OrderEmailDirective>
            <uri:OrderEmailVariation>DEFAULT</uri:OrderEmailVariation>
        </OptionsHeader>
    </soapenv:Header>
    <soapenv:Body>
        <Update xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObject xsi:type="uri1:LicenseToken" 
xmlns:uri1="uri:subscribenet.intraware.com">
                <uri1:Reference>
                <uri1:ID xsi:type="xsd:string">TKN02</uri1:ID>
            </uri1:Reference>
            <uri1:CatalogItem xsi:type="uri1:CatalogItemReference">
<!--                For DEMO -->
                <uri1:ID>QATEST_FNPCert_Package</uri1:ID>
<!--                For SYBS 
                <uri1:ID>10098</uri1:ID> -->
            </uri1:CatalogItem>
            <uri1:Product xsi:type="uri1:ProductReference">
<!--                For DEMO -->
                <uri1:ID>QATEST_FNPCert_Package</uri1:ID>
<!--                For SYBS 
                <uri1:ID>10098-75-1500-41</uri1:ID> -->
            </uri1:Product>
            <uri1:EntitlementEffectiveDate xsi:type="xsd:date">2013-07-31</
uri1:EntitlementEffectiveDate>
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            <uri1:EntitlementExpirationDate xsi:type="xsd:date">2014-07-30</
uri1:EntitlementExpirationDate>
            <uri1:EntitlementQuantity xsi:type="xsd:positiveInteger">10</uri1:EntitlementQuantity>
            <uri1:Register xsi:type="uri1:RegisterType">REQUIRED</uri1:Register>
            <uri1:AdminPrivilege>FALSE</uri1:AdminPrivilege>
            <uri1:DownloadPrivilege>FALSE</uri1:DownloadPrivilege>
            <uri1:ExpirationDate xsi:type="xsd:date">2015-07-30</uri1:ExpirationDate>
            <uri1:Status>INACTIVE</uri1:Status>
            <uri1:DownloadLimit>1</uri1:DownloadLimit>
            <uri1:UserDefinedField code="ACCOUNT-ACCT_LOGO">http://logo.com/images/main.png</
uri1:UserDefinedField>
            <uri1:UserDefinedField code="ORDER-CHANNEL-PARTNER-ID">TST2</uri1:UserDefinedField>
            <uri1:UserDefinedField code="ORDERLINE-LIC_EXP_DATE">2015-07-31</uri1:UserDefinedField>
            <uri1:UserDefinedField code="TOKEN_NOTIF_TO">system@example.com</uri1:UserDefinedField>
            <uri1:UserDefinedField code="TOKEN_NOTIF_CC">testuser@test.com</uri1:UserDefinedField>
            <uri1:UserDefinedField code="TOKEN_NOTIF_BCC">anothertestuser@test.com</
uri1:UserDefinedField>
            </SubscribeNetObject>
        </Update>
    </soapenv:Body>

Update Member
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://
www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:uri="uri:webservice.subscribenet.intraware.com">
    <soapenv:Header>
        <SessionHeader>
            <uri:SessionID xmlns:uri="uri:webservice.subscribenet.intraware.com">5d05ae61-28a5-472d-
baf9-aa327e0f2d44PJYNXEqM7vLqSazz4xsLQdXRhLzSV8raAeI=</uri:SessionID>
        </SessionHeader>
        <OptionsHeader>
            <uri:MemberEmailDirective>DEFAULT</uri:MemberEmailDirective>
            <!--uri:MemberEmailVariation>QA_Variation_01</uri:MemberEmailVariation-->
        </OptionsHeader>
    </soapenv:Header>
    <soapenv:Body>
        <Update xmlns="uri:webservice.subscribenet.intraware.com">
            <SubscribeNetObject xsi:type="uri1:Member" xmlns:uri1="uri:subscribenet.intraware.com" 
xmlns:uri2="uri:webservice.subscribenet.intraware.com">
                <uri1:Reference xsi:type="uri1:MemberReference">
                    <uri1:Email xsi:type="xsd:string">system@example.com</uri1:Email>
                    <uri1:ID xsi:type="uri1:string">system@example.com/uri1:ID>
                    <uri1:AccountReference xsi:type="uri1:AccountReference">
                        <uri1:IntrawareID>35412913</uri1:IntrawareID>
                    </uri1:AccountReference>
                </uri1:Reference>
                <uri1:FirstName xsi:type="xsd:string">TestUser</uri1:FirstName>
                <uri1:LastName xsi:type="xsd:string">LastName</uri1:LastName>
                <uri1:JobTitle>TestJobTitle</uri1:JobTitle>
                <uri1:Phone>8474664603</uri1:Phone>
                <uri1:Fax>8474664604</uri1:Fax>
                <uri1:AddressLine1>1000 E Woodfield Road</uri1:AddressLine1>
                <uri1:AddressLine2></uri1:AddressLine2>
                <uri1:AddressLine3></uri1:AddressLine3>
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                <uri1:AddressLine4></uri1:AddressLine4>
                <uri1:City>Schaumburg</uri1:City>
                <uri1:State>IL</uri1:State>
                <uri1:PostalCode>60173</uri1:PostalCode>
                <uri1:Country>US</uri1:Country>
                <uri1:AdminPrivilege>TRUE</uri1:AdminPrivilege>
                <uri1:DownloadPrivilege>TRUE</uri1:DownloadPrivilege>
                <uri1:MemberNote>TestNote</uri1:MemberNote>
                <uri1:Status>ACTIVE</uri1:Status>
                <!--uri1:UserDefinedField code="QaUser?">Yes</uri1:UserDefinedField-->
                <uri1:Permission xsi:type="uri1:Permission">
                    <uri1:PermissionType>PDCT</uri1:PermissionType>
                    <uri1:PermissionValue>true</uri1:PermissionValue>
                </uri1:Permission>
                <uri1:Permission xsi:type="uri1:Permission">
                    <uri1:PermissionType>DOCS</uri1:PermissionType>
                    <uri1:PermissionValue>true</uri1:PermissionValue>
                </uri1:Permission>
                <uri1:Preference xsi:type="uri1:Preference">
                    <uri1:PreferenceType>EMAIL</uri1:PreferenceType>
                       <uri1:PreferenceValue>ON</uri1:PreferenceValue>
                </uri1:Preference>
                <uri1:Preference xsi:type="uri1:Preference">
                    <uri1:PreferenceType>DOWNLOAD</uri1:PreferenceType>
                    <uri1:IntrawarePreferenceKeyID>Aspera</uri1:IntrawarePreferenceKeyID>
                    <uri1:PreferenceValue>OFF</uri1:PreferenceValue>
                </uri1:Preference>
                <uri1:Preference xsi:type="uri1:Preference">
                    <uri1:PreferenceType>DOWNLOAD</uri1:PreferenceType>
                    <uri1:IntrawarePreferenceKeyID>HTTP</uri1:IntrawarePreferenceKeyID>
                    <uri1:PreferenceValue>ON</uri1:PreferenceValue>
                </uri1:Preference>                
            </SubscribeNetObject>
        </Update>
    </soapenv:Body>
</soapenv:Envelope>
</soapenv:Envelope>

Sample SOAP Calls
In order to transfer a session ID programmatically between two requests, use the property transfer test step. 
Download the following file for an example to transfer the property between two requests:

PropertyTransfer.xml

Import this test case into your project. This is executed against the FNOC endpoint.

https://docs.revenera.com/fnollm/files/PropertyTransfer.xml
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